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Without question, statistics is one of the most dreaded courses for students in the social and
behavioral sciences. Enrolling in their first statistics course, students are often apprehensive,

fearful, or extremely anxious toward the subject matter. And while SPSS is one of the more easy-
to-use statistical software programs available, for anxious students who realize they not only have
to learn statistics, but also new software, the task can seem insurmountable.

Keenly aware of students’ anxiety with statistics (and the fact that this anxiety can affect per-
formance), I’ve incorporated a number of features into the text to both alleviate anxiety toward the
subject matter and build a successful experience analyzing data in SPSS. Several of these features
are described below.

Features of the Text
First and foremost, the book is designed to be hands-on, with the user performing the analyses
alongside on their computer as they read through each chapter. To help the reader stay on-track a
step-by-step approach is used, beginning with creating the variables in SPSS and ending with
writing the results in the format of the American Psychological Association. Screen shots of each
step in SPSS are included, and call-out boxes are used to highlight important information in the
results. These features are designed to create a user-friendly and successful experience in SPSS,
thereby reducing anxiety toward the subject matter. Each of these features (and others included
in the book) are detailed in Table 1 on page xii.

In addition to the features described in Table 1, exercises are included at the end of each
chapter, with the solutions to the exercises provided in Appendix C. Students are encouraged to
work through the exercises to gain the experience required to become more proficient in statistics
and with SPSS.

Coverage and Organization of the Text
The text is designed for students in introductory statistics and research methods courses, as well
as for those in intermediate statistics and graduate courses in quantitative methods. Procedures in
the text that are often covered in introductory statistics or research methods courses include descrip-
tive statistics, t tests, one-way between ANOVA, one-way within ANOVA, two-way between
ANOVA, chi-square, correlation, and regression. For intermediate statistics and graduate courses,
more in-depth coverage of the two-way between subjects ANOVA is presented in Chapter 9, and
chapters on multiple regression, one-between–one-within ANOVA, and reliability are also included.
As individual classes will differ in their coverage of the material, each chapter provides stand-alone
coverage of a given procedure so that instructors can choose the chapters that best meet their
course objectives and their students’ needs.

Regarding the organization of the text, the book is divided into two sections. The first sec-
tion introduces the SPSS software program (Chapter 1), covers descriptive statistics (Chapter 2),
discusses how to use SPSS to produce a variety of graphs (Chapter 3), and concludes with a
chapter on estimating the internal consistency reliability of a scale using coefficient alpha (Chap-
ter 4). The second section covers inferential statistics, including: t tests (Chapters 5–7), analysis
of variance procedures (Chapters 8–11), correlation (Chapter 12), simple and multiple regression

Preface
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xii Preface

(Chapters 13–14), and chi-square procedures (Chapters 15–16). Also, data transformations and
importing Excel files into SPSS are covered in Appendices A and B, respectively.

For those who are new to SPSS and have chosen this text for help with a specific procedure,
after reading the introductory chapter you should be able to turn to the chapter of interest and
follow the instructions to correctly enter and analyze your data.

Formatting Used in the Book
As far as the formatting of the text is concerned, variables and important terminology are pre-
sented in lowercase boldface type. When referring to specific windows, dialog boxes, or options
to select within a dialog box, italics are used. Italics will also be used for information to be entered
into SPSS (with the exception of variables).

IBM SPSS/PASW Version 18 (and Previous Versions)
While this edition of the text is designed for use with version 18 of the SPSS software program (also
referred to as PASW Statistics), those using versions 17 and below shouldn’t experience difficulty
following the instructions to analyze their data successfully. For the procedures we’ll be covering

Table 1 Features of the Text

Feature Description

Four-step process of 
data analysis

In each chapter, the process of data analysis is divided into four 
easy-to-follow steps, including

a

Step 1: Create the variables. Variables are created, including entering value
labels as necessary.

Step 2: Enter the data. The correct structuring of the data file is illustrated.

Step 3: Analyze the data. How to run the correct analysis using the 
pull-down menus in SPSS is illustrated.

Step 4: Interpret the results. Each table of output is discussed, one table
at a time, with sample write-up of the results in APA format provided for
Chapters 4–16.

Screen shots Several screen shots are included in each chapter, helping the reader stay
on-track as they progress through each chapter.

Call-out boxes Call-out boxes are used to highlight important information and to alert the
reader to areas of potential confusion in SPSS (e.g., what to enter in the
Test Value box for the one-sample t test).

Research question 
and null and 
alternative hypotheses

A research question and the null and alternative hypotheses are 
presented for each procedure to help better connect the data to the
research question and hypotheses of interest (applies to Chapters 5–16).

Effect sizes How to calculate, report, and interpret effect sizes is presented. (Reporting
of effect sizes is recommended by the APA and is required by several 
journals for manuscript submission; applies to Chapters 5–14 and 16.)

Assumptions The assumptions of each inferential procedure are provided, along with 
the impact of violating the assumption on the accuracy of the procedure,
helping the reader to determine whether their data meet the requirements
for a statistical procedure of interest (applies to Chapters 5–16).

Chapter 3 does not include Steps 1 and 2.a
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in the text, version 18 is very similar to both versions 17 and 16, with the primary difference being
that version 18 incorporates slightly different graphics. Versions 16 through 18 differ from earlier
versions of the software in that the buttons of the dialog boxes are transposed (this change coincided
with SPSS moving to a Java-based program beginning with version 16). For example, in version
18, the OK button is on the left-hand side of the dialog box, while for versions 15 and below the
OK button is on the right-hand side of the dialog box. If you’re using SPSS version 15 or earlier,
once you’re aware that the buttons are reversed it shouldn’t cause any difficulty. One additional dif-
ference worth noting involves the output (Viewer) files created in SPSS. Output files saved in ver-
sions 15 and below cannot be opened in later versions of SPSS unless a free legacy viewer from
SPSS.com is downloaded.
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1

In this first unit, Chapter 1 introduces the SPSS software program, including creating variables,
entering and analyzing data, saving files, and printing your results. In Chapter 2, using SPSS to

calculate a number of different descriptive statistics is illustrated, including frequencies, measures
of central tendency, and measures of variability. Chapter 3 illustrates how to produce a number of
different graphs in SPSS, including a bar chart, histogram, scatterplot, and a boxplot. Finally,
Chapter 4 illustrates how to use SPSS to estimate the internal consistency reliability of a scale
using coefficient alpha.

I
UNIT

Introduction to SPSS, Descriptive Statistics,
Graphical Displays of Data, 

and Reliability Using Coefficient Alpha
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1
CHAPTER

In this chapter, the SPSS software program is introduced, including starting SPSS, creating variables,
entering data, performing a basic analysis using the pull-down menus, saving files, and printing your

results. Let’s begin by starting SPSS.

Starting SPSS
To start SPSS, first you’ll need to find where it’s located on your computer. Depending on the con-
figuration of your computer, SPSS should be located in one or more of the following places:

1. As an icon1 ( ) on your desktop (the desktop is the main area of workspace on
your computer screen).

2. Within the Programs menu.
3. On the Quick Launch Toolbar (the Quick Launch Toolbar is located to the right of

the Start button at the bottom of your computer screen).

Starting SPSS from each of these locations is described next. (As you read the instructions below,
choose only one of the following methods to open SPSS, so that multiple copies of the program are
not open on your computer.)

Starting SPSS from the icon on your screen

1. Locate the SPSS icon ( ) on your desktop.
2. Double-click2 the SPSS icon. SPSS should open shortly thereafter.

Starting SPSS from the programs menu

1. Click the Start button ( ).
2. Click Programs (or All Programs).
3. Select SPSS Inc. (or SPSS for Windows).
4. Select PASW Statistics 18.0. (Note: Consider the title “PASW” synonymous with

“SPSS.” If you are using a different version than 18, you may see the name “SPSS”
instead; in either case, it's “SPSS” software that is being used.) See Figure 1.1 for details.

Starting SPSS from the Quick Launch Toolbar

1. Depending on the configuration of your computer, you may have an SPSS icon ( ) to
the right of the Start button. If you see an SPSS icon located to the right of the Start but-
ton on your computer, you can single-click it to start the SPSS program. (In Figure 1.1,
SPSS is the second icon to the right of the Start button.)

If you haven’t done so already, open SPSS using one of the methods described above.

Introduction to SPSS

2
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Chapter 1 / Introduction to SPSS 3

The Start button

Figure 1.1 Opening SPSS from the Programs menu. (Note: While your screen will not be identical
to the one above, SPSS should be located within the Programs menu on your computer.)

Once SPSS is opened, a dialog box3 may appear with the phrase “What would you like to
do?” near the top of its window (see Figure 1.2 on page 4). This dialog box is designed to assist
you in getting started in SPSS. Since we will not be using this dialog box in this book (we’ll learn
how to navigate through SPSS on our own), if you see it on your computer screen, click the
Cancel button to close it.

The Data Editor Window
When SPSS opens, the Data Editor window is presented on the screen (the Data Editor window
is shown in Figure 1.3 on page 4). The Data Editor window is used to create variables and enter
data in SPSS. At the very top of the window the SPSS filename is displayed (the name Untitled
indicates that the file hasn’t been given a name yet). Located below the filename is the menu bar,
which contains several different menu options (File, Edit, View, etc.) that are used to complete a
variety of tasks in SPSS (such as saving files, printing results, etc.). Directly below the menu bar
are a number of toolbar buttons that provide quick access to several different options in SPSS. The
main area of the Data Editor window consists of a number of white rectangular objects (known
as cells) which are used for entering data.

The Data Editor consists of two different windows, the Data View window and the Variable
View window. Each of these windows may be accessed by clicking on the appropriate tab at the
bottom left-hand corner of the screen. The tab that has the gold-colored background indicates
which of the two windows is currently open (notice in Figure 1.3 that the Data View window is
currently open). If the Data View window is not currently open on your computer, click the Data
View tab to open it.

We’ll discuss the Data View and Variable View windows next.
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4 Unit I / Introduction to SPSS, Descriptive Statistics, Graphical Displays of Data, and Reliability Using Coefficient Alpha

Figure 1.2 The SPSS 18.0 for Windows “What would you like to do?” dialog box.

Cells in the
Data Editor
window. 

The file name.

The menu
bar. 

Toolbar
buttons. 

The Data View tab is selected,
indicating that the Data View
window is currently open.  

Figure 1.3 The Data Editor window in SPSS (with the Data View tab selected).
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Chapter 1 / Introduction to SPSS 5

Data View window—The window in SPSS that is used for entering data.

The Data View Window

The main area of the Data View window shown in Figure 1.4 consists of a number of cells, which
are used to enter data (data usually consists of numbers but can also be letters or symbols).4 The
rows of the Data View window are numbered (with rows 1 to 28 shown in Figure 1.4), and the
columns all initially have the name var. The first cell (the cell in the upper left-hand corner) has
a gold-colored background, indicating that it is active or ready to receive input.

The Variable View Window

The Variable View window is used for creating variables in SPSS and adding information to a
data file. The Variable View window is accessed by clicking the Variable View tab at the bottom
of the screen. Since the Data View window is currently open, we’ll need to click on the Variable
View tab to open the Variable View window.

1. Open the Variable View window by clicking on the Variable View tab. The
Variable View window is presented in Figure 1.5 (page 6).

The active cell;
it is ready to
receive input. 

The Data View tab is selected,
indicating that the Data View
window is currently open.  

All variables are named
var by default (until data
are entered or their
names are changed by
the user).

In the Data View
window, each row is
for a different person.  

Figure 1.4 The Data View window in SPSS.
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6 Unit I / Introduction to SPSS, Descriptive Statistics, Graphical Displays of Data, and Reliability Using Coefficient Alpha

The Variable
View tab
is selected. 

In the
Variable
View
window,
each row is
for a
different
variable.  

Figure 1.5 The Variable View window in SPSS.

As was the case with the Data View window, each of the rows of the Variable View win-
dow is numbered, and the main area of the window consists of a number of cells. Unlike the
Data View window, however, each of the columns in the Variable View window has a differ-
ent name and function. The different columns of the Variable View window are described in
Figure 1.6.

Of the Variable View window column attributes, we will use the Name and Values options in
this text (the default values for the other columns will be used).

Variable View window—The window in SPSS that is used for creating variables and
adding information to a data file.

With the key features of the Data Editor introduced, let’s create a data file in SPSS.

Remember: In the Data Editor, the Variable View window is for creating variables and
the Data View window is for entering data.

Creating Data Files in SPSS
An SPSS data file is a computer file that contains information (data) on one or more vari-
ables. A variable is an attribute or characteristic that takes on two or more values.

Data file—A computer file that contains information on one or more variables.
Variable—An attribute or characteristic that takes on two or more values.

To create a data file in SPSS, we’ll use the data set shown in Figure 1.7. Figure 1.7 contains
data for five people on the variables gender, age, employment, and iq (variables will be shown
in boldface type throughout the text). Notice that each row in Figure 1.7 contains the values for a
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Chapter 1 / Introduction to SPSS 7

Name of
column

Function 

Name Name is used for naming a variable. In SPSS versions 11.5 and earlier, variable names
could be no more than 8 characters in length (a character is a letter, number, or symbol).
In SPSS version 12.0 and above, variable names can be up to 256 characters in length.
Each variable must begin with a letter, and no two variables can have the same name.
No spaces are allowed in variable names. 

Type Type indicates the type of data that are stored in a variable. A number of different types
exist including, numeric, comma, dot, scientific notation, etc. In this text, we will be
working with numeric data. 

Width Width indicates the number of characters that are displayed in the Data View window.
The default5 is 8. 

Decimals Decimals indicates the number of decimals that are displayed in the Data View window.
The default is 2. 

Label Label is used for describing a variable. Up to 256 characters are allowed. The information
entered in the Label column will appear in the output. 

Values Values is used for coding categorical variables (categorical variables are discussed in
the next section). This feature will be used throughout this text. 

Missing Missing indicates the values that are read as missing data (missing data means that
certain values are not available or are “missing” for a variable). The default value for
missing data is a period, “.” 

Columns Columns indicates the width of the columns that are displayed in the Data View window.
The default width is 8 characters. 

Align Align positions the data either to the left, to the right, or in the center of the cells in the
Data View window. The default alignment is to the right. 

Measure Measure describes the measurement level of the variable. The available options are
nominal, ordinal, or scale. The default is scale. 

Role Role is a new feature in SPSS 18 that allows for preclassifying variables for use in
certain dialog boxes. Role categories include Input, Target, Both, None, Partition, and
Split. The default value for Role is Input, which will be used throughout the text.

Figure 1.6 The name and function of the different columns of the Variable View window.

Person Gender Age Employment 
(Employment status)

IQ
(IQ score) 

Person 1 Employed
Person 2 Not employed
Person 3 Employed
Person 4 Not employed
Person 5 

Male 
Male 

Female
Female
Male 

23
19
32
28
18 Employed

115
90

120
90

116

Figure 1.7 The sample data set to be entered into SPSS.
(Note: The Person column is included for illustration but will
not be entered into SPSS.)

different person on the variables of interest. In the first row, for example, the values for the first
person are displayed: Person 1 is male, 23 years old, employed, and has an IQ score of 115. The
values for the remaining four people are presented in rows 2–5.

Notice in Figure 1.7 that the variables age and iq are in numeric form (i.e., they have num-
bers for values), while gender and employment are in character form (i.e., they have words
for values). An important point to remember (for the vast majority of the procedures covered
in this text) is that to perform analyses on a variable in SPSS, it must be in numeric form.
Therefore, before entering the data into SPSS, we’ll need to change the variables that are
currently in character form (gender and employment) to numeric form. This process is
illustrated next.
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8 Unit I / Introduction to SPSS, Descriptive Statistics, Graphical Displays of Data, and Reliability Using Coefficient Alpha

Assigning Numbers to the Categories of Gender and Employment
We’ll begin by assigning numbers to the different categories of gender. As far as the rules for
assigning numbers are concerned, any number can be assigned to the different categories of a
variable as long as each category is assigned a different number (you may recognize this as an
example of a nominal scale of measurement). To illustrate this process, we’ll assign males a 1 and
females a 2. Therefore, for every male in the data set we’ll enter a 1, and for every female we’ll
enter a 2.

For employment, we’ll assign employed a 1 and not employed a 2.
The data set (with the numeric values entered for the variables gender and employment) is

presented in Figure 1.8.

Gender Age Employment 
(Employment status)

IQ
(IQ score) 

Person 1 1
Person 2 2
Person 3 1
Person 4 2
Person 5 

1
1
2
2
1

23
19
32
28
18 1

115
90

120
90

116

Figure 1.8 The revised data with numeric values entered for
gender and employment. (Note: For gender, 

for employment, 
)2 � "not employed".

1 � "employed", 2 � "female";
1 � "male", 

Categorical variable—A variable that has a limited number of values.
Dichotomous variable—A categorical variable that has only two values.
Continuous variable—A variable that has a large number of different values.

Variables such as gender and employment are known as categorical variables. Categorical
variables take on a limited number of values; categorical variables that take on only two values
(such as gender and employment) are known as dichotomous variables. The variables age
and iq are continuous variables. Continuous variables take on a large number of different
values.

Data Entry and Analysis
With all the variables now in numeric form, we can enter and analyze the data in SPSS.
Throughout this text, the process of data entry and analysis will be divided into the following
four steps: (1) create the variables, (2) enter the data, (3) analyze the data, and (4) interpret the
results. In this chapter, each of these steps will be illustrated using the sample data set provided
in Figure 1.8.

Step 1: Create the Variables

We’ll start by creating the variables gender, age, employment,6 and iq. To create variables in
SPSS, follow the instructions below.

Creating variables in SPSS

1. Make sure the Variable View window is open. If it isn’t open, click the Variable
View tab at the bottom left-hand corner of the screen.

2. The first cell in the upper left-hand corner of the Variable View window should be
active. If the first cell is not active, click on it.

3. In the first row of the Variable View window, enter the name gender and press the
Enter key. Notice that all the cells to the right are automatically filled in with the
default values (the default value for Label is an empty cell).
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4. In row 2, enter the name age and press the Enter key.
5. In row 3, enter the name employment and press the Enter key.
6. In row 4, enter the name iq and press the Enter key. The four variables are now

created in SPSS. See Figure 1.9 for details.

Figure 1.9 The Variable View window with the variables gender, age, employment, and iq entered.

To create value
labels for gender,
first click in the
Values cell,
labeled None. 

Then click the ellipsis
button,      . 

Figure 1.10 Selecting the Values cell for gender.

Value Labels

Recall that we assigned numbers (i.e., 1, 2) to the different categories of gender and employment
because they needed to be changed to numeric form to be analyzed in SPSS. You may also recall
that the numbers we assigned were arbitrary (any two numbers could have been chosen), as they
served only to differentiate between the categories of the variable. To help us keep track of our
numeric assignments more easily, we’ll enter the categories that the different numbers represent
into SPSS (e.g., that 1 is for males and 2 is for females), a process known as creating value labels.
We’ll create value labels for the categorical variables gender and employment.

Let’s start by creating value labels for gender.

Creating value labels for gender

1. Make sure the Variable View window is open. In the first row of the Variable View
window (the row for gender), click the cell in the Values column (where the word
None is displayed). After clicking on the cell labeled None, an ellipsis ( )
should appear in the right-hand corner of the cell.7

2. Click the ellipsis button ( ). See Figure 1.10 for details.
3. The Value Labels dialog box opens (see Figure 1.11 on page 10).
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Figure 1.11 The Value Labels dialog box.

The number assigned to
the category is entered in
theValue box. 

The name of the category
is entered in the Label box. 

After the Value and Label
information have been
entered, click the Add button.

Figure 1.12 The Value Labels dialog box (continued).

4. First, we’ll code into SPSS that males were assigned a 1. Enter a 1 to the right of
Value and male to the right of Label. See Figure 1.12 for details.

5. Click Add. To the right of the Add button, should now be dis-
played. See Figure 1.13 for details.

6. Next we’ll code into SPSS that females were assigned a 2. Enter a 2 to the right of
Value and female to the right of Label.

7. Click Add. The box to the right of the Add button should now display
and See Figure 1.14 for details.

8. Click OK.

With the value labels for gender entered, next we’ll enter the value labels for employment.
Recall that those who were employed were assigned a 1 and those who were not employed were
assigned a 2.

Creating value labels for employment

1. In row 3 of the Variable View window (the row for employment), click the cell in
the Values column.

2. Click the ellipsis button ( ).
3. The Value Labels dialog box opens. Enter a 1 to the right of Value and employed

to the right of Label.

2.00 = “female.”1.00 = “male”

1.00 = “male”
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Figure 1.13 The Value Labels dialog box (continued).

Figure 1.14 The Value Labels dialog box (continued).

4. Click Add. In the box to the right of the Add button, is
displayed.

5. Enter a 2 to the right of Value and not employed to the right of Label.
6. Click Add. In the box to the right of the Add button, both and

are displayed.
7. Click OK.

With the value labels created for gender and employment, next we’ll enter the data into SPSS.

Step 2: Enter the Data

To enter the data into SPSS

1. Click the Data View tab to open the Data View window (see Figure 1.15 on page 12).

In the Data View window, notice that the first four columns are named gender, age, employment,
and iq, which correspond to the four variables we created earlier in SPSS. Recall that in the Data
View window each row corresponds to a different person in the data set, so that when the data are

2.0 = “not employed”
1.0 = “employed”

1 = “employed”
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and each variable is in a
different column. 

In the Data
View window
each participant
is in a different
row…  

Figure 1.15 SPSS Data View window with the variables gender, age, employment, and iq in the
first four columns.

entered, row 1 will contain the values for the first person, row 2 will contain the values for the sec-
ond person, and so on.

2. Consulting Figure 1.8 (the data), we’ll enter the values for each person on the four
variables of interest. To enter the values for the first participant, click the first cell
in row 1 of the Data View window. Enter the values 1, 23, 1, and 115 for the vari-
ables gender, age, employment, and iq, respectively. (An efficient method of
data entry is to press the right-arrow key on the keyboard after entering
each value for a variable. For example, for the first person you would enter a 1 for
gender and then press the right-arrow key, enter a 23 for age followed by the
right-arrow key, and so on.)

3. To enter the values for the second participant, click the first cell in the second row
of the Data View window. Enter the values 1, 19, 2, and 90, for the variables
gender, age, employment, and iq, respectively.

4. Enter the data for the remaining three participants. The completed data file is
shown in Figure 1.16.

Now that the data are entered, we’ll perform a basic analysis in SPSS.

Step 3: Analyze the Data

Throughout this text, we’ll be using the pull-down menus in SPSS to perform statistical analyses
of our data. For our first analysis, we’ll start with a basic procedure in SPSS—producing a sum-
mary report of each of our variables using the Case Summaries procedure.

To perform the Case Summaries procedure in SPSS
1. From the menu bar, select (see

Figure 1.17). (When the menu commands are provided, the sign indicates the
next selection to make. In this case, “ ”
reads, “Select Analyze, then select Reports, then select Case Summaries.”)

Analyze>Reports>Case Summaries
“7”

Analyze>Reports>Case Summaries Á

1: 2
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A Summarize Cases dialog box appears (see Figure 1.18 on page 14).
The Summarize Cases dialog box shown in Figure 1.18 is representative of many of the dia-

log boxes you will encounter in SPSS. First, notice that when the dialog box opens, the variables
gender, age, employment, and iq are located on the left-hand side. To the right of the variables
are two right-arrow buttons ( ) which are used for moving the variables on the left to the boxes
on the right to be analyzed. There are also a number of buttons (Statistics, Options, OK, Paste,
Reset, etc.) which perform different operations in SPSS, and check boxes which allow certain
options to be turned on or off. The boxes that are checked when the dialog box opens are known
as the default settings.

Let’s perform the Case Summaries procedure on each of the variables by moving them to the
Variables box.

Figure 1.16 The completed data file in SPSS.

Figure 1.17 Menu commands for the Case Summaries procedure in SPSS.
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Buttons allow for
selecting various
options or running
program commands. 

In SPSS,when a
dialog box first
opens, the 
variables are
located on the
left–hand side. 

The variables
can be moved to
these boxes to
be analyzed. 

Check boxes allow options to be
enforced (if they are checked) or
not enforced (if they are not checked). 

Figure 1.18 The Summarize Cases dialog box.

Clicking OK
runs a given
procedure in
SPSS (in this
case, the
Case
Summaries
procedure). 

Figure 1.19 The Summarize Cases dialog box (continued).

2. To move the variables to the Variables box, select gender and press and hold
down the shift key. With the shift key continued to be held down, select the last
variable iq. All four variables should be selected. Click the upper-right arrow
button ( ) to move the four variables to the Variables box.8 See Figure 1.19
for details.

3. Click OK.

SPSS opens a new window containing the output—called the Viewer window—that presents
the results of the Case Summaries procedure. We’ll discuss the output next.
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The right side of the
Viewer window
displays the results of
the requested analyses. 

The left side
of the Viewer
window
presents an
outline of the
results.  

Figure 1.20 The SPSS Viewer window with the results of the Case Summaries procedure shown.

Step 4: Interpret the Results

The output of the Case Summaries procedure is presented in Figure 1.20.

Viewer (Output) Window
In SPSS, the Viewer window is divided into two different sections, with the left side of the window
containing an outline of the requested analyses, and the right side of the window displaying the
results of the analyses. We’ll focus our attention throughout this text on the results shown in the right
side of the Viewer window which, in this case, consist of the Case Processing Summary and Case
Summaries tables. These tables will be discussed next.

The Case Processing Summary and Case Summaries tables are displayed in Figure 1.21.

Summarize
Case Processing Summarya

5 100.0% 0 .0% 5 100.0%
5 100.0% 0 .0% 5 100.0%
5 100.0% 0 .0% 5 100.0%
5 100.0% 0 .0% 5 100.0%

gender
age
employment
iq

N Percent N Percent N Percent
Included Excluded Total

Cases

a. Limited to first 100 cases.

Case Summariesa

male 23.00 employed 115.00
male 19.00 not employed 90.00
female 32.00 employed 120.00
female 28.00 not employed 90.00
male 18.00 employed 116.00

5 5 5 5

1
2
3
4
5

NTotal

gender age employment iq

a. Limited to first 100 cases.

Notice that the labels
(male/female, employed/not
employed) are displayed for
gender and employment
(instead of 1 and 2), which is
one of the benefits of creating
value labels in SPSS.

Figure 1.21 The output of the Case Summaries procedure in SPSS.
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Summarize
At the top of the output is the title, Summarize, which indicates the procedure we selected in SPSS
(the Case Summaries procedure).

Case Processing Summary
The first table of results, Case Processing Summary, displays the number of participants (i.e.,
cases) in the data file for each of the variables. The first column, Included, reports an N of 5 for
each of the variables (N corresponds to the number of participants or cases in the data file), indi-
cating that five people were included in the analysis for each variable. The Excluded column
reports an N of 0 for each variable, indicating that none of the participants were excluded from the
analyses (everyone had values on all four variables). The last column, Total, displays the total
number of participants in the data set, which is equal to 5.

Case Summaries
The second table, Case Summaries, displays the values for each of the participants on the four vari-
ables of interest. Notice that the value labels we created for gender and employment are displayed
in the table instead of the numeric values (i.e., 1 and 2) we originally entered into SPSS, which makes
it easier to read the results.

This concludes the discussion of the Case Summaries procedure in SPSS. Next we’ll discuss
how to save SPSS files.

Saving Files
In SPSS, output files and data files are saved separately using different file extensions. File exten-
sions commonly consist of three or four letters at the end of a file name and are preceded by a period
(e.g., “.docx,” “.html,” and “.mp3”). In SPSS, the file extension for data files is “.sav” and the file
extension for output files is “.spv.”

We’ll practice saving both data files and output files in SPSS. Let’s start by saving an output
file. To save the output file, first make sure the Viewer (output) window is active. (If the Viewer
window is active, you should see it on your screen with a dark blue bar at the top of its window.)
If the Viewer window is not active, click on it.

To save the output file

1. With the Viewer window active, select (see Figure 1.22).
2. The Save Output As dialog box opens (see Figure 1.23).

Toward the bottom of the Save Output As dialog box are the File name and Save as type boxes
(see Figure 1.23). In the File name box, the default name Output1 appears, and in the Save as type
box, Viewer Files (*.spv) is shown, confirming that we’re saving the results of the Viewer window
(the output). Notice that Output1 is selected, indicating that the file name is in edit mode and will
be replaced by what is entered on the keyboard.

Let’s name the file Introduction output.

3. Type the name Introduction output. (You should now see Introduction output in
the File name text box.)

Next, we’ll select a location for the file to be saved. Let’s save the file to the desktop.
To save the file to the desktop,

4. Click the list arrow ( ) to the right of the Look in box (located near the top of
the dialog box). A list of folders and/or drives should appear.

5. Select Desktop (see Figure 1.24). (Note: If you prefer to save the file elsewhere,
select the location of your choice.)

File>Save As Á
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Figure 1.22 Menu commands for saving a file.

The File name box is where the
name of the file being saved is
entered. It is not necessary to type
the extension‘.spv ’ when entering
the file name.  The Save as type

box indicates the
type of file that is
being saved. (In
this case, a Viewer
file is being saved.)  

The list arrow
for the Look in
box. The location
in which to save
the file is
selected here. 

Figure 1.23 The Save Output As dialog box.

Figure 1.24 The Save Output As dialog box (continued).
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Figure 1.25 Menu commands for making the Data Editor window active.

6. Click Save. You should see the name Introduction output.spv (with or without the
file extension) in the upper left-hand corner of the Viewer window, indicating that
the file has been saved.

Saving a Data File

To save the data file, first we’ll need to make the Data Editor window active.

To make the Data Editor window active

1. From the menu bar select 
(see Figure 1.25).

Data EditorWindow>Untitled–PASW Statistics

To save the data file

1. With the Data Editor window active, select (see Figure 1.26).
2. The Save Data As dialog box opens.
3. In the File name box, type the name Introduction data.
4. Click on the list arrow ( ) to the right of the Look in box to select the location

where you would like the file to be saved.
5. Click Save. You should see the name Introduction data.sav (with or without the

file extension) in the upper left-hand corner of the Data Editor window, indicating
that the file has been saved.

Printing Files
Next, how to print an output file in SPSS will be illustrated. To print the output, we’ll first need
to make the Viewer window active.

To make the Viewer window active

1. From the menu bar, select 
.Statistics Viewer

Window>Introduction output.spv–PASW

File>Save As Á
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Figure 1.26 The Save As command from the File menu.

To print the output

1. With the Viewer window active, select (see Figure 1.27).File>Print Á

Figure 1.27 Menu commands for printing the output in SPSS.

2. The Print dialog box opens (see Figure 1.28 on page 20 for details). (The Print
dialog box shown on your screen may look different from the one presented in
Figure 1.28.)

3. Click OK.

Assuming you have access to a printer, the Case Processing Summary and Case Summaries
tables should print (along with the title Summarize). You can also print a single table by selecting
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Figure 1.28 The Print dialog box in SPSS.

Person GenderAge
Well–
being

Number of
Activities

4
7
6
8

Male
Female
Female
Female
Female

86
72
59
86
92 4

2

1
2
3
4
5
6
7

Male
Male

68
73 8

2
6
5
7
1
3
5

Figure 1.29 The data for the nursing home residents. (Note: The
person variable is included for illustration but will not be entered
into SPSS.)

it (i.e., clicking on it with the mouse) and then selecting Print from the File menu. (The data file
can also be printed by making the Data Editor window active (with the Data View tab selected)
and selecting Print from the File menu.)

This concludes the introduction to SPSS.

Exercises

1. Shown in Figure 1.29 are data on seven nursing home residents, including their age,
gender, well-being (measured on a 1 to 10 scale with higher scores indicating
greater levels of well-being), and the number of activities they engage in each week.

Enter the data in SPSS and perform the appropriate analyses to answer each
of the questions below. Name the variables age, gender, wellbeing, and
activities, respectively.
a. Create value labels for gender, assigning males a Value of 1 and the Label

male, and females a Value of 2 and the Label female.
b. Save the data file to a location of your choice. Name the file Nursing home data.
c. Run the Case Summaries procedure on the data and print your results.
d. In the Case Summaries table, are the numeric values (i.e., 1 and 2) or the

value labels (i.e., male and female) output in SPSS? Why?
2. A researcher wanted to compare two different types of therapy on children’s self-

esteem and anger management skills. The therapies investigated were nondirective
play therapy (i.e., child directs the play) and directive play therapy (e.g., therapist
leads the child through structured play activities). A total of 12 children were
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included in the study with 6 children (3 boys and 3 girls) receiving each type of
therapy. After six weeks of therapy, the childrens’ self-esteem (measured on a
10 to 50 scale) and anger management skills (measured on a 5 to 25 scale) were
assessed. The data are presented in the file Chapter 1_Exercise 2.sav in the Chapter 1 
folder on the web at www.routledgetextbooks.com/textbooks/9780205735822  (the 
variables are named therapy, gender, selfesteem, and angermanage). Open the 
file and perform the appropriate analyses in SPSS to answer the questions below.
a. Create value labels for therapy and gender. For therapy,

and For gender, and

b. Run the Case Summaries procedure on the data and print your results.
3. The data file Chapter 1_Exercise 3.sav in the Chapter 1 folder on the web at 

www.routledgetextbooks.com/textbooks/9780205735822 contains the values for 10 
students on the fol-lowing three variables: gender, number of classes enrolled in 
(numberclasses), and the number of hours worked per week (hoursworked). Open 
the file in SPSS and perform the appropriate analyses to answer the questions below.
a. Create value labels for gender. For gender, and 
b. Run the Case Summaries procedure on the data and print your results.

2 = “female.”1 = “male”

2 = “female.”
1 = “male”2 = “directive.”1 = “nondirective”
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Participant

1
2
3
4
5
6
7
8
9

10

Gender

1
1
2
2
1
1
1
2
2
2

Mathexam

24
18
34
27
15
26
42
25
31
44

College

1
2
1
2
1
1
2
1
1
2

Satquant

570
450
600
450
580
550
480
520
450
550

Figure 2.1 The sample data set. (Note: The participant
variable is included for illustration but will not be entered
into SPSS.)

2
CHAPTER

In this chapter, we’ll use SPSS to calculate a number of descriptive statistics, including frequencies,
measures of central tendency, and measures of variability. Each of these statistical measures is

discussed below.
Frequencies refer to the number of observations in each category of a variable. If, for example,

for a variable gender there were four males and six females in the data set, the frequency reported
in SPSS for males would be 4 and for females would be 6. Frequencies are typically obtained on cat-
egorical variables.

Measures of central tendency are used to describe the center (or central location) of a set of
scores and consist of the mean, median, and the mode. The mean is the arithmetic average (the sum
of the scores divided by the total number of scores), the median is the middle score (assuming the
scores were ordered from lowest to highest), and the mode is the most frequently occurring score (or
scores) in the data set.

Measures of variability are used to describe the amount of spread or variability in a set of scores.
The standard deviation and variance are two of the most commonly used measures of variability.
The standard deviation is a measure of how far, on average, scores vary from the mean, and the vari-
ance is equal to the standard deviation squared. Other examples of measures of variability include the
range (the difference between the highest and the lowest scores) and the interquartile range (the
difference between the scores at the 25th and 75th percentiles of a distribution).

How to calculate frequencies, measures of central tendency, and measures of variability in SPSS
will be illustrated using the sample data set presented in Figure 2.1.

Descriptive Statistics: Frequencies, 
Measures of Central Tendency, and 

Measures of Variability

22

The Data

For each of the participants in Figure 2.1, their gender, score on a math entrance exam (mathexam),
whether they were attending college at home or away (college), and their score on the math portion
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Figure 2.2 The Variable View window in SPSS with the variables gender, mathexam, college, and satquant entered.

of the SAT (satquant) were recorded. Gender and college are categorical variables, and mathexam
and satquant are continuous variables, with higher scores indicating better performance on both
measures (the mathexam scores range from 0 to 50 and satquant scores range from 200 to 800).
For gender, males are assigned a “1” and females are assigned a “2”; for college, those attending
college at home are assigned a “1” and those attending college away are assigned a “2.”

With an overview of the data set provided, next we’ll enter the data into SPSS.

Step 1: Create the Variables

Steps 1 and 2 below describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name descriptive 
statistics.sav in the Chapter 2 folder. If you prefer to open the file from the web site, skip to 
Step 3 below.

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, four variables will be created. The variables will be named gender,
mathexam, college, and satquant, respectively.

3. Using the process described in Chapter 1, enter the variable names gender,
mathexam, college, and satquant, respectively, in the first four rows of the
Variable View window (see Figure 2.2).

Prior to entering the data, we’ll create value labels in SPSS for the categorical
variables gender and college.

4. Using the process described in Chapter 1, create value labels for gender and
college. For gender, and For college, and

Step 2: Enter the Data

Next, we’ll enter the data into SPSS.

To enter the data

1. Click on the Data View tab. The variables gender, mathexam, college, and
satquant appear in the first four columns of the Data View window.

2. Consulting Figure 2.1, enter the scores for each of the participants on the four
variables of interest. For the first participant, enter the scores 1, 24, 1, and 570, for
the variables gender, mathexam, college, and satquant, respectively. Using this
approach, enter the data for all 10 participants. The completed data set is shown in
Figure 2.3 (page 24).

2 = “away.”
1 = “home”2 = “female.”1 = “male”

M02_YOCK5822_02_SE_C02.qxd  11/4/10  10:23 AM  Page 23



Figure 2.4 Menu commands for the Frequencies procedure.

24 Unit I / Introduction to SPSS, Descriptive Statistics, Graphical Displays of Data, and Reliability Using Coefficient Alpha

Step 3: Analyze the Data

In analyzing the data, first we’ll calculate frequencies for the categorical variables gender and
college, and then we’ll calculate measures of central tendency and variability for the continuous
variables mathexam and satquant.

Frequencies
To calculate frequencies for gender and college, from the menu bar, select

1. (see Figure 2.4).Analyze>Descriptive Statistics>Frequencies Á

Figure 2.3 The completed data set for the 10 participants.
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A Frequencies dialog box opens with the variables gender, mathexam, college, and satquant
on the left-hand side of the dialog box (see Figure 2.5).

Figure 2.5 The Frequencies dialog box.

2. Select the variable gender and then press and hold down the Ctrl key (the Ctrl key
is located in the bottom left-hand corner of your keyboard). Select the variable
college (gender and college should now be selected). Click the right-arrow button
( ) to move the two variables to the Variable(s) box.1 See Figure 2.6 for details.

3. Click OK.

Figure 2.6 The Frequencies dialog box (continued).

The Frequencies procedure runs and the results are presented in the Viewer window. Prior to
discussing the results of the Frequencies procedure for gender and college, we’ll obtain descrip-
tive statistics for mathexam and satquant.

(For consistency throughout the text, we’ll be running procedures from within the Data
Editor window. Since the Viewer window is currently active, we’ll make the Data Editor window
active prior to running the next procedure.)

To make the Data Editor window active

1. From the menu bar, select . The
Data Editor window should now be active. (If you opened the data from the web site,
you’ll select Data EditorWindow>descriptive statistics.sav-PASW Statistics 

Window>Untitled–PASW Statistics Data Editor
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from the menu bar. These instructions will apply throughout the chapter for those
using the file from the web site.)

Measures of Central Tendency and Variability
Next we’ll obtain measures of central tendency and variability for the continuous variables
mathexam and satquant using the Frequencies procedure.

To obtain measures of central tendency and variability

1. From the menu bar, select 
(see Figure 2.4).2

2. The Frequencies dialog box opens. Click the Reset button to clear the existing
variables from the Variable(s) box. Select the variable mathexam and then press
and hold down the Ctrl key. Select the variable satquant (both mathexam and
satquant should now be selected). Click the right-arrow button ( ) to move the
two variables to the Variable(s) box (see Figure 2.7).

Frequencies ÁAnalyze>Descriptive Statistics>

Figure 2.7 The Frequencies dialog box (continued).

3. Click the Statistics button. The Frequencies: Statistics dialog box opens. Under
Central Tendency, select Mean, Median, and Mode. Under Dispersion select Std.
deviation, Variance, Range, Minimum, and Maximum. See Figure 2.8 for details.

4. Click Continue.
5. In the Frequencies dialog box, click on the check mark to the left of Display fre-

quency tables to turn this option off. The box should now be empty, indicating that
frequency tables will not be produced for the variables mathexam and satquant
(frequency tables are typically not produced for continuous variables, as measures
of central tendency and variability are more informative). See Figure 2.9 for
details.

6. Click OK.

The Frequencies procedure runs in SPSS and the results are presented in the Viewer window.
Prior to discussing the results of the Frequencies procedure, the Means procedure will be illustrated.

Analysis of Groups Using the Means Procedure
The Means procedure is useful for obtaining descriptive statistics separately for each group of
a variable (or variables) of interest. For example, instead of obtaining the mean satquant score
for all participants, the mean satquant scores could be obtained separately for those who attended
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college at home and those who attended college away. We’ll illustrate the Means procedure by
obtaining the mean and standard deviation on satquant separately for the different college
groups.

To obtain the Means procedure

1. Make the Data View window active (select 
).

2. From the menu bar, select (see
Figure 2.10 on page 28 for details).

3. The Means dialog box opens (see Figure 2.11 on page 28).

The variable that the mean and standard deviation will be obtained on (satquant) goes into
the Dependent List box and the variable that contains the different groups (college) goes into the
Independent List box.

Analyze>Compare Means>Means Á
Data Editor

Window>Untitled –  PASW Statistics

Figure 2.8 The Frequencies: Statistics dialog box.

Figure 2.9 The Frequencies dialog box (with the Display frequency
tables check box unchecked).
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4. Select satquant and click the upper right-arrow button ( ) to move it to the
Dependent List box.

5. Select college and click the lower right-arrow button ( ) to move it to the
Independent List box (see Figure 2.12).

6. Click Options. The Means: Options dialog box opens (see Figure 2.13).

On the left-hand side of the dialog box (labeled Statistics) are a number of statistics that can
be selected, and on the right-hand side (labeled Cell Statistics) are the statistics that are calculated
by default. Since the Mean and Standard Deviation are on the right-hand side already, we’ll leave
the default options in place. (Number of Cases could be moved to the Statistics box by selecting
it and clicking the arrow button, but we’ll leave it there since it won’t adversely affect our results.)

7. Click Continue.
8. Click OK.

Figure 2.10 Menu commands for the Means procedure.

Figure 2.11 The Means dialog box.
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The Means procedure runs in SPSS and the results are presented in the Viewer window. Prior
to discussing the results, we’ll perform a final analysis using the Means procedure. Instead of
obtaining the mean and standard deviation separately for the different groups of a single variable
(as we did with college), we’ll obtain means for two categorical variables using the layered option.
To illustrate this procedure, we’ll obtain means on satquant for the different college groups lay-
ered (or further subdivided) by gender. This will result in four different mean satquant scores:
males who attended college at home, females who attended college at home, males who attended
college away, and females who attended college away.

Figure 2.12 The Means dialog box (continued).

Figure 2.13 The Means: Options dialog box.
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To perform the Means procedure using the layered option

1. Make the Data View window active (select 
).

2. From the menu bar, select (see
Figure 2.10 for details).

3. The Means dialog box opens with satquant in the Dependent List box and college
in the Independent List box (see Figure 2.14). (Note: If you did not perform the
previous Means procedure, you’ll need to move satquant and college to their
respective boxes.)

Analyze>Compare Means>Means Á
Statistics Data Editor

Window>Untitled –  PASW

Figure 2.14 The Means dialog box.

Layer 2 of 2
indicates that
the results will
be layered by
the variable 
entered into the
Independent List
box (gender). 

Figure 2.15 The Means dialog box using the layered option.

4. To layer the results by gender, in the Layer 1 of 1 section of the dialog box, click
the Next button (after clicking on Next, you should see ‘Layer 2 of 2’ above the
Previous button). Select gender and click the lower-right arrow button ( ) to
move it to the Independent List box (see Figure 2.15).

5. Click OK.

The Means procedure runs in SPSS and the results are presented in the Viewer window. Next we’ll dis-
cuss the output for the four analyses we conducted in this chapter. As a review, the four analyses were:

1. Frequencies on the variables college and gender.
2. Measures of central tendency and variability on mathexam and satquant.
3. Means and standard deviations on satquant for the different college groups.
4. Means and standard deviations on satquant for the different college groups

layered by gender.
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Step 4: Interpret the Output

The output of the four analyses is presented in Figures 2.16–2.19. [If you’ve conducted the analy-
ses on your own computer as you’ve read through the chapter, scroll to the top of the output
(Viewer) window to the first set of results—frequencies for gender and college.]

Analysis 1: Frequencies Procedure—Gender and College
The results of the first analysis we conducted—frequencies for gender and college—are provided
in Figure 2.16.

Frequencies 
Statistics

10 10

0 0

Valid
Missing

N

gender college

Frequency Table
gender

5 50.0 50.0 50.0

5 50.0 50.0 100.0

10 100.0 100.0

male
female

Total

Valid
Frequency Percent Valid Percent

Cumulative
Percent

college

6 60.0 60.0 60.0

4 40.0 40.0 100.0

10 100.0 100.0

home
away

Total

Valid
Frequency Percent Valid Percent

Cumulative
Percent

Figure 2.16 Output of the Frequencies procedure for gender and college.

Frequencies—Statistics
The Statistics table displays the sample size for the variables gender and college. The table indi-
cates that there were 10 valid observations for gender and college (all 10 people had values on both
variables). The value of zero in the Missing row indicates that there were no missing values for
either of the variables (a missing value for gender, for example, would indicate that the gender
of one of the participants was not recorded).

Frequency Table—Gender
The frequency table for gender indicates the frequency, or number of participants, for each cate-
gory of gender. In the table there are five males and five females, with each gender representing
50% of the data set.

Frequency Table—College
The frequency table for college indicates the frequency for each category of college. The table
shows that six students attended college at home and four students attended college away from
home, representing 60% and 40% of the data set, respectively.

Analysis 2: Frequencies Procedure—Mathexam and Satquant
The results of the second analysis we conducted—frequencies for mathexam and satquant—are
presented in Figure 2.17 (page 32).

The Statistics table displays the results of the Frequencies procedure for the continuous
variables mathexam and satquant. (Recall that we requested measures of central tendency and
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Means 
Case Processing Summary

10 100.0% 0 .0% 10 100.0%satquant  * college

N Percent N Percent N Percent

Included Excluded Total

Cases

Report
satquant

545.0000 6 53.94442

482.5000 4 47.16991

520.0000 10 58.30952

college
home

away

Total

Mean N Std. Deviation

Figure 2.18 Output of the Means procedure on satquant for the college groups home and away.
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variability for these variables.) The mean and standard deviation for mathexam is 28.60 and 9.38
(rounding to two decimal places) and for satquant is 520.00 and 58.31, respectively. The min-
imum and maximum values indicate the lowest and highest values in the data set and are help-
ful for ensuring that all the data are within the possible range of values (a value outside of this
range would most likely indicate that a data entry error has been made). The minimum and
maximum values of 15.00 and 44.00 for mathexam and 450.00 and 600.00 for satquant show
that there were no out-of-range values for either variable (as indicated earlier, the range of pos-
sible scores for mathexam is 0 to 50 and for satquant is 200 to 800).3

Analysis 3: Means Procedure—Satquant by College
The results of the third analysis we conducted—Means of satquant for the different college
groups—are presented in Figure 2.18.

Frequencies 
Statistics

10

0

28.6000

26.5000

15.00a

9.38320

88.044

29.00

15.00

44.00

10

0

520.0000

535.0000

450.00

58.30952

3400.000

150.00

450.00

600.00

Valid

Missing

N

Mean

Median

Mode

Std. Deviation

Variance

Range

Minimum

Maximum

mathexam satquant

a. Multiple modes exist. The smallest value is shown 

Figure 2.17 Output of the Frequencies procedure for
mathexam and satquant.

Case Processing Summary
The Case Processing Summary table indicates the number of observations included in the analy-
sis (10), the number of observations excluded (0), and the total number of observations in the data
set (10). The table indicates that all 10 participants were included in the analysis (all 10 people had
values on satquant and college).

Report
The Report table shows the mean, sample size (N), and standard deviation for the college groups
home, away, and total (home and away combined). Inspecting the means for the two groups shows
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satquant

566.6667 3 15.27525

523.3333 3 75.05553

545.0000 6 53.94442

465.0000 2 21.21320

500.0000 2 70.71068

482.5000 4 47.16991

526.0000 5 57.70615

514.0000 5 65.03845

520.0000 10 58.30952

gender

male

female

Total

male

female

Total

male

female

Total

college

home

away

Total

Mean N Std. Deviation

Means 
Case Processing Summary

10 100.0% 0 .0% 10 100.0%satquant *
college * gender

N Percent N Percent N Percent

Included Excluded Total

Cases

Report

Figure 2.19 Output of the Means procedure on satquant for college layered by gender.
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that the six students who attended college at home had a higher mean satquant score (545.00)
than the four students who attended college away (482.50). Those who stayed at home for col-
lege also had satquant scores that were slightly more variable than those who attended college
away (the standard deviation for home was 53.94 compared to a standard deviation of 47.17 for
away). The mean satquant score for the entire sample (Total) was 520.00 with a standard devi-
ation of 58.31 (this agrees with the values obtained in our second analysis).

Analysis 4: Means Procedure—Satquant by College Layered by Gender
The results of the last analysis we conducted—Means of satquant by college layered by
gender—are presented in Figure 2.19.

Case Processing Summary
The Case Processing Summary table indicates the number of observations included in the
analysis (10), the number of observations excluded (0), and the total number of observations in
the data set (10). The table indicates that all 10 participants were included in the analysis (all
10 people had values on satquant, college, and gender).

Report
The Report table displays the mean, sample size (N), and standard deviation on satquant for
college layered by gender. The first section of the table displays the mean and standard devia-
tion for males and females who attend college at home. Notice that males have a higher mean
score than females on satquant (566.67 vs. 523.33) and that females have a larger standard
deviation (75.06 vs. 15.28). The second section of the table displays the mean and standard
deviation for males and females who attend college away from home. For this group of stu-
dents, females have a higher mean than males on satquant (500.00 vs. 465.00) and a larger
standard deviation (70.71 vs. 21.21). Finally, the last section of the table displays the mean and
standard deviation for males and females for home and away combined. When the college
groups are combined, males have a higher mean satquant score than females (526.00 vs. 514.00),
while females have a larger standard deviation (65.04 vs. 57.71).

This concludes the discussion of the Frequencies and Means procedures in SPSS.
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Summary of Steps to Conduct the Frequencies
and Means Procedures

I. Data Entry
1. Create the variables in SPSS by entering the variable names in the Variable

View window.

2. Create value labels for each of the categorical variables. In the Variable View
window, enter the numeric values and labels as appropriate. Click OK.

3. Enter the data for each of the participants in the Data View window.

II. Analysis of the Data

Obtaining frequencies using the Frequencies procedure

1. From the menu bar, select 

2. Move the categorical variables to be analyzed to the Variable(s) box.

3. Click OK.

Obtaining descriptive statistics using the Frequencies procedure

1. From the menu bar, select 

2. Move the continuous variables to be analyzed to the Variable(s) box.

3. Click Statistics.

4. Select the statistics of interest.

5. Click Continue.

6. In the Frequencies dialog box, uncheck Display frequency tables.

7. Click OK.

Obtaining descriptive statistics on one or more categorical variables using the Means
procedure

1. From the menu bar, select 

2. Move the variable(s) that the descriptive statistics will be obtained on to the
Dependent List box. Move the categorical variable to the Independent List box.

3. If you want to layer the results by a second categorical variable, click the
Layered button and move the categorical variable to the Independent List box.
(Disregard this step if you don’t want to layer the results by a second variable.)

4. Click OK.

Exercises

1. A soccer coach evaluated the impact of two different kicking methods (a toe kick
and a heel kick) on the effectiveness of kicking a soccer ball. Four boys and four
girls kicked a ball using one of the two methods and the distance (in feet) and accu-
racy (on a 1 to 10 scale) of the kicks were recorded. The experience level of each
child was also ascertained, with higher values indicating greater experience. Half
of the children (two boys and two girls) kicked the ball using a toe kick and the
other half kicked the ball using a heel kick. The data are provided in Figure 2.20.
For gender, and For method, and

Enter the data in SPSS and perform the appropriate analyses to answer each
of the questions below. Enter value labels as appropriate for gender and method.
a. Report the frequencies for gender and method.

2 = “heel kick.”
1 = “toe kick”2 = “girls.”1 = “boys”

Analyze>Compare Means>Means Á .

Frequencies Á .
Analyze>Descriptive Statistics>

Frequencies Á .
Analyze>Descriptive Statistics>
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Accuracy

5
4
6
9
3
6
7

Gender

1
1
1
1
2
2
2
2

Experience

5
6
2
9
2
7
4
2

Distance

50
45
35
40
42
39
28
32 6

Method

1
1
2
2
1
1
2
2

Figure 2.20 Data for the eight children in the soccer ball kicking
study.

b. Report the mean and standard deviation for experience, distance, and
accuracy for the entire sample.

c. Report the mean and standard deviation for experience, distance, and
accuracy separately for boys and girls. Which group has a higher mean on
each of the three variables? Which group has a larger standard deviation?

d. Report the mean and standard deviation for experience, distance, and
accuracy separately for the toe kicking and heel kicking methods. Which
group has a higher mean on each of the three variables? Which group has a
larger standard deviation?

e. Report the mean and standard deviation for experience, distance, and
accuracy for gender layered by method. Which of the four conditions has
the lowest mean experience and accuracy scores? Which has the highest
mean kicking distance?

2. A student collected data on the perception of water quality in three different cities across 
the United States. She sampled 10 people (5 males and 5 females) each from major cities 
in the Midwest, on the West Coast, and on the East Coast. Each person tasted the 
municipal water from their respective city (the water was provided by the researcher) and 
rated its taste and clarity on a 1–10 scale (with higher ratings indicating better perceived 
taste and clarity, respectively). The data file is located in the Chapter 2 folder online at 
www.routledgetextbooks.com/textbooks/9780205735822 and is named Chapter 
2_Exercise 2.sav. The data file consists of the values of 30 participants on the variables 
location, gender, taste, and clarity. For location,

and For gender,
and Open the file in SPSS and perform the appropriate

analyses to answer the questions below.
a. Report the frequencies for location and gender.
b. Report the mean and standard deviation for taste and clarity for the entire

sample.
c. Report the mean and standard deviation for taste and clarity separately for

the different locations. Which location has the highest mean on each of the
two variables? Which location has the largest standard deviation?

d. Report the mean and standard deviation for taste and clarity separately for
males and females. Which group has the highest mean on each of the two
variables? Which group has the largest standard deviation?

e. Report the mean and standard deviation for taste and clarity for gender layered
by location. Which of the six conditions has the lowest mean taste? Which has
the lowest mean clarity? Which has the highest mean taste and clarity?

3. A researcher collected data on the reading performance and number of hours of tele-vision 
watched per day of 30 children. The gender and socioeconomic status (SES) of each 
participant were also collected. The data file is located in the Chapter 2 folder online at 
www.routledgetextbooks.com/textbooks/9780205735822 and is named Chapter 2_Exer-
cise 3.sav. The data file contains the variables gender, ses, hourstv, a n d  readingscores. 

For gender 1 = “male”, and 2 = “female.” For ses,
and The reading scores are on a 0 to 503 = “high.”1 = “low,” 2 = “middle,”

2 = “female.”1 = “male”
3 = “East Coast.”1 = “West Coast,” 2 = “Midwest,”
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scale with higher scores indicating better reading performance. Open the data file in
SPSS and perform the appropriate analyses to answer the questions below.
a. Report the frequencies for gender and ses.
b. Report the mean and standard deviation for hourstv and readingscores for

the entire sample.
c. Report the mean and standard deviation for hourstv and readingscores sepa-

rately for males and females. Which group has the highest mean on each vari-
able? Which group has the largest standard deviation?

d. Report the mean and standard deviation for hourstv and readingscores for
gender layered by ses. Which group watches the most television on average?
Which group has the highest mean reading scores?
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In this chapter we’ll create a number of different graphs in SPSS. By creating graphs, you can
quickly determine the general shape of a distribution of scores, the overall variability of the data,

and can detect outliers, or scores that are unrepresentative of the majority of the values in the data
set. We’ll use SPSS to create a number of commonly used graphs, including bar charts, histograms,
scatterplots, and boxplots.

To create graphs in this chapter, we’ll use the data file we created in Chapter 2. A copy of the 
file is located in the Chapter 3 folder on the web at www.routledgetextbooks.com/
textbooks/9780205735822 under the file name descriptive statistics.sav. (Note: The following 
commands assume that the SPSS Demystified files have been downloaded from the web site to 
your computer.)
To open the file from your computer

1. Start SPSS.
2. From the menu bar, select 
3. The Open Data dialog box appears (if you are using SPSS 14.0 or below, the dialog

box is named Open File). Click on the list arrow and select the location of the SPSS
Demystified files on your computer.

4. Double-click the Chapter 3 folder to open it. You should see the file descriptive
statistics.sav (the file extension ‘.sav’ may not be shown on your computer). Double-
click the file to open it. After a few moments, the file should open in the SPSS Data
Editor window. The data file is shown in Figure 3.1. (Note: If you don’t see the file
on your computer screen, select 

from the menu bar to make the Data Editor window active.)Statistics Data Editor
Window>descriptive statistics.sav–PASW

File>Open>Data Á .

3
CHAPTER

Graphical Procedures

Figure 3.1 The descriptive statistics.sav data file.
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Figure 3.2 Menu commands for the bar chart procedure.

Bar Charts
The first graph we’ll create in SPSS is a bar chart. Bar charts indicate the frequency, or number
of observations, for each category of a variable (bar charts are typically produced on categorical
variables). We’ll create a bar chart for college.

To create a bar chart in SPSS

1. From the menu bar select (see Figure 3.2).
(Note: If you are using SPSS version 14.0 or lower, the menu commands are

All other commands are the same.)Graphs>Bar.

Graphs>Legacy Dialogs>Bar Á

Figure 3.3 The Bar Charts dialog box.

2. The Bar Charts dialog box opens. To create a bar chart for college, the default
option, Simple, will be used. Click Define (see Figure 3.3).
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Figure 3.4 The Define Simple Bar: Summaries for Groups 
of Cases dialog box.

3. The Define Simple Bar: Summaries for Groups of Cases dialog box opens. Select
college and click the second right-arrow button ( ) from the top to move it to
the Category Axis box. See Figure 3.4 for details.

4. Click OK.

A bar chart for college is produced in the Viewer window (the bar chart will be discussed
after all of the graphs have been produced in SPSS).

Histograms
Next, we’ll create a histogram in SPSS. Histograms are graphs that indicate the frequency, or
number of observations, for intervals of a continuous variable. We’ll create a histogram for the
variable mathexam.

To create a histogram in SPSS

1. Make the Data Editor window active by selecting 
from the menu bar.

2. To produce a histogram in SPSS, from the menu bar select Graphs > Legacy
Dialogs > Histogram (see Figure 3.5 on page 40). (Note: If you are using SPSS
version 14.0 or lower, the menu commands are All
other commands are the same.)

3. The Histogram dialog box opens.
4. Select mathexam and click the upper right-arrow button ( ) to move it to the

Variable box (see Figure 3.6 on page 40).
5. Click OK.

Graphs>Histogram Á .

statistics.sav –  PASW Statistics Data Editor
Window>descriptive 
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A histogram of mathexam is produced in the Viewer window (the histogram will be discussed
after all of the graphs have been produced in SPSS).

Scatterplots
Next, we’ll produce a scatterplot in SPSS. Scatterplots plot the coordinates (a point where the
scores on two variables meet) of participants’ responses on two variables and are often used when
calculating correlation coefficients (correlation is discussed in Chapter 12). We’ll create a scatterplot
of the variables mathexam and satquant.

Figure 3.5 Menu commands for the Histogram procedure.

Figure 3.6 The Histogram dialog box.
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To create a scatterplot in SPSS

1. Make the Data Editor window active by selecting 
from the menu bar.

2. To produce a scatterplot, from the menu bar select 
(see Figure 3.7). (Note: If you are using SPSS version 14.0 or

lower, the menu commands are . All other commands are
the same.)

Graphs>Scatter/Dot
Scatter/Dot Á .

Graphs>Legacy Dialogs>
statistics.sav –  PASW Statistics Data Editor

Window>descriptive 

Figure 3.7 Menu commands for the scatterplot procedure in SPSS.

3. The Scatter/Dot dialog box opens (see Figure 3.8). To produce a scatterplot of
mathexam and satquant, the default option, Simple Scatter, will be used. Click
Define.

Figure 3.8 The Scatter/Dot dialog box.

4. The Simple Scatterplot dialog box opens. Select mathexam and click the upper
right-arrow button ( ) to move it to the Y Axis box. Select satquant and click
the second right-arrow button ( ) to move it to the X Axis box (see Figure 3.9 on
page 42).

5. Click OK.

A scatterplot of mathexam and satquant is produced in the Viewer window (the scatterplot
will be discussed after all of the graphs have been produced in SPSS).
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Boxplots
Next we’ll illustrate how to produce a boxplot in SPSS. Boxplots are useful for displaying
information about a variable including the center (median), the middle 50% of the data, the over-
all spread, and whether or not there are any outliers in the data (outliers are points that are
unrepresentative of the other values in the data set). We’ll produce a boxplot for the variable
mathexam.

To create a boxplot in SPSS

1. Make the Data Editor window active by selecting 
from the menu bar.

2. To create a boxplot, from the menu bar select 
(see Figure 3.10). (Note: If you are using SPSS version 14.0 or lower,

the menu commands are . All other commands are the same.)Graphs>Boxplot
Boxplot Á .

Graphs>Legacy Dialogs>
statistics.sav –  PASW Statistics Data Editor

Window>descriptive 

Figure 3.9 The Simple Scatterplot dialog box.

Figure 3.10 Menu commands for the Boxplot procedure.
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Figure 3.11 The Boxplot dialog box.

4. Click Define.
5. The Define Simple Boxplot: Summaries of Separate Variables dialog box opens.

Select the variable, mathexam, and click the upper right-arrow button ( ) to
move it to the Boxes Represent box (see Figure 3.12).

6. Click OK.

3. The Boxplot dialog box opens. Leave the default option, Simple, selected. In the
Data in Chart Are section of the dialog box, select Summaries of separate variables.
(See Figure 3.11.)

Figure 3.12 The Define Simple Boxplot: Summaries of Separate Variables
dialog box.
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A boxplot for mathexam is produced in the Viewer window.
Next, the results of the four different graphs we created—the bar chart, histogram, scatterplot,

and boxplot—will be described.

Interpret the Results

Bar Chart—College
In the barchart of college shown in Figure 3.13 the groups (home and away) are displayed on
the horizontal axis (X-axis) and the frequency (labeled Count) is displayed on the vertical axis
(Y-axis). On the vertical axis of the bar chart, the height of the bar corresponds to the frequency
for a given group. The bar chart indicates that six of the students attended college at home,
while four of the students attended college away.

Bar Chart – college 

awayhome

6

5

4

3

2

1

0

C
o

u
n

t

college

Figure 3.13 The bar chart of college.

Histogram—Mathexam
The histogram shown in Figure 3.14 displays the values of mathexam (from smallest to largest)
on the X-axis and the frequency on the Y-axis. Notice on the X-axis that each bar in the graph
spans a 5-point range: The first bar has a midpoint of 15, the second bar has a midpoint of 20, and
so on (the midpoints will vary from one histogram to another). The value with the greatest fre-
quency in the graph is for a midpoint of 25, which has a frequency of 4. Notice that SPSS reports
the mean, standard deviation, and sample size to the right of the graph by default.

Scatterplot—Mathexam and Satquant
The scatterplot shown in Figure 3.15 displays the coordinates (each coordinate is indicated by a
circle in the plot) for each of the participants on the variables mathexam and satquant. As we spec-
ified in the Simple Scatterplot dialog box earlier, the values of mathexam are on the Y-axis and
the values of satquant are on the X-axis. There are 10 different coordinates in the plot, with each
coordinate displaying the scores on the two variables for an individual. The coordinate on the far
right of the plot, for example, represents the scores on mathexam and satquant for the third par-
ticipant, with scores of 34 and 600, respectively.

Boxplot—Mathexam
The boxplot of mathexam shown in Figure 3.16 (page 46) summarizes the scores differently
from the histogram that was calculated on mathexam earlier. In the boxplot, the rectangular box
contains the middle 50% of the data, and the line inside the box is equal to the median. The lines
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Histogram – mathexam 

Figure 3.14 The histogram of mathexam.

extending from the box correspond to the whiskers. The two end points of the whiskers represent
the minimum and maximum values, except in the case when there are one or more outliers, which
would be shown as an asterisk falling outside of the whiskers (an example of a boxplot with an
outlier is provided in the end-of-chapter exercises).

This concludes our discussion on creating graphical displays of data.

Scatterplot – mathexam and satquant 
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Figure 3.15 The scatterplot of mathexam and satquant.
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Summary of Steps for Producing Bar Charts, Histograms,
Scatterplots, and Boxplots in SPSS

I. Data Entry
1. Create the variables in SPSS by entering the variable names in the Variable

View window.

2. Create value labels for each of the categorical variables. In the Variable View
window, enter the numeric values and labels as appropriate. Click OK.

3. Enter the data for each of the participants.

II. Analysis of the Data

Obtaining a Bar Chart

1. From the menu bar, select (Note: If
you’re using SPSS version 14.0 or lower, select )

2. In the Bar Charts dialog box, leave the default option Simple selected. Click
Define.

3. In the Define Simple Bar: Summaries for Groups of Cases dialog box, move
the variable of interest to Category Axis box.

4. Click OK.

Obtaining a Histogram

1. From the menu bar, select 
(Note: If you’re using SPSS version 14.0 or lower, select )Histogram.Graphs>

Graphs>Legacy Dialogs>Histogram Á .

Graphs>Bar.
Graphs>Legacy Dialogs>Bar Á .

Case Processing Summary

10 100.0% 0 .0% 10 100.0%mathexam

N Percent N Percent N Percent

Valid Missing Total

Cases

mathexam

45.00

40.00

35.00

30.00

25.00

20.00

15.00

The 75th

percentile. 

The 25th

percentile.

The median
(the 50th

percentile). 

There are no
outliers in the
data, since no
values are
presented
outside of the
end points of the
whiskers (which
represent the
minimum and
maximum values
in this example).

Boxplot – mathexam 

Figure 3.16 The boxplot of mathexam.
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2. In the Histogram dialog box, move the variable of interest to the Variable box.

3. Click OK.

Obtaining a Scatterplot

1. From the menu bar, select 
(Note: If you’re using SPSS version 14.0 or lower, select 

)

2. In the Scatter/Dot dialog box, leave the default option Simple Scatter selected.
Click Define.

3. In the Simple Scatterplot dialog box, move one variable to the Y Axis box and
the other variable to the X Axis box.

4. Click OK.

Obtaining a Boxplot

1. From the menu bar, select (Note: If
you’re using SPSS version 14.0 or lower, select )

2. In the Boxplot dialog box, leave the default option Simple selected. Under
Data in Chart Are, select Summaries of separate variables. Click Define.

3. In the Define Simple Boxplot: Summaries of Separate Variables dialog box,
move the variable of interest to the Boxes Represent box.

4. Click OK.

Exercises

1. Data were collected from 10 sophomores at a local university, including their gender 11 
= “male,” 2 = “female”2, the number of hours they studied per day (hoursstudied), 
the number of cups of coffee they drank per day (cupscoffee), and their grade point 
average (gpa). The data are in the file Chapter 3_Exercise 1.sav in the Chapter 3 folder 
online at www.routledgetextbooks.com/textbooks/9780205735822. Open the file and 
perform the appropriate analyses in SPSS to answer the questions below.
a. Create a bar chart for gender and print your results. How many males and

females are in the data set?
b. Create a histogram for hoursstudied and print your results. What is the mean

number of hours studied per day?
c. Create a scatterplot using the variables gpa and hoursstudied and print your

results (put gpa on the Y-axis).
d. Create a boxplot of cupscoffee and print your results. Are there any outliers

in the plot?
2. The data file Chapter 3_Exercise 2.sav contains data on 15 people including 

whether or not they had allergies (allergy; 1 = “yes,” 2 = “no”), the number 
of (sick) visits made to a doctor over the last year (doctorvisits), and the num-
ber of days missed from work during that same time period (daysmissed). 
Open the file and perform the appropriate analyses in SPSS to answer the 
ques-tions below (the file is located in the Chapter 3 folder online at 
www.routledgetextbooks.com/textbooks/9780205735822).
a. Create a bar chart for allergy and print your results. How many people have

allergies? How many people do not have allergies?
b. Create a histogram of daysmissed and print your results. What is the mean

number of days missed per year?
c. Create a boxplot of doctorvisits. Are there any outliers in the plot?

3. Data were collected from seven children including the number of times per week
(on average) they ate fast food (fastfood) and the degree to which they like corn,
carrots, and cabbage (expressed on a 1 to 10 scale with higher scores indicating
more favorable ratings). The data are in the file Chapter 3_Exercise 3.sav in the

Graphs>Boxplot.
Graphs>Legacy Dialogs>Boxplot Á .

Scatter/Dot.
Graphs>

Graphs>Legacy Dialogs>Scatter/Dot Á .
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Chapter 3 folder online at www.routledgetextbooks.com/textbooks/9780205735822. 
Open the file and perform the appropriate analyses in SPSS to answer the questions 
below.a. Create a histogram of fastfood and print your results.
b. Create a histogram of corn and print your results. What is the mean rating for

corn?
c. Create a scatterplot for fastfood and carrots and print your results (put

carrots on the Y-axis).
d. Create a boxplot for cabbage. Are there any outliers in the plot?
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Reliability refers to the consistency or repeatability of scores on some measure of interest. For
example, consider a 10-item measure of assertiveness given twice over a two-week period to a

group of participants. If the participants’ responses to the items are the same or are very similar
across the two administrations, then the measure would possess a high degree of reliability. If the
responses are fairly different across the two administrations, then the scale would possess a fairly low
degree of reliability.

While there are several different methods of estimating reliability, most fall into one of two
types: reliability based on multiple administrations of a measure and reliability based on a single
administration of a measure.1 Assessing reliability over multiple administrations of a measure con-
sists of administering a scale on two different occasions and measuring the consistency of participants’
responses to the items over the two administrations. For this type of reliability, test-retest reliability
(administering the same measure twice) and alternate form reliability (administering two very sim-
ilar versions of a measure once each) are two commonly used methods.

Reliability over a single administration of a measure consists of administering a scale once and
measuring the consistency of the participants’ responses across the items of the measure. Two dif-
ferent types of reliability for a single administration of a measure are split-half reliability and
coefficient alpha (also known as Cronbach’s alpha). With split-half reliability, the measure is split
in half and the consistency of the participants’ responses on the two halves is estimated. Coefficient
alpha, on the other hand, is not calculated on a single split of a measure but is instead mathematically
equivalent to the mean of all possible splits that could have been taken of the measure. When using
either split-half reliability or coefficient alpha as an estimate of the reliability of a measure, it is
important that all of the items on the scale measure the same characteristic; otherwise the internal con-
sistency will most likely be reduced. In this chapter, we’ll focus on coefficient alpha, which is one
of the most commonly used methods of estimating the reliability of a measure.

Values of coefficient alpha typically range from zero to one with higher values indicating greater
internal consistency among a set of items.2 Shown in Figure 4.1 is an approximate guideline of the
adequacy of a range of different values of coefficient alpha.

An example in which coefficient alpha may be used is presented next.

4
CHAPTER

Reliability (as Measured 
by Coefficient Alpha)

Coefficient Alpha Adequacy 

.90 and above Excellent

.80 – .89 Good 

.70 – .79 Fair 

.60 – .69 Marginal 

.59 and below Poor 

Figure 4.1 Adequacy of inter-
nal consistency reliability
estimates for different values
of coefficient alpha.
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1. I feel good about the direction of
    my life.

2. My life has meaning.

3. In general, I feel like I’m on track
    in my life. 

4. I never feel lost in my life. 

5. I’m currently working toward
    fulfilling my goals in life.

1

1

1

1

1

2

2

2

2

2

3

3

3

3

3

4

4

4

4

4

Items on the Meaning in Life Scale Strongly
Disagree Disagree

Neither
Disagree
nor Agree

Agree Strongly
Agree

5

5

5

5

5

Figure 4.2 Items on the meaning in life scale. For each item, the response options 
are 1 (strongly disagree), 2 (disagree), 3 (neither disagree nor agree), 4 (agree), and 
5 (strongly agree). Each participant was instructed to choose only one response option
for each question.

If the items on the meaning in life scale have a high degree of internal consistency (i.e.,
if the scale is reliable), then the participants should respond in a fairly consistent manner to
each of the items on the scale. For example, for the items presented in Figure 4.2, people who
have a high degree of meaning in life should agree or strongly agree with the items, while
people with a low degree of meaning in life should disagree or strongly disagree with the
items. This type of consistent response pattern for the participants will result in a high value
of coefficient alpha since the participants are responding in a consistent manner on the scale
(e.g., one person agrees with all the items, another person disagrees with the items, etc.). The
exception to this rule is when one or more negative items are included on the scale, which is
discussed next.

Negative Items and Reverse Coding

The meaning in life scale shown in Figure 4.2 is written so that a person with a high degree of
meaning in life would tend to agree or strongly agree with each item on the scale (assuming the
scale is reliable). Some measures, however, are designed with a mixture of items, where a per-
son high on the characteristic of interest would agree with some items and disagree with oth-
ers. Those items that a person high on the characteristic of interest would disagree with are
known as negative items. (An example of a negative item would be if item 2 in Figure 4.2 was
rewritten as “My life has little meaning.” A person with a high degree of meaning in life would
most likely disagree or strongly disagree with this item.) If a scale contains one or more nega-
tive items, each of these items needs to be reverse coded prior to estimating the internal con-
sistency of the scale. Reverse coding is a process where the responses to the negative items are
literally reversed, so that a 1 becomes a 5, a 2 becomes a 4, and so on. Reverse coding of items
is illustrated in Appendix A.

Example
As part of a research project, a student wanted to estimate the internal consistency reliability of a
five-item measure of meaning in life, which is presented in Figure 4.2.

The range of responses for each item on the meaning in life scale shown in Figure 4.2 is from
1 to 5, where and A total score on the scale may be cal-
culated by adding together the responses on the five items, with total scores ranging from 5 to 25
for each participant. Higher scores on the scale correspond to higher levels of meaning in life.
Twenty-five college students responded to the five-item measure.

5 = strongly agree.1 = strongly disagree
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Objective and Data Requirements of Coefficient Alpha

The Data

The responses of the 20 participants to each of the five items of the meaning in life scale are pre-
sented in Figure 4.3. Each row in the table contains the responses for a participant, and the columns
represent the different items on the scale. Meaning1 corresponds to the responses on the first
item on the scale, meaning2 corresponds to the responses on the second item, and so on.

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 

Participant meaning1

5
2
1
5
3
5
5
4
5
4
5
3
1
5
5
4
4
5
5
4

meaning2

5
3
2
5
4
5
4
4
4
5
5
2
1
5
4
4
4
5
4
5

meaning3

4
2
2
5
4
2
4
4
4
5
5
2
1
5
4
3
4
5
5
5

meaning4

5
1
1
4
2
4
3
4
4
4
5
3
2
5
4
4
4
5
5
5

meaning5

4
3
2
5
3
3
4
4
3
3
5
3
1
5
5
3
3
5
4
4

Figure 4.3 The responses of the participants on the five items of the
meaning in life scale. (Note: The participant variable is included for 
illustration but will not be entered into SPSS.)

Coefficient Alpha

Objective Data Requirements Example

To estimate the
internal consistency 
of responses on a
measure.

Scores on at least two items
(variables) are required (although
more than two items are
recommended). All items should
measure the same trait or
characteristic.

Meaning in life scale, consisting of
five items (variables). The internal
consistency of the participants’
responses on the five items will be
determined.

Data Entry and Analysis in SPSS
Steps 1 and 2 below describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name meaning.sav in the 
Chapter 4 folder. If you pre-fer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, five variables will be created, one for each item of the meaning in life
scale. The variables will be named meaning1, meaning2, meaning3, meaning4, and
meaning5, respectively.
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Figure 4.4 The Variable View window with the variables meaning1–meaning5 entered.

3. Enter the variable names meaning1, meaning2, meaning3, meaning4, and
meaning5, respectively, in the first five rows of the Variable View window (see
Figure 4.4).

Figure 4.5 The completed data file for the coefficient alpha example.

Step 2: Enter the Data

1. Click the Data View tab. The variables meaning1, meaning2, meaning3, mean-
ing4, and meaning5, respectively, appear in the first five columns of the Data
View window.

2. Consulting Figure 4.3, enter the scores for each of the participants on the five vari-
ables of interest. For the first participant, enter the scores 5, 5, 4, 5 and 4, for the
variables meaning1, meaning2, meaning3, meaning4, and meaning5, respec-
tively. Using this approach, enter the data for all 20 participants. The completed
data file is shown in Figure 4.5.
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Figure 4.6 Menu commands for the Reliability Analysis procedure.

Step 3: Analyze the Data

1. From the menu bar, select (see
Figure 4.6).

Analyze>Scale>Reliability Analysis Á

Figure 4.7 The Reliability Analysis dialog box.

2. A Reliability Analysis dialog box appears with the variables meaning1–meaning5
in the left-hand side of the dialog box (see Figure 4.7).

3. Select the variable meaning1 and press and hold down the shift key. With the shift
key continued to be held down, select the variable meaning5. All five variables
should be selected. Click the right-arrow button ( ) to move the variables to the
Items box (see Figure 4.8 on page 54).
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Figure 4.8 The Reliability Analysis dialog box (continued).

Figure 4.9 The Reliability Analysis: Statistics dialog box.

4. Click Statistics. The Reliability Analysis: Statistics dialog box opens. Under
Descriptives for select Item and Scale (see Figure 4.9).

5. Click Continue.
6. Click OK.

The reliability procedure runs in SPSS and the results are presented in the Viewer window.

Step 4: Interpret the Results

The output of the reliability analysis is displayed in Figure 4.10.

Case Processing Summary
The first table, Case Processing Summary, shows the number of cases (participants) used in
calculating the reliability of the scale. An N of 20 is presented in the table, indicating that all
20 participants were included in the analysis (they had complete data on all five variables).
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Reliability
Scale: ALL VARIABLES

Case Processing Summary

a. Listwise deletion based on all
   variables in the procedure. 

20

0

20

100.0

.0

100.0

Valid

Excludeda

Total

Cases
N %

Reliability Statistics

.943 5

Cronbach's
Alpha N of Items

Item Statistics

4.0000

4.0000

3.7500

3.7000

3.6000

1.33771

1.16980

1.29269

1.30182

1.09545

20

20

20

20

20

meaning1

meaning2

meaning3

meaning4

meaning5

Mean Std. Deviation N

Scale Statistics

19.0500 31.418 5.60521 5
Mean Variance Std. Deviation N of Items

The value of coefficient
alpha for the 5–item
meaning in life scale. 

Figure 4.10 Output for the reliability procedure.

Reliability Statistics
The second table, Reliability Statistics, displays the value of coefficient alpha (also called Cronbach’s
alpha) for the five-item scale. The value of coefficient alpha is .94 (rounded to two decimal places),
which indicates a very high degree of internal consistency among the items on the scale.

Item Statistics
The next table, Item Statistics, displays the mean, standard deviation, and sample size for each of
the items on the scale. Examining the means on the five items shown in the Item Statistics table,
notice that the participants had the highest mean rating on items 1 (meaning1) and 2 (meaning2),
with an average response of 4.00, which corresponds to a response of “agree” on the scale. The
remaining three items had mean responses between 3.60 and 3.75. Item 1 was the most variable,
with a standard deviation of approximately 1.34 (the standard deviations were fairly similar across
all five items). Overall, the participants’ responses on the five items indicated that they found their
lives to be fairly meaningful, with a mean response on each of the items either equal to or in the
direction of “agree” on the scale (i.e., a value of 4.00).

Scale Statistics
The last table, Scale Statistics, provides the mean, variance, standard deviation, and number of
items for the total scale (the total scale is equal to the sum of the five items). With a possible range
of 5 to 25 on the scale, the mean of the five-item scale is 19.05 with a standard deviation of 5.61.
Therefore, the participants rate fairly highly on personal meaning, since the mean scale rating of
19.05 is approaching the high end of the scale. The mean of the scale is an alternative way of
assessing where the participants fall on the characteristic of interest, and it is equal to the sum
of the means on the five items 14.00 + 4.00 + 3.75 + 3.70 + 3.60 = 19.052.
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Expression of the Results
Beginning with this chapter, a brief write-up of the results of each procedure will be presented.
In writing the results of a reliability analysis, the value of coefficient alpha and the mean and
standard deviation of the entire scale will be presented (the mean and standard deviation of the
individual items may also be presented in a table if desired). A sample write-up of the results
is presented below.

Written Results

A study was conducted to estimate the internal consistency of the five-item meaning in life scale.
Coefficient alpha for the scale was .94, indicating a high degree of internal consistency among the
items on the scale. The means of the individual items ranged from 3.65 to 4.00, with a mean on
the total scale of Overall, the participants’ responses on the scale indicated
that they possessed a fairly high degree of meaning in their lives. The mean and standard devia-
tion of the items of the meaning in life scale are provided in Figure 4.11.3

19.05 1SD = 5.612.

Item

1

2

3

4

5

M

4.00 

4.00 

3.75 

3.70 

3.60 

SD

1.34 

1.17 

1.29 

1.30 

1.10 

Figure 4.11 The mean and
standard deviation of the
items of the meaning in
life scale.

Summary of Steps for Conducting a Reliability Analysis in SPSS
I. Data Entry and Analysis

1. Create as many variables in SPSS as there are items on the scale.

2. Enter the participants’ responses to each of the items on the scale.

3. Select 

4. Move each of the items on the scale to the Items box.

5. Click Statistics. Under Descriptives for select Item and Scale. Click Continue.

6. Click OK.

II. Interpretation of the Results
1. Note the value of coefficient (Cronbach’s) alpha in the Reliability Statistics

table.

2. Inspect the Item Statistics table and the Scale Statistics table to determine the
mean response on the items and total scale, respectively.

3. Write the results indicating the value of coefficient alpha and the mean and
standard deviation of the total scale (the mean and standard deviation of each
of the items may also be presented in a table if desired).

Exercises

1. A researcher administered a seven-item measure of resident satisfaction to 
20 nursing home residents, whose responses are provided in Figure 4.12. For each

Analyze>Scale>Reliability Analysis Á .
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5

Figure 4.12 The seven items of the resident satisfaction
scale.

item on the measure, a 1 corresponds to a response of strongly disagree and a 
7 corresponds to a response of strongly agree. Higher scores on the scale indicate
greater levels of resident satisfaction with the nursing home.

Enter the data in SPSS and perform the appropriate analyses to answer the
questions below. Name the variables item1–item7, respectively.
a. What is the reliability (Cronbach’s alpha) of the scale?
b. How would you characterize the reliability?
c. Provide a written summary of your reliability analysis. Be sure to include the

overall reliability of the scale and the mean and standard deviation of the total
scale in your written results.

2. The responses of 30 people on a 10-item measure of resilience are provided in the file 
Chapter 4_Exercise 2.sav in the Chapter 4 folder online at www.routledgetextbooks.com/
textbooks/9780205735822 (the variables are named resilience1 to resilience10, 
respectively). The range of possible responses on each of the items is from 1
(strongly disagree) to 7 (strongly agree), with higher scores indicating greater resilience. 
Open the file in SPSS and perform the appropriate analyses to answer the questions 
below.
a. What is the reliability (Cronbach’s alpha) of the scale?
b. How would you characterize the reliability?
c. Provide a written summary of your reliability analysis. Be sure to include the

overall reliability of the scale and the mean and standard deviation of the total
scale in your written results.

3. A student used two different scales for a research project, with one scale measuring
self-confidence and the other scale measuring manual dexterity. He calculated
coefficient alpha on the combined scales and found an overall reliability coefficient
of .41. Why might the reliability be so low?
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UNIT

Unit II is the heart of the text and consists of many commonly used inferential procedures. The
following chapters are included in the second unit: the one-sample t test (Chapter 5), the

independent-samples t test (Chapter 6), the dependent-samples t test (Chapter 7), the one-way between
subjects ANOVA (Chapter 8), the two-way between subjects ANOVA (Chapter 9), the one-way
within subjects ANOVA (Chapter 10), the one-between–one-within subjects ANOVA (Chapter 11),
correlation (Chapter 12), simple regression (Chapter 13), multiple regression (Chapter 14), the
chi-square goodness of fit test (Chapter 15), and the chi-square test of independence (Chapter 16).

Before starting Chapter 5 (the one-sample t test), it would be beneficial to review some terminology
relevant to hypothesis testing. If you are new to statistics, consulting a chapter on hypothesis testing
from an introductory statistics textbook may also be helpful.

Samples and Populations
In statistics, we frequently talk about samples and populations. A population consists of an entire
collection of events of interest and a sample is a smaller part (or subset) of the population. Suppose,
for example, that we wanted to conduct research on cell phone usage in the United States and ran-
domly selected 200 cell phone users from various U.S. cities. All people who own a cell phone in the
United States would make up the population, and the 200 people selected for the study would make
up the sample. In practice, we almost always work with samples, as populations are either too costly
or difficult to obtain.

Inferential Statistics
Inferential statistics are statistical procedures that use samples to make generalizations about pop-
ulations. For example, consider trying to forecast the winner in a presidential election. Using infer-
ential statistics, with a relatively small sample (e.g., 2000 people), statements about the population
of all U.S. voters can be made with a fairly high degree of accuracy (assuming the sample is repre-
sentative of the population from which it comes). Inferential statistics are extremely useful because
they allow us to draw conclusions about populations based on limited information (i.e., samples).

Hypothesis Testing
When we use a sample to make an inference about a population, we engage in a process known as
hypothesis testing. In hypothesis testing, it is customary to state two hypotheses, a null hypothesis
and an alternative hypothesis. The null hypothesis typically states that a treatment did not have an
effect, while the alternative hypothesis states that the treatment had an effect. Suppose, for example,
that a new therapy is being evaluated to determine if it helps people who are suffering from depres-
sion. The null hypothesis would state that the therapy did not have an effect on depression (i.e., it did
not change the way people felt), while the alternative hypothesis would state that the therapy had an
effect on depression (i.e., it changed the way people felt). In hypothesis testing, we evaluate the null

Inferential Statistics
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hypothesis with the purpose of either rejecting it or not rejecting it. If, based on the results found
in our study, the null hypothesis seems reasonable, we do not reject it. If, however, the null hypoth-
esis seems unreasonable, we reject it (and side with the alternative hypothesis).

One-Tailed and Two-Tailed Tests
Hypotheses are evaluated using either a two-tailed test or a one-tailed test. A two-tailed test is
used when a treatment is evaluated to see whether it has an impact in either direction (to see if scores
are higher or lower), while a one-tailed test is used when the intent is to investigate only a single
direction (only higher or only lower). Consider an example where two different therapies are inves-
tigated to see which one is more effective at helping people with anxiety (we’ll refer to the ther-
apies as therapy A and therapy B). A two-tailed test would allow for the possibility of either
therapy being more effective (i.e., either or ), while a one-tailed test would spec-
ify beforehand a single direction to be investigated (e.g., ). The advantage of a one-tailed
test is that it has a greater chance of finding the effect (assuming it exists in the hypothesized
direction); the disadvantage of a one-tailed test is that if the effect is located in the opposite direc-
tion of what was anticipated, it cannot be declared. In practice, two-tailed tests are more common
in research, and for this reason they will be emphasized in this text.

Type I and Type II Errors
Recall that in hypothesis testing samples are used to make inferences about populations. Because
samples are incomplete “pictures” of populations, it is possible to make a mistake in the hypoth-
esis testing process. There are two different types of mistakes that can be made—a Type I error
and a Type II error. A Type I error occurs if the null hypothesis is rejected when it is true (if it
is true, it should not have been rejected). A Type II error occurs if the null hypothesis is not
rejected when it is false (if it is false, it should have been rejected). Both are errors in hypothesis
testing since the conclusion made from the hypothesis test is contrary to the true situation.

Power
While Type I and Type II errors are mistakes in hypothesis testing, power is concerned with mak-
ing a correct decision. Power is equal to the probability of rejecting the null hypothesis when it
is false (if the null hypothesis is false and it is rejected, a correct decision has been made). Power
ranges from 0 to 1, with higher values indicating greater power. Power of .80, for example, means
that there is an 80% chance of rejecting the null hypothesis prior to conducting the study. (Put
another way, if a study was conducted many times, power of .80 means that 80% of the time the
null hypothesis would be rejected—a correct decision—and 20% of the time it would not be
rejected—a Type II error.)

Sampling Error
Sampling error is a very important concept in inferential statistics and it’s one that, if understood,
will make following the logic of hypothesis testing easier. Consider a problem where two differ-
ent strategies for remembering words are compared. Suppose that there is no difference between
the two strategies so that whichever strategy is used, the number of words recalled is the same in
the population. Imagine that I took a sample of 10 people and gave them the first strategy, and then
I took a sample of another 10 people and gave them the second strategy, and then compared the
number of words recalled for the two groups. While the strategies result in the same number of
words recalled in the population, it is extremely unlikely that the number of words recalled for the
two groups will be the same in the samples. This is because samples are subsets of the population,
and since only part of the population is taken, it will not be represented perfectly. Generally
speaking, the smaller the sample, the larger the discrepancy between the sample and the popula-
tion. The discrepancy between the sample and the population is known as sampling error. It is

A 6 B
B 6 AA 6 B
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a normal part of statistics and it’s important to keep it in mind in the following chapters. When
different samples are drawn from the same population, the samples will typically not be the same
(e.g., they will not have the same mean).

p-Values
Continuing with the word strategy example, if samples are not typically the same when drawn from
a population, how can we determine whether there is really a meaningful difference between the
samples (i.e., one strategy is really better than the other in the population), or if the difference is
just due to sampling error (i.e., the strategies are the same in the population)? This decision is
made based on the p-value obtained from the output in SPSS. A p-value indicates the exact prob-
ability of obtaining the specific results (or results even more extreme) if the null hypothesis is
true. For example, in the learning strategy problem described previously, let’s assume there was
a difference of two words recalled between the strategies with a p-value of .03. The p-value of .03
would indicate that there is only a 3% chance of getting a difference of two words (or more)
between the groups if the null hypothesis was true. In hypothesis testing, the p-value for a test is
compared to a predetermined value, known as alpha (represented by the symbol ), and based on
that comparison, a decision is made about the null hypothesis. In this text, we will use an alpha
level of .05 (the most commonly used value in the social and behavioral sciences) and evaluate
the p-value against that level.

The process of evaluating the p-value is as follows:

If the p-value is less than or equal to .05 (alpha), the null hypothesis is rejected
(a difference between the strategies is assumed).
If the p-value is greater than .05 (alpha), the null hypothesis is not rejected (a dif-
ference between the strategies is not assumed).

In SPSS the p-value is reported as “sig.”
The decision process for hypothesis testing is summarized in the following table.

a

p-value (reported as “sig.” in SPSS) Decision

If p … .05 Reject the null hypothesis

If p 7 .05 Do not reject the null hypothesis

Example
p-value (reported 
as “sig.” in SPSS)

Decision (using an 
alpha of .05) Interpretation

1 .020 Reject the null hypothesis Side with the alternative
hypothesis

2 .080 Do not reject the null
hypothesis

Side with the null
hypothesis

3 .521 Do not reject the null
hypothesis

Side with the null
hypothesis

Consider the examples shown in the table below. The first example shows a p-value of .020.
With an alpha of .05, what decision would be made about the null hypothesis? Since the p-value
of .02 is less than .05, the null hypothesis is rejected. In examples 2 and 3, the null hypothesis would
not be rejected since both p-values (.080 and .521) are greater than .05.

While an alpha of .05 will be used in this text, if you wish to use another value (such as .01
or .001), all you have to do is adjust your decision rule. If alpha of .01 was used, for example, all
three p-values in the preceding table would lead to the null hypothesis not being rejected since all
values are greater than .01. As is shown in this example, the value of alpha (.05 vs. .01) can make
a difference in the conclusion made about the null hypothesis (i.e., whether it is rejected or not).
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For each of the chapters in this unit, we will examine a p-value, and using the process detailed
above, we will either reject or not reject the null hypothesis. If the null hypothesis is rejected, the
result is often referred to as being “significant” or “statistically significant.” If the null hypothesis
is not rejected, the result is referred to as “not significant.”

Effect Sizes
While hypothesis testing is a powerful tool for making inferences about populations, it is impor-
tant to recognize what hypothesis testing does and does not tell us. Considering our word strat-
egy problem again, hypothesis testing allows us to conclude, with a reasonable degree of assurance,
whether or not the two strategies are different in the population. What hypothesis testing fails to
indicate, however, is how different the groups are (i.e., hypothesis testing indicates that the groups
are different but doesn’t indicate whether the difference is small, moderate, or large). One way to
describe the degree of difference between the groups is by calculating an effect size. Effect sizes
indicate the magnitude of the results in our study. Effect sizes are described further in Chapter 5
and will be illustrated for several of the procedures described in Unit II.

This concludes our introduction to Unit II. Next we’ll begin with the one-sample t test in
Chapter 5.
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The one-sample t test is used when the mean of one sample is compared to some known or estimated
population mean. The sample is typically different from the population in some way, and the

question of interest is whether the mean of the sample differs significantly from the mean of the pop-
ulation on a dependent variable of interest. An example of a one-sample t test is presented below.

Example
An industrial psychologist hired by a leading accounting firm wanted to know if the average num-
ber of hours worked per week at the firm was significantly different from the national average of
52 hours for accountants. The industrial psychologist randomly sampled 16 people from different divi-
sions within the firm and recorded the average number of hours they worked per week over a three-
month period. The dependent variable in this study is the number of hours worked per week.

Objective and Data Requirements of the One-Sample t Test

The One-Sample t Test

62

The One-Sample t Test

Objective Data Requirements Example

To determine whether the 
mean of a sample differs 
significantly from some 
known or estimated 
population mean.

One sample of participants

Dependent variable
Continuous

Accountants at leading 
accounting firm
Dependent variable
• Number of hours worked 

per week

Null and Alternative Hypotheses
The null hypothesis states that the number of hours worked per week at the leading account-
ing firm is equal to the national average of 52 hours:

The alternative hypothesis states that the number of hours worked per week at the
leading accounting firm is not equal to the national average of 52 hours:

H1 : m Z 52

1H12

H0 : m = 52

1H02
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Evaluation of the Null Hypothesis

The one-sample t test provides a test of the null hypothesis that the number of hours worked per
week at the accounting firm is equal to 52 hours. If the t test produces results that seem unlikely
if the null hypothesis is true (results that occur less than 5% of the time), then the null hypothe-
sis is rejected. If the t test produces results that seem fairly likely if the null hypothesis is true
(results that occur greater than 5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Is the number of hours worked per week for employees at a leading accounting
firm different from the national average of 52 hours?”

The Data

The data for the 16 participants are presented in Figure 5.1.

Participant

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16

Hours worked
per week

54
48
68
53
60
45
57
62
71
60
55
63
68
64
56
60

Figure 5.1 The number of
hours worked per week by the
16 employees at the leading
accounting firm. (Note: The
participant variable is
included for illustration but
will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 below describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name hours worked.sav in 
the Chapter 5 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variable

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, one variable will be created for the number of hours worked per week by the
employees at the leading accounting firm. The variable will be named hoursweek.
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3. Enter the name hoursweek and press the down arrow key See Figure 5.2 for
details.

1T2.

Figure 5.2 The Variable View window with the variable hoursweek entered.

Step 2: Enter the Data

1. Click the Data View tab. The variable hoursweek appears in the first column of
the Data View window.

2. To enter the data for hoursweek, make sure the first cell in the upper left-hand
corner of the window is active (if it isn’t active, then click on it). Enter the number
of hours worked for each of the participants, beginning with the first participant’s
value (54) and continuing until the last participant’s value (60) has been entered.
(After entering the value for a participant, press either the down-arrow key  or
the Enter button to move to the next row in the Data View window.) The completed
data file in presented in Figure 5.3.

1T2

Figure 5.3 The completed data file
for the one-sample t test example.
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Step 3: Analyze the Data

1. From the menu bar, select 
(see Figure 5.4).T Test Á

Analyze>Compare Means>One-Sample 

Figure 5.4 Menu commands for the one-sample t test.

2. A One-Sample T Test dialog box appears with the variable hoursweek on the left-
hand side of the dialog box (see Figure 5.5).

Figure 5.5 The One-Sample T Test dialog box.

3. Select the dependent variable, hoursweek, and click the right-arrow button ( )
to move it into the Test Variable(s) box.

4. In the Test Value box, enter 52. This is the value that is specified in the null hypoth-
esis. See Figure 5.6 (page 66) for details. [Note: This step is critical and is often
overlooked. If the default value of zero is left in the Test Value box, the one-sample
t would test whether the employees at the leading accounting firm work significantly 
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different from zero hours per week (which they certainly should!). Be sure to
always enter the value specified in the null hypothesis (in this case, 52) into the
Test Value box when performing a one-sample t test in SPSS.]

5. Click OK.

The one-sample t test procedure runs in SPSS and the results are presented in the Viewer
window.

Step 4: Interpret the Results

The output of the one-sample t test is displayed in Figure 5.7.

The value specified in the null
hypothesis (52) goes into the
Test Value box. 

Figure 5.6 The One-Sample T Test dialog box (continued).

One-Sample Statistics

16 59.0000 7.14609 1.78652hoursweek
N Mean Std. Deviation

Std. Error
Mean

One-Sample Test

3.918 15 .001 7.00000 3.1921 10.8079hoursweek
t df Sig. (2-tailed)

Mean
Difference Lower Upper

95% Confidence
Interval of the

Difference

Test Value = 52

Since the p–value of .001 is less than
.05, the null hypothesis is rejected. 

The Mean Difference of 7.00 is equal to the
difference between the mean number of
hours worked per week at the leading
accounting firm (59), and the value of 52
(the population for accountants) specified in
the null hypothesis.  

Figure 5.7 Output for the one-sample t test.

One-Sample Statistics Table
The first table of output, One-Sample Statistics, displays the sample size (N), mean, standard devi-
ation, and standard error of the mean for the sample. Notice that the average number of hours
worked per week at the leading accounting firm is 59, which is 7 hours more than the national aver-
age of 52. Whether this difference (of 7 hours) is large enough to be statistically significant will
be considered next.

One-Sample Test Table
The next table, One-Sample Test, provides the answer to our research question, that is, whether
the average number of hours worked at a leading accounting firm is different from the national
average of 52 hours. The test of the null hypothesis is provided in the form of a t, where:
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Substituting the appropriate values (Mean Difference, Std. Error Mean) from the One-Sample
Test table yields a t value of

which agrees with the value provided in the One-Sample Test table in column t. With 16 partici-
pants, the degrees of freedom (df) are equal to 15 (number of participants ), with a corre-
sponding p-value of .001. Because the p-value of .001 is less than .05, the null hypothesis that the
average number of hours worked per week at the leading accounting firm is equal to 52 is rejected.
Since the test is significant, inspecting the mean (once again) for the 16 participants from the
One-Sample Statistics table shows that the average number of hours worked at the accounting
firm (59) was significantly higher than the national average of 52.

Effect Sizes
As was described in the Unit II introduction, hypothesis testing indicates whether or not there is a
significant difference between the groups (answering a yes/no question), while effect sizes pro-
vide an indication of the magnitude of the results (answering a “To what degree?” question). In the
current example, with hypothesis testing we concluded that there was a difference in the number
of hours worked between the employees at the leading accounting firm and the national average.
An effect size will now be calculated to express how large that difference is.

A commonly used effect size statistic for the one-sample t test is Cohen’s d, where

Substituting the appropriate values from the One-Sample Test table in Figure 5.7 (Mean
Difference, Std. Deviation) yields a d of

Jacob Cohen (1988), a pioneer in the development of effect size measures, provided guidelines
for what constitutes small, medium, and large effect sizes in practice. While the guidelines provided
by Cohen are in widespread use (and will also be used in this text), it should be noted that they are
only approximations (a sentiment stressed by Cohen) and can vary considerably across disciplines.

Cohen’s guidelines for small, medium, and large effect sizes for the one-sample t test are .20,
.50, and .80, respectively. These values indicate the amount of difference between the sample
mean and the population mean in terms of standard deviation units. Therefore, a value of .20 indi-
cates one-fifth of a standard deviation difference between the groups, .50 indicates one-half of a
standard deviation difference, and .80 indicates eight-tenths of a standard deviation difference.
Using Cohen’s conventions, a d of .98 corresponds to a large effect in practice and indicates a
difference of almost 1 standard deviation in the number of hours worked between the employees
at the leading accounting firm and the national average for accountants (with the employees at the
leading accounting firm working more).1

Expression of the Results in APA Format
For each of the chapters in Unit II, a write-up of the results will be provided using the format of
the American Psychological Association (APA). Specific guidelines for APA format may be found
in the Publication Manual of the American Psychological Association (2009).2

d =

7

7.15
= .98

d =

Difference between the mean of the sample and the mean of the population

Standard deviation

-1

t =

7

1.78652
= 3.918

t =

Difference between the mean of the sample and the mean of the population

Standard error of the mean
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In writing the results, the conclusion of the hypothesis test, the degrees of freedom, the t value,
the p-value, and effect size are reported along with the mean and standard deviation of the
sample. An example of a brief write-up in APA format is presented next.

Written Results

Employees at a leading accounting firm work significantly more hours
per week than the national average of 52 hours, 

Assumptions of the One-Sample t Test
For each of the chapters in Unit II, the assumptions of the statistical procedures will be described.
Assumptions are important because, if they are not met, the results of a given statistical procedure
can be untrustworthy (i.e., the p-values can be inaccurate). Whether a test is compromised by an
assumption violation, however, depends both on the specific assumption that is violated (some
assumptions are much worse than others to violate) and the degree to which the assumption is not
met. The assumptions of the one-sample t test are described next.

1. The observations are independent.
This assumption should be satisfied by designing your study so the participants do
not influence each other in any way. Violating this assumption can seriously compro-
mise the accuracy of the one-sample t test. If there is reason to believe the indepen-
dence assumption has been violated, the one-sample t test should not be used.

2. The dependent variable is normally distributed in the population.
This assumption means that the number of hours worked per week should be nor-
mally distributed in the population. For moderate to large samples sizes 
most types of nonnormal distributions tend to have relatively little impact on the
accuracy of the t test, although some nonnormal distributions can adversely affect the
power of the t test. One remedy for nonnormal data is to perform a nonlinear trans-
formation on the data; nonlinear transformations, however, are beyond the scope of
this text [the interested reader is referred to Tabachnick and Fidell (2007) for more
information on nonlinear transformations].

Summary of Steps for Conducting a One-Sample 
t Test in SPSS

I. Data Entry and Analysis
1. Create one variable in SPSS.

2. Enter the data.

3. Select 

4. Move the dependent variable to the Test Variable(s) box.

5. In the Test Value box, enter the value specified in the null hypothesis.

6. Click OK.

II. Interpretation of the Results
1. Check the p-value (reported as “sig.” (2-tailed)) in the One-Sample Test table.

• If the null hypothesis is rejected. Compare the mean of the sample
to the mean of the population and write the results indicating whether the
sample mean is greater than or less than the population mean.

• If the null hypothesis is not rejected. Write the results indicating
that there is not a significant difference between the mean of the sample and
the mean of the population.

p 7 .05,

p … .05,

Analyze>Compare Means>One-Sample T Test Á .

1N Ú 302,

t1152 = 3.92, p 6 .05, d = 0.98.
1M = 59.00, SD = 7.152
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Exercises

1. For a research project, a student wanted to test whether people who claim to be
successful at picking winning teams in football are able to select “winners” at dif-
ferent than chance levels (i.e., picking winners more or less than 50% of the time).
She identifies 15 people who advertise their ability to pick “winners” and records
the percentage of correct picks for each person over an entire football season. The
percentage of correct picks for the 15 “prognosticators” is presented in Figure 5.8.

Prognosticator

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

Percentage of correct picks

45
46
47
52
51
43
47
38
53
51
52
50
48
47
51

Figure 5.8 Percentage of correct picks for
the 15 prognosticators.

Enter the data in SPSS and perform the appropriate analyses to answer the
questions below (name the variable success). (Hint: For this problem, use a Test
Value of 50 and do not include a % sign when you enter the data.)
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Do the prognosticators pick winners at a rate different from 50%? Test at

d. What is the effect size? Would you characterize the effect size as small,
medium, or large?

e. Write the results of the study using APA format as appropriate.
2. The mean score on a standardized math skills test is known to be 50 for the entire 

U.S. population of fourth graders (with higher scores indicating better perfor-mance). 
A new math skills training program was being used at a local school dis-trict, and an 
administrator was charged with the task of evaluating whether the children under the 
new program have performance that is different from the national average (preferably 
the performance is higher than the national average, but test for either possibility). 
Twenty-five fourth graders who were instructed using the math skills program were 
administered the standardized math exam. The exam scores for the students are 
provided in the file Chapter 5_Exercise 2.sav in the Chapter 5 folder online at 
www.routledgetextbooks.com/textbooks/9780205735822 (the variable is named 
mathscore). Open the file in SPSS and perform the appropriate analyses to answer 
the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Are the scores on the math exam for the fourth graders different from the

national average? Test at 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write the results of the study using APA format as appropriate.

a = .05.

a = .05.
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3. A researcher wanted to examine whether students were either in favor of or
opposed to a presidential candidate. Fifty students were asked to indicate which
of the following statements best reflects their opinion about the candidate.

The responses of the 50 participants are provided in the file Chapter 5_ 
Exercise 3.sav in the Chapter 5 folder online at www.routledgetextbooks.com/
textbooks/9780205735822 (the variable is named score). Open the file in SPSS and 
perform the appropriate analyses to answer the questions below. (Hint: To 
investigate students’ attitudes toward the candidate, test to see whether they are 
different from a neutral response–which implies a value of “3” in the Test Value 
box.)a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Are the students either in favor of or opposed to the candidate? Test at

d. What is the effect size? Would you characterize the effect size as small,
medium, or large?

e. Write the results of the study using APA format as appropriate.

a = .05.

Statement Numeric value in the data file

I am strongly in favor of the candidate. 1

I am somewhat in favor of the candidate. 2

I am neither in favor of nor opposed to the candidate. 3

I am somewhat opposed to the candidate. 4

I am strongly opposed to the candidate. 5
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The independent-samples t test is used when the means of two independent groups are compared
on a continuous dependent variable of interest. An example of an independent-samples t test is

presented next.

Example
A clinical psychologist wanted to investigate the relative effectiveness of cognitive-behavioral therapy
and psychoanalytic therapy on depression. Thirty people suffering from depression were randomly
assigned to receive one of the two therapies, with 15 people receiving cognitive-behavioral therapy and
15 receiving psychoanalytic therapy. After two months of therapy, the depression score for each par-
ticipant was recorded. The independent variable in this study is the type of therapy (cognitive-
behavioral, psychoanalytic) and the dependent variable is depression, with higher scores representing
greater depression levels (the range of possible scores on the depression scale is from 10 to 70).

Objective and Data Requirements 
of the Independent-Samples t Test

6
CHAPTER

The Independent-Samples t Test

Independent-Samples t Test

Objective Data Requirements Example

To test whether the means 
of two groups differ 
significantly on some
dependent variable of 
interest.

One independent variable
with two separate groups

One continuous dependent
variable

Independent variable
• Type of therapy (cognitive-

behavioral, psychoanalytic)
Dependent variable

• Depression

Null and Alternative Hypotheses
The null hypothesis states that the mean depression scores for the two groups are equal in the 
population:

The alternative hypothesis states that the mean depression scores for the two groups are not
equal in the population:

H1 : mpsychoanalytic Z mcognitive-behavioral

H0 : mpsychoanalytic = mcognitive-behavioral
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Evaluation of the Null Hypothesis

The independent-samples t test provides a test of the null hypothesis that the population means for
the two groups are equal. If the t test produces results that seem unlikely if the null hypothesis is
true (results that occur less than 5% of the time), then the null hypothesis is rejected. If t test pro-
duces results that seem fairly likely if the null hypothesis is true (results that occur greater than
5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Is there a difference in the average depression levels between those who received
cognitive-behavioral therapy and those who received psychoanalytic therapy?”

The Data

The data for the 30 participants are presented in Figure 6.1. The participants who received psy-
choanalytic therapy are assigned a “1” and those who received cognitive-behavioral therapy are
assigned a “2.”

Participant

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

Therapy

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

Depression

57
61
67
63
51
55
45
62
41
36
55
57
70
62
58

Participant

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

Therapy

2
2
2
2
2
2
2
2
2
2
2
2
2
2
2

Depression

47
42
59
37
35
42
38
49
61
43
47
49
37
41
48

Figure 6.1 The data for the independent-samples t test example. (Note: The participant
variable is included for illustration but will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 below describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name therapy.sav in the 
Chapter 6 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, two variables will be created, one for the different therapy groups (the independent vari-
able) and one for the depression scores (the dependent variable). The variables will be named
therapy and depression, respectively.
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3. Enter the variable names therapy and depression, respectively, in the first two
rows of the Variable View window (see Figure 6.2 for details).

Figure 6.2 The Variable View window with the variables therapy and depression entered.

4. Using the process described in Chapter 1, create value labels for the variable
therapy. For therapy, and 

Step 2: Enter the Data

1. Click the Data View tab. The variables therapy and depression appear in the first
two columns of the Data View window.

2. Consulting Figure 6.1, enter the values for each of the participants on the two vari-
ables of interest. For the first participant, enter the values 1 and 57 for the vari-
ables therapy and depression, respectively. Using this approach, enter the data
for all 30 participants. The completed data set is presented in Figure 6.3.

2 = “cognitive-behavioral.”1 = “psychoanalytic”

For therapy, notice that the first 15
participants receive a 1 (the psychoanalytic
group) and the second 15 participants receive
a 2 (the cognitive–behavioral group). This is
the general setup for the independent samples
t test and it is used to differentiate between the
groups the participants are in. The second
variable, depression, is for the scores on the
dependent variable. We’ll build on this
approach with the one–way ANOVA in
Chapter 8.  

Figure 6.3 The completed data file for the independent-samples t test example.
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Figure 6.4 Menu commands for the independent-samples t test.

Figure 6.5 The Independent-Samples T Test dialog box.

Step 3: Analyze the Data

1. From the menu bar, select 
(see Figure 6.4).T Test

Analyze>Compare Means>Independent-Samples

An Independent-Samples T Test dialog box appears with the variables therapy and depression in
the left-hand side of the dialog box (see Figure 6.5).

2. Select the dependent variable, depression, and click the upper right-arrow button 
( ) to move it into the Test Variable(s) box.

3. Select the independent variable, therapy, and click the lower right-arrow button 
( ) to move it into the Grouping Variable box.
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Figure 6.6 The Independent-Samples T Test dialog box (continued).

Figure 6.7 The Define Groups
dialog box.

In the Grouping Variable box, two question marks enclosed in parentheses appear to the right
of therapy (see Figure 6.6). The question marks indicate that the numbers originally assigned to
the two therapy groups (i.e., 1 and 2) need to be entered by clicking the Define Groups button.

4. Click Define Groups.
5. The Define Groups dialog box opens. Enter a 1 to the right of Group 1 (the num-

ber assigned to the psychoanalytic group), and a 2 to the right of Group 2 (the
number assigned to the cognitive-behavioral group). See Figure 6.7 for details.

6. Click Continue
7. Click OK.

The independent-samples t test procedure runs in SPSS and the results are presented in the
Viewer window.

Step 4: Interpret the Results

The output of the independent samples t test is displayed in Figure 6.8 on page 76.

Group Statistics Table
The first table of output, Group Statistics, displays the descriptive statistics including the sample
size, mean, standard deviation, and standard error for each of the therapy groups. Notice that the

M06_YOCK5822_02_SE_C06.qxd  11/4/10  10:27 AM  Page 75



76 Unit II / Inferential Statistics

G
ro

u
p

 S
ta

ti
st

ic
s

t–
T

es
t

15 15
56

.0
00

0
45

.0
00

0
9.

41
88

3
7.

63
45

1
2.

43
19

3
1.

97
12

2

th
er

ap
y

ps
yc

ha
na

ly
tic

co
gn

iti
ve

-b
eh

av
io

ra
l

de
pr

es
si

on

N
M

ea
n

S
td

. D
ev

ia
tio

n
S

td
. E

rr
or

M
ea

n

In
d

ep
en

d
en

t 
S

am
p

le
s 

T
es

t

.3
11

.5
82

3.
51

4

3.
51

4

28

26
.8

50

.0
02

.0
02

11
.0

00
00

11
.0

00
00

3.
13

05
0

3.
13

05
0

4.
58

74
7

4.
57

50
7

17
.4

12
53

17
.4

24
93

E
qu

al
 v

ar
ia

nc
es

as
su

m
ed

E
qu

al
 v

ar
ia

nc
es

no
t a

ss
um

ed

de
pr

es
si

on
F

S
ig

.

Le
ve

ne
's

 T
es

t f
or

E
qu

al
ity

 o
f V

ar
ia

nc
es

t
df

S
ig

. (
2-

ta
ile

d)
M

ea
n

D
iff

er
en

ce
S

td
. E

rr
or

D
iff

er
en

ce
Lo

w
er

U
pp

er

95
%

 C
on

fid
en

ce
In

te
rv

al
 o

f t
he

D
iff

er
en

ce

t-
te

st
 fo

r 
E

qu
al

ity
 o

f M
ea

ns

T
he

 G
ro

up
 S

ta
tis

tic
s 

ta
bl

e 
pr

ov
id

es
 th

e 
m

ea
ns

 o
f

th
e 

tw
o 

th
er

ap
y 

gr
ou

ps
 (

ps
yc

ho
an

al
yt

ic
 a

nd
co

gn
iti

ve
–b

eh
av

io
ra

l).
 If

 th
e 

nu
ll 

hy
po

th
es

is
 is

re
je

ct
ed

, w
e 

w
ill

 c
on

su
lt 

th
is

 ta
bl

e 
to

 d
et

er
m

in
e

w
hi

ch
 g

ro
up

 h
as

 th
e 

lo
w

er
 m

ea
n 

de
pr

es
si

on
 s

co
re

. 

T
he

 p
–v

al
ue

 fo
r 

Le
ve

ne
’s

 te
st

 o
f e

qu
al

va
ria

nc
es

. I
f p

 ≤
 .0

5,
 w

e 
as

su
m

e 
th

e
va

ria
nc

es
 a

re
 n

ot
 e

qu
al

 (
an

d 
re

ad
 th

e
bo

tto
m

 r
ow

 o
f r

es
ul

ts
 fo

r 
t)

. I
f p

 >
 .0

5,
w

e 
as

su
m

e 
th

e 
va

ria
nc

es
 a

re
 e

qu
al

 (
an

d
re

ad
 th

e 
to

p 
ro

w
 o

f r
es

ul
ts

 fo
r 

t)
. S

in
ce

th
e 

p–
va

lu
e 

of
 .5

82
 is

 g
re

at
er

 th
an

 .0
5,

w
e 

as
su

m
e 

th
e 

va
ria

nc
es

 a
re

 e
qu

al
 a

nd
in

te
rp

re
t t

he
 r

es
ul

ts
 o

f t
he

 t 
te

st
 u

si
ng

 th
e

E
qu

al
 V

ar
ia

nc
es

 A
ss

um
ed

 r
ow

.  

S
in

ce
 th

e 
p–

va
lu

e 
of

 .0
02

 is
 le

ss
 th

an
 .0

5,
 th

e 
nu

ll
hy

po
th

es
is

 th
at

 th
e 

m
ea

ns
 a

re
 e

qu
al

 fo
r 

th
e 

tw
o

gr
ou

ps
 is

 r
ej

ec
te

d.
 C

on
su

lt 
th

e 
G

ro
up

 S
ta

tis
tic

s
ta

bl
e 

to
 d

et
er

m
in

e 
w

hi
ch

 g
ro

up
 h

as
 th

e 
lo

w
er

m
ea

n 
de

pr
es

si
on

 s
co

re
 (

co
gn

iti
ve

–b
eh

av
io

ra
l i

s
lo

w
er

).
 

Fi
gu

re
 6

.8
Th

e 
ou

tp
ut

 f
or

 t
he

 in
de

pe
nd

en
t-

sa
m

pl
es

 t
te

st
.

M06_YOCK5822_02_SE_C06.qxd  11/4/10  10:27 AM  Page 76



Chapter 6 / The Independent-Samples t Test 77

cognitive-behavioral group had a lower mean depression score than the psy-
choanalytic group Whether the difference between the two groups is large
enough to be statistically significant will be considered shortly.

Independent-Samples Test Table
The second table, Independent-Samples Test, presents the results for Levene’s Test for Equality of
Variances followed by the t-test for Equality of Means. These tests will be discussed separately
below.

Levene’s Test for Equality of Variances
Levene’s Test for Equality of Variances tests whether the population variances are equal for the two
therapy groups, an assumption of the independent-samples t test. SPSS uses a procedure devel-
oped by Levene to test for the assumption of equal variances.

The null and alternative hypotheses for Levene’s test are

(The population variances are equal for the two groups.)

(The population variances are not equal for the two
groups.)

The equal variances assumption is assessed by examining the p-value (sig.) reported under
Levene’s Test for Equality of Variances in the output. If the null hypothesis is rejected,
and it is assumed that the population variances are not equal. If the null hypothesis is not
rejected, and it is assumed that the population variances are equal.

The results from the Independent-Samples Test table shows that Levene’s test produced an
F of .311 (F tests will be discussed in Chapter 8) with a p-value of .582. Since the p-value of .582
is greater than .05, the null hypothesis that the variances are equal is not rejected. Therefore,
based on the results of Levene’s test, we’ll assume that the population variances are equal for the
two groups. The decision rule for assessing the assumption of equal variances is summarized in
Figure 6.9.

p 7 .05,
p … .05,

H1 : s2
psychoanalytic Z s2

cognitive-behavioral

H0 : s2
psychoanalytic = s2

cognitive-behavioral

1mean = 56.002.
1mean = 45.002

Assessing the Assumption of Equal Variances: 

Levene’s Result Decision Conclusion 

p > .05 Fail to reject H0 Assume the variances are equal in the
population. 

p ≤ .05 Reject H0

Fail to reject H0

Assume the variances are not equal in the
population. 

Our data

p = .582; .582 > .05 Assume the variances are equal in the
population. 

Figure 6.9 Decision rule for assessing the assumption of equal variances.

t-Test for Equality of Means
The next section of the table, t-test for Equality of Means, provides the answer to our research ques-
tion, that is, whether there is a difference in the depression levels for the two therapy groups. In
SPSS, two sets of results are presented, one assuming equal variances between the groups and the
other assuming unequal variances between the groups. Since Levene’s test was not significant
(recall that the p-value for Levene’s test was greater than .05), the values from the first row of the
table, labeled Equal variances assumed, will be used. (If, on the other hand, Levene’s test was sig-
nificant (i.e., ), the values from the second row of the table, labeled Equal variances not
assumed, would be used.)

p … .05
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The test of the null hypothesis that the means are equal is provided in the form of a t, where

Substituting the appropriate values (Mean Difference, Std. Error Difference) from the
Independent-Samples Test table yields a t value of

which agrees with the value provided in the Independent-Samples Test table in column t. With
30 participants, the degrees of freedom (df) are equal to 28 (total number of participants – 2), with
a corresponding p-value of .002. Because the p-value of .002 is less than .05, the null hypothesis
that the means are equal is rejected, and it is concluded that the depression scores are significantly
different for the two therapy groups. Since the test is significant, inspecting the means (once again)
from the Group Statistics table indicates that the cognitive-behavioral therapy group had lower aver-
age depression scores than the psychoanalytic group (If, on the
other hand, the t test had not been significant, we would have assumed that any difference between
the means in the Group Statistics table was due to sampling error.)

Effect Sizes
A popular estimate of effect size for the independent-samples t test is given by d, where

and are the samples sizes for groups 1 and 2, and t is the value of the t statistic reported in
Figure 6.8.1

Inserting the appropriate values from the Independent-Samples Test in Figure 6.8 yields an
effect size of

Cohen (1988) gave estimates of values of d of .2, .5, and .8 as corresponding to small, medium,
and large effect sizes, respectively, in the behavioral sciences. Based on Cohen’s guidelines, the effect
size of 1.28 would be considered very large in practice and indicates that the cognitive-behavioral
group has depression scores that are 1.28 standard deviations lower than the psychoanalytic group.

Expression of the Results in APA Format
In writing the results for the independent-samples t test, the conclusion of the hypothesis test, the
degrees of freedom, the t value, the p-value, and the effect size are reported along with the mean
and standard deviation for each of the groups. An example of a brief write-up in APA format is
presented next.

Written Results

Those who received cognitive-behavioral therapy had significantly
lower depression scores than those who received psychoanalytic therapy 
SD = 9.422, t1282 = 3.51, p 6 .05, d = 1.28.

1M = 56.00,
1M = 45.00, SD = 7.632

d = 1.28

d = 3.514A
15 + 15

15 * 15

N2N1

d = tA
N1 + N2

N1N2

1mean = 56.002.1mean = 45.002

t =

11

3.1305
= 3.514

t =

Difference between the two sample means

Standard error of the difference between the two means
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Assumptions of the Independent-Samples t Test

1. The observations are independent.
Violating this assumption can seriously compromise the accuracy of the independent-
samples t test. This assumption should be satisfied by designing your study so the
participants do not influence each other in any way (participants working together in
answering the depression measure would be an example of violating the indepen-
dence assumption). If there is reason to believe the independence assumption has
been violated, the independent-samples t test should not be used.

2. The dependent variable is normally distributed for each of the groups in the population.
This assumption means that the depression scores should be normally distributed in
the population (they should resemble a bell-shaped curve when plotted) for both 
therapy groups. For moderate to large sample sizes, most types of nonnormal 
distributions tend to have relatively little impact on the accuracy of the t test,
although some nonnormal distributions can adversely affect the power of the t test.

3. The variances for each of the groups are equal in the population.
Violating the equal variances assumption can compromise the accuracy of the
independent-samples t test, particularly when the group sample sizes are unequal.
Interpreting the results of Levene’s test in SPSS and reading the appropriate
results for t from the output addresses this assumption.

Summary of Steps for Conducting an Independent-Samples
t Test in SPSS

I. Data Entry and Analysis
1. Create two variables in SPSS (one for the independent variable and one for the

dependent variable).

2. Enter the data.

3. Create value labels for the independent variable. In the Value Labels dialog
box, enter the numeric values and labels as appropriate. Click OK.

4. Select 

5. Move the dependent variable to the Test Variable(s) box and the independent
variable to the Grouping Variable box.

6. Click Define Groups. Enter a 1 for group 1 and a 2 for group 2. Click
Continue.

7. Click OK.

II. Interpretation of the Results
1. Check the results of Levene’s test for the equality of variances.

• If for Levene’s test, equal population variances are assumed for 
the two groups. Interpret the first row of values for the t test, labeled Equal
variances assumed.

• If for Levene’s test, equal population variances are not assumed for
the two groups. Interpret the second row of values for the t test, labeled
Equal variances not assumed.

2. Check the p-value (sig.) in the t-test for Equality of Means section of the
Independent-Samples Test table.
• If the null hypothesis is rejected. Inspect the means from the Group

Statistics table and write the results indicating the nature of the difference
between the groups.

• If the null hypothesis is not rejected. Write the results indicating
that there is not a significant difference between the groups.

p 7 .05,

p … .05,

p … .05

p 7 .05

Analyze>Compare Means>Independent-Samples T Test Á .
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Procedure

Minimally invasive 

Traditional 

Pain

5, 4, 7, 2, 3, 5, 4, 6, 2, 5, 6, 8, 4, 5, 5 

6, 7, 5, 8, 9, 7, 8, 6, 6, 7, 8, 8, 6, 3, 9 

Figure 6.10 The postoperative pain scores for the two
groups.

Exercises

1. Recent advances in surgical technology have led to an increase in the use of mini-
mally invasive surgery (MIS), which involves making one or more small incisions
(using small instruments) to perform a surgery, as opposed to making a consider-
ably larger incision (using larger instruments) that traditional surgery requires.
One of the claims advocates of MIS make is that the patient experiences less pain
following the surgery. To investigate this claim, a researcher followed 30 people
who were scheduled to undergo cardiovascular surgery, with 15 receiving MIS
and 15 receiving traditional surgery. The reported pain level of each surgical
patient was recorded 24 hours following surgery and is presented in Figure 6.10.
The pain scale ranged from 1 to 10, with higher scores indicating a greater degree
of pain.

Enter the data into SPSS and perform the appropriate analyses to answer the
questions below. Name the variables procedure and pain.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Test for the assumption of equal variances. Do the data suggest unequal vari-

ances between the groups?
d. Is there a significant difference in the reported pain levels between the

groups? Test at 
e. What is the effect size for the study? Would you characterize the effect size as

small, medium, or large?
f. Write the results of the study using APA format as appropriate.

2. Two different methods were compared for helping people overcome snake phobia 
(ophidiophobia). Twenty people who suffered from excessive fear of snakes were 
randomly assigned to receive one of two treatments: systematic desensitization
(small, progressive steps are made toward overcoming the snake phobia) or implo-sion 
therapy (the participant is overwhelmed or “flooded” with the fear with the goal of 
overcoming it).2 After three weeks of treatment, the snake anxiety score for each 
participant was obtained using a measure of snake fear (with higher scores representing 
greater fear of snakes). The data are in the file Chapter 6_ Exercise 2.sav in the Chapter 
6 folder online at www.routledgetextbooks.com/textbooks/9780205735822 (the variables 
in the file are named therapy and snakefear; for therapy,

and ). Open the file in SPSS,
and perform the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Test for the assumption of equal variances. Do the data suggest unequal vari-

ances between the groups?
d. Is there a significant difference in the reported snake fear between the groups?

Test at 
e. What is the effect size for the study? Would you characterize the effect size as

small, medium, or large?
f. Write the results of the study using APA format as appropriate.

3. A researcher wanted to investigate whether there was a difference in satisfaction
with nursing homes between residents who had access to a community pet and

a = .05.

2 = “implosion”1 = “systematic desensitization”

a = .05.
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those who did not. Satisfaction was measured on a 5 to 25 scale, with higher scores 
indicating greater satisfaction. Sixty nursing home residents participated in the study, 
with 30 residents participating from a home with a pet and 30 partici-pating from a 
home without a pet. The satisfaction scores for the residents are located in the file 
Chapter 6_Exercise 3.sav in the Chapter 6 folder online at 
www.routledgetextbooks.com/textbooks/9780205735822 (the variables in the file are 

named group and satisfaction; for group, 1 = “pet” and 2 = “no pet”). Open the 
file in SPSS, and perform the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Test for the assumption of equal variances. Do the data suggest unequal vari-

ances between the groups?
d. Is there a significant difference in the reported satisfaction levels between the

residents? Test at 
e. What is the effect size for the study? Would you characterize the effect size as

small, medium, or large?
f. Write the results of the study using APA format as appropriate.

a = .05.
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The dependent-samples t test (also known as paired-samples t, repeated-measures t, or matched-
subjects t) is used when the mean of one sample is compared to the mean of another sample, where

the two samples are related in some way. With the dependent-samples t test, the two samples may
consist of either the same people measured on two occasions or related people who are each measured
once (e.g., identical twins on IQ, husbands and wives on quality of communication). The key to cor-
rectly identifying the dependent-samples t test is to remember that the two samples are naturally
related in some way. An example of a dependent-samples t test is presented next.

Example
A worker for a national polling organization was charged with the task of surveying the public to
determine which issue was more important to voters, the economy or national security. Twenty-five
potential voters were asked to indicate the importance of each of the two issues on a 1 to 7 scale
( important at all and important). The independent variable is the voter
issue (economy, national security) and the dependent variable is the importance rating.1

Objective and Data Requirements 
of the Dependent-Samples t Test

7 = extremelywhere 1 = not

The Dependent-Samples t Test

82

The Dependent-Samples t Test

Objective Data Requirements Example

To test whether the means of 
two related groups differ
significantly on some 
dependent variable of interest.

One independent variable 
with two related groups or
categories
One continuous dependent
variable

Independent variable
• Voter issues (economy, 

national security)
Dependent variable
• Importance rating (on a 1 to 

7 scale)

Null and Alternative Hypotheses
The null hypothesis states that the difference in the importance ratings for the economy and national
security is equal to zero in the population:

The alternative hypothesis states that the difference in the importance ratings is not equal to zero
in the population:

H1 : meconomy - mnational security Z 0

H0 : meconomy - mnational security = 0
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Evaluation of the Null Hypothesis

The dependent-samples t test provides a test of the null hypothesis that the difference between the
two population means is equal to zero. If the t test produces results that seem unlikely if the null
hypothesis is true (results that occur less than 5% of the time), then the null hypothesis is rejected.
If t test produces results that seem fairly likely if the null hypothesis is true (results that occur
greater than 5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Is there a difference in the perceived importance of the economy and national
security for voters?”

The Data

The data for the 25 participants are presented in Figure 7.1.

Participant

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

Economy

5

6

5

6

5

7

7

4

7

5

4

6

7

4

6

7

7

6

6

6

6

3

5

7

7

National Security

7

4

2

3

5

7

6

5

3

4

6

4

5

7

4

5

5

7

4

2

4

1

2

6

7

Figure 7.1 The data for the dependent-samples
t test. (Note: The participant variable is included
for illustration but will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name opinion.sav in the 
Chapter 7 folder. If you prefer to open the file from the web site, skip to Step 3.
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Figure 7.2 The Variable View window with the variables economy and security entered.

84 Unit II / Inferential Statistics

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, two variables will be created, one for the ratings on the economy and one for national
security. The variables will be named economy and security, respectively.

3. Enter the variable names economy and security in the first two rows of the
Variable View window (see Figure 7.2).

Step 2: Enter the Data

1. Click the Data View tab. The variables economy and security appear in the first
two columns of the Data View window.

2. Consulting Figure 7.1, enter the importance ratings for each of the participants on
the two variables of interest. For the first participant, enter the ratings 5 and 7 for
economy and security, respectively. Using this approach, enter the data for all 
25 participants. The completed data set is presented in Figure 7.3.

Figure 7.3 The completed data file
for the dependent-samples t test
example.
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Figure 7.4 Menu commands for the dependent-samples t test.

Step 3: Analyze the Data

1. From the menu bar select: 
(see Figure 7.4).T Test Á

Analyze>Compare Means>Paired–Samples

A Paired-Samples T Test dialog box appears with the variables economy and security in the
left–hand side of the dialog box (see Figure 7.5).

Figure 7.5 The Paired-Samples T Test dialog box.

2. Select the variables, economy and security, and click the right-arrow button ( )
to move them into the Paired Variables box (see Figure 7.6).

3. Click OK.

Figure 7.6 The Paired-Samples T Test dialog box (continued).
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t–Test 
Paired Samples Statistics

5.7600 25 1.16476

4.6000 25 1.77951

.23295

.35590

economy

security

Pair
1

Mean N Std. Deviation
Std. Error

Mean

Paired Samples Correlations

25 .253 .222economy & securityPair 1
N Correlation Sig.

Paired Samples Test

1.16000 1.86369 .37274 .39071 1.92929 3.112 24 .005economy - securityPair 1
Mean Std. Deviation

Std. Error
Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df Sig. (2-tailed)

Since the p–value of .005 is less
than .05, the null hypothesis is
rejected. 

The Paired Samples Statistics table provides the means
of the two variables (economy and security). If the null
hypothesis is rejected, we’ll consult this table to
determine which variable has the higher mean rating.  

The mean of 1.16 is equal to the
difference between the means for
economy and security
(i.e., 5.76 – 4.60 = 1.16). 

Figure 7.7 Output for the Dependent-Samples t Test.

The dependent samples t test procedure runs in SPSS and the results are presented in the Viewer
window.

Step 4: Interpret the Results

The output of the dependent-samples t test is displayed in Figure 7.7.

Paired Samples Statistics
The first table of output, Paired Samples Statistics, displays the descriptive statistics for economy
and security, including the mean, sample size, standard deviation, and standard error of the mean.
Notice that the economy has a higher mean importance rating than national secu-
rity Whether the difference in the mean ratings (5.76 vs. 4.60) is large enough
to be statistically significant will be considered shortly.

Paired Samples Correlations
The Paired Samples Correlations table is not critical to interpreting the results of the paired-
samples t test and therefore will not be discussed, except to mention that the correlation is equal
to the Pearson correlation coefficient between the economy and national security ratings for the
25 respondents (the Pearson correlation coefficient is discussed in Chapter 12).

Paired Samples Test
The Paired Samples Test table provides the answer to our research question, that is, whether there
is a difference in the importance ratings for the economy and national security. The test of the null
hypothesis is provided in the form of a t, where

t =

Mean difference between the ratings on the economy and security

Standard error of the mean of the difference scores

1mean = 4.602.
1mean = 5.762
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Substituting the appropriate values (Mean, Std. Error Mean) from the Paired Samples Test table
yields a t of

which agrees with the value provided in the Paired Samples Test table in column t. With 25 par-
ticipants, the degrees of freedom (df) are equal to 
with a corresponding p-value of .005.

Because the p-value of .005 is less than .05, the null hypothesis that the means are equal is
rejected, and it is concluded that the importance ratings for the economy and national security
are significantly different. Since the test is significant, inspecting the means (once again) from the
Paired Samples Statistics table indicates that the economy had a higher mean importance rating

than national security (If the t test had not been significant, on
the other hand, we would have assumed that any difference between the means in the Paired Sam-
ples Statistics table was due to sampling error.)

Effect Sizes
A commonly used effect size statistic for the dependent-samples t test is d, where

Inserting the appropriate values from the Paired Samples Test table (Mean, Std. Deviation)
produces an effect size of

Cohen’s (1988) conventions for small, medium, and large effect sizes for the dependent
samples t test are .20, .50, and .80, respectively. Using Cohen’s conventions, the effect size of
.62 corresponds to a medium effect in practice and indicates that the economy was rated .62 stan-
dard deviations higher in importance than was national security.

Expression of the Results in APA Format
In writing the results, the conclusion of the hypothesis test, the degrees of freedom, the t value,
the p-value, and the effect size are reported along with the mean and standard deviation for each
of the variables. An example of a brief write-up in APA format is presented below.

Written Results

Voters view the economy as significantly more important than national
security 

Assumptions of the Dependent-Samples t Test
The assumptions of the dependent-samples t test are provided below. The second assumption is
concerned with difference scores rather than the original scores shown in Figure 7.1. Difference
scores are equal to the difference between the two measures taken for each participant (i.e., the
difference between the economy and national security ratings for each person). For example, the
difference score for the first individual in the data set shown in Figure 7.1 would be equal to 
(i.e., ).5 - 7 = -2

-2

1M = 4.60, SD = 1.782, t1242 = 3.11, p 6 .05, d = 0.62.
1M = 5.76, SD = 1.162

d =

1.16

1.86
= .62

d =

Mean difference

Standard deviation of the difference scores

1mean = 4.602.1mean = 5.762

241number of participants in the sample - 12,

t =

1.16

.37274
= 3.112

M07_YOCK5822_02_SE_C07.qxd  11/4/10  10:28 AM  Page 87



88 Unit II / Inferential Statistics

1. Observations are independent within groups.
Violating the assumption of independence within groups can seriously 
compromise the accuracy of the dependent-samples t test. This assumption 
should be satisfied by designing your study so the participants do not influence
each other in any way (participants working together in determining their ratings 
for the importance of the economy would be an example of violating the independence
assumption). If there is reason to believe the independence assumption has been 
violated within groups, the dependent-samples t test should not be used. It is 
important to note that independence between groups is not an assumption of the
dependent-samples t test (we expect a dependency between the two ratings for 
the same person, as it is the reason for using the dependent-samples t test in the 
first place).

2. The difference scores are normally distributed in the population.
This assumption means that the difference between the ratings should be 
normally distributed in the population. For moderate to large sample sizes, most
types of nonnormal distributions tend to have relatively little impact on the accuracy
of the t test, although some nonnormal distributions can adversely affect the power 
of the t test.

Summary of Steps for Conducting a Dependent 
Samples t Test in SPSS

I. Data Entry and Analysis
1. Create two variables in SPSS.

2. Enter the data.

3. Select 

4. Move the two variables to the Paired Variables box.

5. Click OK.

II. Interpretation of the Results
1. Check the p-value (“sig.”) in the far right-hand column of the Paired Samples

Test table.
• If the null hypothesis is rejected. Inspect the means from 

the Paired Samples Statistics table and write the results indicating the 
nature of the difference between the two groups.

• If the null hypothesis is not rejected. Write the results 
indicating that there is not a significant difference between the two 
groups.

Exercises

1. The impact of a campaign film on attitudes toward a political candidate was
investigated. Prior to showing the film, the attitudes of 15 people toward the
candidate were assessed using a political likability scale. After completing the scale,
the participants were shown a 20-minute campaign film in favor of the candi-
date, and then they completed the likability scale a second time. The scores for
the participants across the two administrations of the likability scale are
reported in Figure 7.8 (scores on the scale range from 20 to 100, with higher
scores indicating more favorable attitudes toward the candidate).

Enter the data in SPSS and perform the appropriate analyses to answer the
questions below. Name the variables beforefilm and afterfilm.
a. State the null and alternative hypotheses.

p 7 .05,

p … .05,

Analyze>Compare Means>Paired-Samples T Test Á .
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Participant

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

Before film

75

25

50

45

48

88

55

78

52

46

48

48

57

55

42

After film

80

26

58

65

59

93

52

92

59

52

52

53

61

59

41

Figure 7.8 Attitude ratings toward a
political candidate before and after
viewing the campaign film.

b. State a research question for the data.
c. Did attitudes toward the candidate change after viewing the campaign film?

Test at 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write the results of the study using APA format as appropriate.

2. Air traffic controllers often experience a high degree of on-the-job stress. In an 
effort to help air traffic controllers cope with their stress, the impact of a relax-
ation exercise program was investigated. Thirty air traffic controllers were 
selected from some of the busiest airports in the country and were administered 
a scale measuring job-related stress (the scale ranged from 10 to 50, with higher 
scores indicating greater stress levels). Following the administration of the 
stress scale, the air traffic controllers were trained in a relaxation technique for 
four weeks and were then administered the job-related stress scale a second 
time. The data are in the file Chapter 7_Exercise 2.sav in the Chapter 7 folder 
online at www.routledgetextbooks.com/textbooks/9780205735822  (the 
variables are named prerelax and postrelax). Open the file in SPSS and 
perform the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Are the stress levels different after the relaxation exercise training as com-

pared to before? Test at 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write the results of the study using APA format as appropriate.

3. A researcher investigated the impact of receiving training from a sports psy-
chologist on the accuracy of shots of college tennis players. The shot accuracy 
of 15 tennis players was recorded before and after receiving eight weeks of 
training from a sports psychologist (accuracy scores ranged from 0 to 100, with 
higher scores indicating greater accuracy). The data are in the file Chapter 
7_Exer-cise 3.sav in the Chapter 7 folder online at 
www.routledgetextbooks.com/textbooks/9780205735822  (the variables are 
named beforetraining and aftertraining). Open the file in SPSS and perform 
the appropriate analyses to answer the questions below.

a = .05.

a = .05.
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a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a difference in the accuracy of the tennis players’ shots after receiv-

ing training as compared to before? Test at 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write the results of the study using APA format as appropriate.

a = .05.
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The one-way between subjects analysis of variance (ANOVA) is used when the means of two or
more independent groups are compared on a dependent variable of interest. With the one-way

between subjects ANOVA, the independent variable is a between subjects factor, where each partic-
ipant receives only one level of the factor (i.e., each person is in a single group).1 An example of a
one-way between subjects ANOVA is presented below.

Example
As part of a class-required research project, a student was interested in investigating whether there was
a difference between three different learning strategies (strategies A, B, and C) on word recall. Thirty
students who agreed to participate in the study were randomly assigned to receive one of the three strate-
gies (with 10 students in each strategy group). After learning the strategy of interest, the students were
shown a list of 15 words for five minutes and were asked to remember as many of the words as pos-
sible using the new strategy. After a brief delay, each student wrote down as many of the words as he
or she could remember from the list, with the researcher recording the number of words correctly
recalled for each participant. The independent variable in this study is the type of learning strategy
(A, B, and C) and the dependent variable is the number of words correctly recalled.

Objective and Data Requirements of the One-Way 
between Subjects ANOVA

8
CHAPTER

The One-Way between Subjects 
Analysis of Variance (ANOVA)

The One-Way between Subjects ANOVA

Objective Data Requirements Example

To test whether the means of 
two or more groups differ
significantly on a dependent 
variable of interest.

Independent variable
• Between subjects factor 

with two or more separate 
groups or categories

Dependent variable
• Continuous

Independent variable
• Learning strategy 

(strategies A, B, and C)

Dependent variable
• Number of words

correctly recalled

Null and Alternative Hypotheses
The null hypothesis states that the mean number of words recalled for the three groups is equal in the
population:

H0 :mStrategy A = mStrategy B = mStrategy C
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In order for the null hypothesis to be false, it is not necessary for all the groups to be differ-
ent from each other (although this is one possibility); all that is required is that the null hypothe-
sis be false in some way (i.e., there is a difference somewhere between the groups). Therefore, rather
than generate all possible ways the null hypothesis could be false (which would become increas-
ingly tedious as the number of groups increased), a general statement that the means differ in
some way will be made:

Evaluation of the Null Hypothesis

The one-way between subjects ANOVA provides a test of the null hypothesis that the population
means for the three groups are equal. If the test produces results that seem unlikely if the null
hypothesis is true (results that occur less than 5% of the time), then the null hypothesis is rejected.
If the test produces results that seem fairly likely if the null hypothesis is true (results that occur
greater than 5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Does the number of words recalled depend on the type of learning strategy used?”

The Data

The data for the 30 participants are presented in Figure 8.1. The participants who received strat-
egy A are assigned a “1,” those who received strategy B are assigned a “2,” and those who received
strategy C are assigned a “3.”

H1 : At least one of the population means is different from the others.

1

1

1

1

1

1

1

1

1

1

1

2

3

4

5

6

7

8

9

10

8

10

9

7

9

7

10

8

12

9

2

2

2

2

2

2

2

2

2

2

11

12

13

14

15

16

17

18

19

20

12

10

9

10

9

8

12

10

10

12

21

22

23

24

25

26

27

28

29

30

3

3

3

3

3

3

3

3

3

3

6

4

5

6

4

2

5

3

7

5

Participant Strategy
Word
recall Participant Strategy

Word
recall Participant Strategy

Word
recall

Figure 8.1 The data for the one-way between subjects ANOVA example. (Note: The participant variable is included
for illustration but will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822  under the name word recall.sav in 
the Chapter 8 folder. If you prefer to open the file from the web site, skip to Step 3.
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Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, two variables will be created, one for the different strategy groups (the independent
variable) and one for the number of words recalled (the dependent variable). The variables will
be named strategy and wordrecall, respectively.

3. Enter the variable names strategy and wordrecall in the first two rows of the
Variable View window (see Figure 8.2).

Figure 8.2 The Variable View window with the variables strategy and wordrecall entered.

4. Using the process described in Chapter 1, create value labels for the variable strategy.
For strategy, and 

Step 2: Enter the Data

1. Click the Data View tab. The variables strategy and wordrecall appear in the first
two columns of the Data View window.

2. Consulting Figure 8.1, enter the values for each of the participants on the two vari-
ables of interest. For the first participant, enter the values 1 and 8 for the variables
strategy and wordrecall, respectively. Using this approach, enter the data for all
30 participants. The completed data set is presented in Figure 8.3.

3 = “Strategy C.”1 = “Strategy A,” 2 = “Strategy B,”

For the variable strategy, notice that the
first 10 participants receive a 1 (the strategy
A group), the second 10 participants receive
a 2 (the strategy B group), and the last 10
receive a 3 (the strategy C group). If there
was a fourth group (a strategy D group), the
participants in that group would each receive
a 4. The second variable, wordrecall, is for
the scores on the dependent variable. 

Figure 8.3 The completed data file for the one-way ANOVA example.
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Figure 8.4 Menu commands for the one-way ANOVA procedure.

Figure 8.5 The One-Way ANOVA dialog box.

Step 3: Analyze the Data

1. From the menu bar, select 
(see Figure 8.4).

Analyze>Compare Means>One-Way ANOVA Á

A One-Way ANOVA dialog box appears with the variables strategy and wordrecall in the left-
hand side of the dialog box (see Figure 8.5).

2. Select the dependent variable, wordrecall, and click the upper right-arrow button
( ) to move it into the Dependent List box.

3. Select the independent variable, strategy, and click the lower right-arrow button
( ) to move it into the Factor box. See Figure 8.6 for details.

4. Click Options. The One-Way ANOVA: Options dialog box opens. Under Statistics
select Descriptive and Homogeneity of variance test2 (see Figure 8.7).

5. Click Continue.
6. Click Post Hoc. The One-Way ANOVA: Post Hoc Multiple Comparisons dialog

box opens. Under Equal Variance Assumed select Tukey (not Tukey’s b).3 See
Figure 8.8 (page 96) for details.

7. Click Continue.
8. Click OK.
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The one-way ANOVA procedure runs in SPSS and the results are presented in the Viewer
window.

Step 4: Interpret the Results

The output of one-way ANOVA is displayed in Figure 8.9 (page 97).

Descriptives
The Descriptives table displays the descriptive statistics for each of the groups (and for the total
sample). Examining the means for the different learning strategies, strategy B had the highest
average number of words recalled followed by strategy A with
strategy C producing the lowest number of words recalled, on average, of the
three groups. Whether the difference in the means is large enough to be statistically significant will
be discussed shortly.

1mean = 4.702
1mean = 8.902,1mean = 10.202,

Figure 8.6 The One-Way ANOVA dialog box (continued).

Figure 8.7 The One-Way ANOVA:
Options dialog box.
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Test of Homogeneity of Variances
The next table, Test of Homogeneity of Variances, tests if the variances are equal for the three
groups, an assumption of the between subjects ANOVA. SPSS uses a procedure developed by
Levene to test for the assumption of equal variances.

The null and alternative hypotheses for Levene’s test are

(The variances for the three groups are equal
in the population.)

At least one of the variances is different from the others.

The equal variances assumption is assessed by examining the p-value (sig.) reported in the
Test of Homogeneity of Variances table in the output. If the null hypothesis is rejected,
and it is assumed that the population variances are not equal. If the null hypothesis is not
rejected, and it is assumed that the population variances are equal for the three groups.

For our data, Levene’s test produced an F of .021 (SPSS labels the value Levene Statistic) and
a p-value of .980 (see Figure 8.9). Since .980 is greater than .05, the null hypothesis of equal vari-
ances is not rejected. Therefore, based on the results of Levene’s test, we’ll assume the popula-
tion variances are equal for the three groups. The decision rule for assessing the assumption of equal
variances is summarized in Figure 8.10 (page 98).

ANOVA—The Test of the Null Hypothesis that the Means 
of the Three Strategies are Equal
The next table, ANOVA, provides the answer to our research question, that is, whether or not the
number of words correctly recalled differs for the three strategy groups. ANOVA produces an
F test, which is a ratio of two variances, with each variance represented as a mean square (MS) in
the output:

F =

MS between Groups

MS within Groups

p 7 .05,
p … .05,

H1 :

H0 :s2
strategy A = s2

strategy B = s2
strategy C

Figure 8.8 The One-Way ANOVA: Post Hoc Multiple Comparisons dialog box.
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One way

Descriptives
wordrecall

10 8.9000 1.52388 .48189 7.8099 9.9901 7.00 12.00

10 10.2000 1.39841 .44222 9.1996 11.2004 8.00 12.00

10 4.7000 1.49443 .47258 3.6309 5.7691 2.00 7.00

30 7.9333 2.77841 .50727 6.8959 8.9708 2.00 12.00

Strategy A

Strategy B

Strategy C

Total

N Mean Std. Deviation Std. Error Lower Bound Upper Bound

95% Confidence Interval for
Mean

Minimum Maximum

Test of Homogeneity of Variances
wordrecall

.021 2 27 .980

Levene
Statistic df1 df2 Sig.

ANOVA
wordrecall

165.267 2 82.633 38.073 .000

58.600 27 2.170

223.867 29

Between Groups

Within Groups

Total

Sum of
Squares df Mean Square F Sig.

The p–value for the test of equal
variances, an assumption of ANOVA.
Since .980 is greater than .05,
the null hypothesis is not rejected and
equal variances for the three strategies
are assumed.

The p–value for the test of whether
the means are equal in the population.
Since the p–value (sig.) is less than .05,
the null hypothesis that the means are
equal for the three strategy groups is
rejected.  

Post Hoc Tests 
Multiple Comparisons

Dependent Variable: wordrecall
Tukey HSD

-1.30000 .65884 .138 -2.9335 .3335

4.20000* .65884 .000 2.5665 5.8335

1.30000 .65884 .138 -.3335 2.9335

5.50000* .65884 .000 3.8665 7.1335

-4.20000* .65884 .000 -5.8335 -2.5665

-5.50000* .65884 .000 -7.1335 -3.8665

(J) strategy
Strategy B

Strategy C

Strategy A

Strategy C

Strategy A

Strategy B

(I) strategy
Strategy A

Strategy B

Strategy C

Mean
Difference

(I-J) Std. Error Sig. Lower Bound Upper Bound
95% Confidence Interval

*. The mean difference is significant at the .05 level.

Homogeneous Subsets 
wordrecall

Tukey HSDa

10 4.7000

10 8.9000

10 10.2000

1.000 .138

strategy
Strategy C

Strategy A

Strategy B

Sig.

N 1 2

Subset for alpha = .05

Means for groups in homogeneous subsets are displayed.
a. Uses Harmonic Mean Sample Size = 10.000.

Strategies A and B are not
significantly different since
they share the same column. 

Since strategy C does not share a
column with A and B, it is significantly
different (lower) than strategies A and B.

Figure 8.9 Output for the One-Way between Subjects ANOVA.
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Levene’s result Decision Conclusion 

p > .05 Fail to reject H0 Assume the variances are equal in the
population. 

p ≤ .05 Reject H0

Fail to reject H0

Assume the variances are not equal in the
population. 

Our data

p = .980; .980 > .05 Assume the variances are equal in the
population. 

Figure 8.10 Decision rule for assessing the assumption of equal variances.

Substituting the appropriate values from the ANOVA table in Figure 8.9 produces an F of

which agrees with the value reported in column F of the ANOVA table.
This test produces two degrees of freedom, (df) between groups (number of ) and

df within groups (total sample size the number of groups). The df between groups and df
within groups from the ANOVA table are 2 and 27, respectively.

The p-value in the ANOVA table under the column “sig.” is .000 (which is read as “less
than .001” not “zero”). Since the p-value is less than .05, the null hypothesis that the means
are equal is rejected, and it is concluded that at least one of the strategies is different from the
others.

Post Hoc Tests—Assessing Which Groups Are Different
While the null hypothesis of equal means for the three groups was rejected, the alternative hypoth-
esis is nonspecific, stating only that the means differ in some way. In order to explore how the
groups differ, further testing is required.

One common approach is to test all possible pairs of groups, commonly referred to as
testing all pairwise comparisons. While many different tests of pairwise comparisons are avail-
able in SPSS, one of the more commonly used tests is Tukey’s post hoc procedure. (Post hoc
means “after the fact”; Tukey’s test is typically interpreted only after a significant result for
the overall ANOVA is obtained, i.e., the null hypothesis is rejected.) In the current example
with three groups, Tukey’s procedure will produce three separate tests: A vs. B, A vs. C, and
B vs. C.4

By default, SPSS provides two different tables of output for Tukey’s test, Multiple Com-
parisons and Homogeneous Subsets. While either table can be used to interpret the results of
the pairwise comparisons, the results will be described first using the latter table, Homogenous
Subsets. In the Homogeneous Subsets table in Figure 8.9, two different columns, labeled “1” and
“2,” are presented. When interpreting the results of the Homogenous Subsets table, groups that
share the same column are not significantly different from one another, while groups that do not
share the same column are significantly different. In our example, since strategies A and B
share the same column (column 2), they are not significantly different from each other (any
observed difference between A and B is considered to be due to sampling error). However,
since strategy C does not share a column with strategies A and B, C is significantly different
from A and B. Inspecting the means for the three groups provided in the table shows that the
number of words recalled for strategy C is lower than A and B

The following table summarizes the results of Tukey’s test from the Homogeneous Subsets
table.

1mean = 10.22.
1mean = 8.921mean = 4.72

-

groups - 1

F =

82.633

2.170
= 38.073
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Alternatively, the results of the pairwise comparisons could have been interpreted using the
Multiple Comparisons table. In the Multiple Comparisons table presented in Figure 8.9, the two
groups being tested are presented in the first two columns of the table followed by the mean dif-
ference between the groups, the standard error, the p-value (sig.), and the 95% confidence inter-
val. Reading across the first row of the table, Strategy A is tested against Strategy B, which
produces a mean difference of (mean of strategy  A – mean of strategy B) and a p-value of
.138. Since the p-value is greater than .05, strategies A and B are not significantly different from
one another. The next pairwise comparison (reading diagonally) is Strategy A vs. Strategy C,
which produces a mean difference of 4.2 (mean of strategy A – mean of strategy C), and a p-value
less than .001 (reported as .000 in SPSS due to rounding). Since the p-value is less than .05, A and
C are significantly different. Inspecting the means from the Descriptives table in Figure 8.9 shows
that those using strategy A recalled more words on average than those using strat-
egy C 

The potentially confusing part of the multiple comparisons table is that each of the pairwise
comparisons is presented twice. Following the test of A and C, the test of strategies A and B is
presented again; the only difference between the two tests is that this time strategy B is presented
first. Since the test of B vs. A is exactly the same as A vs. B (notice the identical p-value of .138
for both tests), it makes no difference which of the two tests is reported. The multiple comparisons
table always produces this redundancy, with each pairwise comparison presented twice. Therefore,
when interpreting the results, be sure to report the result of each pairwise comparison only once.
Summarizing the findings so far, we’ve reported the results of A vs. B and A vs. C, with only the
test of B vs. C remaining. Looking diagonally across the next row, we see that B and C are sig-
nificantly different, with a p-value less than .001 (once again reported as .000 in SPSS due to
rounding). The means from the Descriptives table shows that strategy B is sig-
nificantly higher than strategy C In summary, the results of the two tables are the
same: A and B are not significantly different from each other, and both A and B are significantly
higher than C.

Effect Sizes
The measure of effect size commonly used with ANOVA is eta-square . The formula for eta-
square is

The values for sum of squares between groups and the sum of squares total can be found in
the ANOVA table in Figure 8.9.5 Inserting the appropriate values into the above formula produces
an eta-square value of

h2
=

165.267

223.867
= .74

h2
=

Sum of squares between groups

Sum of squares total

1h22

1mean = 4.72.
1mean = 10.22

1mean = 4.72.
1mean = 8.92

-1.3

Test
Do the groups share the 
same column? Result

A vs. B Yes Not significant; assume A and B 
are equal.

A vs. C No Significant; A recalled more words 
than C.

B vs. C No Significant; B recalled more words 
than C.

M08_YOCK5822_02_SE_C08.qxd  11/4/10  10:29 AM  Page 99



100 Unit II / Inferential Statistics

Cohen’s (1988) conventions for small, medium, and large effect sizes for eta-square are .01,
.06, and .14, respectively. Eta-square can be expressed in terms of the percentage of variance in
the dependent variable that is accounted for by the independent variable. A value of .74 corresponds
to a very large effect in practice and indicates that the learning strategies accounted for 74% of the
variance in word recall.

Expression of the Results in APA Format
In writing the results for the one-way between subjects ANOVA, the conclusion of the hypothe-
sis test, the degrees of freedom (df), the F value, the p-value, and the effect size are reported along
with the means and standard deviations of the three strategy groups (the means and standard devi-
ations may be reported in a separate table if desired). An example of a brief write-up in APA for-
mat is presented next.

Written Results

The number of words recalled varied by the learning strategy used, 
Tukey’s post hoc procedure indicated that those who used strategy A

and those who used strategy B recalled sig-
nificantly more words than those who used strategy C There was not a
significant difference in the number of words recalled between strategies A and B.

Assumptions of the One-Way between Subjects ANOVA
1. The observations are independent.

Violating this assumption can seriously compromise the accuracy of the ANOVA test.
This assumption should be satisfied by designing your study so the participants do not
influence each other in any way (participants working together in generating their word
lists would be an example of violating the independence assumption). If there is reason
to believe the independence assumption has been violated, the between subjects
ANOVA should not be used.

2. The dependent variable is normally distributed for each of the 
groups in the population.
This assumption means that the number of words recalled should be normally dis-
tributed in the population for each of the strategy groups. For moderate to large sam-
ple sizes, most types of nonnormal distributions tend to have relatively little impact
on the accuracy of the ANOVA test, although some nonnormal distributions can
adversely affect the power of ANOVA.

3. The variances for each of the groups are equal in the population.
Violating the equal variances assumption can compromise the accuracy of the
ANOVA test, particularly when the sample sizes of the groups are unequal. Interpret-
ing the results of Levene’s test in SPSS and selecting and reporting the results of an
alternative procedure (the Brown-Forsythe test or Welch test) if the variances are not
equal (followed by an appropriate post hoc test if necessary such as Dunnett’s T3)
addresses this assumption. (See below for more information on these procedures.)

Summary of Steps for Conducting a One-Way 
between Subjects ANOVA in SPSS

I. Data Entry and Analysis
1. Create two variables in SPSS (one for the independent variable and one for the

dependent variable).

1M = 4.70, SD = 1.492.
1M = 10.20, SD = 1.4021M = 8.90, SD = 1.522

p 6 .05, h2
= .74,

F12, 272 = 38.07, 
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2. Enter the data.

3. Create value labels for the independent variable. In the Value Labels dialog
box, enter the numeric values and labels as appropriate. Click OK.

4. Select 

5. Move the dependent variable to the Dependent List box and the independent
variable to the Factor box.

6. Click Options. Select Descriptive and Homogeneity of variance test. Click
Continue.

7. Click Post Hoc. Select Tukey. Click Continue.

8. Click OK.

II. Interpretation of the Results
1. Check the results of Levene’s test of homogeneity of variances:

a. If for Levene’s test, equal population variances are assumed. Interpret
the ANOVA F.

• If the ANOVA is significant (i.e., ), interpret the results of
Tukey’s post hoc procedure.

• If the ANOVA is not significant (i.e., ), stop. Write the results
stating that there is not a significant difference between the groups.

b. If for Levene’s test, equal population variances are not assumed.
Rerun the analysis selecting either the Brown-Forsythe or the Welch proce-
dure (by clicking on the Options button), and select one of the post hoc
tests that does not assume equal variances between the groups (e.g., Dun-
nett’s T3) by clicking on Post Hoc. Unlike the ANOVA and Tukey’s test,
these tests do not require the assumption of equal variances.

• If the overall test (Brown-Forsythe or Welch) is significant (i.e., ),
interpret the results of the post hoc procedure.

• If the overall test (Brown-Forsythe or Welch) is not significant (i.e.,
), stop. Write the results stating that there is not a significant dif-

ference between the groups.

Exercises

1. A medical researcher wanted to investigate the effect of different pain medications
on people suffering from migraine headaches. Twenty-one people who had
recently seen a doctor for migraine headaches were randomly assigned to receive
one of three pills: drug A, drug B, or a placebo. While taking the appropriate pill,
each participant recorded their pain level three times a day at regular intervals for
one week (pain was recorded on a 1 to 10 scale, with higher scores indicating
greater pain). The average pain level over the one-week period was calculated for
each participant and is reported in Figure 8.11.

p 7 .05

p … .05

p … .05

p 7 .05

p … .05

p 7 .05

Analyze>Compare Means>One-Way ANOVA Á .

Drug 

A 

B 

C 

Pain

5.2, 4.1, 5.8, 6.85, 4.75, 1.75, 4

3.05, 6.15, 5.5, 6.15, 1.85, 6.4, 3.1

8.15, 7.15, 6.2, 7.85, 9.45, 9.25, 6.3

Figure 8.11 The pain levels for the three
groups.
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Enter the data in SPSS and perform the appropriate analyses to answer the
questions below. Name the variables drug and pain.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Test for the assumption of equal variances. Do the data suggest unequal vari-

ances between the groups? Test at 
d. Is there a significant difference in the reported pain levels between the

groups? Test at 
e. What is the effect size for the overall ANOVA? Would you characterize the

effect size as small, medium, or large?
f. If the overall ANOVA is significant, briefly summarize the results of Tukey’s

post hoc procedure.
g. Write the results of the study using APA format as appropriate (be sure to

include the results of Tukey’s test if the overall ANOVA is significant).
2. A researcher wanted to know whether the level of frustration over high gas prices

differed for different types of vehicle owners. Following a sharp increase in the
price of gas, the researcher asked 30 people to indicate their level of frustration
with prices at the pump (frustration scores ranged from 1 to 10, with higher scores
indicating greater frustration). Ten people were surveyed who owned a motorcycle
as their primary means of transportation (coded a 1 in the data file), 10 were sur-
veyed who owned a hybrid vehicle (coded a 2 in the data file), and 10 were sur-
veyed who owned a nonhybrid vehicle (coded a 3 in the data file). The data are
provided in the file Chapter 8_Exercise 2.sav in the Chapter 8 folder online at
www.routledgetextbooks.com/textbooks/9780205735822  (the variables are named
vehicle and frustration). Open the file in SPSS and perform the appropriate
analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Test for the assumption of equal variances. Do the data suggest unequal vari-

ances between the groups? Test at 
d. Is there a significant difference in the frustration levels of vehicle owners?

Test at 
e. What is the effect size for the overall ANOVA? Would you characterize the

effect size as small, medium, or large?
f. If the overall ANOVA is significant, briefly summarize the results of Tukey’s

post hoc procedure.
g. Write the results of the study using APA format as appropriate (be sure to

include the results of Tukey’s test if the overall ANOVA is significant).
3. A market researcher hired by an alarm company examined whether companies

differed in their response time to alarm calls. Three of the leading companies
were investigated for the study. The response time (in seconds) of each of the
companies to 15 randomly selected calls was recorded and is presented in the
file Chapter 8_Exercise 3.sav in the Chapter 8 folder online at
www.routledgetextbooks.com/textbooks/9780205735822 (the variables are
named company and time; for
company, and 1 = “company A,” 2 = “company B,” 3 = “company C”). Open
the file in SPSS and perform the appropriate analyses to answer the questions
below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Test for the assumption of equal variances. Do the data suggest unequal vari-

ances between the groups? Test at a = .05.
d. Is there a significant difference in the response time for the alarm companies?

Test at a = .05.

a = .05.

a = .05.

a = .05.

a = .05.
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e. What is the effect size for the overall ANOVA? Would you characterize the
effect size as small, medium, or large?

f. If the overall ANOVA is significant, briefly summarize the results of Tukey’s
post hoc procedure.

g. Write the results of the study using APA format as appropriate (be sure to
include the results of Tukey’s test if the overall ANOVA is significant).
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9
CHAPTER

The two-way between subjects analysis of variance (ANOVA) is used when two independent vari-
ables are evaluated on a continuous dependent variable of interest. In the two-way between sub-

jects ANOVA, both of the independent variables are between subjects factors, consisting of two or
more levels each, where each participant receives only one level of each factor. An example of a two-
way between subjects ANOVA is presented next.

Example
A researcher wanted to investigate the effect of physical therapy and relaxation exercise on back
pain. Twenty-four people suffering from acute back pain were recruited from a local orthopedic clinic
for the study. Two different types of physical therapy and relaxation exercises were investigated. For
physical therapy, half (12) of the participants used stretching exercises and the other half (12) used
strengthening exercises. For relaxation exercise, half (12) of the participants used muscle relaxation
(tensing and relaxing muscles starting with the head and moving to the toes) and half (12) used
guided imagery (a structured visual technique intended to aid in relaxation).

The study design (illustrated in Figure 9.1) is an example of a completely crossed design where
the levels of physical therapy are crossed with the levels of relaxation exercise. The study design
resulted in four different conditions (with six participants in each condition): stretching and muscle
relaxation (cell a), stretching and guided imagery (cell b), strengthening and muscle relaxation
(cell c), and strengthening and guided imagery (cell d). This type of design is commonly referred to
as a (“two by two”) ANOVA, with two levels of physical therapy and two levels of relaxation
exercise, resulting in four different conditions.

2 * 2

The Two-Way between Subjects 
Analysis of Variance (ANOVA)

104

Relaxation exercise 

muscle relaxation guided imagery Total

stretching 6 participants (cell a) 6 participants (cell b) 12 

P
hy

si
ca

l
th

er
ap

y

strengthening 6 participants (cell c) 6 participants (cell d) 12 

Total 12 12 24 

Figure 9.1 Study design of the two-way between subjects ANOVA
example.

The study lasted six weeks, with the participants receiving weekly training in the appropriate pro-
cedures. At the end of the six-week period, the participants completed a 10-item questionnaire assess-
ing their current level of pain (total possible scores on the questionnaire ranged from 0 to 60, with 0
indicating no pain and 60 indicating a very high degree of pain). The dependent variable in this study
is the pain level reported at the end of the six-week period, and the independent variables are
physical therapy and relaxation exercise.
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Objectives and Data Requirements 
of the Two-Way between Subjects ANOVA

Two-Way between Subjects ANOVA

Objectives Data Requirements Example

1. To test for main effects

• Is there a difference in pain 
between the stretching and 
strengthening conditions?

• Is there a difference in pain 
between the muscle relaxation 
and guided imagery conditions?

Independent variables

• Two between subjects 
factors with two or 
more levels each

Independent variables

• Physical therapy 
(stretching, 
strengthening)

• Relaxation exercise
(muscle relaxation,
guided imagery)

2. To test for an interaction effect

• Does the impact of physical 
therapy on pain depend on the 
type of relaxation exercise used?

Dependent variable

• Continuous

Dependent variable

• Reported pain level
(after the six-week
period)

Null and Alternative Hypotheses
Three different null hypotheses are tested in the two-way between subjects ANOVA. One null
hypothesis is tested for each of the independent variables (known as tests of main effects), and one
for the combined effect of the two independent variables (known as a test for an interaction effect).
The hypotheses are described below.

Hypothesis 1. Test of Physical Therapy: Stretching vs. Strengthening

The null hypothesis for physical therapy states that the mean pain level for stretching and strength-
ening exercises are equal in the population:

(H.1)

The alternative hypothesis states that the two population means are not equal:

Hypothesis 2. Test of Relaxation Exercise: Muscle Relaxation 
vs. Guided Imagery

The null hypothesis for relaxation exercise states that the mean pain level for muscle relaxation
and guided imagery are equal in the population:

(H.2)

The alternative hypothesis states that the two population means are not equal:

Hypothesis 3. Test of the Interaction Effect of Physical Therapy 
and Relaxation Exercise

The null hypothesis states that there is not an interaction between the two variables:

(H.3)H0 : There is not a physical therapy * relaxation exercise interaction.

H1 :mmuscle relaxation Z mguided imagery

H0 :mmuscle relaxation = mguided imagery

H1 :mstretching Z mstrengthening

H0 :mstretching = mstrengthening
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The alternative hypothesis states there is an interaction between the two variables:

Evaluation of the Null Hypothesis

The two-way between subjects ANOVA tests the three null hypotheses discussed previously. For
a given hypothesis of interest, if the test produces results that seem unlikely if the null hypothe-
sis is true (results that occur less than 5% of the time), then the null hypothesis is rejected. If the
test produces results that seem fairly likely if the null hypothesis is true (results that occur greater
than 5% of the time), then the null hypothesis is not rejected.

Research Questions
The fundamental questions of interest in a two-way ANOVA can also be expressed in the form of
research questions, such as,

For Physical Therapy

“Does the reported pain level differ for those who used stretching exercises versus
those who used strengthening exercises?”

For Relaxation Exercise

“Does the reported pain level differ for those who used muscle relaxation versus
those who used guided imagery?”

For the Interaction of Physical Therapy and Relaxation Exercise

“Does the reported pain level for physical therapy depend on whether muscle
relaxation or guided imagery was used?”

The Data

The data for the 24 participants are presented in Figure 9.2. For physical therapy, those who
received stretching exercises are assigned a “1,” while those who received strengthening exer-
cises are assigned a “2.” For the relaxation exercise, those who received muscle relaxation are
assigned a “1,” while those who received guided imagery are assigned a “2.”

H1 : There is a physical therapy * relaxation exercise interaction.

Participant

1
2
3
4
5
6
7
8
9
10
11
12

Physical
therapy

1
1
1
1
1
1
1
1
1
1
1
1

Relaxation
exercise 

1
1
1
1
1
1
2
2
2
2
2
2

Pain
level 

30
22
25
28
20
20
50
45
35
40
30
45

Participant

13
14
15
16
17
18
19
20
21
22
23
24

Physical
therapy

2
2
2
2
2
2
2
2
2
2
2
2

Relaxation
exercise 

1
1
1
1
1
1
2
2
2
2
2
2

Pain
level 

40
50
38
52
45
50
50
55
50
45
47
43

Figure 9.2 The data for the two-way between subjects ANOVA example. (Note: The participant
variable is included for illustration but will not be entered into SPSS.)
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Data Entry and Analysis in SPSS
Steps 1 and 2 describe how to enter the data into SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 ; for under the name back pain.sav 
in the Chapter 9 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, three variables will be created, one each for physical therapy and relaxation exercise
(the independent variables), and one for the reported pain level (the dependent variable). The vari-
ables will be named phyther, relax, and pain, respectively.

3. Enter the names phyther, relax, and pain, respectively, in the first three rows of
the Variable View window (see Figure 9.3).

Figure 9.3 The Variable View window with the variables phyther, relax, and pain entered.

4. Using the process described in Chapter 1, create value labels for phyther and
relax. For phyther, and For relax,

and 

Step 2: Enter the Data

1. Click the Data View tab. The variables phyther, relax, and pain appear in the first
three columns of the Data View window.

2. Consulting Figure 9.2, enter the values for each of the participants on the three vari-
ables of interest. For the first participant, enter the values 1, 1, and 30, for the vari-
ables phyther, relax, and pain, respectively. Using this approach, enter the data for
all 24 participants. The completed data set is shown in Figure 9.4 (page 108).

Step 3: Analyze the Data

1. From the menu bar, select 
(see Figure 9.5 on page 108).

A Univariate dialog box appears with the variables phyther, relax, and pain in the left-hand
side of the dialog box (see Figure 9.6 on page 109).

2. Select the dependent variable, pain, and click the upper right-arrow button ( )
to move it into the Dependent Variable box.

3. With the ctrl key held down, select the independent variables phyther and relax,
and click the second right-arrow button ( ) from the top to move them into the
Fixed Factor(s) box1 (see Figure 9.7 on page 109).

Analyze>General Linear Model>Univariate Á

2 = “guided imagery.”1 = “muscle relaxation”
2 = “strengthening.”1 = “stretching”
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In the two–way between subjects ANOVA there
is a separate column in SPSS for each factor (with
1’s and 2’s to indicate the levels of the factors).
The particular combination of levels for the two
factors indicate the condition a participant was in.
Participants 1–6, for example, have the values 1,
1, for phyther and relax, indicating that they
received stretching for phyther and muscle
relaxation for relax. The third column, pain, is
for the scores on the dependent variable.  

Figure 9.4 The completed data file for the two-way between subjects ANOVA.

Figure 9.5 Menu commands for the two-way between subjects ANOVA.

4. Click Options. The Univariate: Options dialog box opens. Under Factor(s) and Fac-
tor Interactions select the variables phyther, relax and (don’t select
OVERALL), and click the right-arrow button ( ) to move the variables into the
Display Means for box. Under Display, select Descriptive statistics, Estimates of
effect size, and Homogeneity tests (see Figure 9.8).

5. Click Continue.

phyther*relax

M09_YOCK5822_02_SE_C09.qxd  11/4/10  3:55 PM  Page 108



Chapter 9 / The Two-Way between Subjects Analysis of Variance (ANOVA) 109

Figure 9.6 The Univariate dialog box.

Figure 9.7 The Univariate dialog box (continued).

Figure 9.8 The Univariate: Options dialog box.
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Figure 9.9 Univariate: Profile Plots dialog box.

Figure 9.10 The Univariate: Profile Plots dialog box (continued).

6. Click Plots. The Univariate: Profile Plots dialog box opens. Select phyther and
click the upper right-arrow button ( ) to move it into the Horizontal Axis box.
Select relax and click the middle right-arrow button ( ) to move it into the
Separate Lines box (see Figure 9.9).

7. Click Add. The interaction term is displayed under Plots in the
dialog box (see Figure 9.10).

phyther : relax

8. Click Continue.
9. Click OK.

The two-way ANOVA procedure runs in SPSS and the results are presented in the Viewer
window.
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Prior to discussing the results of the ANOVA, a bar chart will be created. A bar chart is an alter-
native to the profile plot for displaying an interaction effect. The commands for producing a bar chart
for the two-way ANOVA are provided next (see Chapter 3 for more information on bar charts).

To produce a bar chart

1. From the menu bar, select (Note: If you are using SPSS ver-
sion 14.0 or lower, the menu commands are All other com-
mands are the same.)

2. The Bar Charts dialog box opens.
3. Select Clustered.
4. Under Data in Chart are, make sure Summaries for groups of cases is selected.
5. Click Define.
6. Move phyther to the Category Axis box.
7. Move relax to the Define Clusters by box.
8. Under Bars Represent, select Other statistic (e.g., mean) and move pain to the

Variable box (see Figure 9.11).

Graphs>Bar Á .
Graphs>Bar Á .

Figure 9.11 The Define Clustered Bar: Summaries for Groups of Cases
dialog box.

9. Click OK.

The bar chart procedure runs in SPSS and the results are presented in the Viewer window.
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Step 4: Interpret the Results

The output of the two-way between subjects ANOVA is displayed in Figure 9.12, and the output
of the bar chart is displayed in Figure 9.13 (page 114).

Univariate Analysis of Variance 
Between-Subjects Factors

stretching 12

strengthening
12

muscle
relaxation 12

guided
imagery 12

1.00

2.00

phyther

1.00

2.00

relax

Value Label N

Descriptive Statistics
Dependent Variable: pain

24.1667 4.21505 6

40.8333 7.35980 6

32.5000 10.41415 12

45.8333 5.81091 6

48.3333 4.27395 6

47.0833 5.03548 12

35.0000 12.30669 12

44.5833 6.94731 12

39.7917 10.93053 24

relax
muscle relaxation

guided imagery

Total

muscle relaxation

guided imagery

Total

muscle relaxation

guided imagery

Total

phyther
stretching

strengthening

Total

Mean Std. Deviation N

Levene's Test of Equality of Error Variancesa

Dependent Variable: pain

1.238 3 20 .322
F df1 df2 Sig.

Tests the null hypothesis that the error variance of the
dependent variable is equal across groups.

a. Design: Intercept + phyther + relax + phyther * relax 

The p–value (sig.) for the test of
equal variances, an assumption of
ANOVA. Since .322 is greater than
.05, the null hypothesis is not
rejected and equal variances for the
four cells are assumed. 

Tests of Between-Subjects Effects
Dependent Variable: pain

2128.125a 3 709.375 22.889 .000 .774

38001.042 1 38001.042 1226.170 .000 .984

1276.042 1 1276.042 41.174 .000 .673

551.042 1 551.042 17.780 .000 .471

301.042 1 301.042 9.714 .005 .327

619.833 20 30.992

40749.000 24

2747.958 23

Source
Corrected Model

Intercept

phyther

relax

phyther * relax

Error

Total

Corrected Total

Type III Sum
of Squares df Mean Square F Sig.

Partial Eta
Squared

a. R Squared = .774 (Adjusted R Squared = .741)

Our
three
tests of
interest.

All three tests are significant,
since the p–values are less
than .05.

(continued)
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Figure 9.12 The output for the two-way between subjects ANOVA procedure (continued).

Estimated Marginal Means

1. phyther
Dependent Variable: pain

32.500 1.607 29.148 35.852

47.083 1.607 43.731 50.436

phyther
stretching

strengthening

Mean Std. Error Lower Bound Upper Bound

95% Confidence Interval

2. relax
Dependent Variable: pain

35.000 1.607 31.648 38.352

44.583 1.607 41.231 47.936

relax
muscle relaxation

guided imagery

Mean Std. Error Lower Bound Upper Bound

95% Confidence Interval

3. phyther * relax
Dependent Variable: pain

24.167 2.273 19.426 28.907

40.833 2.273 36.093 45.574

45.833 2.273 41.093 50.574

48.333 2.273 43.593 53.074

relax
muscle relaxation

guided imagery

muscle relaxation

guided imagery

phyther
stretching

strengthening

Mean Std. Error Lower Bound Upper Bound
95% Confidence Interval

Since phyther was
significant, the marginal
means table is inspected
to determine which
condition resulted in less
pain. (Stretching resulted
in less pain, with a mean
of 32.50.)

Relax was significant;
the marginal means
table shows that muscle
relaxation resulted in
less pain than guided
imagery. 

Profile Plots 

strengtheningstretching

50.00

45.00

40.00

35.00

30.00

25.00

20.00

E
st

im
at

ed
 M
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g
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n
s

Estimated Marginal Means of Pain

For strengthening, there
is a difference of 2.50
points between the
muscle relaxation
and guided imagery
conditions. 

For stretching, there
is a difference of
16.666 points between
the muscle relaxation
and guided imagery
conditions. 

muscle relaxation
guided imagery

relax
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Between-Subjects Factors
The Between-Subjects Factors table displays the factors included in the study (the independent vari-
ables), the number of levels of each factor, the value labels, and the sample size for each level of
the variables. Notice that there are 12 participants for each level of phyther and relax, which is
consistent with our study design.

Descriptive Statistics
The Descriptive Statistics table shows the mean, standard deviation, and sample size for each
of the conditions in the study (and for the levels of each factor). While we’ll focus our atten-
tion on the Estimated Marginal Means tables later in the output for interpreting mean differ-
ences between groups, we will use the standard deviations from this table in the write-up of
our results.

Levene’s Test of Equality of Error Variances
The next table, Levene’s Test of Equality of Error Variances, provides a test of whether 
the variances are equal for the four cells (conditions) in our study, an assumption of the two-
way between subjects ANOVA (see Chapter 8 for more information on the equal variance
assumption).

The null and alternative hypotheses for Levene’s test are

(The variances for the four cells are equal in the 
population.)

At least one of the variances is different from the others.

The equal variances assumption is assessed by examining the p-value (sig.) reported under
the Levene’s Test of Equality of Error Variances table in the output. If the null hypoth-
esis is rejected, and it is assumed that the population variances are not equal. If the null
hypothesis is not rejected, and it is assumed that the population variances are equal for the four
cells in the study.

p 7 .05,
p … .05,

H1 :

H0 :s1,1
2

= s1,2
2

= s2,1
2

= s2,2
2

Graph 

strengtheningstretching

50.00

40.00

30.00

20.00

10.00

0.00

M
ea

n
 p

ai
n

The difference between
these two bars is 16.666
points. 

The difference between these two bars is
2.50 points. The interaction indicates that
these differences (16.666 vs. 2.50) are
significantly different, which means… 

…the impact of relax
depends on phyther: for
stretching the difference
between the muscle
relaxation and guided
imagery conditions is
large, with muscle
relaxation resulting in
considerably less pain
(16.66 points lower); for
strengthening there is
little difference between
the conditions (with
muscle relaxation 2.50
points lower). 

guided imagery
muscle relaxation

relax

Figure 9.13 Output for the Bar Chart procedure.
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Levene’s test produced an F of 1.238 and a p-value of .322 (see Figure 9.12). Since .322
is greater than .05, the null hypothesis of equal variances is not rejected, and it is assumed that
the population variances are equal for the four conditions in the study.

Tests of Between-Subjects Effects
The next table, Tests of Between-Subjects Effects, displays the results for the tests of the main
effects (phyther and relax) and interaction 2 In the two-way ANOVA, a sep-
arate F test is produced for each of the main effects and the interaction. As was the case with
the one-way ANOVA discussed in Chapter 8, the F test is a ratio of two variances, with each
variance represented as a mean square (MS) in the output:

where MS Effect corresponds to the mean square for the test of interest and MS Error corre-
sponds to the value for mean square error in the Tests of Between-Subjects Effects table. To
calculate the F value for the test of interest, substitute the appropriate MS values in the for-
mula. For example, phyther has an MS of 1276.042. With an MS Error term of 30.992, the
F for phyther is

which agrees with the value of F for phyther in the Tests of Between-Subjects Effects table
reported in Figure 9.12.

This test produces two degrees of freedom (df) for phyther ( of levels of
phyther ) and df for error ( of cells in the study). For
the test of phyther, the df are 1 and 20, respectively.

The reported p-value found in the ANOVA table for phyther under the column “sig.” is .000
(which should be read as “less than .001”). Since the p-value is less than .05, the null hypoth-
esis is rejected, and it is concluded that the reported pain levels for the stretching and strength-
ening conditions are significantly different (which group is lower for phyther will be discussed
in the next section on marginal means).

The next test presented in the Tests of Between-Subjects Effects table is for relax. The test of
relax produces an F value of 17.78 (551.042/30.992) with 1 (number of levels of relax ) and
20 (df error) degrees of freedom. The reported p-value in the ANOVA table for relax under the
column “sig.” is .000. Since the p-value is less than .05, the null hypothesis is rejected, and it is
concluded that the reported pain levels for the muscle relaxation and guided imagery conditions
are significantly different (which group is lower for relax will be discussed in the next section on
marginal means).

The last test of interest, the test of produced an F of 9.714 (301.042/30.992)
on and 20 (df error)
degrees of freedom. The p-value for the test of the interaction is .005, which, since it is less than
.05, leads us to reject the null hypothesis and conclude that there is a significant interaction between
phyther and relax.

Estimated Marginal Means
The Estimated Marginal Means results produces a series of tables, one for each of the factors
and one for the interaction (the marginal means tables are displayed whether the tests are sig-
nificant or not). The marginal means tables are useful for interpreting the direction of significant
results. Since all three tests are significant in our example, each of the marginal means tables
will be discussed below. (If a given test was not significant, on the other hand, any differences
between the marginal means for that test would be considered due to sampling error and would
not be described.)

1 31number of levels of phyther -  12 * 1number of levels of relax -  124
phyther * relax,

- 1

df = total sample size - the number-  1
df = number

F =

1276.042

30.992
= 41.174

F =

MS Effect

MS Error

1phyther : relax2.
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The first table, phyther, presents the marginal means for the two physical therapy conditions.
Since phyther was significant, we’ll inspect the means to see which group had lower reported pain
levels. The marginal means table shows that those in the stretching condition 
had significantly lower reported pain levels than those in the strengthening condition

The second table, relax, presents the marginal means for the two relaxation exercise condi-
tions. Since the test for relax was significant, we’ll inspect the means to see which group had
lower reported pain levels. The marginal means table shows that those who used muscle relaxation

had significantly lower reported pain levels than those who used guided imagery

The last table of marginal means, shows the means for the significant
interaction effect. Each of the four cell means from the study are presented, with each mean rep-
resenting the average pain level of the six participants for the cell of interest. To more clearly
identify the interaction effect, the table has been reproduced in a slightly modified form in
Figure 9.14.

The first column of values in Figure 9.14 shows that, for those in the stretching condition,
the pain level for muscle relaxation (24.167) was 16.666 points lower on average than for guided
imagery (40.833). The next column presents the means for the strengthening condition and
shows that the average pain level for muscle relaxation was only 2.50 points lower than for
guided imagery (45.833 vs. 48.333). These mean differences illustrate the interaction effect: For
stretching, the difference between muscle relaxation and guided imagery was large (16.666),
while for strengthening the difference between muscle relaxation and guided imagery was small
(2.50). A significant interaction effect indicates that these differences (16.666 vs. 2.50) are
themselves significantly different. Looking at the mean pain levels across the four conditions,
Figure 9.14 clearly shows the beneficial impact of combining the muscle relaxation and stretch-
ing conditions on pain (the participants had the lowest average pain level in this condition with
a mean of 24.167).

phyther * relax,
1mean = 44.582.
1mean = 35.002

1mean = 47.082.

1mean = 32.502

Muscle relaxation

Guided imagery 

Mean difference 

Stretching 

24.167

40.833

16.666 

Strengthening 

45.833

48.333

2.500

Marginal means for
relax 

35.000

44.583

9.583

Figure 9.14 Cell means for the four conditions in the study,
the marginal means for relax, and the mean difference between
the relaxation exercise conditions for stretching, strengthening,
and for the marginal means for relax.

Graphical Displays of the Interaction Effect

While we’ve just examined the interaction effect by inspecting the difference between cell means,
it can be also useful to create a graph to display the results. We’ll consider two different types of
graphs for displaying the interaction effect: profile plots and bar charts. These two graphs are
shown in Figures 9.12 and 9.13, respectively.

Profile Plots
The Profile Plots graph (shown in Figure 9.12 on page 113) displays the cell means of the four
conditions in the study. In the plot, the levels of physical therapy are on the X-axis, with stretch-
ing on the left and strengthening on the right. The lines of the plot correspond to the different lev-
els of relax, with the top line in the plot for guided imagery and the bottom line for muscle
relaxation. On the left-hand side of the plot, the difference between the two points represents the
difference between muscle relaxation and guided imagery for stretching (the 16.666 point differ-
ence discussed previously). The difference between the two points on the right side of the plot cor-
responds to the difference between muscle relaxation and guided imagery for strengthening (the
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2.50 point difference). Recall that the interaction indicated that these two differences (16.666 and
2.50) are themselves significantly different. When the means are plotted, this difference results in
(significantly) nonparallel lines, which is another way of describing an interaction.

Graph—Bar Chart
The bar chart shown in Figure 9.13 on page 114 is an alternative to the Profile Plot for pro-
ducing a graph of a significant interaction effect. The profile plot and bar chart present the
same information—the cell means for the four conditions under study; they just present the
information in different ways. In the bar chart in Figure 9.13, phyther is on the horizontal (X)
axis and the levels of relax are plotted as separate bars. The average pain level for each of the
four conditions is equal to the height of the bar on the vertical (Y) axis. The first two bars on
the left show that, for stretching, muscle relaxation resulted in considerably lower pain scores
than guided imagery (the 16.666 point difference), resulting in a substantial difference in height
between the adjacent bars for the stretching condition. The two bars on the right are for the
strengthening condition. Notice that these two bars are very close in height, with muscle relax-
ation slightly lower than guided imagery, reflecting the small (2.50) difference in reported
pain between these two conditions. Viewed from the perspective of the bar chart, a significant
interaction indicates that the difference in height between adjacent bars is not the same across
all levels of the X-axis variable (which is another way of stating that 16.666 is significantly dif-
ferent than 2.50).

Interpreting the Main Effects When the Interaction Effect is Significant
When the interaction effect is significant, significant main effects can be misleading (depending
on the nature of the results), and as a result should be interpreted with caution. This point is illus-
trated in Figure 9.14 on page 116. The first two means in the far right-hand column of Figure 9.14
correspond to the marginal means for relax. The significant main effect for relax indicates that mus-
cle relaxation and guided imagery are significantly different, with pain levels for muscle relaxation
that are 9.583 points lower on average than guided imagery (35.000 vs. 44.583). This is the dif-
ference that the main effect predicts for relax, and it may be obtained by averaging the mean dif-
ferences for the stretching and strengthening conditions However,
the significant interaction effect implies that the difference between the relaxation conditions
depends on the type of physical therapy received: For stretching, the difference is larger than pre-
dicted by the main effect (16.666 versus a predicted value of 9.583), while for strengthening the
difference is smaller (2.500 versus a predicted value of 9.583). Thus, using the main effect (in iso-
lation) to describe the difference between the relaxation exercise conditions mischaracterizes both
values, underestimating the difference for stretching and overestimating the difference for strength-
ening.3 If there was not a significant interaction, however, the main effect(s) would adequately
describe the differences between the groups.

Simple Effects

When a significant interaction effect is present, further testing of the effect is possible using sim-
ple effects analyses. Simple effects analyses compare the effects of one factor at a single level of
the other factor (such as testing the difference between stretching and strengthening at guided
imagery). Simple effects analyses may be performed using the LMATRIX command in SPSS or
by conducting independent samples t tests for the tests of interest. While simple effects are not cov-
ered in this chapter due to space considerations, an example of simple effects testing is illustrated
in Chapter 11.

Effect Sizes
The measure of effect size commonly used with a two-way between subjects ANOVA is par-
tial eta-square To calculate partial eta-square, the sum of squares (SS) from the Tests of1h22.

1116.666 + 2.5002/2 = 9.5832.
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Between-Subjects Effects table is used (named Type III Sum of Squares in the output). The 
formula for partial eta-square is

where corresponds to the sum of squares for the effect of interest and corresponds
to the sum of squares for error. To calculate the partial eta-square for a given test of interest, sub-
stitute the appropriate SS values found in Figure 9.12 in the above formula. For example, phyther
has an SS of 1276.04 and an of 619.83. Substituting the values into the formula produces
a partial eta-square of

which agrees with the value for phyther provided in Figure 9.12. Partial eta-square ranges from
0 to 1, with the larger the value of partial eta-square, the more variance the effect explains in
the dependent variable. Conventional effect size measures for partial eta-square have not been
provided.

Expression of the Results in APA Format
In writing the results for the two-way between subjects ANOVA, the conclusion of the hypothe-
sis test, the degrees of freedom (df), the F value, the p-value, and the effect size are reported along
with the means and standard deviations (the means and standard deviations may be reported in a
separate table if desired). If the interaction is significant, a bar chart or profile plot would also typ-
ically be provided. A sample write-up of the results in APA format is presented next.

Written Results

A between-subjects ANOVA was conducted with back pain as the dependent variable and
physical therapy (stretching/strengthening) and relaxation exercise (muscle relaxation/guided
imagery) as the independent variables. The results indicated that there was a significant main
effect for physical therapy, partial with those using stretch-
ing exercises reporting significantly less pain that those using strength-
ening exercises There was also a significant main effect for relaxation
exercise, partial with those using muscle relaxation

reporting significantly less pain than those using guided imagery
There was also a significant physical therapy by relaxation exercise 

interaction, partial For strengthening, there was little dif-
ference in pain between the muscle relaxation and guided imagery conditions, while for stretch-
ing, the difference in pain between the muscle relaxation and guided imagery conditions was
large, with muscle relaxation resulting in substantially lower pain (see the profile plot in Figure 9.12
or the bar chart in Figure 9.13 for more details). Overall, the participants who received the com-
bined effect of stretching and muscle relaxation reported substantially less pain than the other
conditions.

Assumptions of the Two-Way between Subjects ANOVA
1. The observations are independent.

The independence assumption should be satisfied by designing your study so the par-
ticipants do not influence each other in any way (an example of a violation of this
assumption would be if people received both muscle relaxation and guided imagery).
Violating the independence assumption can seriously compromise the accuracy of
the ANOVA test. If there is reason to believe the independence assumption has been
violated, the between subjects ANOVA should not be used.

h2
= .33.F11, 202 = 9.71, p 6 .05,

1M = 44.58, SD = 6.952.
1M = 35.00, SD = 12.312

h2
= .47,F11, 202 = 17.78, p 6 .05,

1M = 47.08, SD = 5.042.
1M = 32.50, SD = 10.412

h2
= .67,F11, 202 = 41.17, p 6 .05,

2 * 2

partial h2
=

1276.04

1276.04 + 619.83
= .67

SSError

SSErrorSSEffect

partial h2
=

SSEffect

SSEffect + SSError
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2. The dependent variable is normally distributed for each of the cells in the population.
This assumption means that the dependent variable should be normally distributed in
the population for each of the cells in the study. For moderate to large sample sizes,
most types of nonnormal distributions tend to have relatively little impact on the
accuracy of the ANOVA test, although some nonnormal distributions can adversely
affect the power of ANOVA.

3. The variances for each of the cells are equal in the population.
This assumption means that the variances in each of the cells (the four conditions in
the study) should be equal in the population. Violating the equal variances assump-
tion can compromise the accuracy of the ANOVA test, particularly when the group
sample sizes are unequal. Interpreting the results of Levene’s test in SPSS addresses
this assumption. If the equal variance assumption is violated and the sample sizes are
fairly unequal in the cells, the two-way ANOVA should not be used (unlike the one-
way ANOVA in Chapter 8, SPSS does not currently have a built-in procedure for
unequal variances in the two-way ANOVA).

Summary of Steps for Conducting a Two-Way 
between Subjects ANOVA in SPSS

I. Data Entry and Analysis
1. Create three variables in SPSS (one for each independent variable and one for

the dependent variable).

2. Create value labels for each independent variable. In the Value Labels dialog
box, enter the numeric values and labels as appropriate. Click OK.

3. Enter the data.

4. Select 

5. Move the dependent variable to the Dependent Variable box and the independent
variables to the Fixed Factor(s) box.

6. Click Options. Move the factors and the interaction term to the Display Means
for box. Select Descriptive statistics, Estimates of effect size, and Homogeneity
tests. Click Continue.

7. Click Plots. Move the factor with the greater number of levels (if relevant) to
the Horizontal Axis box and the other factor to the Separate Lines box. Click
Add. Click Continue. (As an alternative to the profile plot, a bar chart may be
created.)

8. If there are any factors with three or more levels, Click Post Hoc. Move the
factor with three or more levels to the Post Hoc Tests for box. Select Tukey (not
Tukey’s-b). Click Continue.

9. Click OK.

II. Interpretation of the Results
1. Check Levene’s test of equality of error variances.

a. If for Levene’s test, equal variances are assumed. Proceed with
intepreting the ANOVA test.

• Interpret the results of each of the factors, indicating the nature of the dif-
ferences for significant main effects with two levels. For significant main
effects with three or more levels, interpret the results of Tukey’s test.

• If the interaction is significant, describe the nature of the relationship
between the two variables.

b. If for Levene’s test, equal population variances are not assumed.
Since SPSS does not have a two-way procedure for unequal variances, if your
sample sizes are equal or nearly equal, running the traditional two-way
ANOVA should result in fairly accurate p-values (how accurate they are
depends on the degree of inequality in the sample sizes and the variances).

p … .05

p 7 .05

Analyze>General Linear Model>Univariate Á .
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If the difference in the sample sizes is moderate to large, one option is to run
two separate one-way ANOVAs (for factors with three or more levels) or t
tests (for factors with two levels), testing for equal variances for each factor
(if two separate tests are run, however, an interaction effect cannot be tested).
For factors with two levels, read the bottom row from the t-test for Equality
of Means table to interpret the results (see Chapter 6 for more details). For
factors with three or more levels and equal variances, run the traditional
one-way ANOVA followed by Tukey’s test. For factors with three or more
levels and unequal variances, use either the Brown-Forsythe or Welch’s test
and select a post hoc test that does not assume equal variances (see Chapter 8
for more details).

• For significant factors with two levels (i.e., the t test), inspect the
means in the Group Statistics table to describe the nature of the differ-
ences between the groups. For significant factors with three or more
levels, interpret the results of the post hoc procedure for the factor(s)
of interest.

• For nonsignificant factors, do not describe any mean differences between
the groups. Write the results stating that there is not a significant differ-
ence between the groups for the factor(s) of interest.

Exercises

1. A researcher investigated the impact of gender and cell phone usage on driving
performance. Each of the 24 people (12 males and 12 females) who agreed to par-
ticipate in the study drove a car on a closed course where their driving accuracy
was assessed (driving accuracy was measured on a 0 to 50 scale, with higher
scores indicating better driving performance). While driving on the closed course,
half of the participants (6 males and 6 females) spoke on a cell phone, while the
other half did not. The data are provided in Figure 9.15.

Gender

1

1

1

1

1

1

1

1

1

1

1

1

Cellphone 

1

1

1

1

1

1

2

2

2

2

2

2

Driving score

34

29

38

34

33

30

45

44

46

42

47

40

Gender

2

2

2

2

2

2

2

2

2

2

2

2

Cellphone 

1

1

1

1

1

1

2

2

2

2

2

2

Driving score

35

32

27

26

37

24

48

47

40

46

50

39

Figure 9.15 The data for Exercise 1. For gender, 1 = “male” and 
2 = “female” For cellphone, 1 = “spoke on cell phone” and 2 = “didn’t
speak on cell phone.”

Enter the data in SPSS and perform the appropriate analyses to answer the
questions below. Name the variables gender, cellphone, and drivingscore.
a. State the null and alternative hypotheses for each test of interest.
b. State a research question for each test of interest.
c. Test for the assumption of equal variances. Do the data suggest unequal vari-

ances between the conditions? Test at 
d. Test for main effects of gender, cell phone use, and for a 

interaction (use for each test). Which tests, if any, are significant?
Which tests, if any, are not significant?

a = .05
gender * cellphone

a = .05.
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e. Report the effect size for each of the tests. Which of the tests has the largest
effect size?

f. Write the results of the study using APA format as appropriate.
2. A psychologist investigated the impact of two different teaching methods

(methods A and B) and majors in college (broadly classified as natural science
and social science) on math anxiety. Forty college students (20 from each
major) were included in the study, with half of the students (10 from each
major) receiving teaching method A and half receiving teaching method B. After six 
weeks of instruction using the appropriate method, a math anxiety scale was 
administered. Scores on the scale ranged from 20 to 80, with higher scores 
indicating greater math anxiety. The data are provided in the file Chapter 9_Exercise 
2.sav in the Chapter 9 folder online at www.routledgetextbooks.com/
textbooks/9780205735822 . In the data file, the variables are named method
( and ), major ( and

), and mathanxiety. Open the file in SPSS, and perform
the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses for each test of interest.
b. State a research question for each test of interest.
c. Test for the assumption of equal variances. Do the data suggest unequal

variances between the conditions? Test at 
d. Test for main effects of method, major, and for a interaction

(use for each test). Which tests, if any, are significant? Which tests,
if any, are not significant?

e. Report the effect size for each of the tests. Which of the tests has the largest
effect size?

f. Write the results of the study using APA format as appropriate.
3. Shown in Figure 9.16 is a plot of a significant interaction effect examining the

impact of diet (whole grain, nonwhole grain), and the number of pounds over-
weight at the beginning of the study (11–30 pounds, 31–50 pounds) on weight
loss. For diet, the two diets were identical with the exception that one used whole
grains (e.g., whole wheat pasta) while the other did not (e.g., white pasta). The
dependent variable is the amount of weight lost in the study, with a positive value
indicating that weight was lost (the means are displayed for each of the four
conditions in the plot in Figure 9.16).

a = .05
method * major

a = .05.

2 = “social science”
1 = “natural science”2 = “method B”1 = “method A”

31–50 pounds11–30 pounds 

E
st

im
at

ed
 M

ar
g
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 M
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n
s

12.00

10.00

8.00

6.00

4.00

2.00

0.00

2.40

0.40

2.10

11.50

Estimated Marginal Means of weightloss

weight 

non-whole grain
whole grain

diet

Figure 9.16 The interaction plot.weight : diet
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Using the information in the plot, answer the questions below.
a. Which of the four conditions experienced the greatest weight loss in the

study? Which experienced the least?
b. Describe the significant interaction plot. Make sure that your description

characterizes the interaction effect present in the graph (e.g., don’t limit your-
self to describing how those who were more overweight lost more weight, on
average, than those who were less overweight, as this is a description of a
main effect).
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The one-way within subjects analysis of variance (ANOVA) is used when the means of an
independent variable are compared on a continuous dependent variable of interest. In a within

subjects ANOVA, the independent variable is a within subjects factor with two or more levels,
where each participant receives all levels of the independent variable.1 An example of a one-way
within subjects ANOVA is presented next.

Example
A school psychologist wanted to evaluate the potential effectiveness of a new social skills program,
which was designed to teach children skills for fostering good relationships with their peers. Twenty-
five fourth graders who were having difficulties in peer relations were enrolled in the social skills pro-
gram for a period of 16 weeks. The social skills of the 25 children (as rated by the teachers) were
measured immediately before the start of the program, at 8 weeks, and at the conclusion of the pro-
gram (at 16 weeks). A 10-item social skills scale was used to measure social skills in children. The
scale ranged from 6 to 60, with higher scores indicating more socially appropriate behaviors. The inde-
pendent variable in this study is time (before, 8 weeks, and after) and the dependent variable is the
social skills scores.

Objectives and Data Requirements of the One-Way within
Subjects ANOVA

10
CHAPTER

The One-Way within Subjects Analysis 
of Variance (ANOVA)

One-Way within Subjects ANOVA

Objective Data Requirements Example

To test whether the 
means of two or more 
related groups differ 
significantly on a dependent
variable of interest.

Independent variable

• Within subjects factor 
with two or more levels

Dependent variable

• Continuous

Independent variable

• Time (before, 8 weeks, 
after)

Dependent variable

• Social skills scores

Null and Alternative Hypotheses
The null hypothesis states that the mean social skills scores for the three time occasions are equal in
the population:

H0 :mbefore = m8 weeks = mafter
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In order for the null hypothesis to be false, it is not necessary that all three means be differ-
ent from one another (although this is one possibility); all that is required is that the null hypoth-
esis is false in some way (i.e., there is a difference somewhere between the groups). Therefore,
rather than generate all possible ways the null hypothesis could be false (which would become
increasingly tedious as the number of groups increased), a general statement that the means
differ in some way will be made.

Evaluation of the Null Hypothesis

The one-way within subjects ANOVA provides a test of the null hypothesis that the population
means for the three time occasions are equal. If the test produces results that seem unlikely if the
null hypothesis is true (results that occur less than 5% of the time), then the null hypothesis is
rejected. If the test produces results that seem fairly likely if the null hypothesis is true (results that
occur greater than 5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Is there a difference in social skills before, during, or after a 16-week social
skills training program?”

The Data

The data for the 25 participants are presented in Figure 10.1. The three time occasions, before,
8 weeks, and after, correspond to the social skills scores immediately before, halfway through, and
immediately following the conclusion of the program.

H1 : At least one of the means is different from the others.

Participant

14

15

16

17

18

19

20

21

22

23

24

25

Before

32

34

22

16

31

14

13

15

31

35

28

26

8 Weeks

30

32

25

19

28

14

10

14

32

32

29

25

After

31

36

29

22

31

18

14

16

32

36

31

25

Participant 

1

2

3

4

5

6

7

8

9

10

11

12

13

Before

20

25

28

18

24

30

18

14

12

9

15

17

35

8 Weeks

24

26

31

16

25

28

22

17

15

11

15

16

32

After

26

25

30

17

30

31

25

21

16

10

19

20

31

Figure 10.1 The data for the one-way within subjects ANOVA. (Note: The participant
variable is included for illustration but will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822  under the name social skills.sav in 
the Chapter 10 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.
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In SPSS, three variables will be created, one for each of the time occasions social skills scores were
measured. The variables will be named before, week8 and after, respectively.

3. Enter the variable names before, week8, and after, respectively, in the first three
rows of the Variable View window (see Figure 10.2).

Figure 10.2 The Variable View window in SPSS with the variables before, week8, and after entered.

Step 2: Enter the Data

1. Click the Data View tab. The variables before, week8, and after appear in the first
three columns of the Data View window.

2. Consulting Figure 10.1, enter the scores for each of the participants on the three
variables of interest. For the first participant, enter the scores 20, 24, and 26 on the
variables before, week8, and after, respectively. Using this approach, enter the
data for all 25 participants. The completed data set is presented in Figure 10.3.

Notice for the one–way within
subjects ANOVA that a separate
variable is created in SPSS for each
level of the within subjects factor.
This is the general setup for all within
subjects factors. If there were five
levels to a within subjects factor, for
example, five variables would be
created in SPSS. 

Figure 10.3 The data file for the one-way within subjects ANOVA example.
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Figure 10.4 Menu commands for the one-way within subjects ANOVA procedure.

Step 3: Analyze the Data

1. From the menu bar, select 
(see Figure 10.4).Measures Á

Analyze>General Linear Model>Repeated

The Repeated Measures Define Factor(s) dialog box opens (see Figure 10.5). This dialog box is used
to provide a name for the within subjects factor and to enter the number of levels of the factor.

Figure 10.5 The Repeated Measures Define
Factor(s) dialog box.
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2. Double-click the name “factor1” in the Within Subject Factor Name text box
(factor1 is the default name provided by SPSS for the within subjects factor).
Enter the name, time.

3. In the text box to the right of Number of Levels, enter a 3. This corresponds to the
number of levels (before, week8, after) of the within subjects factor. See Figure 10.6
for details.

Figure 10.6 The Repeated Measures Define
Factor(s) dialog box (continued).

4. Click Add.
5. Click Define.

The Repeated Measures dialog box opens with the three time occasions (before, week8,
after) on the left-hand side of the dialog box (see Figure 10.7 on page 128).

6. With the ctrl key held down, select the time occasions before, week8, and after.
Click the upper right-arrow button ( ) to move the three variables into the
Within Subjects Variables box (see Figure 10.8 on page 128).2

7. Click Options. Under the Factor(s) and Factor Interactions box, select time, and
click the right-arrow button ( ) to move it to the Display Means for box. Under
Display, select Descriptive statistics and Estimates of effect size (see Figure 10.9
on page 129).

8. Click Continue.
9. Click OK.

The one-way within subjects ANOVA procedure runs in SPSS and the results are presented
in the Viewer window.
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Figure 10.7 The Repeated Measures dialog box.

Figure 10.8 The Repeated Measures dialog box (continued).

Step 4: Interpret the Results

The output for the one-way within subjects ANOVA is displayed in Figure 10.10 (page 131).

Within-Subjects Factors
The first table, Within-Subjects Factors, lists the three time occasions the participants were mea-
sured, including before the program (before), eight weeks into the program (week8), and at the
conclusion of the program (after).
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Figure 10.9 The Repeated Measures: Options dialog box.

Descriptive Statistics
The Descriptive Statistics table displays the mean and standard deviation for each of the three
time periods. Notice that the mean social skills scores were lowest for before
followed by week8 and after Whether the difference in the
means is large enough to be statistically significant will be examined shortly.

Multivariate Tests
The null hypothesis that the means of the three time occasions are equal in the population can be
tested using either a univariate test (ANOVA) or a multivariate test (MANOVA). The Multivariate
Tests table provides the results of four different multivariate tests. While the multivariate tests are
automatically output in the results, multivariate procedures are beyond the scope of this text and
will therefore not be discussed here. Interested readers are referred to Maxwell and Delaney (2004)
or Stevens (2002) for more details on the MANOVA procedure.

Mauchly’s Test of Sphericity
The next table, Mauchly’s Test of Sphericity, provides a test of the sphericity assumption, which
is an assumption of the within subjects ANOVA when there are three of more levels to the within
subjects factor.3 While a test of this assumption is provided in the Mauchly’s Test of Sphericity table
(the p-value for the test is .056), this test can be inaccurate (see Howell, 2007, or Maxwell &
Delaney, 2004, for more details) and therefore will not be considered (an alternative solution to
testing the assumption of sphericity will be provided).4

1mean = 24.882.1mean = 22.722,
1mean = 22.482,
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General Linear Model 
Within-Subjects Factors

Measure: MEASURE_1

before

week8

after

time
1

2

3

Dependent
Variable

Descriptive Statistics

22.4800 8.10411 25

22.7200 7.35142 25

24.8800 7.20139 25

before

week8

after

Mean Std. Deviation N

Multivariate Testsb

.569 2.000 23.000 .000

.431 2.000 23.000 .000

1.318 2.000 23.000 .000

1.318 15.155a
15.155a
15.155a
15.155a

2.000 23.000 .000

Pillai's Trace

Wilks' Lambda

Hotelling's Trace

Roy's Largest Root

Effect
time

Value F Hypothesis df Error df Sig.

a. Exact statistic 
b. Design: Intercept

Within Subjects Design: time 

Mauchly's Test of Sphericityb

Measure: MEASURE_1

.779 5.751 2 .056 .819 .871 .500

Within Subjects Effect

time

Mauchly's W
Approx.

Chi-Square df Sig.
Greenhous
e-Geisser Huynh-Feldt Lower-bound

Epsilona

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is
proportional to an identity matrix.

a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in
    the Tests of Within-Subjects Effects table. 

b. Design: Intercept Within Subjects Design: time 

Tests of Within-Subjects Effects
Measure: MEASURE_1

87.360 2 43.680 14.298 .000 .373

87.360 1.638 53.343 14.298 .000 .373

87.360 1.741 50.166 14.298 .000 .373

87.360 1.000 87.360 14.298 .001 .373

146.640 48 3.055

146.640 39.305 3.731

146.640 41.794 3.509

146.640 24.000 6.110

Sphericity Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Sphericity Assumed

Greenhouse-Geisser

Hunh-Feldty

Lower-bound

Source
time

Error(time)

Type III Sum
of Squares df Mean Square F Sig.

Partial Eta
Squared

The p–value for the
test that the social
skills scores are equal
across the 3 time
occasions. Use either
the Greenhouse–
Geisser or
Sphericity Assumed
values (both are
significant since p < .05
for each test).  
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Figure 10.10 Output for the one-way within subjects ANOVA procedure.

Tests of Within-Subjects Contrasts
Measure: MEASURE_1

72.000 1 72.000 16.457 .000 .407

15.360 1 15.360 8.853 .007 .269

105.000 24 4.375

41.640 24 1.735

time
Linear

Quadratic

Linear

Quadratic

Source
time

Error(time)

Type III Sum
of Squares df Mean Square F Sig.

Partial Eta
Squared

Tests of Between-Subjects Effects
Measure: MEASURE_1
Transformed Variable: Average

40926.720 1 40926.720 247.336 .000 .912

3971.280 24 165.470

Source
Intercept

Error

Type III Sum
of Squares df Mean Square F Sig.

Partial Eta
Squared

Estimated Marginal Means 
time

Measure: MEASURE_1

22.480 1.621 19.135 25.825

22.720 1.470 19.685 25.755

24.880 1.440 21.907 27.853

time
1

2

3

Mean Std. Error Lower Bound Upper Bound
95% Confidence Interval

If the assumption of sphericity is not met, the standard ANOVA F test (reported as Sphericity
Assumed in the Tests of Within-Subjects Effects table) is inaccurate, yielding results that lead to
rejecting a true null hypothesis more often than is warranted. As a result of the inaccuracy of the
F test when the assumption of sphericity is violated, several alternative F tests that adjust for the
lack of sphericity have been proposed. There are three such “adjustment procedures” in the Tests
of Within-Subjects Effects table: Greenhouse-Geisser, Huynh-Feldt, and Lower-bound. Each of
these procedures attempts to adjust for the inaccuracy of the standard ANOVA F when the spheric-
ity assumption has been violated. Since Mauchly’s Test of Sphericity can be inaccurate, we’ll
bypass this test and take the more cautious approach of using one of the adjustment procedures
printed out in SPSS (i.e., we’ll assume the assumption of sphericity has been violated and proceed
accordingly). Of the three adjustment procedures, the Lower-bound adjustment is overly cautious
as it rejects the null hypothesis too infrequently (which is known as being conservative) and as a
result is not recommended. When choosing an adjustment procedure, therefore, the choice is
between the Greenhouse-Geisser and Huynh-Feldt procedures. While both procedures can provide
fairly accurate adjustments when the assumption of sphericity has been violated, the Greenhouse-
Geisser adjustment can be slightly conservative (i.e., it rejects the null hypothesis less often than
is warranted) while the Huynh-Feldt adjustment can be slightly liberal (i.e., it rejects the null
hypothesis more often than is warranted). We’ll take the more cautious approach and interpret
the Greenhouse-Geisser adjustment (although this will come at a slight sacrifice in power). While
the Greenhouse-Geisser adjustment provides a more accurate result than the standard (sphericity
assumed) F when the assumption of sphericity has been violated, because it is tedious to calcu-
late by hand, its solution is usually considered only when conducting analyses by computer.
Therefore, those who are using SPSS to confirm results of hand calculations will want to use the
Sphericity Assumed values.

Tests of Within-Subjects Effects
The next table, Tests of Within-Subjects Effects, provides the answer to our research question, that
is, whether or not the social skills scores differ for the three time occasions. ANOVA produces an
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F test, which is the ratio of two variances, with each variance represented as a mean square (MS)
in the output

Substituting the values from the Tests of Within-Subjects Effects table under the row
Greenhouse-Geisser yields an F of

which agrees with the value of F in the ANOVA table for the Greenhouse-Geisser solution. (The
Sphericity Assumed F is also 14.298 (43.680/3.055).5 While all four procedures in the Tests of
Within-Subject Effects table produce the same F value, they differ in their df and p-values. As a
reminder, if you are comparing the results to hand calculations you’ll want to use the sphericity
assumed values).

The ANOVA test produces two degrees of freedom (df) for time [
and df for error ],

which results in values of 2 and 48, respectively, for the sphericity assumed values. To obtain the
df for the Greenhouse-Geisser procedure, an adjustment is applied to the sphericity assumed
degrees of freedom to compensate for the lack of sphericity in the data. In fact, if you look at the
previous table, Mauchly’s Test of Sphericity, you’ll see that the value of a statistic called epsilon
for Greenhouse-Geisser is .819. Multiplying the value of epsilon by the sphericity assumed degrees
of freedom (2, 48) produces the degrees of freedom (within rounding error) of 1.638 and 39.305
that are reported for the Greenhouse-Geisser test.

The reported p-value found under the column “Sig.” for Greenhouse-Geisser is .000 (which
is read as “less than .001”). Since the p-value is less than .05, the null hypothesis that the means
of the three time occasions are equal is rejected (the null hypothesis would also be rejected using
the sphericity assumed procedure, with a p-value less than .001 reported in the table). After dis-
cussing the remaining three tables of output, additional testing will be conducted to examine the
nature of the differences among the three time occasions.

Test of Within-Subjects Contrasts and Tests of Between-Subjects Effects
The next two tables, Test of Within-Subjects Contrasts and Tests of Between-Subjects Effects, will
not be used in our discussion of the one-way within subjects ANOVA. While the Test of Within-
Subjects Contrasts can be used for conducting certain follow-up tests for time, we’ll conduct
dependent-samples t tests since, with only two levels of the within subjects factor tested at a time,
the assumption of sphericity is not required.

The Tests of Between-Subjects Effects table displays the results for any between subjects fac-
tors included in the study. Since we don’t have a between subjects factor in our study, this table
is not relevant here (this table will be discussed in Chapter 11).

Estimated Marginal Means
The Estimated Marginal Means table provides the means, standard error, and the 95% confidence
interval for each of the three time occasions. While the Descriptive Statistics table discussed ear-
lier also provided the means for each of the groups, the difference between the two tables is that
the Estimated Marginal Means table displays the standard error and the 95% confidence interval
for each of the groups, while the Descriptive Statistics table displays the standard deviation and
the sample size.

Follow-up Tests after a Significant Result for the Overall ANOVA

Since the test for time was significant (see the Tests of Within-Subjects Effects section for a review),
the null hypothesis that the social skills scores were equal across the three time occasions was
rejected. Because the alternative hypothesis is nonspecific, however, stating only that the means
differ in some way, follow-up testing is required to determine which of the time occasions are

1df = 1total sample size - 12*1the number of levels - 122levels - 12
1df = number of 

F =

53.343

3.731
= 14.298

F =

MS Time

MS Error 1time2
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significantly different from one another. The approach we’ll take for the follow-up tests is simi-
lar to that of the one-way between subjects ANOVA in Chapter 8. Recall for the between subjects
ANOVA, if the overall test was significant, all pairwise comparisons were tested using Tukey’s
test. For the within subjects ANOVA, all pairwise comparisons will be tested using dependent-
samples t tests, which is an appropriate follow-up procedure for the within subjects ANOVA. This
would result in three pairwise t tests: before vs. week8, before vs. after, and week8 vs. after. The
commands for conducting the dependent samples t tests in SPSS are summarized next. (See
Chapter 7 for more information on conducting dependent samples t tests.)

To conduct the three dependent-samples t tests in SPSS

1. From the menu bar select, 

2. The Paired-Samples T Test dialog box opens. With the ctrl key held down, select
the variables before and week8 and click the right-arrow button ( ) to move
them to the Paired Variables box.

3. Repeat this procedure for before and after and week8 and after. All three pairs
should now be in the Paired Variables box (see Figure 10.11).

T Test Á .
Analyze>Compare Means>Paired-Samples

Figure 10.11 The Paired-Samples T Test dialog box.

4. Click OK.

The paired-samples t tests procedure runs in SPSS and the results are presented in the Viewer
window. The output for the dependent-samples t tests is displayed in Figure 10.12 on page 134.

T-Tests—Pairwise Comparisons of the Three Time Occasions
In conducting t tests of all possible pairwise comparisons, the following three null hypotheses
were tested:

A common practice when conducting follow-up tests is to adjust the alpha level for each test
so that the entire set of follow-up tests does not exceed .05 (the alpha used for each test is referred
to as the alpha level per comparison). To find the alpha level for each test, take the overall alpha
level for the set of tests (.05) and divide that by the number of follow-up tests conducted. For
three tests and an alpha level of .05, the per comparison alpha level is (rounded
down so that the sum of the three tests does not exceed .05). This means that instead of evaluat-
ing each test against an alpha level of .05, the p-value for each test will be compared to an alpha
level of .016. If the p-value is less than or equal to .016, the null hypothesis for the comparison of
interest will be rejected. If the p-value is greater than .016, the null hypothesis will not be rejected.

.05/3 = .016

 H0 :mweek 8 = mafter

 H0 :mbefore = mafter

 H0 :mbefore = mweek8
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T–Test 
Paired Samples Statistics

22.4800 25 8.10411 1.62082

22.7200 25 7.35142 1.47028

22.4800 25 8.10411 1.62082

24.8800 25 7.20139 1.44028

22.7200 25 7.35142 1.47028

24.8800 25 7.20139 1.44028

before

week8

Pair
1

before

after

Pair
2

week8

after

Pair
3

Mean N Std. Deviation
Std. Error

Mean

Paired Samples Correlations

25 .956 .000

25 .932 .000

25 .964 .000

before & week8Pair 1

before & afterPair 2

week8 & afterPair 3

N Correlation Sig.

Paired Samples Test

–.24000 2.40278 .48056 –1.23182 .75182 –.499 24 .622

–2.40000 2.95804 .59161 –3.62102 –1.17898 –4.057 24 .000

–2.16000 1.95107 .39021 –2.96536 –1.35464 –5.535 24 .000

before - week8Pair 1

before - afterPair 2

week8 - afterPair 3

Mean Std. Deviation
Std. Error

Mean` Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df Sig. (2-tailed)

For the test of the
pairwise comparisons,
before vs. after and
week8 vs. after are
both significant, since
p < .016 for each test
(before vs. week8 is
not significant since
its p–value of .622 is
greater than .016). 

Figure 10.12 Output for the dependent-samples t follow-up tests.

This ensures that the probability of committing a Type I error (rejecting the null hypothesis when
it is true) will be no greater than .05 for the entire set of follow-up tests. (If no adjustment was made
and each follow-up test was conducted at .05, the overall alpha for the set of tests would approach
the sum of the alpha levels for the three tests, or .15).

The results of the three pairwise comparisons are presented in the Paired Samples Test table.
The results indicate that the first test, before vs. week8, is not significant, since the p-value of
.622 is greater than .016. The remaining two tests, before vs. after and week8 vs. after, are both
significant, with reported p-values of .000 Since the latter two tests are significant,
we’ll inspect the means presented in the Paired-Samples Statistics table to determine which of the
time occasions has the higher social skills scores. The Paired-Samples Statistics table shows that
social skills scores at after (24.88) are higher than both before (22.48) and week8 (22.72).

The results of the pairwise comparisons are summarized in Figure 10.13.

Effect Sizes
The measure of effect size commonly used with one-way within subjects ANOVA is partial
eta–square To calculate partial eta–square, the sum of squares (SS) from the Tests of1h22.

1p 6 .0012.

M10_YOCK5822_02_SE_C10.qxd  11/4/10  10:31 AM  Page 134



Chapter 10 / The One-Way within Subjects Analysis of Variance (ANOVA) 135

Test 

Before vs. 8 weeks 

Before vs. after 

8 weeks vs. after 

Are the groups
significantly different
(is the p–value less

than or equal to .016)?

No 

Yes 

Yes 

Result 

No significant difference between social 
skills scores before the program began 
and at 8 weeks

Significant; at the end of the program 
children had higher social skills scores 
than before the program began 

Significant; at the end of the program 
children had higher social skills scores 
than at 8 weeks

Figure 10.13 Summary of the results of the three pairwise comparisons.

Within-Subjects Effects table are used (they are referred to as Type III Sum of Squares in the out-
put). The formula for partial eta-square is

For time, the values for and are reported in the Tests of Within-Subjects Effects
table in Figure 10.10 as and Inserting the appropriate values from Figure
10.10 produces a partial eta–square of

which agrees with the value reported in the Tests of Within-Subjects Effects table for time.
While conventional effect size measures for small, medium, and large effect sizes for partial

eta-square have not been provided, the larger the value of partial eta-square, the more variance the
effect explains in the dependent variable.

Expression of the Results in APA Format
In writing the results for the one-within subjects ANOVA, the conclusion of the hypothesis test,
the degrees of freedom (df), the F value, the p-value, the effect size, and the results of the pair-
wise comparisons are reported (assuming the overall ANOVA is significant) along with the mean
and standard deviation for each of the time occasions social skills scores were measured (the mean
and standard deviation for each of the groups may be reported in a separate table if desired).
A sample write-up in APA format is presented next.

Written Results

The social skills scores for the children were significantly different across the time occasions,
Greenhouse-Geisser adjusted partial Dependent
samples t tests were conducted to assess which of the time occasions differed from one another,
with each test conducted at an alpha level of .016. The results indicated that the social skills scores
were significantly higher at the end of the program than at eight weeks

and at the end of the program as compared
to before the program began There was
not a significant difference in social skills scores before the program began and at eight weeks,
t1242 = - .50, p 7 .016.

1M = 22.48, SD = 8.102, t1242 = -4.06, p 6 .016.
1M = 22.72, SD = 7.352, t1242 = -5.54, p 6 .016,

1M = 24.88, SD = 7.202

h2
= .37.F11.64, 39.312 = 14.30, p 6 .05,

partial h2
=

87.360

87.360 + 146.640
= .373

SSError1time2 .SSTime

SSErrorSSEffect

partial h2
=

SSEffect

SSEffect + SSError
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[Note: If you prefer to use the sphericity assumed values, replace the Geisser-Greenhouse
degrees of freedom (1.64, 39.31) with the sphericity assumed values (2, 48) and delete the phrase
“Geisser-Greenhouse adjusted” from the results. All other results remain the same.]

Assumptions of the One-Way within Subjects ANOVA
1. The observations are independent between the participants.

Violating this assumption can seriously compromise the accuracy of the within sub-
jects ANOVA (teachers working together in determining their ratings of social skills
scores for students is an example of a violation of the independence assumption). If
there is reason to believe the independence assumption has been violated, the within
subjects ANOVA should not be used.

2. The dependent variable is normally distributed at each level of the independent variable
in the population.
This assumption means that the social skills scores should be normally distributed in
the population for each level of the independent variable (e.g., social skills scores
should be normally distributed at before, eight weeks, and after). For moderate to
large sample sizes, most types of nonnormal distributions tend to have relatively little
impact on the accuracy of the ANOVA test, although some nonnormal distributions
can adversely affect the power of the ANOVA test.

3. Sphericity.
The sphericity assumption requires that the variances of the difference scores are
equal for all pairs of levels of the within subjects factor in the population. For exam-
ple, if you calculated the difference score between the first two levels of the within
subjects factor for each of the participants (before–8 weeks) and then calculated the
variance of those scores (recall that the variance is equal to the standard deviation
squared) and repeated this procedure for all other combinations of levels (before–
after and 8 weeks–after), the sphericity assumption requires that these three 
variances are equal,

Violating the assumption of sphericity can compromise the accuracy of the ANOVA
test, resulting in the null hypothesis being rejected more often than is warranted.
Using an alternative procedure that adjusts for the presence of sphericity (e.g.,
Greenhouse-Geisser) addresses a violation of this assumption. Because multivariate
analysis of variance (MANOVA) does not require the assumption of sphericity,
MANOVA is also a viable option, although a discussion of this procedure is beyond
the scope of this text (see Maxwell and Delaney [2004] or Stevens [2002] for more
details on the MANOVA procedure).

Summary of Steps for Conducting a One-Way within Subjects
ANOVA in SPSS

I. Data Entry and Analysis
1. Create the number of variables in SPSS equal to the number of levels of the

within subjects factor.

2. Enter the data.

3. Select 

4. Enter the name of the within subjects factor in the Within-Subject Factor Name
text box, and enter the number of levels in the Number of Levels box. Click
Add. Click Define.

5. Move the variables (i.e., the levels of the within subjects factor) into the
Within-Subjects Variables box.

Analyze>General Linear Model>Repeated Measures Á .

sbefore-8 weeks
2

= sbefore-after
2

= s8 weeks-after
2
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6. Click Options. Move the within subjects factor to the Display Means for box.
Under Display, click Descriptive statistics and Estimates of effect size. Click
Continue.

7. Click OK.

II. Interpretation of the Results
1. Interpret the results for the overall ANOVA by examining the p-value either

under Greenhouse-Geisser or the Sphericity Assumed rows (use the Sphericity
Assumed values if comparing results to hand calculations).

a. If the ANOVA is significant (i.e., ), run dependent-samples t tests
for all possible pairwise comparisons. Evaluate each t test at an alpha equal
to .05 divided by the number of pairwise comparisons tested. Include the
results for the overall ANOVA and the dependent-samples t tests in your
write-up.

b. If the ANOVA is not significant (i.e., ), stop (do not conduct 
t tests). Write the results stating that there is not a significant difference
between the groups.

Exercises

1. A school social worker examined the impact of a new truancy prevention program on
the number of truancies at a local school. Fifteen children were enrolled in the new
program, and the number of truancies for each child was tracked over a nine-month
period, with the number of truancies recorded in three-month intervals. The data are
provided in Figure 10.14.

p 7 .05

p … .05

0–3 months

30

36

39

45

21

36

30

36

33

42

36

30

21

24

36

3–6 months

28

30

37

40

24

44

28

34

36

37

39

35

20

18

30

6–9 months

20

24

34

35

17

20

17

28

27

26

38

36

10

20

30

Figure 10.14 The number of truancies (at
three-month intervals) for the children
enrolled in the truancy program.

Enter the data into SPSS and perform the appropriate analyses to answer the
questions below. Name the variables month3, month6, and month9, respectively.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a significant difference in the number of truancies over the three time

periods? Test at a = .05.
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d. What is the effect size for the ANOVA?
e. If the overall ANOVA is significant, perform follow-up tests as appropriate.

Adjust alpha for each test so that the set of tests does not exceed .05.
f. Write the results of the study using APA format as appropriate.

2. A clinical psychologist wanted to investigate the effectiveness of psychoanalytic 
therapy over time. Fifteen people who checked into a treatment facility (and con-
sented to participate) were enrolled in the study. Each of the participants received 
psychoanalytic therapy for a period of 8 weeks. To measure the effectiveness of 
the therapy, the participants were administered a general measure of well-being 
before beginning therapy, 4 weeks into treatment, and after 8 weeks. The well-
being measure ranged from 10 to 50, with higher scores indicating greater well-
being. The data are in the file Chapter 10_Exercise 2.sav in the Chapter 10 folder 
online at www.routledgetextbooks.com/textbooks/9780205735822  (the variables 
are named beforetherapy, fourweeks, and eightweeks). Open the data file in 
SPSS and per-form the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a significant difference in the well-being scores over time? Test at

d. What is the effect size for the ANOVA?
e. If the overall ANOVA is significant, perform follow-up tests as appropriate.

Adjust alpha for each test so that the set of tests does not exceed .05.
f. Write the results of the study using APA format as appropriate.

3. A marketing researcher investigated the impact of offering different types of wifi
Internet service on the likelihood of eating at a fast-food restaurant. The likelihood
of dining at a fast-food restaurant was investigated under three different classifica-
tions: free wifi service, pay per use wifi service, and no wifi service. Ten people
(who ate fast food at least once a month) were asked to rate on a 1 to 10 scale the
likelihood ( likelihood and likelihood) that they would dine
at a fast-food restaurant in each of the three conditions (free wifi, pay per use wifi, 
and no wifi). The data are provided in the file Chapter 10_Exercise 3.sav in the 
Chapter 10 folder online at www.routledgetextbooks.com/textbooks/9780205735822  
(the variables are named freewifi, payforwifi, and nowifi). Open the data file in 
SPSS and perform the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a significant difference in the likelihood of eating at a fast-food

restaurant based on the type of wifi service offered? Test at 
d. What is the effect size for the overall ANOVA?
e. If the overall ANOVA is significant, perform follow-up tests as appropriate.

Adjust alpha for each test so that the set of tests does not exceed .05.
f. Write the results of the study using APA format as appropriate.

a = .05.

10 = greatest1 = least

a = .05.
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Aone-between–one-within subjects ANOVA is used when two independent variables are evaluated
on a dependent variable of interest. In the one-between–one-within ANOVA, one of the inde-

pendent variables is a between subjects factor and the other is a within subjects factor. The between
subjects factor consists of two or more levels, where each participant receives only one level of the
treatment. The within subjects factor consists of two or more levels, where each participant receives
all levels of the treatment.1 An example of a one-between–one-within ANOVA is presented next.

Example
A researcher investigated whether a mentoring program designed for beginning high school teachers was
effective at reducing stress. Twenty new teachers participated in the study, with 10 teachers receiving the
mentoring program and 10 teachers serving as the control group (i.e., they did not receive any mentoring
support). In the mentoring program, the new teachers were assigned a mentor whom they met with weekly
to discuss aspects of their job that are particularly challenging as they begin their careers (e.g., classroom
management issues). After agreeing to participate in the study, all the teachers were administered a teach-
ing stress scale one week before beginning teaching (before), four weeks into the year (week4), and eight
weeks into the year (week8). The teaching stress scale ranged from 20 to 80, with higher scores indicat-
ing greater teaching-related stress. In this study, support (2 levels—mentor, no mentor) is the between sub-
jects factor, time (3 levels—before, 4 weeks, and 8 weeks) is the within subjects factor, and the dependent
variable is the reported level of teaching-related stress experienced by the new teachers.

Objectives and Data Requirements of the One-Between–One-
Within ANOVA

11
CHAPTER

The One-Between–One-Within Subjects
Analysis of Variance (ANOVA)

One-between–One-within ANOVA

Objectives Data Requirements Example

To test for main effects

• Is there a difference in stress 
levels between mentored and 
nonmentored teachers?

• Is there a difference in stress 
levels before the program 
began, at four weeks, and at eight weeks?

Independent variables

• One-between subjects 
factor (with two or more 
levels)

• One-within subjects factor
(with two or more levels)

Independent variables

• Support (mentor, 
no mentor)

• Time (before, four 
weeks, eight weeks)

To test for an interaction effect

• Does the impact of support 
(mentor, no mentor) depend 
on time (before, 4 weeks, 8 weeks)?

Dependent variable

• Continuous

Dependent variable

• Teaching stress
scores
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Null and Alternative Hypotheses
There are three different null hypotheses for the one-between–one-within subjects ANOVA. One
null hypothesis is tested for each of the independent variables (known as tests of main effects), and
one for the combined effect of the two independent variables (known as a test for an interaction
effect). Each of these hypotheses is described below.

Hypothesis 1. Test of Support: Mentoring vs. No Mentoring

The null hypothesis for support states that the mean stress levels for mentored and nonmentored
teachers are equal in the population:

The alternative hypothesis states that the mean stress levels for mentored and nonmentored
teachers are not equal in the population:

Hypothesis 2. Test of Time: Before, Four Weeks, and Eight Weeks

The null hypothesis for time states that the mean stress levels in the population are equal before
the program began, at four weeks, and at eight weeks:

When there are three or more levels to a factor, the alternative hypothesis states that there is
a difference somewhere between the levels of the factor:

Hypothesis 3. Test of the Interaction Effect of Support and Time

The null hypothesis states that there is not an interaction between support and time:

The alternative hypothesis states that there is an interaction between the two variables:

Evaluation of the Null Hypothesis

The one-between–one-within ANOVA provides a test of the three null hypotheses discussed above.
For a given hypothesis of interest, if the test produces results that seem unlikely if the null hypoth-
esis is true (results that occur less than 5% of the time), then the null hypothesis is rejected. If the
test produces results that seem fairly likely if the null hypothesis is true (results that occur greater
than 5% of the time), then the null hypothesis is not rejected.

Research Questions
The fundamental questions of interest in a one-between–one-within ANOVA can also be expressed
in the form of research questions, such as,

For support

“Do the reported stress levels differ for those who received mentoring versus
those who did not?”

H1 : There is a support * time interaction.

H0 : There is not a support * time interaction.

H1 : At least one of the population means is different from the others.2

H0 :mbefore = m4 weeks = m8 weeks

H1 :mmentored Z mnot mentored

H0 :mmentored = mnot mentored
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For time

“Is there a difference in the reported stress levels before beginning teaching, at
four weeks, and at eight weeks?”

For the interaction of time and support

“Do the reported stress levels for time depend on whether or not mentoring was
received?”

The Data

The data for the 20 participants are presented in Figure 11.1. For support, those who received
mentoring are assigned a “1” and those who did not receive mentoring are assigned a “2.” For time,
before, week4, and week8 correspond to teacher stress scores immediately before beginning
teaching, four weeks into the school year, and eight weeks into the school year, respectively.

Participant

1
2
3
4
5
6
7
8
9
10

Support

1
1
1
1
1
1
1
1
1
1

Before 

40
45
42
38
46
40
42
39
35
43

Week4

39
44
44
36
44
37
38
37
33
44

Week8 

35
42
44
30
38
25
35
29
31
38

Participant 

11
12
13
14
15
16
17
18
19
20

Support

2
2
2
2
2
2
2
2
2
2

Before

38
47
41
39
44
42
42
40
38
41

Week4

44
45
48
41
44
39
48
46
45
40

Week8 

42
42
45
43
41
35
46
42
43
35

Figure 11.1 The data for the one-between–one-within ANOVA. (Note: The participant variable is
included for illustration but will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822  under the name teaching stress.sav in 
the Chapter 11 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, four variables will be created, one for the support groups (mentor/no mentor) and
one for each of the time occasions teaching stress was assessed. The variables will be named
support, before, week4, and week8, respectively.

3. Enter the names support, before, week4, and week8, respectively, in the first four
rows of the Variable View window (see Figure 11.2).

Figure 11.2 The Variable View window with the variables support, before, week4, and week8 entered.
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4. Using the process described in Chapter 1, create value labels for support. For
support, and 

Step 2: Enter the Data

1. Click the Data View tab. The variables support, before, week4, and week8
appear in the first four columns of the Data View window.

2. Consulting Figure 11.1, enter the values for each of the participants on the four
variables of interest. For the first participant, enter the values 1, 40, 39, and 35, for
the variables support, before, week4 and week8, respectively. Using this
approach, enter the data for all 20 participants. The completed data set is pre-
sented in Figure 11.3.

2 = “no mentor.”1 = “mentor”

Notice that the structuring of the data
file for the one–between one–within
subjects ANOVA combines the features
of the between subjects ANOVA
(different numbers for the different levels
of support) with the features of the within
subjects ANOVA (the different levels of
time entered as separate variables in
SPSS – before, week4 and week8). 

Figure 11.3 The completed data file for the one-between–one-within ANOVA.

Step 3: Analyze the Data

1. From the menu bar, select 
(see Figure 11.4).

A Repeated Measures Define Factor(s) dialog box opens (see Figure 11.5). This dialog
box is used to provide a name for the within subjects factor and to enter the number of levels
of the factor.3

2. Double-click “factor1” in the Within Subject Factor Name text box (factor1 is the
default name SPSS provides for the within subject factor). Enter the name time.

3. In the Number of Levels text box, enter the number 3. This corresponds to the
number of levels of time (before, week4, and week8). See Figure 11.6 for details.

4. Click Add.
5. Click Define.

Measures Á

Analyze>General Linear Model>Repeated 
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Figure 11.4 Menu commands for the one-between–one-within subjects ANOVA procedure.

Figure 11.5 The Repeated Measures Define
Factor(s) dialog box.

Figure 11.6 The Repeated Measures Define
Factor(s) dialog box (continued).
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Figure 11.7 The Repeated Measures dialog box.

The Repeated Measures dialog box opens with support, before, week4, and week8 on the
left-hand side of the dialog box (see Figure 11.7).

6. Select the between subjects variable, support, and click the middle right-arrow
button ( ) to move it into the Between-Subjects Factor(s) box.

7. With the Ctrl key held down, select the variables before, week4, and week8, and
click the upper right-arrow button ( ) to move them into the Within-Subjects
Variables box (see Figure 11.8).

Figure 11.8 The Repeated Measures dialog box (continued).
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8. Click Options. The Repeated Measures: Options dialog box opens. Under the
Factor(s) and Factor Interactions box select support, time, and support*time,
and click the right-arrow button ( ) to move them into the Display Means for
box. Under Display select Descriptive statistics and Estimates of effect size (see
Figure 11.9).

Figure 11.9 The Repeated Measures: Options dialog box.

9. Click Continue.
10. Click Plots. The Repeated Measures: Profile Plots dialog box opens. Select the fac-

tor, time, and click the upper right-arrow button ( ) to move it to the Horizontal
Axis box. Select the factor, support, and click the middle right-arrow button ( ) to
move it to the Separate Lines box. See Figure 11.10 for details.

Figure 11.10 The Repeated Measures: Profile Plots dialog box.
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11. Click Add. The interaction term appears in the Plots box (see
Figure 11.11).

time * support

Figure 11.11 The Repeated Measures: Profile Plots dialog box 
(continued).

12. Click Continue.
13. Click OK.

The one-between–one-within ANOVA procedure runs in SPSS and the results are presented
in the Viewer window.

Step 4: Interpret the Results

The output for the one-between–one-within ANOVA is displayed in Figure 11.12 (page 149).

Within-Subjects Factors
The first table, Within-Subjects Factors, lists the three time occasions the participants were mea-
sured, including before the program began (before), four weeks into the program (week4), and at
the conclusion of the program at eight weeks (week8).

Between-Subjects Factors
The Between-Subjects Factors table displays the between subjects factor, support, the value labels
for the levels of support, and the sample size for each of the groups.

Descriptive Statistics
The Descriptive Statistics table displays the mean, standard deviation, and sample size for each
of the conditions in the study (the levels of time are displayed under Total in the table). While
we’ll focus our attention on the Estimated Marginal Means tables later in the output for inter-
preting mean differences, the standard deviations from this table will be used in the write-up of
our results.

Multivariate Tests
The null hypothesis for time and the time*support interaction may be tested either using a uni-
variate test (ANOVA) or a multivariate test (MANOVA). The Multivariate Tests table provides the
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General Linear Model 
Within-Subjects Factors

Measure: MEASURE_1

before

week4

week8

time
1

2

3

Dependent
Variable Between-Subjects Factors

mentor 10

no mentor 10

1.00

2.00

support
Value Label N

Descriptive Statistics

41.0000 3.29983 10

41.2000 2.78089 10

41.1000 2.97180 20

39.6000 4.08792 10

44.0000 3.12694 10

41.8000 4.20025 20

34.7000 6.00093 10

41.4000 3.68782 10

38.0500 5.94249 20

support
mentor

no mentor

Total

mentor

no mentor

Total

mentor

no mentor

Total

before

week4

week8

Mean Std. Deviation N

Multivariate Testsb

.704 20.183a 2.000 17.000 .000 .704

.296 20.183a 2.000 17.000 .000 .704

2.375 20.183a 2.000 17.000 .000 .704

2.375 20.183a 2.000 17.000 .000 .704

.365 4.878a 2.000 17.000 .021 .365

.635 4.878a 2.000 17.000 .021 .365

.574 4.878a 2.000 17.000 .021 .365

.574 4.878a 2.000 17.000 .021 .365

Pillai's Trace

Wilks' Lambda

Hotelling's Trace

Roy's Largest Root

Pillai's Trace

Wilks' Lambda

Hotelling's Trace

Roy's Largest Root

Effect
time

time * support

Value F Hypothesis df Error df Sig.
Partial Eta
Squared

a. Exact statistic
b. Design: Intercept + support
    Within Subjects Design: time 

Mauchly's Test of Sphericityb

Measure: MEASURE_1

.545 10.310 2 .006 .687 .767 .500
Within Subjects Effect
time

Mauchly's W
Approx.

Chi-Square df Sig.
Greenhouse

-Geisser Huynh-Feldt Lower-bound

Epsilona

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is
proportional to an identity matrix.

a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in
    the Tests of Within-Subjects Effects table.
b. Design: Intercept + support
    Within Subjects Design: time

(continued)
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Tests of Within-Subjects Effects
Measure: MEASURE_1

159.033 2 79.517 12.078 .000 .402

159.033 1.375 115.676 12.078 .001 .402

159.033 1.534 103.699 12.078 .000 .402

159.033 1.000 159.033 12.078 .003 .402

108.633 2 54.317 8.251 .001 .314

108.633 1.375 79.016 8.251 .004 .314

108.633 1.534 70.836 8.251 .003 .314

108.633 1.000 108.633 8.251 .010 .314

237.000 36 6.583

237.000 24.747 9.577

237.000 27.605 8.585

237.000 18.000 13.167

Sphericity Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Sphericity Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Sphericity Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Source
time

time * support

Error(time)

Type III Sum
of Squares df Mean Square F Sig.

Partial Eta
Squared

The p–values for the
tests of time and time
x support. Use either
the Greenhouse–
Geisser or Sphericity
Assumed values (in
this example both time
and time x support
are significant using
either criteria since
p < .05 for each test).  

Tests of Within-Subjects Contrasts
Measure: MEASURE_1

93.025 1 93.025 8.463 .009 .320

66.008 1 66.008 30.349 .000 .628

105.625 1 105.625 9.610 .006 .348

3.008 1 3.008 1.383 .255 .071

197.850 18 10.992

39.150 18 2.175

time
Linear

Quadratic

Linear

Quadratic

Linear

Quadratic

Source
time

time * support

Error(time)

Type III Sum
of Squares df Mean Square F Sig.

Partial Eta
Squared

Tests of Between-Subjects Effects
Measure: MEASURE_1
Transformed Variable: Average

97526.017 1 97526.017 2852.101 .000 .994

212.817 1 212.817 6.224 .023 .257

615.500 18 34.194

Source
Intercept

support

Error

Type III Sum
of Squares df Mean Square F Sig.

Partial Eta
Squared

Support is significant
since p < .05. 
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Estimated Marginal Means 
1. support

Measure: MEASURE_1

38.433 1.068 36.190 40.676

42.200 1.068 39.957 44.443

support
mentor

no mentor

Mean Std. Error Lower Bound Upper Bound

95% Confidence Interval

2. time
Measure: MEASURE_1

41.100 .682 39.667 42.533

41.800 .814 40.090 43.510

38.050 1.114 35.710 40.390

time
1

2

3

Mean Std. Error Lower Bound Upper Bound

95% Confidence Interval

3. support * time
Measure: MEASURE_1

41.000 .965 38.973 43.027

39.600 1.151 37.182 42.018

34.700 1.575 31.391 38.009

41.200 .965 39.173 43.227

44.000 1.151 41.582 46.418

41.400 1.575 38.091 44.709

time
1

2

3

1

2

3

support
mentor

no mentor

Mean Std. Error Lower Bound Upper Bound

95% Confidence Interval

Profile Plots 

321

42.50

40.00

37.50

35.00

E
st

im
at

ed
 M

ar
g

in
al

 M
ea

n
s

Estimated Marginal Means of MEASURE_1

The significant interaction
effect indicates that the
difference between the
levels of support changed
over time. (i.e., the distance
between the top and bottom
lines changed over time). 

no mentor
mentor

support

Figure 11.12 Output for the one-between–one-within ANOVA.
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results of four different multivariate tests for time and While the multivariate
tests are automatically output in the results, multivariate procedures are beyond the scope of this
text and will therefore not be discussed. Interested readers are referred to Maxwell and Delaney
(2004) or Stevens (2002) for more details on the MANOVA procedure.

Mauchly’s Test of Sphericity
The next table, Mauchly’s Test of Sphericity, tests the sphericity assumption, which is an assump-
tion of the one-between–one-within ANOVA when there are three or more levels to the within sub-
jects factor.5 While a test of this assumption is provided in the Mauchly’s Test of Sphericity table
in SPSS (the p-value for the test is .006), this test can be inaccurate (see Howell, 2007, or Maxwell
& Delaney, 2004, for more details) and will therefore not be considered (an alternative approach
to testing the assumption of sphericity will be provided).

As was discussed in Chapter 10, if the sphericity assumption is not met, the ANOVA F test
(reported as Sphericity Assumed in the Tests of Within Subjects Effects table) is inaccurate, yield-
ing results that lead to rejecting a true null hypothesis more often than is warranted. As a result
of the inaccuracy of the F test when the assumption of sphericity is violated, several alternative
F tests that adjust for the lack of sphericity have been proposed. There are three such “adjustment
procedures” in the Tests of Within-Subjects Effects table: Greenhouse-Geisser, Huynh-Feldt, and
Lower-bound. For reasons discussed in Chapter 10, we will evaluate the Greenhouse-Geisser F
in the output. While the Greenhouse-Geisser adjustment provides a more accurate result when
the assumption of sphericity has been violated, because it is tedious to calculate by hand, its
solution is usually only considered when conducting analyses by computer. Therefore, those
who are using SPSS to confirm results of hand calculations will want to use the Sphericity
Assumed values.

Test of Within-Subjects Effects
The next table, Tests of Within-Subjects Effects, provides the answer to two of our research ques-
tions, that is, whether or not the stress scores differ for the three time occasions and whether or
not there is an interaction between time and support.

As was the case with the one-way ANOVA discussed in Chapter 8, the F test is a ratio of two
variances, with each variance represented as a mean square (MS) in the output

In the one-between–one-within ANOVA, the tests that include the within subjects factor
(i.e., time and ) have an error term that is different from the test of the between
subjects factor (i.e., support). In the Tests of Within-Subjects Effects table, time and

share the same error term, MS Error(time). For time, the F ratio is

Substituting the appropriate values from the data in Figure 11.12 under the Greenhouse-
Geisser row results in an F for time of

which agrees with the value of F in the Tests of Within-Subjects Effects table reported in Figure
11.12. [The Sphericity Assumed F is also 12.078 (79.517/6.583). While all four tests produce the
same F value, they differ in their df and p-values.]

The test of time produces two degrees of freedom, df for time and df for error, which are 2 and
36, respectively, for the Sphericity Assumed values. (As a reminder, if you are calculating the F val-
ues by hand you’ll want to compare your results with the Sphericity Assumed values). The Greenhouse-
Geisser procedure applies an adjustment to the original degrees of freedom to compensate for the

F =

115.676

9.577
= 12.078

F =

MS Time

MS Error 1time2

time * support

time * support

F =

MS Effect

MS Error

time * support.4
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lack of sphericity in the data. If you look in the previous table, Mauchley’s Test of Sphericity, you’ll
see that the value of a statistic called epsilon for Greenhouse-Geisser is .687. Multiplying this value
by the sphericity assumed degrees of freedom (2, 36) produces the degrees of freedom (within round-
ing error) of 1.375 and 24.747 that are reported for the Greenhouse-Geisser test.

The reported p-value found under the column “Sig.” for Greenhouse-Geisser for time is .001.
Since the p-value is less than .05, the null hypothesis that the means of the three time occasions are equal
is rejected, and it is concluded that at least one of the time occasions is different from the others.

Moving to the test of the Greenhouse-Geisser F is 8.251 (79.016/9.577) with
a p-value of .004. Since the p-value is less than .05, the null hypothesis is rejected, and it is con-
cluded that there is a significant interaction (a write-up of the results will be
provided later in the chapter).

Tests of Within-Subjects Contrasts
The next table, Tests of Within-Subjects Contrasts, can be used for conducting certain follow-up tests
for within subjects main effects and interactions. This table will not be discussed for the one-
between–one-within ANOVA, as we will be using an alternative method for conducting follow-up
tests, which will be discussed shortly.

Tests of Between-Subjects Effects
The Tests of Between-Subjects Effects table reports the results of the test of the between subjects
factor, support. The F for support is 6.224 with a
corresponding p-value of .023.6 Since the p-value is less than .05, the null hypothesis that the
mean stress levels are equal for mentored and nonmentored teachers is rejected (a write-up of the
results for support will be provided later in the chapter).

Estimated Marginal Means
The Estimated Marginal Means tables present the means for the levels of each of the factors and
for the interaction. The first table, support, presents the means for the mentored and nonmentored
groups. Since support was significant, we’ll inspect the means to determine which group had lower
stress scores. The marginal means for support shows that those who had a mentor 
had lower mean stress levels than those who did not have a mentor 

The next table, time, shows the means for the levels of time. Since there are three levels to
time, we cannot definitively conclude which of the three time occasions are significantly differ-
ent without further testing (recall the nonspecific nature of the alternative hypothesis with three
or more groups). (Due to space considerations, follow-up tests will not be conducted here; how-
ever, instructions for conducting follow-up tests for the within subjects factor are provided on the
summary page prior to the chapter exercises.)

The last table, support*time, shows the means for the six conditions in
the study. To interpret the significant interaction effect, we’ll focus our attention on the Profile Plots
table, which presents the means of the six conditions in graphical form.

Profile Plots
The Profile Plots graph displays a plot of the means of the six conditions in the study. As we spec-
ified earlier in SPSS, time is on the horizontal axis and the levels of support are represented as
separate lines (in the plot, 1, 2, and 3 correspond to before, week4, and week8, respectively, for
time). Inspecting the means, prior to the start of the program, the mentored and nonmentored
groups had mean stress levels that were nearly identical (41.00 vs. 41.20), while at both four and
eight weeks mentored teachers reported lower stress levels than nonmentored teachers (39.60 vs.
44.00 at four weeks and 34.70 vs. 41.40 at eight weeks). The significant interaction effect indi-
cates that the lines are significantly nonparallel, confirming that the difference between the men-
tored and nonmentored groups changed over time.

Testing of the Interaction Effect: Simple Effects Analyses

While the interaction effect indicates that the lines are significantly nonparallel, it does not indicate
which points are significantly different from one other.7 To determine which points are significantly
different, simple effects testing will be conducted. Simple effects tests are used to examine

13 time * 2 support2

1mean = 42.202.
1mean = 38.432

1MS support/MS error = 212.817/34.1942

time * support

time * support,
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differences for one factor at a single level of the other factor. In the current example, several differ-
ent simple effects tests could be conducted, including testing support (mentored vs. nonmentored
teachers) at each level of time (i.e., testing across the lines in the Profile Plot), as well as testing time
(before, week4, and week8) at each level of support (i.e., testing within each line in the Profile Plot).

To illustrate simple effects testing for the one-between–one-within ANOVA, we’ll test whether
mentored versus nonmentored teachers differed significantly in their scores before the program
began, at four weeks, and at eight weeks (referred to as 1, 2, and 3 in the interaction plot). This
entails conducting three separate independent-samples t tests, one for each level of time. Since the
t tests are follow-up tests, they will each be conducted at alpha level of .016 (.05/3) to ensure that
the total alpha for the three tests combined does not exceed .05 (see Chapter 10 for more details
on adjusting alpha for follow-up tests).

Testing mentored versus nonmentored teachers at each level of time would imply the fol-
lowing three null hypotheses:

The commands for running the independent samples t tests are provided next (see Chapter 7
for more details on the independent samples t test).

1. From the menu bar select 

2. Move support to the Grouping Variable box.
3. Click Define Groups. Assign a 1 to Group 1 and a 2 to Group 2.
4. With the Ctrl key held down, select before, week4, and week8 and click the right-

arrow button ( ) to move them to the Test Variable(s) box (see Figure 11.13).
5. Click OK.

T Test Á .
Analyze>Compare Means>Independent-Samples 

 H0 :mmentored–8 weeks = mnot mentored–8 weeks

 H0 :mmentored–4 weeks = mnot mentored–4 weeks

 H0 :mmentored–before = mnot mentored–before

Figure 11.13 The Independent-Samples T Test dialog box.

Results of the Simple Effects Analyses—Testing Support at Each Level of Time

The results of the independent-samples t tests are shown in Figure 11.14 on page 153. The Independent
Samples Test table shows that support is significant at both four weeks and eight weeks

but not at before (recall that each test was evaluated at an alpha level of
.016). The means in the Group Statistics table indicate that at both four and eight weeks those who
were mentored reported significantly less stress than those who were not mentored. These results will
be incorporated into the overall write-up of the results provided at the conclusion of the chapter.

1p = .88521p = .0082
1p = .0152
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Other tests of simple effects could have been conducted, such as testing for differences across
time for each support group. For example, we could test stress levels across time for those who
had a mentor, which would imply a one-way within subjects ANOVA. If the ANOVA was sig-
nificant, then as was illustrated in Chapter 10, all pairwise comparisons of time could be tested
using dependent samples t tests (i.e., 1 vs. 2, 1 vs. 3, and 2 vs. 3). While these tests will not be illus-
trated here due to space considerations, a test of mentored teachers over time will be addressed in
Exercise 3 at the conclusion of this chapter (with the solution provided in Appendix C).

Effect Sizes
The measure of effect size commonly used with the one-between–one-within ANOVA is partial
eta-square To calculate partial eta-square for the effect of interest, the sums of squares (SS)
from the appropriate table (either the Tests of Within-Subjects Effects or the Tests of Between-
Subjects Effects table) are used. The formula for partial eta-square is

partial h2
=

SSEffect

SSEffect + SSError

1h22.

T–Test 
Group Statistics

10 41.0000 3.29983 1.04350

10 41.2000 2.78089 .87939

10 39.6000 4.08792 1.29271

10 44.0000 3.12694 .98883

10 34.7000 6.00093 1.89766

10 41.4000 3.68782 1.16619

support

mentor
no mentor

mentor

no mentor

mentor

no mentor

before

week4

week8

N Mean Std. Deviation
Std. Error

Mean

Independent Samples Test

.483 .496 –.147 18 .885 –.20000 1.36463 –3.06699 2.66699

–.147 17.498 .885 –.20000 1.36463 –3.07290 2.67290

1.984 .176 –2.703 18 .015 –4.40000 1.62754 –7.81934 –.98066

–2.703 16.846 .015 –4.40000 1.62754 –7.83621 –.96379

2.693 .118 –3.008 18 .008 –6.70000 2.22736 –11.37950 –2.02050

–3.008 14.949 .009 –6.70000 2.22736 –11.44890 –1.95110

Equal variances
assumed
Equal variances
not assumed

Equal variances
assumed

Equal variances
not assumed

Equal variances
assumed

Equal variances
not assumed

before

week4

week8

F Sig.

Levene's
Test for Equality

of Variances

t df
Sig.

(2-tailed)
Mean

Difference
Std. Error
Difference Lower Upper

95% Confidence
Interval of the

Difference

t-test for Equality of Means

With an adjusted alpha of .016, week4 and
week8 are significant, with p–values <
.016 (before is not significant, since its
p–value is > .016).

Figure 11.14 The output of the independent-samples t tests (the tests of simple effects following the significant interaction).
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The values for and refer to the Type III Sum of Squares in the ANOVA table
in Figure 11.12. (For time and is expressed as ) For time,
inserting the appropriate values into the above formula produces a partial eta-square of

which agrees with the value reported in the Tests of Within-Subjects Effects table.
The larger the value of partial eta-square, the more variance the effect explains in the depen-

dent variable. Conventional effect size measures for small, medium, and large effect sizes for
partial eta-square have not been provided.

Expression of the Results in APA Format
In writing the results for the one-between–one-within ANOVA, the conclusion of the hypothesis
test, the degrees of freedom (df), the F value, the p-value, and the effect size are reported for each
of the tests along with the means and standard deviations for the groups (the means and standard
deviations may be reported in a separate table if desired). A sample write-up in APA format is pre-
sented next.

Written Results
A one-between–one-within ANOVA on teaching stress was conducted with support
(mentored, not mentored) as the between subjects factor and time (before, 4 weeks, and 
8 weeks) as the within subjects factor. The results showed a significant main effect for sup-

port, partial and a significant main effect for time, 

Greenhouse-Geisser adjusted partial For support,
mentored teachers reported significantly less stress than nonmentored teachers. There was
also a significant interaction, Greenhouse-Geisser adjusted 

partial Simple effects analyses were conducted for support at each
level of time, with each test conducted at an alpha level of .016. The results of the simple
effects tests indicated that mentored teachers reported significantly less stress than nonmen-
tored teachers at four weeks, and at eight weeks, 

There was not a significant difference between mentored and nonmentored teach-
ers before beginning teaching, Means and standard deviations for
mentored and nonmentored teachers at before, four weeks, and eight weeks are reported in
Figure 11.15.

t1182 = - .15, p 7 .016.
p 6 .016.

t1182 = -3.01, t1182 = -2.70, p 6 .016,

h2
= .31.8.25, p 6 .05,

F11.38, 24.752 =support * time

h2
= .40.F11.38, 24.752 = 12.08, p 6 .05,

h2
= .26,F11, 182 = 6.22, p 6 .05,

2 * 3

partial h2
=

159.033

159.033 + 237.000
= .402

SSError1time2 .SSerrortime * support,
SSErrorSSEffect

Mentored Not mentored 
Time M SD M SD
Before 41.00 3.30 41.20 2.78
4 weeks 39.60 4.09 44.00 3.13
8 weeks 34.70 6.00 41.40 3.69

Figure 11.15 Means and standard deviations for mentored and non-
mentored teachers before the academic year began, at four weeks,
and at eight weeks.

Assumptions of the One-Between–One-Within Subjects ANOVA
1. The observations are independent between the participants.

Violating this assumption can seriously compromise the accuracy of the one-
between–one-within subjects ANOVA. If there is reason to believe the indepen-
dence assumption has been violated, the one-between–one-within subjects
ANOVA should not be used.
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2. Normality.
This assumption means that (1) the dependent variable should be normally distrib-
uted in the population for each level of the within subjects factor and (2) the mean
score for the subjects (averaged across the levels of the within subjects factor)
should be normally distributed for each level of the between subjects variable. See
Chapter 8 for the consequences on violating the normality assumption.

3. Homogeneity of variance.
This assumption means that the variances should be equal in the population for
each level of the between subjects factor (the variances are calculated on the
scores for the participants averaged across the levels of the within subjects factor).
See Chapter 8 for consequences of violating this assumption.

4. Sphericity.
The sphericity assumption requires that the variances of the difference scores are
equal for all pairs of levels of the within subjects factor in the population. Since
violating the assumption of sphericity can compromise the accuracy of the
ANOVA test, using an alternative procedure that adjusts for the presence of
sphericity (e.g., Greenhouse-Geisser) is recommended. See Chapter 10 for more
details on the sphericity assumption.

5. Homogeneity of variance-covariance matrices.
This assumption means that the corresponding variances and covariances are
equal for the different levels of the between subjects factor (a covariance is a mea-
sure of the shared variability between two variables). In the current example, with
three levels to the within subjects factor, this assumption means that the three
corresponding variances and the three covariances

are equal for the two groups.
With equal or approximately equal sample sizes, small to moderate violations of
the equal variance-covariance matrix assumption are generally tolerable. If the
inequality in both the sample sizes and the variance-covariance matrices between
the groups is moderate to large, the one-between–one-within subjects ANOVA
should not be used.

Summary of Steps for Conducting a One-Between–
One-Within ANOVA in SPSS

I. Data Entry and Analysis
1. Create one variable for the between subjects factor and a separate variable for

each level of the within subjects factor.

2. Create value labels for the between subjects variable. In the Value Labels
dialog box, enter the numeric values and labels as appropriate. Click OK.

3. Enter the data.

4. Select 

5. In the Repeated Measures Define Factor(s) dialog box, enter a name for the
within subjects factor in the Within Subject Factor Name text box and the num-
ber of levels in the Number of Levels box. Click Add. Click Define.

6. In the Repeated Measures dialog box, move the between subjects factor to the
Between-Subjects Factor(s) box. Move the levels of the within subjects factor
to the Within-Subjects Variables box.

7. Click Options. Move each of the factors and the interaction term to the Display
Means for box. Under Display, click Descriptive statistics and Estimates of
effect size. Click Continue.

8. Click OK.

II. Interpretation of the Results
1. In the Tests of Within-Subjects Effects table, interpret the results of the tests of the

within subjects factor and the interaction by reading either the Greenhouse-Geisser

Analyze>General Linear Model>Repeated Measures Á .

1cov1before, week42 , cov1before, week82 , cov1week4, week822
1varbefore , varweek4 , varweek82
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or the Sphericity Assumed p-values (use the sphericity assumed values if compar-
ing results to hand calculations). Interpret the results of the between subjects factor
by examining the p-value in the Tests of Between-Subjects Effects table.
• If the between subjects factor is significant, examine the marginal means if

there are two levels to the factor. For three or more levels, run Tukey’s test
(by clicking Post Hoc and selecting Tukey) and interpret the results accord-
ingly (see Chapter 8 for more details on Tukey’s test). If the within subjects
factor is significant, examine the marginal means if there are two levels to
the factor. If there are three or more levels, conduct dependent samples t
tests as appropriate. If the interaction is significant, describe the nature of the
interaction or conduct simple effect tests (if desired) using an experiment-
wise alpha of .05.

• If none of the tests for the one-between–one-within ANOVA are significant,
stop. Write the results stating that the tests of the main effects and the inter-
action are not significant.

Exercises

1. A clinical psychologist compared the effectiveness of cognitive-behavioral and psy-
choanalytic therapy over time. Twenty people who were seeking therapy agreed to
participate in the study, with 10 of the participants receiving cognitive-behavioral
therapy and 10 receiving psychoanalytic therapy. The participants were adminis-
tered a general measure of well-being before therapy began, at 8 weeks and again at
16 weeks. The well-being measure ranged from 10 to 50, with higher scores indicat-
ing higher levels of well-being. The data are provided in Figure 11.16.

Therapy

1
1
1
1
1
1
1
1
1
1

Before 

19
18
21
22
24
18
19
19
17
23

Week8 

18
18
22
23
24
21
23
20
18
24

Week16 

22
21
24
28
26
27
25
23
16
28

Therapy

2
2
2
2
2
2
2
2
2
2

Before 

23
19
16
18
23
24
19
22
20
22

Week8 

23
19
17
19
25
25
20
24
20
22

Week16 

17
20
15
19
24
23
18
22
19
23

Figure 11.16 The data for Exercise 1. For therapy, 1 = “cognitive-behavioral” and
2 = “psychoanalytic.”

Enter the data in SPSS and perform the appropriate analyses to answer the
questions below. Name the variables therapy, before, week8, and week16,
respectively.
a. State the null and alternative hypothesis for each test of interest.
b. State a research question for each test of interest.
c. Test for main effects and the interaction (use for each test). Which

tests, if any, are significant? Which tests, if any, are not significant?
d. Report the effect size for each of the tests. Which of the tests has the largest

effect?
e. Write the results of the study using APA format as appropriate.

2. Conduct simple effects tests of the interaction effect in Exercise 1. Test to see if
there are differences between the two therapies at each of the three time occasions
(i.e., perform a separate test of the two therapy groups at before, week 8, and
week 10). Evaluate each test at an appropriate alpha level so that the overall
alpha for the three tests does not exceed .05.

a = .05
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3. In the problem addressed in the chapter, simple effects analyses were conducted by 
testing mentored versus nonmentored teachers at each level of time. Another possible 
analysis is to test whether there is a difference in stress scores for those who were 
mentored over the three time occasions. Perform this test in SPSS and answer each of the 
questions below. The data are provided in the file teaching stress.sav in the Chapter 11 
folder online at www.routledgetextbooks.com/textbooks/9780205735822 . Open the file 
in SPSS and perform the appropriate analyses to answer the ques-tions below (those who 
are mentored are assigned a value of “1” for support).(Hint: To perform the test, either 
the Select Cases or Split File procedure is required. See Appendix A for more 
information on these procedures.)
a. State the null and alternative hypothesis for the test of interest.
b. State a research question for the test of interest.
c. Is there a significant difference in stress scores across the three time occasions

for mentored teachers? Test at 
d. If time is significant, perform follow-up tests as appropriate. Evaluate each

test at an appropriate level so that the overall alpha for the set of follow-up
tests does not exceed .05. Which tests, if any, are significant? Which tests, if
any, are not significant?

e. Write the results of the study using APA format as appropriate.

a = .05.
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CHAPTER

The Pearson r correlation coefficient measures the degree of the linear relationship between two
variables. The degree of the relationship is expressed by the letter r; r can be positive (higher

scores on one variable are associated with higher scores on the other variable), negative (higher scores
on one variable are associated with lower scores on the other variable), or zero (no relationship
between the scores on the two variables). The values of the correlation coefficient can range from 
(a perfect negative relationship) to 1.0 (a perfect positive relationship). An example in which the
Pearson r correlation coefficient may be used is presented next.

Example
For a research project, a student wanted to examine whether there was a relationship between mean-
ing in life and psychological well-being. Thirty students who agreed to participate in the study were
administered a meaning in life scale and a measure of psychological well-being. The scores on the
meaning in life scale ranged from 10 to 70 (with higher scores indicating greater meaning in life),
and the well-being scale ranged from 5 to 35 (with higher scores indicating greater well-being).

Objective and Data Requirements of the Pearson r
Correlation Coefficient

-1.0

The Pearson r Correlation Coefficient

158

The Pearson r Correlation Coefficient

Objective Data Requirements Example

To measure the degree 
of the linear relationship 
between two variables.

Two continuous variables1 Variable 1: Meaning in life
Variable 2: Well-being

Null and Alternative Hypotheses
The null hypothesis states that there is no relationship between the two variables in the popula-
tion. The population symbol for the correlation coefficient is given by the Greek letter 
(pronounced ):

The alternative hypothesis states that there is a relationship between the two variables in the
population:

H1 : r Z 0

H0 : r = 0

“ro  ”
r
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Evaluation of the Null Hypothesis

The Pearson r correlation coefficient provides a test of the null hypothesis that there is no rela-
tionship between meaning in life and psychological well-being. If the test produces results that seem
unlikely if the null hypothesis is true (results that occur less than 5% of the time), then the null
hypothesis is rejected. If the test produces results that seem fairly likely if the null hypothesis is
true (results that occur greater than 5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Is there a relationship between meaning in life and psychological well-being?”

The Data

The data for the 30 participants are presented in Figure 12.1.

Participant 

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

Meaning
in Life

35
65
14
35
65
33
54
20
25
58
30
37
51
50
30

Well-
being

19
27
19
35
34
34
35
28
12
21
18
25
19
25
29

Participant

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

Meaning
in Life 

70
25
55
61
53
60
35
35
50
39
68
56
19
56
60

Well-
being

31
12
20
31
25
32
12
28
20
24
34
28
12
35
35

Figure 12.1 The data for the correlation coefficient example. (Note: The par-
ticipant variable is included for illustration but will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 below describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name meaning.sav in the 
Chapter 12 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In the Variable View window, two variables will be created, one for meaning in life and one for
psychological well-being. The variables will be named meaning and wellbeing, respectively.

3. Enter the variable names meaning and wellbeing, respectively, in the first two
rows of the Variable View window (see Figure 12.2 on page 160 for details).

Step 2: Enter the Data

1. Click the Data View tab. The variables meaning and wellbeing appear in the first
two columns of the Data View window.
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2. Consulting Figure 12.1, enter the scores for each of the participants on the two
variables of interest. For the first participant, enter the scores 35 and 19 for the
variables meaning and wellbeing, respectively. Using this approach, enter the
data for all 30 participants. The completed data set is presented in Figure 12.3.

Figure 12.2 The Variable View window with the variables meaning and wellbeing entered.

Figure 12.3 The data file for the Pearson r correlation coefficient example.

Step 3: Analyze the Data

1. From the menu bar, select 
(see Figure 12.4).

Analyze>Correlate>Bivariate Á
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A Bivariate Correlations dialog box appears with the variables meaning and wellbeing on
the left-hand side of the dialog box (see Figure 12.5).

Figure 12.4 Menu commands for the Pearson r correlation coefficient.

Figure 12.5 The Bivariate Correlations dialog box.

2. With the Ctrl key held down, select the variables, meaning and wellbeing, and click
the right-arrow button ( ) to move them to the Variables box (see Figure 12.6 on
page 162).

3. Click OK.

The correlation procedure runs in SPSS and the results are presented in the Viewer window.

Step 4: Interpret the Results

The output of the Correlations procedure is displayed in Figure 12.7 (page 162).

Correlations
SPSS produces a single table of output, labeled Correlations, which contains the answer to our
research question, that is, whether or not there is a relationship between the variables meaning and
wellbeing.
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Figure 12.6 The Bivariate Correlations dialog box (continued).

Correlations 
Correlations

1 .549**

.002

30 30

.549** 1

.002

30 30

Pearson Correlation

Sig. (2-tailed)

N

Pearson Correlation

Sig. (2-tailed)

N

meaning

welbeing

meaning welbeing

**. Correlation is significant at the 0.01 level (2-tailed). 

The correlation
between meaning
and well–being. 

The correlation is
significant, since the p–
value is less than .05.

The identical results are presented
twice in the Correlations table.  

Figure 12.7 The output for the Pearson r correlation coefficient.

Notice in the Correlations table that the variables meaning and wellbeing are presented
twice, once in the rows and once in the columns (this is a redundancy that occurs in all Correlations
tables produced by SPSS). The value of the correlation coefficient and the p-value of the test of
the null hypothesis can be found by locating where meaning and wellbeing intersect. The
Correlations table indicates that the correlation between meaning and wellbeing is .549 with a
corresponding p-value of .002 based on 30 participants. Since the p-value of .002 is less than .05,
the null hypothesis is rejected, and it is concluded that there is a positive relationship between
meaning and wellbeing in the population (the two asterisks to the right of the correlation coeffi-
cient indicate that the correlation is statistically significant at the .01 level, since .002 is less than
.01). The remaining two cells show a correlation of 1, a perfect positive correlation. This shouldn’t
be a surprise however, since these values correspond to the correlation of a variable with itself
(meaning with meaning and wellbeing with wellbeing), which is always equal to 1.

Effect Sizes
Unlike the other statistical procedures we have considered thus far, the correlation coefficient
itself is a commonly used measure of effect size. Cohen gave estimates of values of r of

and as corresponding to small, medium, and large effect sizes, respectively.; .5; .1, ; .3,
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Based on Cohen’s guidelines, the correlation of .549 corresponds to a large effect size in prac-
tice, suggesting a fairly strong positive relationship between meaning in life and psychological
well-being.

Expression of the Results in APA Format
While SPSS presents the sample size (N) in the Correlations table, the degrees of freedom are
not provided, although they are typically presented in the results. The formula for the degrees of
freedom is

where N corresponds to the total sample size (number of participants) in the study. With 30
people in the study, the degrees of freedom are equal to 28.

In writing the results, the conclusion of the hypothesis test, the value of r, the degrees of
freedom (df), and the p-value are reported. An example of a brief write-up in APA format is
presented next.

Written Results

There is a significant positive relationship between meaning in life and psychological well-being,

When calculating a correlation coefficient, it is often of interest to produce a scatterplot
to check for a linear (straight-line) relationship between the two variables and to check for
outliers. The commands for producing scatterplots are provided in Chapter 3. (For more infor-
mation on checking for linearity and outliers, consulting an introductory statistics textbook is
recommended.)

Assumptions of the Pearson Correlation Coefficient
1. Independence of observations between the participants.

This assumption means that the scores for each of the participants should be inde-
pendent of all other participants’ scores (an example of violating the indepen-
dence assumption would be if two participants worked together on the well-being
measure). If the independence assumption has been violated, the correlation coef-
ficient should not be used.

2. Bivariate normality.
This assumption means that each of the variables should be normally distributed
in the population and that for any value of one variable, the scores on the other
variable should be normally distributed. For moderate to large sample sizes, most
types of nonnormal data tend to have relatively little impact on the accuracy of the
test of the correlation coefficient.

Summary of Steps for Conducting a Pearson Correlation
Coefficient in SPSS

I. Data Entry and Analysis
1. Create two variables in SPSS.

2. Enter the data.

3. Select 

4. Move the two variables to the Variables box.

5. Click OK.

Analyze>Correlations>Bivariate Á .

r1282 = .55, p 6 .05.

df = 1N - 22
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II. Interpretation of the Results
1. Check the p-value in the Correlations table.

• If the null hypothesis is rejected. Write the results indicating that
there is a significant (positive or negative) relationship between the two
variables.

• If the null hypothesis is not rejected. Write the results indicating
that there is not a significant relationship between the two variables.

Exercises

1. A student was interested in examining whether there was a relationship between
the amount of time studying (in minutes) and the grade received on an exam (on
a 0 to 100 scale). The amount of time spent studying (examprep) and the final
grade on the exam (grade) for 25 students is reported in Figure 12.8.

p 7 .05,

p … .05,

examprep
(in minutes)

450
65
120
240
100
490
200
400
55
40
280
180
365
200
290
200
105
460
300
450
365
80
185
180
300

grade

90
50
75
82
55
85
79
83
60
48
74
96
85
63
77
82
80
89
55
92
95
55
75
81
87

Figure 12.8 The data
for the 25 participants.

Enter the data in SPSS, and perform the appropriate analyses to answer the
questions below. Name the variables examprep and grade.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Calculate the correlation coefficient between the two variables in SPSS. What

is the value of the correlation?
d. Is the correlation significant? Test at 
e. What is the effect size for the study? Would you characterize the effect size as

small, medium, or large?
f. Write the results of the study using APA format as appropriate.

2. A researcher was interested in investigating whether there was a relationship
between martial satisfaction and level of empathic understanding (i.e., the level of
empathy one has). One spouse was selected from each of 25 married couples and
was administered both a martial satisfaction scale and an empathy scale. The marital
satisfaction scale ranged from 15 to 60, and the empathy scale ranged from 10 to 50

a = .05.
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(higher scores on the scales indicate greater degrees of martial satisfaction and empathy, 
respectively). The data are located in the file Chapter 12_Exercise 2.sav in the Chapter 
12 folder online at www.routledgetextbooks.com/textbooks/9780205735822  (the 
variables are named maritalsatisfaction and empathy). Open the file in SPSS, and 
perform the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Calculate the correlation coefficient between the two variables in SPSS. What

is the value of the correlation?
d. Is the correlation significant? Test at 
e. What is the effect size for the study? Would you characterize the effect size as

small, medium, or large?
f. Write the results of the study using APA format as appropriate.

3. A researcher investigated whether there was a relationship between the time spent 
being read to as a child (at age 3) and later performance on a second-grade English 
skills exam. The parental report of the amount of time spent reading to their child 
(on a 1 to 10 scale) and the scores on an English skills exam (on a 10 to 50 scale) 
were recorded for 30 students (higher scores indicate being read to more at age 3 
and better performance on the exam in second grade, respectively). The data are 
located in the file Chapter 12_Exercise 3.sav in the Chapter 12 folder online at 
www.routledgetextbooks.com/textbooks/9780205735822  (the variables are 
named readingtime and examscores). Open the file in SPSS, and perform the 
appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Calculate the correlation coefficient between the two variables in SPSS. What

is the value of the correlation?
d. Is the correlation significant? Test at 
e. What is the effect size for the study? Would you characterize the effect size as

small, medium, or large?
f. Write the results of the study using APA format as appropriate.

a = .05.

a = .05.
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Simple linear regression is used when the objective is to predict scores on one variable using scores
on another variable.1 In regression, the variable that is being predicted is known as the dependent

or criterion variable, and the variable that is used to predict scores is known as the independent or
predictor variable. An example in which linear regression is used is presented next.

Example
For a research project a student wanted to examine whether or not social support (the degree to which
one can turn to others for support) is predictive of psychological well-being in college students.
Twenty-five students who agreed to participate in the study were administered measures of social sup-
port and psychological well-being. The range of possible responses for social support is from 8 to
40 and for well-being is from 10 to 70, with higher scores indicating higher levels of social support
and well-being, respectively.

Objective and Data Requirements of Simple Regression

Simple Linear Regression

166

Simple Linear Regression

Objective Data Requirements Example

To predict scores on a 
dependent variable using 
scores from an inde-
pendent variable.

Dependent variable

• Continuous
Independent variable

• Continuous2

Dependent variable

• Well-being
Independent variable

• Social support

Null and Alternative Hypotheses
The null hypothesis states that social support does not predict well-being. To evaluate the null hypoth-
esis, a regression equation is created (the equation will be introduced later), and a regression coeffi-
cient, known as a beta weight, is tested to see whether it is significantly different from zero. A beta
weight significantly different from zero indicates that the independent variable is a significant pre-
dictor of the dependent variable. The population symbol for the regression coefficient is given by the
Greek letter or beta.

The null hypothesis states that the beta weight is equal to zero:

(The beta weight for social support is equal to zero; social support does not
predict well-being.)

The alternative hypothesis states that the beta weight does not equal zero:

(The beta weight for social support is not equal to zero; social support predicts
well-being.)

H1 : bSSI Z 0

H0 : bSSI = 0

b,
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Evaluation of the Null Hypothesis

The linear regression procedure in SPSS provides a test of the null hypothesis that social support
does not predict well-being. If the test produces results that seem unlikely if the null hypothesis
is true (results that occur less than 5% of the time), then the null hypothesis is rejected. If the test
produces results that seem fairly likely if the null hypothesis is true (results that occur greater
than 5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Does social support predict psychological well-being in college students?”

The Data

The social support and well-being scores for the 25 participants are presented in Figure 13.1.

Participant Social Support Well-being Participant Social Support Well-being

1 20 32 14 35 66
2 38 65 15 32 25
3 35 60 16 34 52
4 30 56 17 35 70
5 12 25 18 28 51
6 31 25 19 17 32
7 18 65 20 24 42
8 28 56 21 31 25
9 14 23 22 16 61

10 24 42 23 32 52
11 34 60 24 19 26
12 28 51 25 25 41
13 32 58

Figure 13.1 The data for the multiple regression example. (Note: The participant variable is
included for illustration but will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 below describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name well being.sav in 
the Chapter 13 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, two variables will be created, one for social support and one for well-being. The vari-
ables will be named support and wellbeing, respectively.

3. Enter the variable names support and wellbeing in the first two rows of the
Variable View window (see Figure 13.2 on page 168 for details).

Step 2: Enter the Data

1. Click the Data View tab. The variables support and wellbeing appear in the first
two columns of the Data View window.
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2. Consulting Figure 13.1, enter the scores for each of the participants on the two
variables of interest. For the first participant, enter the scores 20 and 32 on the
variables support and wellbeing, respectively. Using this approach, enter the data
for all 25 participants. The completed data file is shown in Figure 13.3.

Figure 13.2 The Variable View window with the variables support and wellbeing entered.

Figure 13.3 The completed data file for the linear regression example.

Step 3: Analyze the Data

1. From the menu bar, select (see Figure 13.4).

A Linear Regression dialog box appears with the variables support and wellbeing on the
left-hand side of the dialog box (see Figure 13.5).

2. Select the variable, wellbeing, and click the upper right-arrow button ( ) to
move it into the Dependent box.

Analyze>Regression>Linear Á
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Figure 13.4 Menu commands for the linear regression procedure.

Figure 13.5 The Linear Regression dialog box.

3. Select the variable, support, and click the second right-arrow button from the top
( ) to move it into the Independent(s) box (see Figure 13.6).

Figure 13.6 The Linear Regression dialog box (continued).
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Figure 13.7 The Linear Regression: Statistics dialog box.

4. Click Statistics. Select Descriptives (Estimates and Model fit should already be
selected). See Figure 13.7 for details.

5. Click Continue.
6. Click OK.

The linear regression procedure runs in SPSS and the results are presented in the Viewer
window.

Step 4: Interpret the Results

The output of the linear regression procedure is displayed in Figure 13.8.

Descriptive Statistics
The Descriptive Statistics table displays the mean, standard deviation, and sample size for each
of the variables.

Correlations
The Correlations table displays the correlation between well-being and social support. The
correlation between the two variables is .490 with a one-tailed p-value of .0064 (SPSS rounds
down to three decimal places for a value of .006; doubling .0064 produces, within rounding
error, a value of .013 for a two-tailed test). The correlation between the two variables is significant
using either a one-tailed test or a two-tailed test In simple linear
regression, if the (two-tailed) correlation is significant, the regression will be significant 
as well.

Variables Entered/Removed
The Variables Entered/Removed table presents the variable (support) that was used to predict
well-being scores.

1.013 6 .052.1.006 6 .052
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Regression 

Descriptive Statistics

46.4400 15.70318 25

26.8800 7.52950 25

wellbeing

support

Mean Std. Deviation N

Correlations

1.000 .490

.490 1.000

. .006

.006 .

25 25

25 25

wellbeing

support

wellbeing

support

wellbeing

support

Pearson Correlation

Sig. (1-tailed)

N

wellbeing support

Variables Entered/Removedb

supporta . Enter
Model

1

Variables
Entered

Variables
Removed Method

a. All requested variables entered.
b. Dependent Variable: wellbeing

Model Summary

.490a .240 .207 13.98053
Model

1
R R Square

Adjusted
R Square

Std. Error of
the Estimate

a. Predictors: (Constant), support

The R2 value of .24 indicates that
social support accounted for 24% of
the variance in well–being scores.

The Pearson
correlation
coefficient
between well–
being and social
support.

ANOVAb

1422.692 1 1422.692 7.279 .013a

4495.468 23 195.455

5918.160 24

Regression

Residual

Total

Model

1

Sum of
Squares df Mean Square F Sig.

a. Predictors: (Constant), support
b. Dependent Variable: wellbeing

Coefficientsa

18.954 10.565 1.794 .086

1.023 .379 .490 2.698 .013

(Constant)

support

Model
1

B Std. Error

Unstandardized
Coefficients

Beta

Standardized
Coefficients

t Sig.

a. Dependent Variable: wellbeing

The ANOVA and
Coefficients tables
provide a test of the
same null hypothesis in
simple regression, that
is, whether support is a
significant predictor of
well–being (notice the
identical p–values for
the two tests). Social
support is a significant
predictor of well–being,
since the p–value is
less than .05.

Figure 13.8 The output for the linear regression procedure.
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Model Summary
The Model Summary table displays R, (R Square), Adjusted and the standard error of the
estimate. The first three of these values measure the degree to which well-being was predicted from
social support, and the last value measures the degree to which well-being was not predicted from
social support. Each of these values is discussed next.

The first value, R, is the multiple correlation coefficient, and, in simple regression, is
equal to the absolute value of the Pearson correlation between social support and well-being
(R ranges from 0 to 1). The second value, is the square of R and, when
multiplied by 100%, is interpreted as the percentage of total variance in the dependent vari-
able that is accounted for by the independent variable. In the current example, social support
accounted for of the variance in well-being scores. Adjusted modifies
the value of in an attempt to better estimate the true population value ( calculated on
the sample tends to overestimate the population value.) Finally, the standard error of the esti-
mate indicates the degree to which the independent variable was unable to predict scores on
the dependent variable. The value of 13.98 indicates that, when using social support scores
to predict well-being, the regression equation was “off” in predicting well-being scores by
about 13.98 points on average.

ANOVA
The next table, ANOVA, tests whether social support was a significant predictor of well-being. This
test is conducted using an analysis of variance (ANOVA), which was discussed in Chapter 8. In
simple regression, a p-value less than or equal to .05 in the ANOVA table indicates that the independent
variable is a significant predictor of the dependent variable. Since the p-value of .013 is less than .05,
social support is a significant predictor of well-being.

Coefficients
The last table, Coefficients, provides the necessary values to construct a regression equation
and to test the null hypothesis of whether social support is a significant predictor of well-
being. (Since the ANOVA table already indicated that social support was a significant predic-
tor of well-being, the test of the predictor in the Coefficients table is redundant in simple
regression).3

The regression equation will be discussed first, followed by the test of social support.
In linear regression, an equation is created in the form of

Where

predicted score on the dependent variable. In our example, corresponds to 
the predicted well-being scores.

Y-intercept; the value of when 
slope of the regression line.
scores on the independent variable for each of the participants. In our example,

X corresponds to the social support scores.

The values in the regression equation, a (the Y-intercept), and b (the slope), are found in the
Coefficients table in the Unstandardized Coefficients column labeled “B.” In the Coefficients table,
the value of the Y-intercept is 18.954 and the value of the slope is 1.023. Substituting these val-
ues into the regression equation formula produces the following equation for predicting well-
being scores:

YNwell-being = 18.954 + 1.0231social support2

 X = the
 b = the

X = 0.YN a = the

YN YN = the

YN = a + bX

R2R2
R224% (.24 * 100%)

1.4902
= .242R2,

R2,R2
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This is the regression equation based on the 25 college students. For a given score on social
support, a predicted well-being score can be found. For example, the first two participants had social
support scores of 20 and 38, respectively. Inserting these scores into the above equation produces
the following predicted well-being scores:

Predicted well-being score for participant 1

Predicted well-being score for participant 2

A predicted score can be found for each of the individuals in the dataset.4 The predicted scores
will almost always have some error (they will not match the actual scores exactly); the higher the
value of R, the more closely the predicted values will be to the actual values, with an R of 1 result-
ing in perfect prediction for all individuals.

Testing Social Support for Significance

A test of social support is also provided in the Coefficients table. In the last two columns of the
table, the t and p-values for the test of social support are presented. The test of social support pro-
duced a t of 2.698 with a corresponding p-value of .013. Because the p-value of .013 is less than
.05, the null hypothesis that the beta weight is equal to zero is rejected, and it is concluded that
social support is a significant predictor of psychological well-being. Notice that the p-value for
social support in the Coefficients table (.013) is identical to the p-value provided in the ANOVA
table (.013). These p-values are the same because, as was indicated earlier, in simple regression
they test the same null hypothesis, that is, whether or not social support is a significant predictor
of psychological well-being.

While the values from the Unstandardized Coefficients columns were used in finding predicted
scores, the Standardized Coefficients value will be presented in the write-up of the results. The stan-
dardized coefficient is referred to as a beta weight, and it is equal to the value of the regression
coefficient if the predictor and the criterion variable were in z-score form (i.e., if both variables
were standardized with a mean of zero and a standard deviation of 1).5 The value of beta in the
standardized coefficients column is equal to .490, which is identical to the Pearson correlation
coefficient between the two variables that was reported in the Correlations table (beta will always
be equal to the Pearson correlation in simple regression).

While the test of the constant is usually not of interest in simple regression, it tests whether
the Y-intercept is significantly different from zero. In this case, the value of 18.954 is not signif-
icantly different from zero since the p-value for the test (.086) is greater than .05.

Effect Sizes
The measure of effect size commonly used for simple regression is given by Cohen (1988)
expressed values in simple regression of .01, .09, and .24 as corresponding to small, medium,
and large effect sizes, respectively. In our example, an indicates that 24% of the vari-
ance in well-being scores can be accounted for by knowing social support scores, representing a
large effect.

R2
= .24

R2
R2.

 YNwell-being = 57.83

 YNwell-being = 18.954 + 1.0231382

 YNwell-being = 39.41

 YNwell-being = 18.954 + 1.0231202
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Expression of the Results in APA Format
In the write-up of the results, the standardized regression coefficient, the result of the test of the
predictor (social support), and the value of will be provided. A sample write-up of the results
is presented next.

Written Results

A regression analysis was conducted with well-being as the criterion variable and social support
as the predictor. Social support was a significant predictor of well-being, 

and accounted for of the variance in well-being scores.
(Note: The degrees of freedom for t are equal to in simple regression, where N is equal

to the number of pairs of scores in the study. In our example therefore )

Assumptions in Simple Regression
1. Independence of observations between the participants.

The independence assumption means that the scores for each participant should be
independent of all other participants’ scores (an example of violating the indepen-
dence assumption would be if two different participants worked on the well-being
measure together). Violating this assumption can seriously compromise the accuracy
of the statistical tests performed using the regression procedure. If there is reason to
believe the independence assumption has been violated, linear regression should not
be used.

2. Bivariate normality.
This assumption means that each of the variables should be normally distributed in
the population, and that for any value of one variable, the scores on the other variable
should also be normally distributed. For moderate to large sample sizes, most types
of nonnormal data tend to have relatively little impact on the accuracy of the regres-
sion procedure.

3. Homoscedasticity.
Homoscedasticity means that the variances on the dependent variable are equal in the
population for all levels of the independent variable. Mild to moderate violations of
this assumption are generally tolerable in simple regression.

Summary of Steps for Conducting a Simple Linear Regression
Analysis in SPSS

I. Data Entry and Analysis
1. Create two variables in SPSS, one for the independent variable and one for the

dependent variable.

2. Enter the data.

3. Select 

4. Move the independent and dependent variables to their respective boxes.

5. Click Statistics. Click Descriptives (Estimates and Model fit should already be
selected). Click Continue.

6. Click OK.

II. Interpretation of the Results
1. In the chapter description, all the tables (Descriptive Statistics, Correlations,

Variables Entered/Removed, Model Summary, ANOVA, and Coefficients) were
described. In this summary, only information from the Model Summary and
Coefficients tables will be described.

Analyze>Regression>Linear Á .

df = 23.N = 25;
N - 2

24% (R2
= .2422.70, p 6 .05,

b = .49, t1232 =

R2
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• Note the value of in the Model Summary table.
• Examine the p-value for the predictor in the Coefficients table (or in the

ANOVA table, as these tests are equivalent in simple regression).
• If the predictor is significant the null hypothesis is rejected.

Write the results indicating that the independent variable is a significant 
predictor of the dependent variable.

• If the predictor is not significant the null hypothesis is not
rejected. Write the results indicating that the independent variable is not a
significant predictor of the dependent variable.

Exercises

1. A researcher investigated whether a father’s level of optimism was predictive of
his son’s optimism as a young adult. Twenty fathers and sons who agreed to par-
ticipate in the study were each administered a scale measuring their current level
of optimism (the scale ranged from 10 to 50, with higher scores indicating greater
optimism). The data are provided in Figure 13.9.

1p 7 .052,

1p … .052,

R2

Father Son
40 45
30 35
25 20
29 35
20 22
25 35
46 48
49 39
46 49
23 38
46 35
26 28
16 19
29 45
46 31
49 41
37 31
31 36
42 45
43 48

Figure 13.9 The
optimism scores
of 20 fathers and
sons.

Enter the data in SPSS and perform the appropriate analyses to answer the questions
below. Name the variables father and son, respectively.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is the predictor significant? Test using 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write a regression equation for the data.
f. Write the results of the study using APA format as appropriate.

2. An employee for a school district wanted to know whether a seventh-grade math
skills entrance exam was predictive of performance (as measured by the final
grade) in seventh-grade mathematics. The entrance exam scores and the final

a = .05.
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course grade in seventh-grade mathematics for 30 students were obtained. The 
possible range of scores on the entrance exam are from 20 to 100 and the final grade 
in mathematics is from 0 to 100 (higher scores indicate better performance on both 
measures). The data are in the file Chapter 13_Exercise 2.sav in the Chapter 13 
folder online at www.routledgetextbooks.com/textbooks/9780205735822 (the 
variables are named mathexam and grade). Open the file in SPSS and perform the 
appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is the predictor significant? Test using 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write a regression equation for the data.
f. Write the results of the study using APA format as appropriate.

3. An industrial psychologist wanted to investigate whether agreeableness (being lik-
able, friendly, and getting along with others) was predictive of success at work. 
Twenty-five employees were selected and were administered a scale measuring 
agreeableness (the scale ranged from 7 to 35, with higher scores indicating greater 
agreeableness). Following the administration of the scale, the supervisor’s level of 
satisfaction with the employee was obtained (satisfaction scores ranged from 0 to 10, 
with higher scores indicating greater satisfaction). The data are in the file Chapter 
13_Exercise 3.sav in the Chapter 13 folder online at www.routledgetextbooks.com/
textbooks/9780205735822 (the variables are named agreeableness and satisfaction). 
Open the file in SPSS and perform the appropriate analyses to answer the questions 
below.
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is the predictor significant? Test using 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write a regression equation for the data.
f. Write the results of the study using APA format as appropriate.

a = .05.

a = .05.
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Multiple linear regression is used when the objective is to predict scores on one variable using
scores from two or more different variables.1 In multiple regression, the variable that is being

predicted is known as the dependent or criterion variable, and the variables that are used to predict
the dependent variable are known as the independent or predictor variables. An example in which
multiple linear regression may be used is presented next.

Example
For a project in a research methods class, a student wanted to investigate whether connectedness,
optimism, and academic success were predictive of meaning in life in college students. Thirty students
who agreed to participate in the study were administered the four measures, which are described in
Figure 14.1 on page 178.

Objective and Data Requirements of Multiple Regression

14
CHAPTER

Multiple Linear Regression

Multiple Linear Regression

Objective Data Requirements Example

To predict the scores on a 
dependent variable using 
scores on two or more 
independent variables.

Dependent variable
• Continuous

Independent variables

• Continuous or categorical2

Dependent variable
• Meaning in life

Independent variables

• Optimism

• Connectedness

• Academic success

Null and Alternative Hypotheses
In multiple regression, there are separate null and alternative hypotheses for each predictor (inde-
pendent) variable. A regression equation is created (the equation will be introduced later), and the
regression weight for each predictor (known as a beta weight) is tested to see whether it is signifi-
cantly different from zero. A beta weight significantly different from zero indicates that the inde-
pendent variable is a significant predictor of the dependent variable. The population symbol for the
regression coefficient is given by the Greek letter, or beta.

The null hypothesis for each of the predictors is that the beta weight is equal to zero:

(H.1) (The beta weight of connect is equal to zero; connect 
does not predict meaning in life.)

H0 : bconnect = 0

b,
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Scale What it measures Scale range 

Meaning in life
(meaning)

The degree of meaning one
currently finds in life.

10–70; higher scores
indicate greater meaning
in life. 

Connectedness
(connect) 

How connected one feels to
others; the degree to which
one may turn to others for
support.

8–40; higher scores
indicate greater perceived
support from others.

Optimism (optimism) How optimistic one is about
their life.

10–50; higher scores
indicate greater optimism.

Academic success
(success)

The degree to which a
person has achieved
academic success in their life.

5–25; higher scores
indicate greater academic
success.

Figure 14.1 Description of the measures used in the multiple regression
example.

(H.2) (The beta weight of optimism is equal to zero; optimism
does not predict meaning in life.)

(H.3) (The beta weight of success is equal to zero; success does
not predict meaning in life.)

The alternative hypothesis for each of the predictors is that the beta weight is not equal to zero:

(The beta weight of connect is not equal to zero; connect 
predicts meaning in life.)

(The beta weight of optimism is not equal to zero; optimism 
predicts meaning in life.)

(The beta weight of success is not equal to zero; success 
predicts meaning in life.)

In addition to testing the individual predictors for significance, another hypothesis in multi-
ple regression is whether the regression equation, with all the predictors included, significantly pre-
dicts the dependent variable. If the regression equation is significant, the predictors (taken together)
account for a significant amount of variance in meaning in life scores (i.e., they predict meaning
in life). A measure of the amount of variance accounted for is given by (which ranges from
0 to 1), with an indicating that no variance in meaning in life scores is accounted for by
the predictors, and a indicating that all of the variance is accounted for by the predictors
(in practice usually falls somewhere between 0 and 1).

The null hypothesis states that the predictors (taken as a whole) do not account for any variance
in meaning in life scores in the population (i.e., they do not predict meaning in life):

(H.4)

The alternative hypothesis states that the predictors (taken as a whole) account for variance
in meaning in life scores in the population (i.e., they predict meaning in life):

Evaluation of the Null Hypothesis

The multiple regression procedure in SPSS provides tests of the null hypotheses that each of the
predictors individually (hypotheses H.1, H.2, and H.3) and combined (hypothesis H.4) do not pre-
dict meaning in life. If, for a given test of interest, the test produces results that seem unlikely if
the null hypothesis is true (results that occur less than 5% of the time), the null hypothesis is
rejected. If the test produces results that seem fairly likely if the null hypothesis is true (results that
occur greater than 5% of the time), the null hypothesis is not rejected.

H1 : R2
7 0

H0 : R2
= 0

R2
R2

= 1
R2

= 0
R2

H1 : bsuccess Z 0

H1 : boptimism Z 0

H1 : bconnect Z 0

H0 : bsuccess = 0

H0 : boptimism = 0
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Research Questions
The fundamental questions of interest in a research study can also be expressed in the form of
research questions, such as,

Individual predictors (hypotheses H.1, H.2, and H.3)

“Does connectedness predict meaning in life?”
“Does optimism predict meaning in life?”
“Does academic success predict meaning in life?”

All predictors simultaneously (hypothesis H.4)

“When taken together, do connectedness, optimism, and academic success predict
meaning in life?”

The Data

The meaning in life (meaning), connectedness (connect), optimism (optimism), and academic
success (success) scores for the 30 participants are presented in Figure 14.2.

Participant

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15

Meaning

34
62
54
59
28
31
64
57
26
44
62
54
59
68
36

Connect

25
41
38
36
18
28
25
22
19
27
31
25
24
28
31

Optimism

14
35
40
35
32
15
35
45
32
23
47
50
35
31
17

Success 

12
20
18
17
15
18
22
24
21
12
17
20
14
16
19

Participant 

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

Meaning

54
68
53
33
45
25
61
53
22
40
50
32
55
35
52

Connect

36
37
29
20
21
29
38
21
21
25
25
16
30
19
21

Optimism

29
42
46
23
27
32
39
30
18
30
41
17
34
22
42

Success 

18
22
15
14
11
7

22
17
11
16
18
12
21
7
13

Figure 14.2 The data for the multiple regression example. (Note: The participant variable is included for illustration
but will not be entered into SPSS.)

Data Entry and Analysis in SPSS
Steps 1 and 2 below describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name meaning in life.sav in 
the Chapter 14 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, four variables will be created, one for the criterion variable (meaning in life) and one for
each of the predictors (connectedness, optimism, and success). The variables will be named
meaning, connect, optimism, and success, respectively.

3. Enter the variable names meaning, connect, optimism, and success, respectively,
in the first four rows of the Variable View window (see Figure 14.3 on page 180).
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Step 2: Enter the Data

1. Click the Data View tab. The variables meaning, connect, optimism, and success
appear in the first four columns of the Data View window.

2. Consulting Figure 14.2, enter the scores for each of the participants on the four
variables of interest. For the first participant, enter the scores 34, 25, 14, and 12,
on the variables meaning, connect, optimism, and success, respectively. Using
this approach, enter the data for all 30 participants. The completed dataset is
presented in Figure 14.4.

Figure 14.3 The Variable View window with the variables meaning, connect, optimism, and
success entered.

Figure 14.4 The completed data file for multiple regression example.

M14_YOCK5822_02_SE_C14.qxd  11/4/10  10:34 AM  Page 180



Chapter 14 / Multiple Linear Regression 181

Step 3: Analyze the Data

1. From the menu bar, select 
(see Figure 14.5).

Analyze>Regression>Linear Á

Figure 14.5 Menu commands for the multiple regression procedure.

A Linear Regression dialog box appears with the variables meaning, connect, optimism, and
success in the left-hand side of the dialog box (see Figure 14.6).

Figure 14.6 The Linear Regression dialog box.

2. Select the dependent variable, meaning, and click the upper right-arrow button
( ) to move it into the Dependent box.

3. With the Ctrl key held down, select the independent variables connect, optimism,
and success and click the second right-arrow button ( ) from the top to move
them into the Independent(s) box. See Figure 14.7 on page 182 for details.
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4. Click the Statistics button. The Linear Regression: Statistics dialog box opens.
Select Descriptives (Estimates and Model fit should already be selected). See
Figure 14.8 for details.

Figure 14.7 The Linear Regression dialog box (continued).

Figure 14.8 The Linear Regression: Statistics dialog box.
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Regression 
Descriptive Statistics

47.2000 13.90212 30

26.8667 6.76570 30

31.9333 10.02044 30

16.3000 4.38768 30

meaning

connect

optimism

success

Mean Std. Deviation N

Correlations

1.000 .561 .663 .555

.561 1.000 .307 .425

.663 .307 1.000 .474

.555 .425 .474 1.000

. .001 .000 .001

.001 . .050 .010

.000 .050 . .004

.001 .010 .004 .

30 30 30 30

30 30 30 30

30 30 30 30

30 30 30 30

meaning

connect

optimism

success

meaning

connect

optimism

success

meaning

connect

optimism

success

Pearson Correlation

Sig. (1-tailed)

N

meaning connect optimism success

The correlation between the
predictors and the criterion
variable (meaning in life).

(continued)

5. Click Continue.
6. Click OK.

The multiple regression procedure runs in SPSS and the results are presented in the Viewer
window.

Step 4: Interpret the Results

The output of the multiple linear regression procedure is displayed in Figure 14.9.

Descriptive Statistics
The Descriptive Statistics table displays the mean, standard deviation, and sample size for each
of the variables.

Correlations
The Correlations table displays the bivariate correlations (i.e., the correlation between two vari-
ables) for all the variables included in the study (for a review of correlation, see Chapter 12).
Ideally, each of the predictors will correlate moderately to highly with the criterion variable (higher
correlation tends to lead to better prediction), and the predictors will not correlate too highly with
each other (low correlations among the predictors allows them to make relatively unique contri-
butions in predicting the dependent variable).3 The Correlations table shows that all correlations
between the predictors and the criterion are significant (all have ), with the high-
est correlation between meaning and optimism (.66), and the lowest correlation between meaning
and success (.56). The predictors are moderately correlated with each other, with values ranging
from .31 to .47.

p-values 6 .05
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Figure 14.9 The output for the multiple linear regression procedure.

ANOVAb

3394.295 3 1131.432 13.308 .000a

2210.505 26 85.019

5604.800 29

Regression

Residual

Total

Model
1

Sum of
Squares df Mean Square F Sig.

a. Predictors: (Constant), success, connect, optimism
b. Dependent Variable: meaning

Coefficientsa

–1.971 8.281 –.238 .814

.691 .282 .336 2.449 .021

.653 .196 .470 3.334 .003

.599 .470 .189 1.274 .214

(Constant)

connect

optimism

success

Model
1

B Std. Error

Unstandardized
Coefficients

Beta

Standardized
Coefficients

t Sig.

a. Dependent Variable: meaning 

Both connect and
optimism are
significant, since
their p–values are
less than .05. They
both account for a
significant amount
of unique variance
in meaning scores.

Since the p–value is
less than .05, the
overall regression
model (with all
predictors included) is
significant. The
predictors collectively
account for a
significant amount of
variance in meaning in
life scores.

Variables Entered/Removedb

success,
connect,
optimisma

. Enter

Model
1

Variables
Entered

Variables
Removed Method

a. All requested variables entered.
b. Dependent Variable: meaning

Model Summary

.778a .606 .560 9.22060

Model

1

R R Square
Adjusted
R Square

Std. Error of
the Estimate

a. Predictors: (Constant), success, connect, optimism

The predictors account for 61% of
the variance in meaning in life scores.

Variables Entered/Removed
The Variables Entered/Removed table summarizes the variables that were used to predict mean-
ing in life. Notice that all of the predictors (success, connect, and optimism) are displayed in the
Variables Entered box. A note below the table reads “all requested variables entered,” which indi-
cates that all predictors were included simultaneously in the regression model. Alternative pro-
cedures exist that allow for a subset of the predictors to enter the regression model first, followed
by other predictors second, and so on. One of the more popular of these procedures is hierarchi-
cal regression, which allows predictors to be entered in an order specified by the user. With hier-
archical regression, one or more predictors have the “first shot” at predicting the criterion variable,
one or more other predictors have the “second shot,” and so on.4

Model Summary
The Model Summary table displays R, (R–Square), Adjusted and the standard error of
the estimate. The first three of these values measure the degree to which meaning in life was
predicted from the three independent variables and the last value measures the degree to which
meaning in life was not predicted from the three variables. Each of these values is discussed
below.

R2,R2
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The first value, R, is known as the multiple correlation coefficient, and it is equal to the absolute
value of the correlation between the original meaning in life scores and the predicted meaning in
life scores from the regression analysis (R ranges from 0 to 1). The second value, is the square
of and, when multiplied by 100%, is interpreted as the percentage of total variance
in the dependent variable that is accounted for by the independent variables. In the current exam-
ple, the variables connect, optimism, and success account for of the variance
in meaning in life scores. Adjusted modifies the value of in an attempt to better estimate the
true population value ( calculated on the sample tends to overestimate the population value).
Finally, the standard error of the estimate indicates the degree to which the independent variables
were unable to predict scores on the dependent variable. The value of 9.2206 indicates that, when
using the variables connect, optimism, and success to predict meaning in life, the regression equa-
tion was “off” in predicting meaning in life scores by about 9.22 points on average.

ANOVA—Testing the Overall Regression for Significance
The next table, ANOVA, tests whether the regression model, with all of the predictors included,
significantly predicts meaning in life (which is analogous to a test of whether is significantly
greater than zero). This test is conducted using an analysis of variance (ANOVA), which was dis-
cussed in Chapter 8. In the ANOVA table, a p-value less than or equal to .05 indicates that the
regression model, with all the predictors included, significantly predicts meaning in life scores.
Since the p-value of .000 (which should be read as “less than .001”) is less than .05, the null
hypothesis that is rejected, and it is concluded that the regression model (with the three
predictors included) significantly predicts meaning in life.

Coefficients—Testing the Individual Predictors for Significance
The last table, Coefficients, provides the necessary values to construct a regression equation and
test each of the predictors for significance.

The regression equation will be discussed first, followed by the test of whether connect,
optimism, and success are significant predictors of meaning in life.

In multiple regression, an equation is created in the form of

Where

predicted score on the dependent variable. In our example, corresponds to 
the predicted meaning in life scores.

Y-intercept; the value of when all 
regression coefficient for the ith predictor. In this example, i takes on the 

values of 1, 2, or 3 for the first (connect), second (optimism), and third 
(success) predictors, respectively.

score on the ith predictor (independent variable) for the participants. In this 
example, i takes on the values of 1, 2, and 3 for the first, second, and third 
predictors, respectively.

The regression equation can be extended for as many predictors as are included in the regres-
sion model. For example, if a fourth predictor was included, would be added to the above
equation.

The values in the regression equation, a (the Y-intercept; called “constant” in SPSS) and
and (the regression coefficients for each of the predictors), are found in the Coefficients

table in the Unstandardized Coefficients column heading labeled “B.” In the Coefficients table, the
value of the Y-intercept is and the coefficients of connect, optimism, and success are
.691, .653, and .599, respectively. Substituting these values into the regression equation formula
produces the following equation for predicting meaning in life scores:

YNmeaning in life = -1.971 + .6911connect2 + .6531optimism2 + .5991success2

-1.971

b3b1 , b2 ,

+b4X4

 Xi = the

 bi = the
Xs = 0.YN a = the

YN YN = the

YN = a + b1X1 + b2X2 + b3X3

R2
7 0

R2

R2
R2R2

61% 1.61 * 100%2

R 1.7782
L .612

R2,
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This is the regression equation based on the scores of the 30 college students. Given an indi-
vidual’s score on the three predictors, a predicted meaning in life score can be found. For exam-
ple, the first participant had connect, optimism, and success scores of 25, 14, and 12, respectively.
Inserting these scores into the equation yields a predicted meaning in life score of

A predicted score can be found using this method for each individual in the dataset.5 The pre-
dicted scores will almost always have some error (they will not match the actual scores exactly);
the higher the value of R, the more closely the predicted values will be to the actual values, with
an R of 1 resulting in perfect prediction (the predicted scores would match the actual scores exactly).

Interpreting the Direction of the Regression Coefficients

The fact that the regression weights for each of the predictors are positive (.691, .653, and .599)
means, for example, that a one-point increase in connect (e.g., moving from 25 to 26) would
result in a .691 point predicted increase in meaning in life scores, assuming all other predictors
were held constant. A negative regression weight has the opposite interpretation, that is, a one-point
increase in the predictor would result in a decrease of the predicted score by the value of the
regression weight, assuming all other predictors were held constant. It is important to emphasize
that this interpretation of the regression coefficient hinges on the scores of all other predictors
being held constant, which in practice is unlikely, as a person who has higher academic perfor-
mance would also tend to be more optimistic, etc. (i.e., the predictors are correlated).

Testing Each of the Predictors for Significance

A test of each of the predictors may be found in the Coefficients table. The last two columns of
the table present t and p-values for each of the predictors. In the Coefficients table, both connect

and optimism are significant, since their p-values
are less than .05. Success, on other hand, is not significant, since its p-value of .214 is greater
than .05.

Notice the column labeled Standardized Coefficients in the Coefficients table. While the unstan-
dardized coefficients were used in finding predicted scores, the standardized coefficients will be pre-
sented in the write-up of the results. The standardized coefficients are referred to as beta weights
and are equal to the value of the regression coefficients if the predictors and the criterion were in
z-score form (i.e., if they were standardized with a mean of zero and a standard deviation of 1).6

While in most cases the constant is not of interest in multiple regression, the test of the
constant reported in the Coefficients table is a test of whether the Y-intercept is significantly dif-
ferent from zero. In this case, the value of is not significantly different from zero since
the p-value for the test (.814) is greater than .05.

Effect Sizes
Measures of effect size in regression are given by Cohen (1988) expressed values of .02,
.13, and .26 as corresponding to small, medium, and large effect sizes, respectively. In the above
example, an of .61 would be considered to be a very large effect in practice, indicating that the
predictors accounted for 61% of the variance in meaning in life scores.

Expression of the Results in APA Format
In the write-up of the results for multiple regression, both the test of the regression model with
all the predictors included (including and the results of the ANOVA test) and the test of theR2

R2

R2R2.

-1.971

1t = 3.334, p = .00321t = 2.449, p = .0212

 YNMeaning in life = 31.634

 YNMeaning in life = -1.971 + .6911252 + .6531142 + .5991122
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individual predictors (including beta, the t value and the p-value) will be provided. A sample
write-up is presented next.

Written Results

A multiple regression was conducted predicting meaning in life from the variables connectedness,
optimism, and academic success. Overall, the regression was significant, 

Of the predictors investigated, both connectedness 
and optimism were significant.

Academic success was not a significant predictor of meaning in life, 
(Note: The degrees of freedom for each of the t tests in multiple regression are equal to N-

p-1, where number of predictors and N = number of participants in the study.)

Assumptions in Multiple Regression
1. Independence of observations between the participants.

Independence of observations means that the scores for each of the participants
are independent of one another (the participants shouldn’t influence each other in
completing the measures). Violating this assumption can seriously compromise
the accuracy of the statistical tests performed using the multiple regression proce-
dure. If there is reason to believe the independence assumption has been violated,
the multiple regression procedure should not be used.

2. The variables are distributed multivariate normal in the population.
This assumption means that each variable should be both normally distributed on
its own and for all possible combinations of the other variables (e.g., the success
scores should be normally distributed for all possible score combinations on
meaning, connect, and optimism). For moderate to large sample sizes, most types
of nonnormal data tend to have relatively little impact on the accuracy of the mul-
tiple regression procedure.

3. Homoscedasticity.
Homoscedasticity means that the variances on the dependent variable are equal in
the population for all possible combinations of levels of the independent variables.
Mild to moderate violations of this assumption are generally tolerable in multiple
regression.7

Summary of Steps for Conducting a Multiple Regression
Analysis in SPSS

I. Data Entry and Analysis
1. Create a separate variable in SPSS for each predictor and for the criterion.

2. Enter the data.

3. Select 

4. Move the independent variables and the dependent variable to their respective
boxes.

5. Click Statistics. Select Descriptives (Estimates and Model fit should already be
selected). Click Continue.

6. Click OK.

II. Interpretation of the Results
1. In the chapter description, all the tables (Descriptive Statistics, Correlations,

Variables Entered/Removed, Model Summary, ANOVA, and Coefficients) were
described. In this summary, only information from the Model Summary,
ANOVA, and Coefficients tables will be described.

Analyze>Regression>Linear Á .

p = the

b = .19, t1262 = 1.27, p 7 .05.
1b = .47, t1262 = 3.33, p 6 .052t1262 = 2.45, p 7 .052

1b = .34,= 13.31, p 6 .05, R2
= .61.

F13, 262
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a. Note the value of in the Model Summary table. In the ANOVA table, if
the null hypothesis that is rejected, indicating that the

regression model (with all the predictors included) accounts for a signifi-
cant amount of variance in the dependent variable.

b. In the Coefficients table, examine the p-value for each of the predictors.

• If one or more of the predictors is significant the null hypoth-
esis that the beta weight is zero for the predictor(s) of interest is rejected.
Write the results indicating the variable(s) that significantly predict(s) the
criterion variable. Indicate any nonsignificant predictors as well.

• If none of the predictors are significant ( for each of the predictors
in the Coefficients table), the null hypothesis that the beta weight is zero
for each of the predictors is not rejected. Write the results indicating that
the predictor variables do not significantly predict the criterion variable.

Exercises

1. An industrial psychologist examined predictors of job satisfaction among 
30 employees of different companies. The predictors investigated included the
importance of work (importance), the opportunity for advancement in the com-
pany (advance), and the ability to express ideas to the boss (express). The crite-
rion variable is job satisfaction (satisfaction). Higher scores on each of the
variables indicate higher levels of the characteristic of interest (e.g., higher scores
on satisfaction indicate greater satisfaction with one’s job). The data are provided
in Figure 14.10.

p 7 .05

1p … .052,

R2
7 0p … .05,

R2

Satisfaction Importance Advance Express 
12 18 
22 20 
17 12 
25 12 
10 17 
30 15 
20 19 
9 17 

18 23 
14 11 
16 15 
29 17 
24 17 
23 17 
21 25 
13 22 
22 18 
10 20 
21 21 
21 8 
18 17 
31 15 
25 15 
21 19 
27 15 
19 18 
19 21 
15 17 

35 20
48 24
22 10
38 8
33 20
45 15
30 12
38 22
45 21
23 12
13 8
41 21
33 15
40 21
48 19
45 18
23 10
45 15
27 22
12 12
12 6
41 22
29 17
42 19
30 20
39 24
42 22
46 19
25 8 21 19 
41 17 12 23

Figure 14.10 The data for Exercise 1.
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Enter the data in SPSS and perform the appropriate analyses to answer the
questions below. Name the variables satisfaction, importance, advance, and
express, respectively.
a. State the null and alternative hypotheses for the individual predictors.
b. State the null and alternative hypothesis for the overall regression model.
c. Write a research question for each of the predictors and for the overall regres-

sion model.
d. What is for the model? Is the overall model significant?
e. Which, if any, of the predictors are significant? Which, if any, predictors are

not significant?
f. What is the effect size for the overall regression model? Would you character-

ize the effect size as small, medium, or large?
g. Write a regression equation for the data.
h. Write the results using APA format as appropriate.

2. A researcher was interested in predicting happiness from the variables forgiveness
and social support. Twenty-five people who agreed to participate in the study were
administered the three measures of interest, which are described in Figure 14.11.

R2

Happiness
(happiness)

Forgiveness
(forgiveness)

Social Support
(support)

The level of happiness one currently
finds in life.

The degree to which one can forgive
others.

The degree to which one feels they
can turn to others for support.

Measure What It Measures Scale Range 

7–35; higher scores indicate
greater happiness. 

10–50; higher scores
indicate a greater
willingness to forgive.

5–25; higher scores indicate
a stronger support network.

Figure 14.11 The variables for Exercise 2.

Fear of death
(feardeath)

Well-being
(wellbeing)

Meaning in life
(meaning)

The degree of fear one
has toward death.

The level of well-being
one currently has in life.

The degree of meaning
one currently finds in life.

Measure What It Measures Scale Range

8–48; higher scores indicate
greater fear of death.

5–40; higher scores indicate
greater well-being.

30–70; higher scores indicate
more meaning in life.

Figure 14.12 The variables for Exercise 3.

The data are provided in the file Chapter 14_Exercise 2.sav in the Chapter 14 
folder on the web at www.routledgetextbooks.com/textbooks/9780205735822. Open the 
file in SPSS and perform the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses for the individual predictors.
b. State the null and alternative hypothesis for the overall regression model.
c. Write a research question for each of the predictors and for the overall regres-

sion model.
d. What is for the model? Is the overall model significant?
e. Which, if any, of the predictors are significant? Which, if any, predictors are

not significant?
f. What is the effect size for the overall regression model? Would you character-

ize the effect size as small, medium, or large?
g. Write a regression equation for the data.
h. Write the results using APA format as appropriate.

3. A researcher was interested in predicting fear of death from the variables well-
being and meaning in life. Fifty people who agreed to participate in the study
were administered scales measuring each of the three variables, which are
described in Figure 14.12.

R2
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The data are provided in the file Chapter 14_Exercise 3.sav in the Chapter 14 
folder on the web at www.routledgetextbooks.com/textbooks/9780205735822. Open the 
data file in SPSS and perform the appropriate analyses to answer the questions below.
a. State the null and alternative hypotheses for the individual predictors.
b. State the null and alternative hypothesis for the overall regression model.
c. Write a research question for each of the predictors and for the overall regres-

sion model.
d. What is for the model? Is the overall significant model?
e. Which, if any, of the predictors are significant? Which, if any, predictors are

not significant?
f. What is the effect size for the overall regression model? Would you characterize

the effect size as small, medium, or large?
g. Write a regression equation for the data.
h. Write the results using APA format as appropriate.

R2

M14_YOCK5822_02_SE_C14.qxd  11/4/10  10:34 AM  Page 190



191

The chi-square goodness of fit procedure tests whether the proportion (or frequency) of cases that
fall within each category of a variable are consistent with the proportions (or frequencies) spec-

ified under the null hypothesis. An example in which the chi-square goodness of fit test may be used
is presented next.

Example
A student interested in social psychology wanted to investigate whether perceived responsibility var-
ied as a function of group size (i.e., are people held more or less responsible for an action based
solely on the size of the group they are in?). Ninety college students participated in the study and were
described three scenarios in which a woman was in need of help, with the scenarios differing only
by the number of people available nearby to help the woman. In the three scenarios, the group sizes
consisted of 1 person, 5 people, and 25 people. In all three scenarios, the participants were told no
one helped the woman. When the scenarios were described, the participants were asked to consider
a single person in each of the groups and to indicate in which of the three scenarios the individual
was most responsible for failing to help the woman (they were instructed to choose only one of the
three scenarios).

Objective and Data Requirements of the Chi-Square 
Goodness of Fit Test

15
CHAPTER

The Chi-Square Goodness of Fit Test

The Chi-Square Goodness of Fit Test

Objective Data Requirements Example

To test whether the 
proportions (or frequencies) 
in the sample differ 
significantly from the 
proportions (or frequencies) 
specified under the null 
hypothesis.

One categorical variable with 
two or more categories. Each 
participant provides a frequency
(by falling in one of the 
categories).

Categorical Variable
• Group size (1, 5, 25).

Null and Alternative Hypotheses
The null hypothesis states that perceived responsibility does not vary as a function of group size,
which would imply an equal proportion of cases (or number of people) in each of the three categories:

of people who choose each category is equal in the population2.
H0 : Perceived responsibility does not vary by group size 1the proportion or number 
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The alternative hypothesis states that perceived responsibility varies by group size, which
would imply an unequal proportion of cases (or number of people) in the three categories:

Evaluation of the Null Hypothesis

The chi-square goodness of fit tests whether the proportions in each of the categories are equal to
those specified in the null hypothesis. If the test produces results that seem unlikely if the null
hypothesis is true (results that occur less than 5% of the time), then the null hypothesis is rejected.
If the test produces results that seem fairly likely if the null hypothesis is true (results that occur
greater than 5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Does perceived responsibility vary by group size?”

The Data

The data for the 90 participants are presented in Figure 15.1. Of the 90 participants, 42 chose the
1-person category as the most responsible, 30 chose the 5-person category, and 18 chose the 25-
person category as the most responsible. These data are often referred to as observed frequencies,
since they were observed in the study.

of people who choose each category is not equal in the population2.
H1 : Perceived responsibility varies by group size 1the proportion or number 

One person (alone) 5 person 25 person

42 1830

Figure 15.1 The number of participants who chose the 1-person, 5-person,
and 25-person categories as most responsible (i.e., the observed frequencies).

One person (alone) 5 person 25 person

1/3 1/31/3

Figure 15.2 The proportion of participants expected to choose
each category if the null hypothesis is true.

The chi-square goodness of fit test compares the frequencies observed in the study (those
shown in Figure 15.1) to the frequencies that are expected under the null hypothesis (called the
expected frequencies). To determine the expected frequencies, first we’ll need to find the propor-
tion of people expected to choose each of the categories if the null hypothesis is true. Since the
null hypothesis states that perceived responsibility does not vary for the different group sizes, we
would expect an equal proportion of people to select each category. With three categories, one-
third of the participants should select each category, as is shown in Figure 15.2 below.

Once the proportions are determined for each of the categories, they are converted into
expected frequencies by multiplying each proportion by the total sample size (N) in the study.

The formula for generating the expected frequency for each of the categories is provided as
follows:

category2 * 1N2
Expected frequency for a category = 1proportion of cases expected in that 
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Applying this formula to each of the categories produces the following expected frequencies:

The expected frequencies for the three categories are summarized in Figure 15.3.

Expected frequency in “25-person” category = 11/32 * 90 = 30.
Expected frequency in “5-person” category = 11/32 * 90 = 30.
Expected frequency in “1-person” category = 11/32 * 90 = 30.

One person (alone) 5 person 25 person

30 3030

Figure 15.3 The number of people expected to fall within each category if
the null hypothesis is true (the expected frequencies).

The chi-square goodness of fit test compares the observed frequencies in Figure 15.1 to the
expected frequencies in Figure 15.3. In general, the greater the discrepancy between the observed
and expected frequencies, the more likely the null hypothesis will be rejected.1

Before entering the data into SPSS, we’ll discuss two different methods of data entry for the
chi-square procedure. The two methods differ in how the data file is structured and will be referred
to as the weight cases and the individual observations methods of data entry. These methods are
described next.

Weight Cases Method
With the weight cases method of data entry, the number of rows required in the Data View window
is equal to the number of categories for the variable of interest (in this example there would be
three rows of data for the three different group size categories). Two variables are required in SPSS:
one for the different categories and one for the number of people falling within each category (i.e.,
the frequencies). The weight cases method is typically used when the frequencies are already tal-
lied for each of the categories (as the data are in this example; see Figure 15.1 for more details).

Individual Observations Method
With the individual observations method of data entry, the number of rows required in the Data
View window is equal to the number of people in the study (in this example there would 90 rows
of data for the 90 participants). Only one variable is required in SPSS, with a participant receiv-
ing a given value (e.g., 1, 2, or 3) for falling in a particular category. This approach is most use-
ful when the frequencies have not already been tallied in each of the categories but instead are
entered directly, such as from an instrument or a survey form.

The features of the weight cases and individual observations methods of data entry are sum-
marized in Figure 15.4.

Method 

Weight cases 

Individual
observations

Number of variables
required in SPSS

Two — one for the
different categories
and one for the
frequencies

One — for the
different categories

Number of rows of 
data required in the 
Data View window

Equal to the number
of categories of the
variable (in our
example, 3)

Equal to the number of
participants in the study
(in our example, 90)

When to use 

When the data are
provided in
summarized form
(e.g., see Figure 15.1)

When the data have not
already been summarized
(e.g., entering data from
surveys)

Figure 15.4 Features of the weight cases and individual observations methods of data entry for
the chi-square goodness of fit procedure.

Since the data are already tallied for each of the categories (as is shown in Figure 15.1), we’ll
use the weight cases method of data entry, which will require two variables to be entered in SPSS.
(For those who prefer to use the individual observations method of data entry, a description of how
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to structure the data file using this method is provided in Figure 15.7 and an example may be
found in Exercise 2 in the end-of-chapter exercises.)

Data Entry and Analysis in SPSS
Steps 1 and 2 describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name no help.sav in the 
Chapter 15 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, two variables will be created, one for the different group size categories (i.e., 1, 5,
and 25) and one for the frequencies (i.e., the number of people who chose each group size as most
responsible). The variables will be named groupsize and frequency, respectively.

3. Enter the name groupsize and frequency in the first two rows of the Variable
View window (see Figure 15.5).

Figure 15.5 The Variable View window with the variables groupsize and frequency entered.

Next, we’ll create value labels for the different categories in our study. We’ll assign the
1-person category a 1, the 5-person category a 2, and the 25-person category a 3.

4. Using the process described in Chapter 1, create value labels for the variable
groupsize. For groupsize, and 

Step 2: Enter the Data

1. Click the Data View tab. The variables groupsize and frequency appear in the
first two columns of the Data View window.

Since we’re using the weight cases method of data entry, we’ll need to create a separate row
in the data file for each of the three conditions in our study. The structuring of the data file using
the weight cases method is illustrated in Figure 15.6.

Inspecting Figure 15.6, we’ll enter three rows of data in SPSS, with each row corresponding
to a different category in our study.

To enter the data

1. In the first row of the Data View window, enter a 1 and 42 for the variables
groupsize and frequency, respectively. In row 2, enter a 2 and 30 for groupsize
and frequency, respectively, and in row 3, enter a 3 and 18. The completed data
set is presented in Figure 15.7.

3 = “25 person.”1 = “1 person,” 2 = “5 person,”
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Step 3: Analyze the Data

Prior to running the chi-square analysis, we’ll first need to weight the cases for frequency.2

Weighting the cases indicates that the values for a given variable represent the total number
of observations as opposed to a single score. For example, when frequency is weighted, this
indicates in SPSS that the value of 42 in the first category corresponds to 42 people, not a
score of 42.

To weight the cases for frequency

1. From the menu bar, select (see Figure 15.8 on 
page 196).

2. The Weight Cases dialog box opens. Select Weight cases by and select the vari-
able, frequency. Click the right-arrow button ( ) to move frequency into the
Frequency Variable box (see Figure 15.9 on page 196).

3. Click OK. This indicates that the frequency values (42, 30, and 18) correspond to
the total number of people in each category, not a single score.3

With the cases weighted for frequency, we can now perform the chi-square goodness of fit
test in SPSS.

Data>Weight Cases Á

Groupsize Frequency

1 42
2 30
3 18

Figure 15.6 The values for
groupsize and frequency
using the weight cases
method of data entry. For
groupsize, 1 corresponds to
the 1-person category, 2
corresponds to the 5-person
category, and 3 corresponds
to the 25-person category.

If the individual observations method of data
entry was used, a single variable would have
been created (groupsize) consisting of 90 rows
of data (one row for each person in the study).
Forty–two rows would have a value of 1 (for
the one person group), 30 rows would have a
value of 2 (for the 5 person group), and 18
rows would have a value of 3 (for the 25
person group). The cases would not be
weighted in SPSS for this method of data
entry (weighting of cases is described next).

Using the weight cases method
of data entry, two variables are
created, one to indicate the
different categories (groupsize)
and one for the frequencies
(frequency).

Figure 15.7 The completed data file for the chi-square goodness of fit example.
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Figure 15.8 Menu commands for the Weight Cases procedure.

Figure 15.9 The Weight Cases dialog box.

1. From the menu bar, select 
(see Figure 15.10). (Note: If you are using SPSS 

version 17.0 or earlier, the menu commands are 
All other commands remain the same.)

A Chi-Square dialog box appears with the variables groupsize and frequency in the left-
hand side of the box (see Figure 15.11).

2. Select the variable, groupsize, and click the right-arrow button ( ) to move it
into the Test Variable List box (see Figure 15.12 on page 198). (Note: Frequency
should remain on the left-hand side of the dialog box.)

3. Click OK.

Tests>Chi-square Á .
Analyze>Nonparametric 

Dialogs>Chi-square Á

Analyze>Nonparametric Tests>Legacy 
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‘Weight On’ indicates that the
cases have been weighted.

Figure 15.10 Menu commands for the chi-square goodness of fit procedure.

Figure 15.11 The Chi-Square Test dialog box.
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Figure 15.12 The Chi-Square Test dialog box (continued).

The chi-square goodness of fit test runs and the results are presented in the Viewer window.

Step 4: Interpret the Results

The output of the chi-square goodness of fit procedure is displayed in Figure 15.13.

NPar Tests 

Chi–Square Test 

Frequencies 
groupsize

42 30.0 12.0
30 30.0 .0
18 30.0 –12.0
90

1 person
5 person
25 person
Total

Observed N Expected N Residual

Test Statistics

9.600
2

.008

Chi-Squarea

df
Asymp. Sig.

groupsize

a. 0 cells (.0%) have expected frequencies less than
    5. The minimum expected cell frequency is 30.0.

Figure 15.13 Output for the chi-square goodness
of fit test procedure.
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Groupsize
The first table, labeled groupsize, reports the observed frequencies (Observed N), the expected fre-
quencies (Expected N), and the residual, or the difference between the observed and expected fre-
quencies for the 1-person, 5-person, and 25-person categories. In the table, observed frequencies
of 42, 30, and 18 are reported for the 1 person, 5 person, and 25 person categories, respectively.
An expected frequency of 30 is reported for each of the three categories, which confirms our cal-
culations for the expected frequencies shown earlier. Notice that in the residual column there is a
difference of 12 between the observed and expected frequencies for the 1-person and 25-person
categories (for the 1-person category while for the 25-person cat-
egory ). Whether the difference between the observed and expected
frequencies is large enough to be statistically significant will be considered next.

Test Statistics
The next table, Test Statistics, provides the answer to our research question, that is, whether per-
ceived responsibility varies as a function of group size. The chi-square goodness of fit test pro-
duces a chi-square statistic, which is given by

where the observed and expected frequencies correspond to the Observed N and the Expected N,
respectively, in the groupsize table. Inserting the observed and expected frequencies from the
groupsize table produces a chi-square value of

which is equal to the Chi-Square value in the Test Statistics table. The chi-square test has 2 degrees
of freedom and a p-value (reported as Asymp. Sig.) of .008.
Because the p-value is less than .05, the null hypothesis that the frequencies are equal across the
three categories is rejected, indicating that perceived responsibility varies by group size.

Since the results are significant, we’ll examine the difference between the observed and
expected frequencies in the groupsize table to determine which of the categories the participants
viewed as being most (and least) responsible for not helping. For the 1-person category, the
observed frequency was 42 while the expected frequency was 30, indicating that 12 more people
chose the 1-person category than expected. For the 5-person category, there was no difference
between the observed and expected frequencies (30 observed vs. 30 expected), while for the 25-
person category, 12 fewer people chose the category than expected (18 observed vs. 30 expected).
In summary, people chose the 1-person category more than expected and the 25-person category
less than expected (with no difference between the observed and expected categories for the
5-person category). This suggests that people perceive a greater responsibility to help others when
a person is alone as compared to being in a large group.

Expression of the Results in APA Format
In writing the results, the conclusion of the hypothesis test, the degrees of freedom, the sample size,
the chi-square value, and the p-value are reported. For significant results, the relationship between
the observed and expected frequencies should also be described. An example of a brief write-up
in APA format is presented next.

Written Results

The perceived responsibility for failing to help a person in need varied as a function of group size,
Participants rated people who are alone as most responsiblex2 12, N = 902 = 9.60, p 6 .05.

1df = the number of categories - 12,

x2
= 9.60

x2
=

142 - 3022

30
+

130 - 3022

30
+

118 - 3022

30

1x22

x2
= a

1observed frequency - expected frequency22

expected frequency

Expected N 7 Observed N
Observed N 7 Expected N,
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and those who are in large groups (25 people) as least responsible for failing to help a person in
need. The percentage of people who rated the 1-person, 5-person, and 25-person groups as being
the most responsible was 46.7%, 33.3%, and 20.0%, respectively.4

(Note: The “2” to the right of in the above results is for the degrees of freedom. The sam-
ple size is also provided in parentheses, because unlike the other procedures covered in this text,
the sample size cannot be determined from the degrees of freedom for the chi-square test.)

Assumptions of the Chi-Square Goodness of Fit Test
1. Observations are independent.

The independence assumption means that the observations (i.e., the participants) in
each of the cells are independent of each other. An example of violating this
assumption would be if a person was counted in two different cells (e.g., each par-
ticipant was asked to provide the top two scenarios where perceived responsibility is
greatest). Violating the independence assumption can seriously compromise the
accuracy of the chi-square test. If there is reason to believe the independence
assumption has been violated, the chi-square goodness of fit test should not be used.

2. The magnitude of the expected cell frequencies.
For tables with four cells (categories) or less an expected frequency of 5 or more in
each cell is recommended. For larger tables, having one or a few cells with expected
frequencies less than 5 will most likely not invalidate the results of the chi-square
procedure, although the power may suffer if the total sample size is small.

Summary of Steps for Conducting a Chi-Square 
Goodness of Fit Test in SPSS

Instructions for conducting a chi-square goodness of fit test in SPSS are provided
for both the weight cases and individual observations methods of data entry. (As
noted previously, the structuring of the data file for the individual observations
method is illustrated in Exercise 2 of the end-of-chapter exercises.)

Ia. Data Entry and Analysis—Weight Cases Method
1. Create two variables in SPSS (one for the categorical variable and one for the

frequency variable).

2. Create value labels for the categorical variable. In the Value Labels dialog box,
enter the numeric values and labels as appropriate. Click OK.

3. Enter the data. (For the weight cases method of data entry, the number of rows
in the data file is equal to the number of categories of the variable.)

4. Weight the cases for the frequency variable by selecting 

5. Select Weight cases by and move the frequency variable to the Frequency
Variable box. Click OK.

6. Select 

7. Move the categorical variable to the Test Variable List box (the frequency
variable should remain on the left).

8. Click OK.

Ib. Data Entry and Analysis—Individual Observations Method
1. Create one variable in SPSS (for the categories).

2. Create value labels for the variable. In the Value Labels dialog box, enter the
numeric values and labels as appropriate. Click OK.

3. Enter the data. (For the individual observations method of data entry, the number
of rows in the data file is equal to the number of participants in the study).

Analyze>Nonparametric Tests>Chi-Square Á .

Weight Cases Á .
Data>

x2
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4. Select 

5. Move the variable to the Test Variable List box.

6. Click OK.

II. Interpretation of the Results (the interpretation is the same regardless of
which method of data entry is used)
In the Test Statistics table, examine the p-value (shown in SPSS as Asymp. Sig.).
• If the null hypothesis is rejected. Write the results indicating the

nature of the relationship between the observed and expected frequencies.
• If the null hypothesis is not rejected. Write the results indicating that

there is not a significant difference between the observed and expected frequen-
cies (e.g., there is not a preference for any of the categories).

Exercises

1. A researcher was interested in investigating the influence of eye size on attraction.
Photos of two different people (who were determined by experts to be of similar
attractiveness and eye size) were used in the study. The photos were manipulated
prior to the study so that one of the two people in the photos had moderately
larger eyes (the photos were counterbalanced so that one person had larger eyes
for half of the participants and the other person had larger eyes for the other half
of the participants). Eighty people viewed both photos, indicating which of the
two they found more attractive. The data are presented in Figure 15.14.

p 7 .05,

p … .05,

Analyze>Nonparametric Tests>Chi-Square Á .

Large eyes 

60

Small eyes

20

Figure 15.14 The number of participants who chose each
photo as most attractive.

Enter the data into SPSS and perform the appropriate analyses to answer the
questions below. Name the variables eyesize and frequency (be sure to weight the
cases prior to analyzing the data). For eyesize, code large eyes a “1” and small
eyes a “2.”
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a preference for one of the photos? Test using 
d. Write the results using APA format as appropriate.

2. A market researcher investigated whether people perceive a difference in the pic-
ture quality of plasma and LCD televisions. Shoppers at a local warehouse store
were shown a movie trailer on both a plasma and LCD television and were asked
to indicate which of the two televisions had the better picture quality. The choices
of the 65 shoppers included in the study are provided in Figure 15.15.

a = .05.

Plasma

35

LCD 

30

Figure 15.15 The number of people who chose plasma and
LCD televisions as having the best picture quality.

The data are provided in the file Chapter 15_Exercise 2.sav in the Chapter 15 
folder online at www.routledgetextbooks.com/textbooks/9780205735822 (the 
variable is named tv with plasma televisions coded a “1” and LCD televisions 
coded a “2”). The data file

M15_YOCK5822_02_SE_C15.qxd  11/4/10  10:35 AM  Page 201



202 Unit II / Inferential Statistics

has been entered using the individual observations method (i.e., there is no need to
weight the cases for this example). Open the data in SPSS and perform the appro-
priate analyses to answer the questions below (instructions for analyzing the data
using the individual observations method are provided in the “Summary of Steps”
section prior to the chapter exercises).
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a difference in the perceived picture quality of plasma and LCD tele-

visions? Test using 
d. Write the results of the study using APA format as appropriate.

3. A marketing firm conducted a study to assess consumer preferences of differently
priced coffees. The leading brand in each category of $3-, $6-, and $10-priced
coffee (for 12 oz. of ground coffee) was selected. One hundred and fifty people
tasted the three coffee brands (without knowing the cost of each) and indicated
which coffee they preferred. The preferences of the 150 participants are shown in
Figure 15.16.

a = .05.

$3 brand 

30

$10 brand 

58

$6 brand 

62

Figure 15.16 The number of people who chose the $3, $6,
and $10 coffee brands as the best tasting.

The data are provided in the file Chapter 15_Exercise 3.sav in the Chapter 15 
folder online at www.routledgetextbooks.com/textbooks/9780205735822. (In the 
file, the variables are named cost and frequency with the $3 brand coded a “1,” 
the $6 brand coded a “2,” and the $10 brand coded a “3” for cost.) Open the data 
in SPSS and perform the appropriate analyses to answer the questions below (for 
this problem, be sure to weight the cases prior to analyzing the data).
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a preference for one (or more) of the coffees? Test using 
d. Write the results of the study using APA format as appropriate.

a = .05.
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The chi-square test of independence provides a test of whether there is a relationship between
two categorical variables, with each variable consisting of two or more categories. An example

in which the chi-square test of independence may be used is presented next.

Example
A researcher wanted to investigate whether there was a relationship between personality type
(introvert, extrovert) and choice of recreational activity (going to an amusement park, taking a one-
day retreat). Each of the 100 participants who agreed to participate in the study were adminis-
tered a personality measure and, based on their scores on that measure, were classified as either
an introvert or extrovert. Each participant was then asked to indicate which day-long recreational
activity they would prefer: going to an amusement park or on a retreat. The personality type
and choice of recreational activity for each of the participants is provided in Figure 16.1.

16
CHAPTER

The Chi-Square Test of Independence

Preferred recreational activity 

Amusement
park

Retreat Total 

Introvert 28 40
Personality type 

Extrovert 43 17 60

Total 55 45 100

12

Figure 16.1 Classification table of the 100 study participants.

In Figure 16.1, personality type is presented in the rows of the table and the preferred recre-
ational activity is presented in the columns. Of the 100 people in the study, 40 were classified as
introverts and 60 were classified as extroverts. Of the introverts, 12 preferred the amusement park and
28 preferred the retreat. Of the extroverts, 43 preferred the amusement park and 17 preferred the
retreat. The categorical variables in the study are personality type and preferred recreational activ-
ity, and the data to be analyzed are in the form of counts or frequencies. The current example is
referred to as a (read “two by two”) chi-square with two levels each for personality and
recreational activity, resulting in a total of four cells.

2 * 2
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Null and Alternative Hypotheses
The null and alternative hypotheses for the chi-square test of independence are as follows:

Evaluation of the Null Hypothesis

The chi-square test of independence provides a test of the null hypothesis that there is no rela-
tionship between personality type and choice of recreational activity. If the test produces results
that seem unlikely if the null hypothesis is true (results that occur less than 5% of the time), then
the null hypothesis is rejected. If the test produces results that seem fairly likely if the null hypoth-
esis is true (results that occur more than 5% of the time), then the null hypothesis is not rejected.

Research Question
The fundamental question of interest in a research study can also be expressed in the form of a
research question, such as,

“Is there a relationship between personality type and preferred recreational activity?”

Data Entry and Analysis in SPSS
Steps 1 and 2 below describe how to enter the data in SPSS. The data file is also on the web at 
www.routledgetextbooks.com/textbooks/9780205735822 under the name choice.sav in the 
Chapter 16 folder. If you prefer to open the file from the web site, skip to Step 3.

Step 1: Create the Variables

1. Start SPSS.
2. Click the Variable View tab.

In SPSS, three variables will be created, one for the different personality types, one for the
preferred activity, and one for the frequencies. The variables will be named personality, activity,
and frequency, respectively.

activity.
H1 : There is a relationship between personality type and choice of recreational 

activity.
H0 : There is not a relationship between personality type and choice of recreational 

Chi-Square Test of Independence

Objective Data Requirements Example

To determine if a 
relationship exists 
between two 
categorical variables.

Frequencies or counts

Two categorical variables 
with two or more 
categories each

Frequencies (the number of 
people in each cell)
Categorical variables

• Personality type (introvert,
extrovert)

• Recreational activity
(amusement park, retreat)

Objective and Data Requirements of the Chi-Square 
Test of Independence
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3. Enter the variable names personality, activity, and frequency, respectively, in the
first three rows of the Variable View window (see Figure 16.2).

Figure 16.2 The Variable View window with the variables personality, activity, and frequency entered.

Personality Activity Frequency 

12
28
43

1 1
1 2
2 1
2 2 17

Figure 16.3 The four conditions in the
study design. For personality, introverts
are assigned a “1” and extroverts are
assigned a “2.” For activity, amusement
park is assigned a “1” and retreat is
assigned a “2.”

4. Using the process described in Chapter 1, create value labels for the categorical
variables personality and activity. For personality, 

For activity, 

Step 2: Enter the Data

Next, we’ll enter the data into SPSS. There are two different methods for entering data into SPSS
for the chi-square test of independence: the weight cases method and the individual observations
method (see Chapter 15 for a description of these two methods). As was noted in Chapter 15,
the weight cases method is used when the data are provided with the frequencies already tallied
in the cells. Since the frequencies are tallied in the cells in our example (see Figure 16.1), we’ll
use the weight cases method for entering the data. (A description of how to structure the data file
using the individual observations method is provided in Figure 16.4.)

In our example, recall that introverts and extroverts can choose either the amusement park or
the retreat, resulting in four different conditions in the study (introvert/amusement park,
introvert/retreat, extrovert/amusement park, extrovert/retreat). Since we’re using the weight cases
method of data entry, we’ll need to create a separate row in the Data View window for each of these
four conditions. The proper structuring of the data file using the weight cases method is illustrated
in Figure 16.3.

1 = “amusement park” and 2 = “retreat.”“extrovert.”
1 = “introvert” and 2 =

To enter the data

1. Click the Data View tab. The variables personality, activity, and frequency
appear in the first three columns of the Data View window.

Inspecting Figure 16.3, the first condition corresponds to introverts (coded a “1”) who chose
the amusement park (also coded a “1”), of which there were 12 people total. Therefore, these
values will be entered in the first row of the Data View window.
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2. Enter the values 1, 1, and 12, for personality, activity, and frequency, respec-
tively, in the first row of the Data View window. Enter the values for the remain-
ing three conditions in rows 2 through 4 of the Data View window (i.e., enter a
1, 2, and 28 in row 2, a 2, 1, and 43 in row 3, and a 2, 2, and 17 in row 4). The
completed data file is shown in Figure 16.4.

Using the weight cases
method of data entry, three
variables are created, two for
the categorical variables (i.e.,
personality, activity) and
one for the frequencies (i.e.,
frequency).

If the individual observations method of data entry
was used, only two variables would be created
(frequency would not be created), and each person
would receive the appropriate values on
personality and activity to indicate the cell they
were in. In the current example, there would be 12
rows with values of 1 for both personality and
activity (introverts who chose the amusement park),
28 rows with values of 1 and 2, 43 rows with values
of 2 and 1, and 17 rows with values of 2 and 2 on
personality and activity, respectively (for a total of
100 rows of data). See Exercise 2 in the end–of–
chapter exercises for more details on this method
of data entry.

Figure 16.4 The completed data file for the chi-square test of independence example.

Step 3: Analyze the Data

Prior to running the chi-square test, we’ll first need to weight the cases for frequency. Weighting
the cases indicates that the values for a given variable represent the total number of observations
as opposed to a single score. For example, when frequency is weighted, a value of 12 for frequency
will be interpreted as 12 people, not a score of 12.

To weight the cases for frequency

1. From the menu bar, select (see Figure 16.5).
2. The Weight Cases dialog box opens. Select Weight cases by and select the vari-

able, frequency. Click the right-arrow button ( ) to move frequency into the
Frequency Variable box (see Figure 16.6).

3. Click OK. This indicates that the frequency values (12, 28, 43, and 17) correspond
to the total number of people in each cell, not a single score.1

With the cases weighted for frequency, now we can perform the chi-square test of indepen-
dence in SPSS.

To perform the chi-square test of independence

1. From the menu bar, select 
(see Figure 16.7 on page 208).

The Crosstabs dialog box opens with the variables personality, activity, and frequency in
the left-hand side of the box (see Figure 16.8 on page 208).

2. Select personality, and click the upper right-arrow button ( ) to move it into the
Row(s) box.

Analyze>Descriptive Statistics>Crosstabs Á

Data>Weight Cases Á

M16_YOCK5822_02_SE_C16.qxd  11/4/10  10:36 AM  Page 206



Chapter 16 / The Chi-Square Test of Independence 207

Figure 16.5 Menu commands for the Weight Cases procedure in SPSS.

Figure 16.6 The Weight Cases dialog box.

3. Select activity, and click the middle right-arrow button ( ) to move it into the
Column(s) box. See Figure 16.9 on page 208 for details. (Note: Frequency should
remain on the left-hand side of the Crosstabs dialog box.)

4. Click the Statistics button. The Crosstabs: Statistics dialog box opens. Select
Chi-square and Phi and Cramer’s V (see Figure 16.10 on page 209).

5. Click Continue.
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‘Weight On’ indicates that the
cases have been weighted.

Figure 16.7 Menu commands for the chi-square test of independence.

Figure 16.8 The Crosstabs dialog box.

Figure 16.9 The Crosstabs dialog box (continued).
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Figure 16.10 The Crosstabs: Statistics dialog box.

6. Click Cells. The Crosstabs: Cell Display dialog box opens. Under Counts select
Expected (Observed should already be selected) and under Percentages select
Row. See Figure 16.11 for details.

Figure 16.11 The Crosstabs: Cell Display dialog box.
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Crosstabs
Case Processing Summary

100 100.0% 0 .0% 100 100.0%personality *activity
N Percent N Percent N Percent

Valid Missing Total
Cases

personality * activity Crosstabulation

12 28 40
22.0 18.0 40.0

30.0% 70.0% 100.0%
43 17 60

33.0 27.0 60.0
71.7% 28.3% 100.0%

55 45 100
55.0 45.0 100.0

55.0% 45.0% 100.0%

Count
Expected Count
% within personality
Count
Expected Count
% within personality
Count
Expected Count
% within personality

introvert

extrovert

personality

Total

amusement
park retreat

activity

Total

Chi-Square Tests

16.835b 1 .000

15.194 1 .000

17.230 1 .000
.000 .000

16.667 1 .000

100

Pearson Chi-Square
Continuity Correctiona

Likelihood Ratio
Fisher's Exact Test
Linear-by-Linear
Association
N of Valid Cases

Value df
Asymp. Sig.

(2-sided)
Exact Sig.
(2-sided)

Exact Sig.
(1-sided)

a. Computed only for a 2x2 table
b. 0 cells (.0%) have expected count less than 5. The minimum expected count is 18.00.

Symmetric Measures

–.410 .000
.410 .000
100

Phi
Cramer's V

Nominal by
Nominal
N of Valid Cases

Value Approx. Sig.

a. Not assuming the null hypothesis.
b. Using the asymptotic standard error assuming the null

hypothesis.

Figure 16.12 Output for the chi-square test of independence.

7. Click Continue.
8. Click OK.

The chi-square test of independence runs in SPSS and the results are presented in the Viewer
window.

Step 4: Interpret the Results

The results of the chi-square test of independence are presented in Figure 16.12.
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Case Processing Summary
The Case Processing Summary table displays the number of valid (and missing) cases for the data
set. All 100 participants had valid observations in the data set, since everyone was classified on
both personality type and activity.

Personality activity Crosstabulation
The personality activity Crosstabulation table provides important information about the observed
and expected frequencies. The values identified as “Count” in the table consist of the observed fre-
quencies we originally entered into SPSS (i.e., 12, 28, 43, and 17), and the values labeled “Expected
Count” are the frequencies that are expected (within sampling error) if the null hypothesis is true.
If the chi-square test is significant, the discrepancy between the observed and expected frequen-
cies will be inspected to determine the nature of the relationship between the two variables.

Chi-Square Tests
While the Chi-Square Tests table provides the results of a number of different tests, the most com-
monly used is the Pearson Chi-Square. As shown in the previous chapter, the formula for the
Pearson Chi-Square statistic is

where the observed and expected frequencies correspond to Count and Expected Count, respec-
tively, in the personality activity Crosstabulation table. Inserting the observed and expected
frequencies into the chi-square formula produces a chi-square value of

which corresponds to the value of the Pearson Chi-Square reported in the Chi-Square Tests
table. The chi-square test has 1 degree of freedom 

and a p-value
(Asymp. Sig.) of .000 (read as ). Because the p-value is less than .05, the null hypothesis
is rejected, and it is concluded that a relationship exists between personality type and activity
preference.

Since the test is significant, we’ll examine the difference between the observed and expected
frequencies (the counts) in the personality activity Crosstabulation table to determine the nature
of the relationship between the two variables. Inspecting the first cell in the table (introverts who
chose the amusement park), only 12 chose the amusement park while 22 were expected to, indi-
cating that introverts chose the amusement park less frequently than expected. Moving to the
retreat column, 28 introverts chose the retreat while only 18 were expected to, indicating that
introverts chose the retreat more frequently than expected. For extroverts, the opposite pattern
exists: Extroverts chose the amusement park more often than expected (observed count of 43 vs.
an expected count of 33) and the retreat less often than expected (observed count of 17 vs. an
expected count of 27). The results are summarized in Figure 16.13.

*

6 .001
number of categories of recreational activity - 124personality - 12*1the

3df = 1the number of categories of 

x2
= 16.835

x2
=

112 - 2222

22
+

128 - 1822

18
+

143 - 3322

33
+

117 - 2722

27

*

x2
= ©

1observed frequency - expected frequency22

expected frequency

*

*

Introvert 

Extrovert 

Amusement park

Fewer chose than expected
(12 observed, 22 expected)

More chose than expected
(43 observed, 33 expected)

Retreat 

More chose than expected
(28 observed, 18 expected)

Fewer chose than expected
(17 observed, 27 expected)

Conclusion 

Introverts
preferred the

retreat

Extroverts
preferred the
amusement

park

Figure 16.13 Summary of the results for the chi-square test of independence.
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In summary, the results indicated that introverts preferred the retreat while extroverts preferred
the amusement park.

Symmetric Measures
The Symmetric Measures table will be discussed in the following section on effect sizes.

Effect Sizes
A commonly used measure of effect size for the chi-square test of independence is Cramer’s V.
The formula for Cramer’s V is

where is the value of the Pearson Chi-Square provided in the Chi-Square Tests table, N is
the total sample size in the study, and k is the number of levels of the variable with the fewest
categories.

Inserting the appropriate values from Figure 16.12 yields a value of

which agrees with the value provided in the Symmetric Measures table under Cramer’s V.
Cohen’s (1988) conventions for small, medium, and large effect sizes for Cramer’s V are .10,

.30, and .50, respectively (these effect size designations apply only to tables where at least one of
the variables has only two categories, i.e., tables, etc.). Therefore, the value
of .41 corresponds to a medium effect size, indicating a moderate relationship between the two
variables.*

Expression of the Results in APA Format
In writing the results, the conclusion of the hypothesis test, the degrees of freedom, the sample size,
the chi-square value, the p-value, and the effect size are reported. For significant results, the rela-
tionship between the observed and expected frequencies and the percentage of people falling
within each category may also be described. An example of a brief write-up in APA format is
presented next.

Written Results

There is a significant relationship between personality type and choice of recreational activity,
Cramer’s Given the choice of attending a retreat or

going to an amusement park, introverts preferred to attend the retreat (70% of the introverts chose
the retreat) while extroverts preferred the amusement park (72% of the extroverts chose the amuse-
ment park).

Assumptions of the Chi–Square Test of Independence
1. Observations are independent.

The independence assumption means that the observations in each of the cells are
independent of each other. An example of violating this assumption would be if a
person was counted in two different cells (e.g., a person was allowed to select both
recreational activities). Violating this assumption can seriously compromise the

V = .41.x2 11, N = 1002 = 16.84, p 6 .05,

2 * 2, 2 * 3, 2 * 4

V = A
16.835

10012 - 12
= .41

x2

V = B
x2

N1k - 12

*(Note: For tables only, Cramer’s V is also known as the phi coefficient, which is equal to the Pearson r correlation
coefficient between two dichotomous variables.)

2 * 2
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accuracy of the chi-square test. If there is reason to believe the independence assump-
tion has been violated, the chi-square test of independence should not be used.

2. The magnitude of the expected cell frequencies.
For small tables (tables with four cells) an expected frequency of 5 or more in
each cell is recommended. For larger tables, having one or a few cells with
expected frequencies less than 5 will most likely not invalidate the results of
the chi-square procedure, although the power may suffer if the total sample
size is small.

Summary of Steps for Conducting a Chi-Square 
Test of Independence in SPSS

Instructions for conducting a chi-square test of independence in SPSS are provided
below for both the weight cases and individual observations methods of data entry.
(As noted previously, the structuring of the data file using the individual observa-
tions method is illustrated in Exercise 2 of the end-of-chapter exercises.)

Ia. Data Entry and Analysis—Weight Cases Method
1. Create three variables in SPSS (one for each of the categorical variables and

one for the frequency variable).

2. Create value labels for each of the categorical variables. In the Value Labels
dialog box, enter the numeric values and labels as appropriate. Click OK.

3. Enter the data. (For the weight cases method of data entry, the number of rows
is equal to the multiple of the number of categories of the two variables.)

4. Weight the cases for the frequency variable by selecting 

5. Select Weight cases by and move the frequency variable to the Frequency
Variable box. Click OK.

6. Select 

7. Move one of the categorical variables to the Row(s) box and the other to the
Column(s) box. (The frequency variable should remain in the left-hand side of
the dialog box.)

8. Click Statistics. Select Chi-square and Phi and Cramer’s V. Click Continue.

9. Click Cells. Under Counts click Expected (Observed should already be
selected) and under Percentages, select Row. Click Continue.

10. Click OK.

Ib. Data Entry and Analysis—Individual Observations Method
1. Create two variables in SPSS (one for each categorical variable).

2. Create value labels for each of the categorical variables. In the Value Labels
dialog box, enter the numeric values and labels as appropriate. Click OK.

3. Enter the data. (For the individual observations method of data entry, the num-
ber of rows in the data file is equal to the number of participants in the study.)

4. Select 

5. Move one of the categorical variables to the Row(s) box and the other to the
Column(s) box.

6. Click Statistics. Select Chi-square and Phi and Cramer’s V. Click Continue.

7. Click Cells. Under Counts select Expected (Observed should already be
selected) and under Percentages, select Row. Click Continue.

8. Click OK.

II. Interpretation of the Results (the interpretation is the same regardless of
which method of data entry is used)
Check the p-value (Asymp. Sig.) for Pearson Chi-Square in the Chi-Square Tests
table.

Analyze>Descriptive Statistics>Crosstabs Á .

Analyze>Descriptive Statistics>Crosstabs Á .

Weight Cases Á .
Data>
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• If the null hypothesis is rejected. Write the results indicating the
nature of the relationship between the two variables.

• If the null hypothesis is not rejected. Write the results indicating that
there is not a relationship between the two variables.

Exercises

1. A researcher investigated whether there was a relationship between the type of
feeding received as a baby (classified as breastfed—yes/no) and weight in first
grade (classified as overweight—yes/no). The parental report of the type of feed-
ing provided as a baby and the body mass index (BMI) of 300 first graders was
ascertained. Based on the BMI scores, the first graders were classified as either
being overweight or not. The data are provided in Figure 16.14.

p 7 .05,

p … .05,

Overweight 

Yes No Total

Yes 84 100Breastfed 
No 144 200

Total 72 228 300

56

16

Figure 16.14 Data for the 300 children in the breastfeeding study.

Film

Action Drama Total

Females 80 95gender 
Males 30 65

Total 50 110 160

35

15

Figure 16.15 Gender and movie preference of the 160 study
participants.

Enter the data into SPSS and perform the appropriate analyses to answer the
questions below. Name the variables breastfed, overweight, and frequency (be
sure to weight the cases prior to analyzing the data). For breastfed and
overweight, code yes a “1” and no a “2.”
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a significant relationship between the type of feeding received as a

baby and weight in first grade? Test using 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write the results using APA format as appropriate.

2. A student wanted to examine whether there was a relationship between gender
and movie preference. One hundred and sixty people who entered a video store
(95 women and 65 men) were asked whether they would prefer watching an
action film or a drama (assuming they had to choose between the two types of
movies). The choices of the participants are presented in Figure 16.15.

a = .05.

The data are provided in the file Chapter 16_Exercise 2.sav in the Chapter 16 
folder online at www.routledgetextbooks.com/textbooks/9780205735822 and are 
entered using the indi-vidual observations method. In the file, the variables are 
named gender (with females coded a “1” and males coded a “2”) and film (with 
action movies coded a “1” and dramas coded a “2”). Open the file and perform the 
appropriate analyses in SPSS to answer the questions below (instructions for 
analyzing the data using the individual observations method are provided in the 
“summary of steps” section prior to the chapter exercises).
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a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a significant relationship between gender and movie preference? Test

using 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write the results using APA format as appropriate.

3. A medical researcher was interested in investigating whether there was a relation-
ship between exercise (yes/no) and experiencing a heart attack (yes/no) among the
elderly. Four hundred and five elderly were questioned about their exercise habits
and whether or not they had ever experienced a heart attack. The responses of the
study participants are presented in Figure 16.16.

a = .05.

Heart attack

Yes No Total 

Yes 140 150Exercise
No 220 255

Total 45 360 405

35

10

Figure 16.16 Data for the 405 elderly in the exercise study.

The data are provided in the file Chapter 16_Exercise 3.sav in the Chapter 16 
folder online at www.routledgetextbooks.com/textbooks/9780205735822 (the 
variables are named exercise, heartattack, and frequency, with both exercise 
and heartattack coded a “1” for yes and a “2” for no). Open the file and perform 
the appropriate analyses in SPSS to answer the questions below (for this problem, 
be sure to weight the cases prior to analyzing the data).
a. State the null and alternative hypotheses.
b. State a research question for the data.
c. Is there a significant relationship between exercise and whether or not one

has a heart attack? Test using 
d. What is the effect size? Would you characterize the effect size as small,

medium, or large?
e. Write the results using APA format as appropriate.

a = .05.
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APPENDIX

In the context of data analysis, certain operations often need to be performed on one or more
variables prior to analyzing your data. For example, one commonly required operation is to add

a number of variables together in SPSS to produce a total score. In this appendix, a number of
commonly used procedures in SPSS will be illustrated, including the Recode, Compute, Select
Cases, and Split File procedures.

To illustrate each of these procedures, the data presented in Figure A.1 will be used (we’ll open
the data file from your computer shortly). The data consist of values from 10 participants on the fol-
lowing four variables: gender meaning1, meaning2, and meaning3.
The last three variables are items from a scale measuring meaning in life.

11 = “male,” 2 = “female”2,

Data Transformations and Other Procedures

216

Participant
1
2
3
4
5
6
7
8
9
10

gender
1
1
1
1
1
2
2
2
2
2

meaning1
4
1
5
3
4
4
5
5
1
5

meaning2
2
4
1
3
2
1
2
1
4
1

meaning3 
5
2
5
3
4
5
4
5
1
5

Figure A.1 The sample data. (Note: The participant variable
is included for illustration but will not be entered into the
data file.)

The items on the meaning in life scale are presented in Figure A.2.

The Recode Procedure
For the items on the meaning in life scale shown in Figure A.2, the participants read each statement
and choose a response—ranging from strongly disagree to strongly agree—that best characterizes their
feelings toward the statement. Reading through each of the items, notice that meaning1 and meaning3
are written so that a person with a very high degree of meaning in life would most likely answer
“strongly agree” to the items (they would circle a “5” for each item), while meaning2 is written so
that this same person would most likely answer “strongly disagree” to the item (they would circle a
“1”). Meaning2 is an example of a negative item, where a person high on the characteristic of inter-
est (meaning in life) answers in the opposite direction of the scale. Therefore, in this example, a per-
son with a very high degree of meaning in life would most likely answer items meaning1, meaning2,
and meaning3 with values of 5, 1, and 5, respectively. Typically, when analyzing the responses on
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Item

meaning1 

meaning2 

meaning3 

Items on the
Meaning in Life

Scale

I feel good about
the direction of my
life.

My life has little
meaning. 

In general, I feel
like I’m on track in
my life. 

Strongly
Disagree

1

1

1

Disagree

2 

2 

2 

Neither
Disagree
or Agree

3 

3 

3 

Agree

4 

4 

4 

Strongly
Agree

5 

5 

5 

Figure A.2 Items on the meaning in life scale. For each item, the response options
are 1 (strongly disagree), 2 (disagree), 3 (neither disagree or agree), 4 (agree) and
5 (strongly agree). Each participant was instructed to choose only one response
option for each question.

the scale, a total score is calculated by adding together the responses on the items. In this
example, a person with a very high degree of meaning in life would have a total score of

However, because the scale is ultimately designed so that higher scores on the
scale correspond to higher levels of meaning in life, a person with a very high degree of meaning
in life should have a score of (Since meaning2 is a negative item, however, this
isn’t the case.) To correct for this, a process called reverse coding is conducted where the responses
to the negative item on the scale (meaning2) are literally reversed, so that a 1 becomes a 5, a 2
becomes a 4, a 3 remains a 3, a 4 becomes a 2, and a 5 becomes a 1. With meaning2 reverse
coded, a person with a high degree of meaning in life would have a total score of 15 (instead of
11), which is consistent with the intent of the scale. With the rationale for reverse coding provided,
let’s open the data file and recode the negative item meaning2 in SPSS.

(Note: The following instructions assume that the SPSS Demystified files have been down-
loaded from the web site to your computer. If the files are not on your computer, they may be 
obtained online at www.routledgetextbooks.com/textbooks/9780205735822.)

To open the file from your computer

1. Locate the SPSS Demystified files on your computer. In the Appendix A folder,
open the file Appendix A.sav.

To recode the item meaning2 in SPSS

1. From the menu bar, select 
(see Figure A.3). (Note: If you are using SPSS version 14.0 or below, the menu
commands are . All other com-
mands are the same.)

Transform>Recode>Into different variables

Transform>Recode into Different Variables Á

15 15 + 5 + 52.

11 15 + 1 + 52.

Figure A.3 Menu commands for the Recode (Into Different Variables)
procedure.
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Figure A.4 The Recode into Different Variables dialog box.

3. Select meaning2 and click the right-arrow button ( ) to move it to the Input
Variable Output Variable box (the box reads Numeric Variable Output
Variable once meaning2 is moved into it). Under Name, enter the name
meaning2_recode (see Figure A.5). This is the name of the new variable that will
contain the reverse coded values.

::

Figure A.5 The Recode into Different Variables dialog box (continued).

4. Click Change. You should see meaning2 meaning2_recode in the Numeric
Variable Output Variable box.

5. Click Old and New Values. The Recode into Different Variables: Old and New
Values dialog box opens. This dialog box will be used to recode the values for
meaning2, so that a 1 becomes a 5, a 2 becomes a 4, and so on.

6. Under Old Value, enter a 1 in the Value text box. Under New Value, enter a 5 in
the Value text box (see Figure A.6).

7. Click the Add button. The Old New box should display 
(see Figure A.7).

1 : 5:

:
:

2. The Recode into Different Variables dialog box opens (see Figure A.4).
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Figure A.6 The Recode into Different Variables: Old and New Values dialog box.

8. Enter the remaining values to be recoded clicking
the Add button each time an Old Value and New Value combination has been
entered. Once all five pairs of values have been entered, the Old New box
should contain the recoded values shown in Figure A.8 (page 220).2

9. Click Continue.
10. Click OK.

In the SPSS Data View window, you should see the new variable meaning2_recode in the data
file containing the reverse coded items of the variable meaning2 (see Figure A.9 on page 220).

:

12 : 4, 3 : 3,14 : 2, 5 : 12,

Figure A.7 The Recode into Different Variables: Old and New Values dialog box
(continued).
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Figure A.8 The Recode into Different Variables: Old and New Values dialog box
(continued).

The Compute Procedure
As was indicated at the beginning of this appendix, a commonly performed operation in SPSS is
to add a number of variables together to create a total score. To add variables together in SPSS,
the Compute procedure is used.

We’ll use the Compute procedure to add together the items of the meaning in life scale to
produce a total score.

Figure A.9 The Data Editor window with the recoded variable meaning2_recode added to the
data file.
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Figure A.10 Menu commands for the Compute procedure.

To add variables in SPSS

1. From the menu bar, select (see Figure A.10).
(Note: If you are using SPSS version 14.0 or earlier, the menu commands are

All other commands are the same.)Transform>Compute Á .

Transform>Compute Variable

2. The Compute Variable dialog box opens (see Figure A.11).

Figure A.11 The Compute Variable dialog box.

To compute a total score for the meaning in life scale, we’ll need to add together the items
meaning1, meaning2_recode, and meaning3.3 To create a new variable in SPSS that is equal to
the sum of the three variables, we’ll first need to provide a name for the new variable in SPSS that
will contain the total score. We’ll name the variable meaning_total.

1. In the Target Variable box, enter the name meaning_total.

To create a total score, we’ll move the appropriate variables to the Numeric Expression box
and add them together using the plus sign.41+2
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2. Select the first variable, meaning1, and click the right-arrow button ( ) to move
it to the Numeric Expression box. Click the plus button below the Numeric
Expression box (or press the Shift and keys on your keyboard). Move
meaning2_recode to the Numeric Expression box and click the plus button.
Finally, move meaning3 to the Numeric Expression box. In the Numeric Expres-
sion box, the statement should read, meaning1 + meaning2_recode + meaning3
(see Figure A.12).

1+2
+

1+2

Figure A.12 The Compute Variable dialog box (continued).

Figure A.13 The Data Editor window with the variable meaning_total added to the data file.

3. Click OK. A new variable is created in the Data View window named meaning_total
which is the sum of variables meaning1, meaning2_recode, and meaning3 (see
Figure A.13).
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The Select Cases Procedure
When analyzing data, certain questions of interest may require performing analyses on only part
of the data file. In this situation, the Select Cases procedure may be used.

To illustrate the Select Cases procedure, suppose that you wanted to conduct a one-sample t
test on males to see if their responses to meaning1 were significantly different from a neutral
response on the scale (a neutral response is a value of “3” on the scale; see Chapter 5 for more
information on the one-sample t test). This would require selecting only males in the data set, a
situation where the select cases procedure could be used.

To select only males using the select cases procedure

1. From the menu bar, select (see Figure A.14).Data>Select Cases Á

Figure A.14 Menu commands for the Select Cases procedure.

2. The Select Cases dialog box opens (see Figure A.15 on page 224).
3. Under Select, click If condition is satisfied.
4. Click the If button (located below If condition is satisfied). The Select Cases: If

dialog box opens (see Figure A.16 on page 224).
5. Select the variable gender, and click the right-arrow button ( ) to move it to

the box on the right.

Recall for this example that we want to select only males. Since males are coded with a 1,
enter (do not include the quotation marks) to the right of gender (see Figure A.17 on
page 225). This indicates that only males will be selected by SPSS.

6. Click Continue.
7. The Select Cases dialog box should now read gender =1 to the right of the If

button in the Select Cases dialog box (see Figure A.18 on page 225).
8. Click OK.

Notice in the Data View window shown in Figure A.19 on page 226 that there are diagonal
lines in the row headings of observations 6 through 10, indicating that females will not be included

“ = 1”
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Figure A.15 The Select Cases dialog box.

Figure A.16 The Select Cases: If dialog box.
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Figure A.17 The Select Cases: If dialog box (continued).

Figure A.18 The Select Cases dialog box.
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Figure A.19 The data file with males selected.

in the analysis. Also, a filter variable has been created in the data set indicating which cases are
selected (those that receive a “1” are selected while those that receive a “0” are not).

To answer the initial question that prompted the use of the select cases procedure for this
example, a one-sample t test was conducted on meaning1 for males. The results of the one-
sample t test are provided in Figure A.20.

T–Test 
One-Sample Statistics

5 3.4000 1.51658 .67823meaning1

N Mean Std. Deviation
Std. Error

Mean

One-Sample Test

.590 4 .587 .40000 –1.4831 2.2831meaning1

t df Sig. (2-tailed)
Mean

Difference Lower Upper

95% Confidence
Interval of the

Difference

Test Value = 3

Figure A.20 The results of the one-sample t test on meaning1 for males.

Notice in the output shown in Figure A.20 that there is no indication that males were selected.
The One-Sample Statistics table shows an N of 5, however, indicating that the test was conducted
on only five of the participants in the data file. (As a review of the material covered in Chapter 5,
the results indicate that males do not score significantly different from a response of “3” on
meaning1 since the p-value of .587 is greater than .05.)5

Next we’ll illustrate how to use the Split File procedure, which is another way to perform
analyses on separate parts of a data set in SPSS. Prior to using the Split File procedure, however,
we’ll need to turn off the Select Cases procedure so that we have access to the entire data set. If
the Select Cases procedure is not turned off, all subsequent analyses would be conducted only on
males.

To turn off the Select Cases procedure

1. From the menu bar select 
2. Under Select, click the All Cases button (see Figure A.21).
3. Click OK.

Data>Select Cases Á .
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Figure A.21 The Select Cases dialog box.

In the Data View window, all of the cases should now be selected (there should no longer be
a line through observations 6–10). While the filter variable still remains in the data file, it is no
longer enforced. It may be deleted (if desired) by clicking on the filter_$ column heading in the
Data View window and pressing the Delete key on the keyboard.

The Split File Procedure
Suppose that instead of conducting a one-sample t test for males only, you wanted to conduct
separate one-sample t tests on meaning1 for males and females. While the Select Cases pro-
cedure could be used in this situation, it would require performing the analysis twice (once for
males and once for females). A more efficient approach would be to use the Split File proce-
dure, which automatically performs separate analyses for each group of a variable of interest.
The Split File procedure is illustrated next.

To perform the Split File procedure

1. From the menu bar select (see Figure A.22 on page 228).
2. The Split File dialog box opens (see Figure A.23 on page 228).

There are two different methods for splitting the file: Compare groups and Organize output
by groups. Compare groups reports the results for the groups in the same table, while Organize
output by groups reports the results for the groups in separate tables. We’ll use the Compare groups
method.

3. Select Compare groups.
4. Select gender. Click the right-arrow button ( ) to move gender to the Groups

Based on box (see Figure A.24 on page 229).
5. Click OK.

Data>Split File Á
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Figure A.22 Menu commands for the Split File procedure.

Figure A.23 The Split File dialog box.

After clicking OK you should see “Split File On” displayed in the bottom right-hand corner
of the Data Editor window.

The results of the separate one-sample t tests for males and females evaluating whether the
responses on meaning1 are significantly different from a “3” are reported in Figure A.25. (Note:
See Chapter 5 for more details on how to run the one sample t test.)

Using the Compare groups option, notice that the output shows the results for males and
females together in the same tables, with the results for males presented first, followed by the
results for females. Alternatively, if the Organize output by groups option was selected, the results
for males and females would be presented in separate tables. (As a review again of the material
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Figure A.24 The Split File dialog box (continued).

T–Test 
One-Sample Statistics

5 3.4000 1.51658 .67823

5 4.0000 1.73205 .77460

meaning1

meaning1

gender
male

female

N Mean Std. Deviation
Std. Error

Mean

One-Sample Test

.590 4 .587 .40000 –1.4831 2.2831

1.291 4 .266 1.00000 –1.1506 3.1506

meaning1

meaning1

gender

male

female

t df Sig. (2-tailed)
Mean

Difference Lower Upper

95% Confidence
Interval of the

Difference

Test Value = 3

Figure A.25 The results of the one-sample t test on meaning1 for males and females.

covered in Chapter 5, is the average response on meaning1 for either males or females significantly
different from a “3”? It’s not, since the p-values of .587 and .266 are both greater than .05.)

Turning off the Split File Procedure
As was the case with the Select Cases procedure discussed earlier, if you wanted to perform sub-
sequent analyses on the entire sample, the Split File procedure would need to be turned off first.
To turn off the Split File procedure, in the Split File dialog box select Analyze all cases, do not
create groups and click OK (see Figure A.26 on page 230). (Alternatively, if SPSS is closed after
using the Split File or Select Cases procedure, the option will be turned off when SPSS is started
again by default.)
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Figure A.26 Turning off the Split File procedure.

This concludes the discussion of the Recode, Compute, Select Cases, and Split File procedures.
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In this appendix, how to import Microsoft Excel files into SPSS is illustrated. To demonstrate this
procedure, an Excel file was created using the data from Appendix A. The Excel file is presented

in Figure B.1.

B
APPENDIX

Importing Files into SPSS

A B C D

1 gender meaning1 meaning2 meaning3

2 1 4 2 5

3 1 1 4 2

4 1 5 1 5

5 1 3 3 3

6 1 4 2 4

7 2 4 1 5

8 2 5 2 4

9 2 5 1 5

10 2 1 4 1

11 2 5 1 5

Figure B.1 The Excel file Excel File_Appendix B.xls.

To import the Excel file into SPSS, we’ll use the SPSS Database Wizard, which provides assis-
tance with importing files into SPSS.1

To access the Database Wizard

1. From the menu bar select 
(see Figure B.2).

File>Open Database>New Query Á

Figure B.2 Menu commands for importing an Excel file into SPSS.
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2. The Database Wizard dialog box opens (see Figure B.3).

Figure B.3 The Database Wizard dialog box.

Figure B.4 The ODBC Driver Login dialog box.

Three different types of files are listed in the Database Wizard dialog box, including
dBASE Files, Excel Files, and MS Access Database files. Since we want to import an Excel
file, we’ll select Excel Files.

3. Select Excel Files from the Database Wizard dialog box.
4. Click Next. The ODBC Driver Login dialog box opens (see Figure B.4).

Next we’ll open the Excel file from your computer.

5. Click the Browse button (see Figure B.4) and select the location of the SPSS 
Demystified files on your computer. (If the files have not been downloaded to your 
computer, they may be obtained on the web at www.routledgetextbooks.com/
textbooks/9780205735822.)

6. Open the Appendix B folder and select the file Excel File_Appendix B.xls. Click
Open.
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Figure B.5 The ODBC Driver Login dialog box (continued).

7. The file should appear in the Database textbox of the ODBC Driver Login
window (see Figure B.5). (Note: While the file is located on drive F: in Figure
B.5, it may be in a different location on your computer.)

8. Click OK.
9. The Database Wizard: Select Data dialog box opens (see Figure B.6).

Figure B.6 The Database Wizard: Select Data dialog box.

Three different sheets (Sheet1$, Sheet2$, and Sheet3$) are presented in the Available Tables
box, which correspond to the three worksheets created (by default) for an Excel file. Our data are
located in the first worksheet, Sheet1$. (To verify this, if you click on the button to the left of
Sheet1$, you should see the variables gender, meaning1, meaning2, and meaning3 displayed.)
The instructions in the Database Wizard dialog box indicate to drag the items of interest from the
Available Tables box to the Retrieve Fields in This Order box. Since our data are in Sheet1$, we’ll
drag Sheet1$ to the Retrieve Fields in This Order box.

10. Select Sheet1$ and drag it to the Retrieve Fields in This Order box 
(see Figure B.7 on page 234).

+
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Figure B.7 The Database Wizard: Select Data dialog box (continued).

Figure B.8 The Excel file imported into SPSS.

The Retrieve Fields in This Order box displays the four variables in the data file, gender,
meaning1, meaning2, and meaning3, confirming that the correct file has been selected.

11. Click Finish. The data file opens in SPSS with the participants’ scores in
rows 1 through 10 of the Data View window and the variables in the first four
columns (see Figure B.8).
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This concludes the illustration of importing Excel files into SPSS. If you have data saved in MS
Access, you may open it in SPSS using the New Query procedure. If you have data saved in a for-
mat where the values are separated by commas, spaces, or tabs, the file will need to be opened using
an alternative method in SPSS. To open these types of files, select from
the menu bar and follow the on-screen instructions.

File>Read Text Data Á
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Chapter 1—Introduction to SPSS
1. c.

Solutions to Chapter Exercises

236

Case Processing Summarya

7 100.0% 0 .0% 7 100.0%

7 100.0% 0 .0% 7 100.0%

7 100.0% 0 .0% 7 100.0%

7 100.0% 0 .0% 7 100.0%

age

gender

wellbeing

activities

N Percent N Percent N Percent

Included Excluded Total

Cases

a. Limited to first 100 cases.

a. Limited to first 100 cases.

Case Summariesa

86.00 male 4.00 2.00

72.00 female 7.00 6.00

59.00 female 6.00 5.00

86.00 female 8.00 7.00

92.00 female 4.00 1.00

68.00 male 2.00 3.00

73.00 male 8.00 5.00

7 7 7 7N

1

2

3

4

5

6

7

Total

age gender wellbeing activities

d. The value labels (male/female) are output in the Case Summaries table. When
value labels are created, they are printed in the results by default instead of the
numeric values (1, 2) originally entered into SPSS. This is beneficial as it makes
reading the results easier and avoids confusing males and females (in the event
that it was forgotten which group was assigned a 1 and which group was
assigned a 2).
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Case Processing Summarya

12 100.0% 0 .0% 12 100.0%

12 100.0% 0 .0% 12 100.0%

12 100.0% 0 .0% 12 100.0%

12 100.0% 0 .0% 12 100.0%

therapy

gender

selfesteem

angermanage

N Percent N Percent N Percent

Included Excluded Total

Cases

a. Limited to first 100 cases.

Case Summariesa

nondirective male 25.00 12.00

nondirective male 30.00 15.00

nondirective male 34.00 13.00

nondirective female 28.00 19.00

nondirective female 39.00 21.00

nondirective female 42.00 15.00

directive male 37.00 9.00

directive male 29.00 19.00

directive male 26.00 22.00

directive female 38.00 17.00

directive female 43.00 11.00

directive female 26.00 21.00

12 12 12 12

1

2

3

4

5

6

7

8

9

10

11

12

NTotal

therapy gender selfesteem angermanage

a. Limited to first 100 cases.

2. b.

3. b.

Case Summariesa

male 3.00 20.00
male 5.00 10.00
female 5.00 20.00
female 4.00 14.00
female 6.00 6.00
male 2.00 .00
female 1.00 40.00
female 3.00 20.00
male 5.00 15.00
female 6.00 25.00

10 10 10N

1
2
3
4
5
6
7
8
9
10
Total

gender
number
classes hoursworked

a. Limited to first 100 cases.
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Statistics

experience distance accuracy

Mean
Std. Deviation

4.6250
2.61520

38.8750
7.10005

5.7500
1.83225

Report

5.5000
2.88675

42.5000
6.45497

6.0000
2.16025

3.7500
2.36291

35.2500
6.39661

5.5000
1.73205

Mean
Std. Deviation

Mean
Std. Deviation

gender

boys

girls

experience distance accuracy

Report

5.0000
2.16025

44.0000
4.69042

4.5000
1.29099

4.2500
3.30404

33.7500
5.05800

7.0000
1.41421

Mean
Std. Deviation

Mean
Std. Deviation

method

toe kick

heel kick

experience distance accuracy

Report

5.5000
.70711

47.5000
3.53553

4.5000
.70711

5.5000
4.94975

37.5000
3.53553

7.5000
2.12132

4.5000
3.53553

40.5000
2.12132

4.5000
2.12132

3.0000
1.41421

30.0000
2.82843

6.5000
.70711

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

method

toe kick

heel kick

toe kick

heel kick

gender

boys

girls

experience distance accuracy

Chapter 2—Descriptive Statistics
1. a. For gender there are four boys and four girls. For method there are four toe

kickers and four heel kickers.
b.

c.

Boys have a higher mean on all three variables. Boys also have a larger stan-
dard deviation on all three variables.

d.

Toe kickers have more experience (5.00) and distance (44.00) in their kicks,
while heel kickers have greater accuracy (7.00). Heel kickers have a larger
standard deviation on all three variables.

e.
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Statistics

6.8667
1.45586

8.1333
1.16658

Mean
Std. Deviation

taste clarity

Report

6.9000
1.28668

7.8000
1.03280

7.8000
.91894

8.7000
1.15950

5.9000
1.52388

7.9000
1.19722

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

location

West Coast

Midwest

East Coast

taste clarity

Report

6.6667
1.58865

8.0667
1.27988

7.0667
1.33452

8.2000
1.08233

Mean
Std. Deviation

Mean
Std. Deviation

gender

male

female

taste clarity

Females have the highest mean ratings on taste (7.07) and clarity (8.20).
Males have the largest standard deviation on both taste (1.59) and clarity
(1.28).

e.

Girls using the heel kicking method had the lowest mean experience (3.00),
while both boys and girls who used the toe kicking method tied for the lowest
mean accuracy score (4.50). Boys using the toe kicking method had the highest
mean kicking distance of all four conditions (47.50).

2. a. For location, there are 10 people from each region (West Coast, Midwest, and
East Coast). There are 15 males and 15 females in the data set.

b.

c.

The Midwest has the highest mean on both taste (7.80) and clarity (8.70). The
East Coast has the largest standard deviation on both taste (1.52) and clarity
(1.20).

d.

Report

6.6000
1.14018

8.0000
1.22474

8.0000
.70711

8.8000
1.30384

5.4000
1.67332

7.4000
1.14018

7.2000
1.48324

7.6000
.89443

7.6000
1.14018

8.6000
1.14018

6.4000
1.34164

8.4000
1.14018

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

location

West Coast

Midwest

East Coast

West Coast

Midwest

East Coast

gender

male

female

taste clarity
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Statistics

3.1500
1.37922

28.2667
12.34262

Mean
Std. Deviation

hourstv readingscores

Report

3.3367
1.52976

25.9333
11.90718

2.9633
1.23512

30.6000
12.73241

Mean
Std. Deviation

Mean
Std. Deviation

gender

male

female

hourstv readingscores

Report

3.3400
1.47792

18.0000
9.87421

3.9000
1.03983

23.8000
6.30079

2.7700
2.03150

36.0000
12.16553

3.3400
1.47792

18.0000
9.87421

3.6000
.51841

36.4000
11.32696

1.9500
.95851

37.4000
6.58027

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

Mean
Std. Deviation

ses

low

middle

high

low

middle

high

gender

male

female

hourstv readingscores

Males on the East Coast have the lowest mean ratings on both taste (5.40) and
clarity (7.40). Males in the Midwest have the highest mean ratings on both
taste (8.00) and clarity (8.80).

3. a. There are 15 males and 15 females. There are 10 people in each SES group
(10 low, 10 middle, and 10 high).

b.

c.

Males have a higher mean on hourstv (3.34) and females have a higher mean
on readingscores (30.60). Males have the largest standard deviation on
hourstv (1.53), while females have the largest standard deviation on read-
ingscores (12.73).

d.

Middle SES males watch the most TV (3.90). High SES females have the
highest mean reading scores (37.40).
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femalemale

gender

6

4

2

0

C
o

un
t

hoursstudied

6.004.002.000.00

F
re

q
ue

nc
y

3

2

1

0

Mean � 3.05
Std. Dev. � 1.848

N � 10

Chapter 3—Graphical Procedures
1. a.

There are three males and seven females.
b.

The mean number of hours studied was 3.05.
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6.005.004.003.002.001.000.00

g
p

a

4.00

3.50

3.00

2.50

2.00

hoursstudied

6.00

5.00

4.00

3.00

2.00

1.00

0.00

cupscoffee

c.

d.

There are no outliers in the boxplot.
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noyes

allergy

6

4

2

0

C
o

un
t

daysmissed

40.0030.0020.0010.000.00

F
re

q
ue

nc
y

3

2

1

0

Mean � 11.20
Std. Dev. � 9.211

N � 10

The mean number of days missed per year was 11.20.

2. a.

There are three people who have allergies and seven people who do not have
allergies.

b.
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doctorvisits

14.00

12.00

10.00

8.00

6.00

4.00

2.00

0.00

6

10.008.006.004.002.000.00

3.0

2.5

2.0

1.5

1.0

0.5

0.0

F
re

q
ue

nc
y

Mean � 3.4643 
 Std. Dev. � 3.30539 
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c.

Observation number 6 is an outlier with 15 visits made to the doctor last year.
3. a.
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b.

The mean rating for corn is 5.14.
c.
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cabbage

6.00

5.00

4.00

3.00

2.00

1.00

d.

There are no outliers in the boxplot.

Chapter 4—Reliability
1. a.

b. The reliability of the scale is fair.
c. Coefficient alpha for a seven-item measure of resident satisfaction was calcu-

lated based on the responses of 20 nursing home residents. The reliability of
the scale was fair, with a coefficient alpha of .72. The mean score on the total
scale was 25.75 with a standard deviation of 7.18.

2. a.
b. The reliability of the scale is excellent.
c. Coefficient alpha for a 10-item measure of resilience was calculated based on

the responses of 30 participants. The scale possessed a very high degree of
internal consistency reliability, with a coefficient alpha of .95. The mean
score on the total scale was 50.37 with a standard deviation of 13.59.

3. The estimate of coefficient alpha is low because it was calculated on the
combined scales. Because the two scales are measuring different characteristics,
coefficient alpha should be calculated separately for each scale. Recall that coef-
ficient alpha measures the internal consistency of a set of items. When two scales
that are measuring different constructs are combined, the internal consistency
will be reduced, since self-confidence and manual dexterity do not measure the
same thing.

Coefficient alpha = .95

Coefficient alpha = .72
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Chapter 5—One-Sample t Test
1. a.

b. “Do the prognosticators pick winners in football games different from chance
levels (50%)?”

c. No. The prognosticators did not pick winners at different than chance levels

d. Effect (or 0.48). Using Cohen’s
standards, the effect size is small (although it is close to a medium effect).

e. The prognosticators do not pick winning football teams at a rate different
from chance levels 

2. a.

b. “Are the math scores for the fourth graders at the local school district differ-
ent from the national average (of 50)?”

c. Yes. The students perform significantly better (higher) on the math exam than
the national average 

d. Effect Using Cohen’s standards, this
represents a medium effect, with the students from the local school district
scoring approximately one-half of a standard deviation higher on the exam
than the national average.

e. The students using the new program at the local school district scored signifi-
cantly higher on the standardized math exam than
the national average of 

3. a.

b. “Are the students either in favor of or opposed to the candidate?”
c. No. The students were neither in favor of nor opposed to the candidate

d. Effect Using Cohen’s standards, the
effect size is very small.

e. The students were neither significantly in favor of nor opposed to the candi-
date, 

Chapter 6—Independent-Samples t Test
1. a.

b. “Is there a difference in reported pain between minimally invasive and tradi-
tional surgical procedures?”

c. The variances are not significantly different, Levene’s 
d. Yes 

e. or 1.31. The effect is very large, with MIS 

patients reporting pain levels that were 1.31 standard deviations lower on
average than patients who had traditional surgery.

f. There is a significant difference in the reported pain levels between mini-
mally invasive and traditional surgical procedures,

Those who had minimally invasive
surgery reported significantly less postoperative
pain than those who had traditional surgery 

2. a.
H1 : msystematic desensitization Z mimplosion

H0 : msystematic desensitization = mimplosion

1M = 6.87, SD = 1.602.
1M = 4.73, SD = 1.672

t1282 = -3.58, p 6 .05, d = 1.31.

d = -3.58A
15 + 15

15 * 15
= -1.31

1p = .0012.
F = .005, p 7 .05.

H1 : mminimally invasive Z mtraditional

H0 : mminimally invasive = mtraditional

1M = 3.16, SD = 1.062, t1492 = 1.07, p 7 .05, d = 0.15.

size = 13.16 - 32/1.05676 = 0.15.
1p = .2902.

H1 : m Z 3
H0 : m = 3

50, t1242 = 2.53, p 6 .05, d = 0.51.
1M = 55.44, SD = 10.742

size = 155.44 - 502/10.73577 = 0.51.
1p = .0182.

H1 : m Z 50
H0 : m = 50
p 7 .05, d = 0.48.

1M = 48.07%, SD = 4.04%2, t1142 = -1.85, 

size = 148.0667 - 502/4.04381 = -0.48
1p = .0852.

H1 : m Z 50
H0 : m = 50
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b. “Is there a difference in the level of snake fear between those who received
systematic desensitization and those who received implosion therapy?”

c. The variances are not significantly different, Levene’s 
d. Yes 

e. or 1.28. This is a very large effect size, with 

fear levels 1.28 standard deviations lower for those who had systematic 
desensitization.

f. There is a significant difference in the level of reported snake fear between
systematic desensitization and implosion therapeutic techniques,

Those who received systematic desensiti-
zation reported significantly less fear of snakes
than those who received implosion therapy 

3. a.

b. “Is there a difference in the resident satisfaction between nursing homes with
a pet and those without a pet?”

c. The variances are not significantly different, Levene’s 
d. No 

e. or 0.28. This is a small effect.

f. There is a not significant difference in the satisfaction levels between nursing
home residents who have access to a pet and those who do not,

Chapter 7—Dependent-Samples t Test
1. a.

b. “Is there a difference in attitudes toward the political candidate after viewing
the campaign film as compared to before?”

c. Yes 
d. or 1.05. The effect size is 1.05, indicating that

attitudes were over one standard deviation higher after viewing the campaign
film as compared to before. This is a large effect.

e. The attitudes toward the political candidate were significantly more favorable
after viewing the campaign film as compared to
before 

2. a.

b. “Is there a difference in the stress levels of air traffic controllers before using
the relaxation exercises as compared to after?”

c. Yes 
d. The effect size is 0.38, indicating that stress levels

were .38 standard deviations lower after using the relaxation exercise as com-
pared to before. This is a small effect.

e. The stress levels of the air traffic controllers were significantly lower after
using the relaxation exercise as compared to
before, 

3. a.

b. “Is there a difference in accuracy of tennis shots before receiving training
from a sports psychologist as compared to after?”

c. Yes 1p = .0022.

H1 : mbefore training - mafter training Z 0
H0 : mbefore training - mafter training = 0

1M = 36.23, SD = 9.762, t1292 = 2.08, p 6 .05, d = 0.38.
1M = 34.83, SD = 8.782

d = 11.4/3.691562 = 0.38
1p = .0472.

H1 : mstress before relaxation - mstress after relaxation Z 0
H0 : mstress before relaxation - mstress after relaxation = 0

1M = 54.13, SD = 15.682, t1142 = -4.05, p 6 .05, d = 1.05.
1M = 60.13, SD = 17.532

d = 1-6/5.732122 = -1.05
1p = .0012.

H1 : mbefore film - mafter film Z 0
H0 : mbefore film - mafter film = 0

t1582 = -1.08, p 7 .05, d = 0.28.

d = -1.08A
30 + 30

30 * 30
= -0.28

1p = .2842.
F = .241, p 7 .05.

H1 : mhome with a pet Z mhome without a pet

H0 : mhome with a pet = mhome without a pet

1M = 59.30, SD = 11.642.
1M = 47.10, SD = 6.822

t1182 = -2.86, p 6 .05, d = 1.28.

d = -2.86A
10 + 10

10 * 10
= -1.28

1p = .0102.
F = 2.29, p 7 .05.
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d. or 1.00. The effect size is 1.00, indicating
that the shots were more accurate by the amount of one standard deviation
after receiving the eight weeks of training. This is a large effect.

e. The accuracy scores of the collegiate tennis players were significantly higher
after receiving training from the sports psychologist 
as compared to before 

Chapter 8—One-Way ANOVA
1. a.

b. “Does the level of pain experienced by people with migraine headaches
depend on the type of drug used?”

c. The variances are not significantly different, 
d. Yes 

e. This is a large effect.

f. A and B are less than the placebo. There is not a significant difference
between A and B.

g. The pain levels of migraine sufferers differed by the type of drug used,
Tukey’s post hoc procedure revealed

that those who took drug A and those who took
drug B had significantly lower reported pain than
those who took the placebo There was not a signifi-
cant difference in the pain levels between drug A and drug B.

2. a.

b. “Does the level of frustration over gas prices differ for the owners of different
types of vehicles?”

c. The variances are not significantly different, 
d. Yes 

e. This is a large effect.

f. Hybrid owners are less frustrated than motorcycle and nonhybrid car owners.
Motorcycle owners are less frustrated than nonhybrid car owners.

g. The frustration levels differed for the different vehicle owners,
Tukey’s post hoc procedure revealed

that hybrid vehicle owners and motorcycle owners
reported significantly less frustration than nonhy-

brid vehicle owners Hybrid owners also reported
significantly less frustration than motorcycle owners.

3. a.
At least one of the means is different from the others.

b. “Does the response time to alarm calls differ by alarm company?”
c. The variances are not significantly different, 
d. No 

e. The effect size is (essentially) zero.

f. The ANOVA was not significant. Tukey’s test is not required.
g. The response time to alarm calls was not significantly different for the different

alarm companies, F12, 422 = .03, p 7 .05, h2
= .001.

h2
=

132.844

104933.2
= .001.

1p = .9742.
F12, 422 = .001, p 7 .05.

H1 :
H0 : mCompany A = mCompany B = mCompany C

1M = 8.00, SD = 1.632.
1M = 5.80, SD = 1.692

1M = 3.50, SD = 1.432
F12, 272 = 20.08, p 6 .05, h2

= .60.

h2
=

101.267

169.367
= .60.

1p 6 .0012.
F12, 272 = .05, p 7 .05.

H1 : At least one of the means is different from the others.
H0 : mmotorcycle = mhybrid car = mnonhybrid car

1M = 7.76, SD = 1.302.
1M = 4.60, SD = 1.872

1M = 4.64, SD = 1.612
F12, 182 = 8.88, p 6 .05, h2

= .50.

h2
=

46.205

93.057
= .50.

1p = .0022.
F12, 182 = 1.27, p 7 .05.

H1 : At least one of the means is different from the others.
H0 : mDrug A = mDrug B = mPlacebo

d = 1.00.
1M = 85.07, SD = 6.462, t1142 = -3.86, p 6 .05, 

1M = 89.27, SD = 5.782

d = 1-4.2/4.212232 = -1.00
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Chapter 9—Two-Way ANOVA
1. a.

b. “Is there a difference in driving performance between males and females?”
“Is there a difference in driving performance between those who spoke on a
cell phone while driving and those who did not?”
“Is there an interaction between gender and cell phone usage?”

c. There is not a significant difference in the cell variances,

d. Gender is not significant cell phone is significant
phone is not significant 

e.
1p = .2582.1p 6 .0012; gender * cell

1p = .5842;
F13, 202 = 2.47, p 7 .05.

H1 : There is a gender * cell phone interaction.
H0 : There is not a gender * cell phone interaction;
H1 : mcell phone Z mno cell phone

H0 : mmales = mfemales ; H1 : mmales Z mfemales ; H0 : mcell phone = mno cell phone ;

Cell phone has the largest effect.
f. A between-subjects ANOVA was conducted with driving performance as

the dependent variable and gender and cell phone usage as the independent vari-
ables. There was a significant cell phone effect, 
partial with those speaking on a cell phone having significantly poorer
driving performance than those who did not speak on
a cell phone There was not a significant gender
effect, partial nor was there a significant
interaction effect, partial 

2. a.

There is not a method major interaction; There is a method 
major interaction.

b. “Is there a difference in math anxiety between the different teaching 
methods?”
“Do natural science majors and social science majors differ in math anxiety?”
“Is there an interaction between teaching method and college major?”

c. There is not a significant difference in the cell variances, 

d. Method major and the interaction
are all significant.

e.
1p = .0082

method * major1p = .0012,1p = .0022,
p 7 .05.

F13, 362 = 2.26,

*H1 :*H0 :
H0 : mnatural science = msocial science ; H1 : mnatural science = msocial science

H0 : mmethod A = mmethod B; H1 : mmethod A Z mmethod B;
h2

= .06.F11, 202 = 1.36, p 7 .05,
h2

= .02,F11, 202 = .31, p 7 .05,
1M = 44.50, SD = 3.532.

1M = 31.58, SD = 4.422
h2

= .76,
F11, 202 = 61.63, p 6 .05,

2 * 2

Major has the largest effect.

Test Partial eta–square

Gender .02

Cell phone .76

Gender * cell phone .06

Test Partial eta–square

Method .24

Major .27

Method * major .18
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f. A between-subjects ANOVA was conducted with math anxiety as the
dependent variable and teaching method and college major as the independent
variables. There was a significant teaching method effect, 

partial with those who received instruction under method
B having significantly lower math anxiety than
those under method A There was a significant
major effect, partial with natural science
majors reporting significantly lower math anxiety 
than social science majors There was also a sig-
nificant interaction effect, partial

Under method B, the difference in math anxiety between natural
science majors and social science majors was
small. Under method A, however, social science majors had
substantially higher levels of math anxiety than natural science majors

3. a. The 31–50 pound group on the whole grain diet lost the most weight (11.50
pounds). The 11–30 pound group on the nonwhole grain diet lost the least
weight (.40 pounds).

b. For the 11–30 pound group, those on the whole grain diet lost slightly more
weight than those on the nonwhole grain diet (they lost 2 pounds more). For
the 31–50 pound group, however, those on the whole grain diet lost substan-
tially more weight than those on the nonwhole grain diet (a difference of 9.40
pounds). The interaction illustrates the combined effect of eating the whole
grain diet and being 31–50 pounds overweight on weight loss, as this group
lost substantially more weight than the other groups. The whole grain diet
appears to be particularly effective for those who began the study more over-
weight (31–50 pounds).

Chapter 10—One-Within ANOVA
1. a.

At least one of the means is different from the others.
b. “Does the number of truancies change over time under the truancy prevention

program?”
c. Yes 
d. Partial 
e. Each test will be conducted at .016 (.05/3).
f. The truancy rate differed significantly over time, Greenhouse-Geisser

adjusted partial Dependent-
samples t tests revealed that students had significantly fewer truancies at nine
months than at six months 

and at nine months compared to three months
There was not a signifi-

cant difference in the number of truancies between six months and three
months, 
(Note: If you prefer to use the sphericity assumed values, substitute the
Greenhouse-Geisser df with 2 and 28 (the sphericity assumed df), and delete
the phrase “Greenhouse-Geisser adjusted.”)

2. a.
At least one of the means is different from the others.

b. “Does well-being change over time when receiving psychoanalytic therapy?”
c. No 

d. Partial 
e. Follow-up tests are not conducted since the overall ANOVA is not significant.

h2
= .07.

1p = .330–Greenhouse–Geisser; p = .341—sphericity assumed2.

H1 :
H0 : mbefore therapy = mfour weeks = meight weeks

t1142 = .87, p 7 .016.

1M = 33.00, SD = 7.082, t1142 = 4.75, p 6 .016.
7.462, t1142 = 3.92, p 6 .016,

1M = 32.00, SD =1M = 25.47, SD = 8.182

h2
= .52.F11.71, 23.982 = 15.20, p 6 .05,

h2
= .52.

1p 6 .001–Greenhouse–Geisser; p 6 .001—sphericity assumed2.

H1 :
H0 : mthree months = msix months = mnine months

1M = 36.002.

1M = 55.502
1M = 36.8021M = 34.302

h2
= .18.

F11, 362 = 7.88, p 6 .05,method * major
1M = 46.15, SD = 13.482.

1M = 35.15, SD = 9.202
h2

= .27,F11, 362 = 13.20, p 6 .05,
1M = 45.75, SD = 14.292.

1M = 35.55, SD = 8.442
h2

= .24,p 6 .05,
F11, 362 = 11.35, 

2 * 2

Z03_YOCK5822_02_SE_AppC.QXD  11/4/10  10:38 AM  Page 251



252 Appendix C / Solutions to Chapter Exercises

f. The general well-being scores of those who received psychoanalytic therapy did
not change over time, Greenhouse-Geisser adjusted 

partial 
(Note: If you prefer to use the sphericity assumed values, substitute the
Greenhouse-Geisser df with 2 and 28 (the sphericity assumed df), and delete
the phrase “Greenhouse-Geisser adjusted.”)

3. a.
At least one of the means is different from the others.

b. “Does the likelihood of visiting a fast-food restaurant differ for the type of
wifi service offered?”

c. Yes 

d. Partial 
e. Each test will be conducted at .016 (.05/3).
f. The likelihood of dining at a fast-food restaurant differed for the type of wifi ser-

vice offered, Greenhouse-Geisser adjusted 
partial Dependent-samples t tests revealed that people were more
likely to eat at a restaurant if free wifi was offered 
than if the service was not free 

People were also more likely to eat at a fast-food restaurant if free
wifi was offered versus no wifi at all 

There was not a significant difference in the likelihood of eating at
a fast-food restaurant if there was pay-per-use wifi versus no wifi at all,

(Note: If you prefer to use the sphericity assumed values, substitute the
Greenhouse-Geisser df with 2 and 18 (the sphericity assumed df), and delete
the phrase “Greenhouse-Geisser adjusted.”)

Chapter 11—One-Between–One-Within ANOVA
1. a.

At least one of the means is different from the others.

b. “Do well-being scores differ for those who receive psychoanalytic therapy
versus cognitive-behavioral therapy?”
“Do well-being scores differ over time?”
“Do well-being scores change at different rates over time for the psychoana-
lytic and cognitive behavioral groups (that is, is there an interaction)?”

c. Time 
and 

are significant. Therapy is not 
d.

1p = .3882.sphericity assumed2
time * therapy 1p 6 .001–Greenhouse–Geisser; p 6 .001—
1p = .007—Greenhouse–Geisser; p = .002—sphericity assumed2

H1 : There is a time * therapy interaction.
H0 : There is not a time * therapy interaction.
H1 :
H0 : mbefore program = mweek 8 = mweek 16

H1 : mcognitive-behavioral Z mpsychoanalytic

H0 : mcognitive-behavioral = mpsychoanalytic

t192 = .80, p 7 .016.

p 6 .016.
1M = 3.40, SD = 1.962, t192 = 5.25, 

p 6 .016.
1M = 3.80, SD = 2.302, t192 = 4.95, 

1M = 7.00, SD = 2.582
h2

= .70.
p 6 .05,F11.78, 16.002 = 20.53, 

h2
= .70.

1p 6 .001–Greenhouse–Geisser; p 6 .001—sphericity assumed2.

H1 :
H0 : mfree wifi = mpay per wifi = mno wifi

h2
= .07.p 7 .05,

F11.50, 20.942 = 1.12, 

has the largest effect.
e. A one-between–one-within ANOVA was conducted on well-being with time

(before, 8 weeks, 16 weeks) as the within-subjects factor and type of therapy
(cognitive-behavioral, psychoanalytic) as the between-subjects factor. There

Time * therapy

Test Partial eta–square

Time .29

Therapy .04

Time * therapy .49
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was a significant time effect on well-being, Greenhouse-Geisser adjusted
partial There was not a signifi-

cant therapy effect on well-being, partial 
There was a significant interaction, Greenhouse-

Geisser adjusted partial The
interaction plot shows that there was little difference in well-being scores
between the two therapy groups before the onset of therapy and at 8 weeks;
however, at 16 weeks, those who had cognitive behavioral therapy had con-
siderably higher general well-being scores than those who had psychoanalytic
therapy.
(Note: If you prefer to use the sphericity assumed values, substitute the 
Greenhouse-Geisser df with 2 and 36 for time and (the
sphericity assumed df ), and delete the phrase “Greenhouse-Geisser adjusted.”)

2. The results of the simple effects analyses revealed that, at week 16, those who had
cognitive behavioral therapy had significantly higher
well-being scores than those who had psychoanalytic therapy 

(The p-value for this test is approximately .0156,
which can be found by double-clicking on the Independent Samples Test table and
then double-clicking on the value .016.) There was not a significant difference in
the well-being scores between the two therapies before the onset of therapy,

or at 8 weeks, 
3. a.

b. “Do the stress levels of mentored teachers differ before beginning teaching, at
four weeks, or at eight weeks?”

c. Yes, time is significant ( spheric-
ity assumed).

d. Stress levels at eight weeks were significantly lower than at four weeks and at
before. There was not a significant difference between before and four weeks.

e. Simple effects analyses were conducted to assess whether mentored teachers’
stress scores differed over the three time occasions. The results of a one-way
within subjects ANOVA showed that time was significant, Greenhouse-
Geisser adjusted partial Follow-
up dependent-samples t tests were conducted, with each test conducted at an
alpha level of .016. The results indicated that mentored teachers reported sig-
nificantly less stress at eight weeks compared to before the program began,

and at eight weeks compared to four weeks,
There was not a significant difference in stress scores

between before the program began and at four weeks, 
Means and standard deviations for the two groups at each level of time are
reported in Figure AC.1 below.
(Note: If you prefer to use the sphericity assumed values, substitute the
Greenhouse-Geisser df with 2 and 18 (the sphericity assumed df), and delete
the phrase “Greenhouse-Geisser adjusted.”)

t192 = 2.49, p 7 .016.
t192 = 4.46, p 6 .016.
t192 = 4.41, p 6 .016,

h2
= .67.F11.17, 10.562 = 18.39, p 6 .05,

p = .001–Greenhouse–Geisser; p 6 .001,

H1 : At least one of the means is different from the others.
Ho : mbefore mentored = m4 weeks mentored = m8 weeks mentored

t1182 = - .25, p 7 .016.t1182 = - .54, p 7 .016,

2.942, t1182 = 2.67, p 6 .016.
1M = 20.00, SD =

1M = 24.00, SD = 3.712

time * therapy

h2
= .49.F11.36, 24.442 = 17.02, p 6 .05,

time * therapyh2
= .04.

F11, 182 = .78, p 7 .05,
h2

= .29.F11.36, 24.442 = 7.46, p 6 .05,

Figure AC.1 Means and standard deviations for
mentored teachers before the academic year
began, at 4 weeks, and at 8 weeks.

Mentored

Time M SD

Before 41.00 3.30

4 weeks 39.60 4.09

8 weeks 34.70 6.00
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Chapter 12—Correlation
1. a.

b. “Is there a relationship between the amount of time studying and the grade on
the exam?”

c.
d. Yes 
e. The effect size is large 
f. There is a significant positive relationship between the amount of time studying

and the grade on the exam, 
2. a.

b. “Is there a relationship between marital satisfaction and empathic 
understanding?”

c.
d. Yes 
e. The effect size is large 
f. There is a significant positive relationship between marital satisfaction and

empathic understanding, 
3. a.

b. “Is there a relationship between the amount of time being read to as a three-
year-old and scores on a second-grade English exam?”

c.
d. Yes 
e. The effect size is large 
f. There is a significant positive relationship between the time being read to as a

three-year-old and scores on a second-grade English exam,

Chapter 13—Simple Regression
1. a.

b. “Is a father’s level of optimism predictive of his son’s optimism as a young
adult?”

c. Yes 
d. This is a large effect.
e.
f. Fathers’ optimism scores were a significant predictor of their sons’ level of

optimism, 
2. a.

b. “Are the scores on a seventh-grade math entrance exam predictive of the 
end-of-the-year grade in mathematics?”

c. Yes 
d. This is a large effect.
e.
f. The entrance exam was a significant predictor of the final grade in seventh-

grade mathematics, 
3. a.

b. “Is an employee’s level of agreeableness predictive of their supervisor’s satis-
faction with their work?”

c. No 
d. This is a medium effect in practice.R2

= .12.
1p = .0932.

H1 : bagreeableness Z 0
H0 : bagreeableness = 0

b = .62, t1282 = 4.17, p 6 .05, R2
= .38.

YNgrade = 47.92 + .5061mathexam2
R2

= .38.
1p 6 .0012.

H1 : bmath exam Z 0
H0 : bmath exam = 0

b = .66, t1182 = 3.75, p 6 .05, R2
= .44.

YNson = 16.313 + .5711father2
R2

= .44.
1p = .0012.

H1 : bfather Z 0
H0 : bfather = 0

r1282 = .52, p 6 .05.

1r = .522.
1p = .0032.

r = .52

H1 : r Z 0
H0 : r = 0

r1232 = .56, p 6 .05.

1r = .562.
1p = .0042.

r = .56

H1 : r Z 0
H0 : r = 0

r1232 = .68, p 6 .05.

1r = .682.
1p 6 .0012.

r = .68

H1 : r Z 0
H0 : r = 0
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e.
f. Employees’ level of agreeableness was not a significant predictor of their

supervisor’s satisfaction with their work,

Chapter 14—Multiple Regression
1. a.

b.

c. Individual predictors:
“Does the importance of one’s job predict job satisfaction?”
“Does the opportunity to advance in one’s job predict job satisfaction?”
“Does the ability to express ideas to one’s boss predict job satisfaction?”
All predictors simultaneously:
“When taken together, does the importance of one’s job, the opportunity to
advance, and the ability to express ideas to one’s boss predict job satisfaction?”

d. Yes, the overall model is significant, 
e. Importance and express are significant. Advance

is not significant.
f. This is a large effect.
g.

h. A multiple regression was conducted predicting job satisfaction from the
variables importance of one’s job, the opportunity to advance, and the ability
to express ideas to one’s boss. Overall, the regression was significant,

Of the predictors investigated, the
importance of one’s job was a significant predictor of job satisfaction,

as was the ability to express ideas to one’s
boss, The opportunity to advance was not a
significant predictor of job satisfaction, 

2. a.

b.

c. Individual predictors:
“Does forgiveness predict happiness?”
“Does social support predict happiness?”
All predictors simultaneously:
“When taken together, do the variables forgiveness and social support predict
happiness?”

d. Yes, the overall model is significant, 
e. Forgiveness is significant. Support is not.
f. This is a large effect.
g.
h. A multiple regression was conducted predicting happiness from the variables

social support and forgiveness. Overall, the regression was significant,
Of the predictors investigated, forgive-

ness was significant, while social support
was not, 

3. a.

b.
H1 : R2

7 0
H0 : R2

= 0

H1 : bwell-being Z 0; H1 : bmeaning in life Z 0
H0 : bwell-being = 0; H0 : bmeaning in life = 0

b = .19, t1222 = 1.19, p 7 .05.
b = .66, t1222 = 4.22, p 6 .05,

F12, 222 = 9.32, p 6 .05, R2
= .46.

YNhappiness = 5.798 + .3991forgiveness2 + .2991support2
R2

= .46.
1p = .24621p 6 .0012
p = .001.R2

= .46.

H1 : R2
7 0

H0 : R2
= 0

H1 : bforgiveness Z 0; H1 : bsupport Z 0
H0 : bforgiveness = 0; H0 : bsupport = 0

b = .11, t1262 = .85, p 7 .05.
b = .37, t1262 = 2.53, p 6 .05.

b = .52, t1262 = 3.65, p 6 .05,

F13, 262 = 11.51, p 6 .05, R2
= .57.

1.0691express2.
YNjob satisfaction = -5.756 + 1.0511importance2 + .2051advance2 +

R2
= .57.

1p = .4032
1p = .01821p = .0012

p 6 .001.R2
= .57.

H1 : R2
7 0

H0 : R2
= 0

H1 : bimportance Z 0; H1 : badvance Z 0; H1 : bexpress Z 0
H0 : bimportance = 0; H0 : badvance = 0; H0 : bexpress = 0

b = .34, t1232 = 1.75, p 7 .05, R2
= .12.

YNsatisfaction = 5.332 + .0971agreeableness2
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c. Individual predictors:
“Does well-being predict fear of death?”
“Does meaning in life predict fear of death?”
All predictors simultaneously:
“When taken together, do the variables well-being and meaning in life predict
fear of death?”

d. Yes, the overall model is significant, 
e. Meaning is significant. Well-being is not 
f. This is a medium effect.

g. A multiple regression was conducted predicting fear of death from the vari-
ables well-being and meaning in life. Overall, the regression was significant,

Of the predictors investigated, meaning
in life was significant, but well-being
was not, 

Chapter 15—Chi-Square Goodness of Fit Test
1. a.

b. “Is eye size related to attractiveness?”
c. Yes 
d. There was a significant preference for the photos with larger eyes,

Of the two types of photos, 75% of the par-
ticipants rated the person with larger eyes as more attractive, while 25% rated
the person with the smaller eyes as more attractive.

2. a. There is not a difference in the perceived picture quality of plasma and
LCD televisions.

There is a difference in the perceived picture quality of plasma and LCD
televisions.

b. “Is there a difference in perceived picture quality of plasma and LCD 
televisions?”

c. No 
d. There is not a difference in perceived picture quality between plasma and

LCD televisions, 
3. a.

b. “Is there a preference among the three coffees?”
c. Yes 
d. There was a preference among the three coffees,

Of the three price categories of coffee,
20% of the participants preferred the $3 brand, 41% preferred the $6 brand,
and 39% preferred the $10 brand.

Chapter 16—Chi-Square Test of Independence
1. a. There is not a relationship between the type of feeding received as an

infant and weight in first grade.
There is a relationship between the type of feeding received as an infant

and weight in first grade.
b. “Is there a relationship between the type of feeding received as an infant and

weight in first grade?”

H1 :

H0 :

x212, N = 1502 = 12.16, p 6 .05.

1p = .0022.

H1 : There is a preference among the three coffees.
H0 : There is not a preference among the three coffees.

x211, N = 652 = .39, p 7 .05.

1p = .5352.

H1 :

H0 :

x211, N = 802 = 20.0, p 6 .05.

1p 6 .0012.

one of the photos2.
H1 : Eye size is related to attractiveness 1there is a preference for 
one of the photos.2
H0 : Eye size is not related to attractiveness 1there is not a preference for 

b = .21, t1472 = 1.38, p 7 .05.
b = - .41, t1472 = -2.68, p 6 .05,

F12, 472 = 3.60, p 6 .05, R2
= .13.

YNfear of death = 36.434 + .2901wellbeing2 - .3491meaning2
R2

= .13.
1p = .1762.1p = .0102

p 6 .05.R2
= .13.
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c. Yes 
d. Effect (or .13). This is a small effect.
e. There is a significant relationship between type of feeding received as an infant

and whether or not a child is overweight in first grade, 
Cramer’s Those who were breastfed were overweight

at a significantly lower rate (16% overweight) than those who were not
breastfed (28% overweight).

2. a. There is not a relationship between gender and movie preference.
There is a relationship between gender and movie preference.

b. “Is there a relationship between gender and movie preference?”
c. Yes 
d. Effect (or .40). This is a medium effect.
e. There is a significant relationship between gender and movie preference,

Cramer’s Given the choice of
an action film or drama, females preferred dramas (84% to 16%), while males
preferred action films (54% to 46%).

3. a. There is not a relationship between exercise and heart attack rates among
the elderly.

There is a relationship between exercise and heart attack rates among the
elderly.

b. “Is there a relationship between exercise and heart attack rates among the
elderly?”

c. Yes 
d. Effect (or .11). This is a small effect.
e. There is a significant relationship between exercise and heart attack rates

among the elderly, Cramer’s 
Those who did not exercise experienced a higher heart attack rate (13.7%)
than those who exercised (6.7%).
(Note: Even though the effect size is small using Cohen’s guidelines, notice
that the heart attack rate is twice as high in the no exer-
cise group, indicating that a small effect can be at times of great practical
importance.)

113.7/6.7 = 2.042

V = .11.x211, N = 4052 = 4.77, p 6 .05,

size = - .11
1p = .0292.

H1 :

H0 :

V = .40.x211, N = 1602 = 26.02, p 6 .05,

size = - .40
1p 6 .0012.

H1 :
H0 :

V = .13.5.26, p 6 .05,
x211, N = 3002 =

size = - .13
1p = .0222.
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Chapter 1
1. An icon is a picture on your computer. and are examples of icons.
2. To “double-click” the mouse means to press the left button twice in rapid succession;

to “click” the mouse means to press the left button once (also referred to as a single
click); and to “right-click” the mouse means to press the right button once.

3. A dialog box is a window that allows certain operations to be performed by selecting
options, clicking buttons, moving variables, and so on.

4. The word “data” is plural, referring to two or more values. Datum is singular,
referring to one value.

5. Default values are the settings in SPSS that are in place when the SPSS program starts.
6. SPSS versions 11.5 and earlier required variable names to be no more than eight

characters. If you are using version 11.5 or earlier, name the variable employ instead
of employment.

7. If you click on the far right-hand side of the Values cell (where the ellipsis button is
located after clicking the cell), the Value Labels dialog box will open immediately
(i.e., it will only take one step to open the box instead of two).

8. If you prefer to move the variables over individually, select gender and click the
upper-right arrow button, then select age and click the upper-right arrow button, and
continue with this process until all variables are moved into the Variables box.

Chapter 2
1. Alternatively, each variable may be moved over individually by selecting gender and

clicking the right-arrow button ( ), and then selecting college and clicking the
right-arrow ( ) button.

2. Measures of central tendency and variability may also be obtained using the
Descriptives procedure in SPSS. To run the Descriptives procedure, from the menu
bar select . . . and move the vari-
ables to be analyzed to the Variable(s) box. In the Descriptives procedure, the mean,
standard deviation, minimum, and maximum values are selected by default. Addi-
tional descriptive statistics may be selected by clicking the Options button.

3. An out-of-range value is a data point that is outside the minimum and maximum
values for a variable (a value of 50 would be an example of an out-of-range value for
satquant). While having no out-of-range values does not ensure that there are no
data entry errors (there can be errors within the possible range of values as well), it is
a simple check against one fairly common type of data entry error. For protection
against data entry errors within the range of possible values, enter the data carefully
and at a minimum double-check all entered values.

Analyze>Descriptive Statistics>Descriptives

Notes

258

Z04_YOCK5822_02_SE_NOTE.QXD  11/4/10  10:39 AM  Page 258



Notes 259

Chapter 4
1. Interrater reliability is one type of reliability that does not fall into either of these

categories. Interrater reliability measures the consistency of raters or judges who
are assessing some characteristic of interest.

2. While coefficient alpha can be negative, this typically indicates that an error has
been made in the calculation, such as including one or more negative items that
have not been reverse coded in the estimate (negative items will be discussed
shortly).

3. M and SD are abbreviations for the mean and standard deviation, respectively,
using the format of the American Psychological Association (APA).

Chapter 5
1. An alternative measure of effect in this example would be to simply state the

difference in hours worked between the employees at the leading accounting firm
and the national average (employees from the leading firm worked seven more
hours per week on average). When the dependent variable makes sense intuitively,
this is a reasonable practice (although d can still be reported as well). However,
when the dependent variable doesn’t have intuitive meaning (such as a measure of
assertiveness on a 10 to 50 scale), then a standardized measure such as d is better.

2. While reporting the exact p-value in the written results is recommended in the
6th edition of the APA Publication Manual, the tradition of reporting is
used in this text to provide continuity with classes (e.g., introductory statistics)
where SPSS analyses supplement hand calculations. For those reporting results in
research papers or presentations, reporting the specific p-value is recommended.
For example, if a p-value of .003 is reported in SPSS, then report 
instead of in your written results. If a p-value of .000 is output in
SPSS, report 

Chapter 6
1. An alternative solution for d may be found by taking the mean difference between

the two groups divided by the pooled standard deviation. While this formula is
more appealing intuitively, since SPSS does not provide the pooled standard
deviation in the output, the formula is not presented here.

2. It is the responsibility of the researcher to ensure that the guidelines of the American
Psychological Association have been followed regarding the ethical treatment of
research participants.

Chapter 7
1. The term independent variable used in this text is not necessarily meant to imply a

variable that is actively manipulated by the researcher but is instead used to help
identify the characteristics of each statistical procedure. Whether the variable is a
true independent variable, quasi-experimental, or nonexperimental will not affect
the calculations of the t test; it will, however, affect the type of conclusions that
may be drawn from the study.

Chapter 8
1. “Factor” is another name for an independent variable in ANOVA. “Level” is

another name for a category or group. The factor gender, for example, has two
levels: male and female.

“p 6 .001.”
“p 6 .05”

“p = .003”

“p 6 .05”
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2. Brown-Forsythe and Welch (shown in Figure 8.7) are alternative tests to ANOVA
when the variances are not equal between the groups. If Levene’s test suggests
unequal variances, then one of these tests can be used in place of the standard
one-way ANOVA (both Levene’s test and assumption of equal variances will be
discussed shortly).

3. If Levene’s test suggests unequal variances, a post hoc test under Equal Variances
Not Assumed should be used (instead of Tukey’s).

4. Tukey’s post hoc procedure has a built-in control so that the overall alpha (Type I
error rate) for the three tests combined does not exceed .05. More will be said
about controlling the overall alpha for follow-up tests in Chapters 10 and 11.

5. Eta-square can be calculated in SPSS using the General Linear Model—
Univariate procedure. The General Linear Model procedure (and the calculation
of eta-square using it) is illustrated in Chapter 9.

Chapter 9
1. A fixed factor is an independent variable where the levels were specifically

chosen for the study with the intent not to generalize to other possible levels. 
A random factor, on the other hand, consists of an independent variable whose
levels were randomly selected from a larger number of potential levels with the
intent to generalize the findings to the wider population of levels. Fixed factors
are more common than random factors in most areas of study, although random
factors do occur with some regularity in certain disciplines.

2. In the Tests of Between-Subjects Effects table, the corrected total sum of squares is
equal to the sum of squares for phyther, relax, and error. The
corrected model sum of squares is equal to the sum of squares for phyther, relax,
and The intercept and total are usually not of interest in the two-
way ANOVA.

3. The presence of a significant interaction does not necessarily mean the main effects
should uniformly not be interpreted, but instead indicates that they can be mislead-
ing. In main effects are interpreted, they should be done so in light of the interaction.

Chapter 10
1. While within subjects factors most commonly consist of the same people mea-

sured on multiple occasions, they can also consist of related people each measured
once (e.g., husbands and wives).

2. While before, week8, and after are entered as variables in SPSS, in the one-way
within subjects ANOVA design they are levels of the within subjects factor time.

3. When there are only two levels to a within subjects factor, the assumption of
sphericity is not required.

4. While Mauchley’s test of sphericity won’t be evaluated here, the approach for
evaluating it is as follows: The null hypothesis is that the data are spherical in the
population; if for Mauchley’s test, the null hypothesis is rejected and it is
assumed that the sphericity assumption has not been satisfied. If the null
hypothesis is not rejected and it is assumed that the sphericity assumption has
been satisfied.

5. While all four procedures in the Tests of Within-Subjects Effects table produce the
same value for F, they frequently differ in their degrees of freedom (and subse-
quently in their p-values).

Chapter 11
1. While within subjects factors most commonly consist of the same people measured

on multiple occasions, they can also consist of related people each measured once
(e.g., siblings).

p 7 .05,
p … .05

phyther*relax.

phyther*relax,
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2. Since the alternative hypothesis is nonspecific, if time is significant, further testing
will be required to assess where the differences are. Compare this to the hypothesis
for support which has only two groups: If support is significant, the means for
the two groups only need to be examined to determine which group has less stress
(i.e., further testing is not required).

3. To this point we have not created a name for the within subjects factor in SPSS
(we’ve created names for the levels of the within subjects factor—before, week4,
week8).

4. The Multivariate Tests table tests the within subjects factor (time) and any
interaction that includes the within subjects factor. Between subjects factors
(by themselves) are not tested in this table.

5. When there are only two levels to a within subjects factor, the assumption of
sphericity is not required.

6. There are not different adjustment procedures for support since the sphericity
assumption does not apply to between subjects factors.

7. For example, mentored vs. nonmentored teachers may be significantly different
only at time 3, or they may be significantly different at both time 2 and time 3.

Chapter 12
1. While most correlations are calculated on two continuous variables, the Pearson

correlation coefficient can also be calculated on one dichotomous and one continu-
ous variable (called a point-biserial correlation), or on two dichotomous variables
(called a phi coefficient).

Chapter 13
1. Linear regression is related to correlation (correlation was discussed in Chapter 12);

in fact, a significant correlation between two variables is required in order for one
variable to be a significant predictor of the other in linear regression. However, the
objectives of the two procedures are somewhat different. Where correlation
describes the relationship between two variables, in simple linear regression the
goal is to assess whether one variable is a significant predictor of another variable.

2. While continuous predictors are typically used in simple regression, a predictor
variable can be categorical if it consists of only two values (i.e., it is dichoto-
mous). If the categorical variable consists of more than two categories, special
coding of the variable is required and multiple regression should be used.

3. While the ANOVA and Coefficients tables provide the same test in simple regression,
they are not identical in multiple regression, as is illustrated in Chapter 14.

4. The predicted scores can be solved for in SPSS by clicking the Save button in the
Linear Regression dialog box (shown in Figure 13.6) and then clicking
Unstandardized in the Predicted Values section of the dialog box. The predicted
scores will then be placed in the data file to the right of the variable wellbeing.

5. When the regression coefficients are standardized, the Y-intercept is equal to zero
and is dropped from the Coefficients table (which is why there is no value
reported for Constant in the Standardized Coefficients column).

Chapter 14
1. Multiple regression is a fairly complex topic and only an introduction is presented

here. Stevens (2002) is a good resource for more information on the topic.
2. Categorical variables with two levels (e.g., gender) may be entered directly into

SPSS as a single predictor; categorical variables with three or more levels must be
recoded into multiple predictors (with the number of predictors equal to the number
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of categories ) prior to entering them into the regression equation. See Cohen,
Cohen, West, and Aiken (2002) for more information on coding categorical
predictors with three or more levels.

3. High correlations among the predictors can lead to a problem known as multi-
collinearity, which can result in unstable estimates for the predictors in the regres-
sion equation. See Stevens (2002) for more details on multicollinearity.

4. In hierarchical regression one or more predictors enter the model and a first
regression is run, then one or more new predictors enter the model and a second
regression is run, and so on. A primary objective of hierarchical regression is to
see if the predictor(s) added in a later run account for a significant amount of vari-
ance above and beyond the predictor(s) added earlier.

5. SPSS can solve for these scores by clicking the Save button in the Linear
Regression dialog box (shown in Figure 14.6) and then clicking on
Unstandardized in the Predicted Values section of the dialog box. The predicted
scores will then be placed in a new variable to the right of success in the data file.

6. When the regression coefficients are standardized, the Y-intercept is equal to zero
and is dropped from the Coefficients table (which is why there is no value
reported for Constant in the Standardized Coefficients column).

7. If one or more categorical predictors are included in the model, and the inequality
in the sample sizes is moderate to large, then the presence of homoscedasticity
can compromise the accuracy of the multiple regression procedure.

Chapter 15
1. Strictly speaking, the value of the chi-square statistic is also affected by the

absolute size of the expected frequencies.
2. When using the weight cases method of data entry, if the cases are not weighted

prior to running the chi-square, the results will be incorrect.
3. It is important to note that the cases remain weighted until either the weight cases

option is turned off (by clicking Do not weight cases in the Weight Cases dialog
box and clicking OK) or until SPSS is closed. If additional analyses are performed
other than the chi-square test, failing to turn the weight cases option off can lead
to incorrect analyses and/or error messages.

4. The percentage of people in each of the categories may be calculated in SPSS by
running the Frequencies procedure on groupsize (assuming the cases are
weighted). See Chapter 2 for more information on using the Frequencies procedure
in SPSS.

Chapter 16
1. It is important to note that the cases remain weighted until either the weight cases

option is turned off (by selecting Do not weight cases in the Weight Cases dialog
box and clicking OK) or until SPSS is closed. If additional analyses are performed
other than the chi-square test, failing to turn the weight cases option off can lead
to incorrect analyses and/or error messages.

Appendix A
1. While the recode step, may seem unnecessary, if it is omitted, there will be

missing values for all 3s in the data set.
2. More than one variable may be recoded in a single SPSS run as long as all the

recoded variables have the same scale values (e.g., all variables have the response
option 1, 2, 3, 4, and 5). To add additional variables, move each variable to the

box (see Figure A.5) and assign anNumeric Variable : Output Variable

3 : 3,

-1
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appropriate name for each recoded variable. For example, if a fourth item,
meaning4, existed and was negative, meaning4 would be moved to the

box and the variable name
meaning4_recode would be entered in the Output Variable Name box. Since the
recoded values were already entered for meaning2_recode, they would not need
to be entered again.

3. Because meaning2 is a negative item, meaning2_recode is used in computing the
total score.

4. An alternative method for adding the variables together would be to use the sum
function in SPSS. Functions are built-in commands in SPSS that carry out certain
operations on variables. Coverage of these functions, however, is beyond the
scope of this text.

5. While the t test was conducted to illustrate the Select Cases procedure, it is
unlikely it would have been significant with a sample size of only five participants
(due to low power).

Appendix B
1. Excel files can also be opened in SPSS 18.0 by the following method: From the

menu bar select and then in the Open Data dialog box
select Excel files under files of type. Next, locate and select the Excel file of
interest, click the Open button, and then follow the instructions in the Opening
Excel Data Source window in SPSS to open the file. If the Excel file is formatted
with the variables in row 1 of the spreadsheet and the data beginning in row 2,
then the file should open successfully in SPSS after clicking the OK button in the
Opening Excel Data Source window.

File>Open>Data Á .

Numeric Variable : Output Variable
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A

Active cell, 5
Adjusted 

in multiple regression, 184–185
in simple regression, 171–172

Alpha
adjusted for multiple tests, 133–134
defined, 60

Alternate form reliability, 49
Alternative hypothesis, 58–59
Analysis of variance (ANOVA), one-

between–one-within subjects
assumptions, 154–155
commands for analyzing, 142–146
effect size, 153–154
entering the data, 142
example, 139
exercises, 156–157
expression of results in APA format, 154
null and alternative hypotheses, 140
objectives and data requirements of, 139
output of, 146–154
research questions, 140–141
summary of steps for conducting,

155–156
Analysis of variance (ANOVA), one-

way between subjects
assumptions, 100
commands for analyzing, 94–95
effect size, 99–100
entering the data, 92–93
example, 91
exercises, 101–103
expression of the results in APA 

format, 100

R2

Index

null and alternative hypotheses, 91–92
objective and data requirements of, 91
output of, 95–99
research question, 92
summary of steps for conducting,

100–101
Analysis of variance (ANOVA), one-

way within subjects
assumptions, 136
commands for analyzing, 126–128
effect size, 134–135
entering the data, 124–125
example, 123
exercises, 137–138
expression of the results in APA 

format, 135–136
null and alternative hypotheses,

123–124
objective and data requirements of,

123
output of, 128–135
research question, 124
summary of steps for conducting,

136–137
Analysis of variance (ANOVA), two-

way between subjects
assumptions, 118–119
commands for analyzing, 107–111
effect size, 117–118
entering the data, 107–108
example, 104
exercises, 120–122
expression of the results in APA 

format, 118
null and alternative hypotheses,

105–106
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Analysis of variance (continued )
objectives and data requirements of, 105
output of, 112–118
research questions, 106
summary of steps for conducting,

119–120
APA results section

chi-square goodness of fit test,
200–201

chi-square test of independence, 212
Pearson r correlation coefficient, 163
dependent samples t test, 87
independent samples t test, 78
multiple regression, 187
one-sample t test, 67–68
one-between–one-within subjects

ANOVA, 154
one-way between subjects ANOVA,

100
one-way within subjects ANOVA,

135–136
simple regression, 174
two-way between subjects ANOVA,

118
Assumptions

chi-square goodness of fit test, 200
chi-square test of independence,

212–213
dependent samples t test, 87–88
independent samples t test, 78
multiple regression, 187
one-sample t test, 68
one-between–one-within subjects

ANOVA, 154–155
one-way between subjects ANOVA, 100
one-way within subjects ANOVA, 136
Pearson r correlation coefficient, 163
simple regression, 174
two-way between subjects ANOVA,

118–119
Average. See mean

B

Bar chart, 38–39, 44, 111, 114, 117, 119
Beta weight, 166, 173, 177–178, 186
Between-subjects factor, 91
Bivariate correlation. See Pearson r

correlation coefficient
Bivariate linear regression. See simple

regression

Boxplot, 42–46
Brown-Forsythe test, 101

C

Categorical variables, 8
Cell, 5
Central tendency, measures of, 22
Charts. See graphical procedures
Chi-square goodness of fit test

assumptions, 200
commands for analyzing, 195–198
entering the data, 194–195
example, 191
exercises, 201–202
expression of the results in APA 

format, 199–200
null and alternative hypotheses,

191–192
objective and data requirements of,

191
output of, 198
research question, 192
summary of steps for conducting,

200–201
Chi-square test of independence

assumptions, 212–213
commands for analyzing, 206–210
effect size, 212
entering the data, 205–206
example, 203
exercises, 214–215
expression of the results in APA 

format, 212
null and alternative hypotheses, 204
objective and data requirements of,

204
output of, 210–212
research question, 204
summary of steps for conducting,

213–214
Coefficient alpha

commands for analyzing, 
53–54

entering the data, 52
example, 50–51
exercises, 56–57
expression of the results, 56
objective and data requirements of, 51
output of, 54–55
summary of steps for conducting, 56
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Cohen’s d
dependent samples t test, 87
independent samples t test, 78
one-sample t test, 67

Column(s)
in data view window, 5
in variable view window, 6

Completely crossed design, 104
Compute procedure, 220–222
Correlation. See Pearson r correlation

coefficient
Cramer’s V, 212
Criterion variable, 166, 177
Cronbach’s alpha. See coefficient alpha

D

d statistic. See Cohen’s d
Data, defined, 5
Data editor, 3–6
Data entry, 11–12
Data file, 6–7
Data view window, 5
Dependent samples t test. See t test,

dependent samples
Dependent variable, 62
Dialog box, 3
Difference scores, 87–88
Dunnett’s T3, 101

E

Effect size statistic, computing
chi-square test of independence, 212
dependent samples t test, 87
independent samples t test, 78
multiple regression, 186
one-between–one-within ANOVA,

153–154
one-sample t test, 67
one-way between subjects ANOVA,

99–100
one-way within subjects ANOVA,

134–135
Pearson r correlation coefficient,

162–163
simple regression, 173
two-way between subjects ANOVA,

117–118
Entering data. See data entry
Equal variances, assumption of

independent samples t test, 76–77

one-between–one-within subjects
ANOVA, 155–156

one-way between subjects ANOVA,
96–98

two-way between subjects ANOVA,
114–115

Eta-square, 99–100. See also partial eta
square

Expected frequencies
chi-square goodness of fit test,

192–193, 198–200
chi-square test of independence,

210–213
Extension. See file extension

F

F test, for Levene’s. See Levene’s test of
equality of variances

F test
one-between–one-within subjects

ANOVA, 150–151
one-way between subjects ANOVA,

96–98
one-way within subjects ANOVA,

131–132
two-way between subjects ANOVA,

115–116
Factor, 91
File extension, 16–18
File menu

open, 37
print, 18–20
save as, 16–18

File, splitting. See split file procedure
Follow-up tests

one-between–one-within subjects
ANOVA, 151–153

one-way between subjects ANOVA,
98–99

one-way within subjects ANOVA,
132–134

two-way between subjects ANOVA,
120

Frequencies procedure, 24–26

G

General linear model procedure
in one-between–one-within subjects

ANOVA, 142–143
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General linear model (continued )
in one-way within subjects ANOVA,

126
in two-way between subjects

ANOVA, 107–108
Goodness of fit test. See chi-square

goodness of fit test
Graphical procedures

bar chart, 38–39, 44, 111, 114, 117,
119

boxplot, 42–46
histogram, 39–40, 44
scatterplot, 40–42, 44–45

Greenhouse-Geisser adjustment procedure
in one-between–one within subjects

ANOVA, 147–148, 150–151
in one-way within subjects ANOVA,

130–132

H

See null hypothesis
See alternative hypothesis

Histogram, 39–40, 45
Homogeneity of variance. See equal

variances, assumption of
Huynh-Feldt adjustment procedure

in one-between–one-within subjects
ANOVA, 148, 150

in one-within subjects ANOVA,
130–131

Hypothesis testing, 58–59

I

Icon, 2
Independence of observations, assump-

tion of, 68, 79, 88, 100, 118, 136,
154, 163, 174, 187, 200, 212

Independent samples t test. See t test,
independent samples

Independent variable, 71
Inferential statistics, 58
Interaction effect

one-between–one-within subjects
ANOVA, 150–151

two-way between subjects ANOVA,
115–117

Intercept
in multiple regression, 185–186
in simple regression, 172–173

H1 .
H0 .

Internal consistency reliability. See coef-
ficient alpha

L

Labels. See value labels
Levels, of a factor, 91
Levene’s test of equality of variances

independent samples t test, 76–77
one-way between subjects ANOVA,

96–98
two-way between subjects ANOVA,

114–115
Linear regression. See simple regression
LMATRIX command, in two-way

between subjects ANOVA, 117
Lower-bound adjustment procedure

in one-between–one-within subjects
ANOVA, 147–148, 150

in one-way within subjects ANOVA,
130–131

M

Main effect, 105, 117, 139
Marginal means, 116, 152
Matched subjects t test. See t test,

dependent samples
Mauchley’s test of sphericity

in one-between–one-within subjects
ANOVA, 147, 150–151

in one-way within subjects ANOVA,
129–132

Mean. See measures of central tendency
Means procedure, 26–30, 32–33
Measures of central tendency, 22
Median. See measures of central 

tendency
Menu bar, 3
Mode. See measures of central tendency
Multiple comparisons, 98–99
Multiple correlation coefficient

in multiple regression, 185
in simple regression, 171–172

Multiple linear regression
assumptions, 187
commands for analyzing, 180–183
effect size, 186
entering the data, 180
example, 177
exercises, 188–190
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expression of the results in APA 
format, 186–187

null and alternative hypotheses,
177–178

objective and data requirements of, 177
output of, 183–186
research questions, 179
summary of steps for conducting,

187–188
Multivariate test

in one-between–one-within subjects
ANOVA, 146–147, 150

in one-way within subjects ANOVA,
129–130

N

Negative item, 50, 216–220
Normality, assumption of, 68, 79,

87–88, 100, 119, 136, 155, 163,
174, 187

Null hypothesis, 58–59

O

Observed frequencies
chi-square goodness of fit test,

192–193, 198–199
chi-square test of independence, 

211
One-between–one-within subjects

ANOVA. See Analysis of variance
(ANOVA), one-between–one-within
subjects

One-sample t test. See t test, one-sample
One-tailed test, 59
One-way between subjects ANOVA. See

Analysis of variance (ANOVA),
one-way between subjects

One-way within subjects ANOVA. See
Analysis of variance (ANOVA),
one-way within subjects

Outliers
in boxplots, 42, 45, 46
correlation, 163

Output
chi-square goodness of fit test,

198–199
chi-square test of independence,

210–212
coefficient alpha, 54–55

dependent samples t test, 86–87
independent samples t test, 75–78
multiple regression, 183–187
one-sample t test, 66–67
one-between–one-within subjects

ANOVA, 146–154
one–way between subjects ANOVA,

95–99
one–way within subjects ANOVA,

128–135
Pearson r correlation coefficient,

161–163
simple regression, 170–173
two–way between subjects ANOVA,

112–118
Output window, 15–16

P

Paired samples t test. See t test, depen-
dent samples

Pairwise comparisons, 97–99, 132–134
Partial eta-square

in one-way within subjects ANOVA,
134–135

in one-between–one-within ANOVA,
153–154

in two-way between subjects
ANOVA, 117–118

Pearson chi-square test statistic
chi-square goodness of fit test,

198–199
chi-square test of independence, 

210–212
Pearson r correlation coefficient

assumptions, 163
commands for analyzing, 160–161
effect size, 162–163
entering the data, 159–160
example, 158
exercises, 164–165
expression of the results in APA 

format, 163
null and alternative hypotheses,

158–159
objective and data requirements of, 158
output of, 161–163
research question, 159
summary of steps for conducting,

163–164
Phi coefficient, 212
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Population, 58
Post hoc tests. See follow-up tests
Power, 59
Predicted value

in multiple regression, 185–186
in simple regression, 172–173

Predictor
in multiple regression, 177
in simple regression, 166

Print dialog box, 20
Printing

the data file, 20
the output file, 18–20

Profile plots, 113, 115, 149, 151
Programs menu, 2
p-value, 60–61

R

R
in multiple regression, 184–185
in simple regression, 171–172

in multiple regression, 184–187
in simple regression, 170–174

Recode procedure, 50, 216–220
Regression

multiple. See multiple regression
simple. See simple regression

Regression equation
in multiple regression, 185–186
in simple regression, 172–173

Related samples t test. See t test, depen-
dent samples

Reliability. See coefficient alpha
Repeated measures t test. See t test,

dependent samples
Results. See output

S

Sample, 58
Sampling error, 59–60
Saving files

data, 18
output, 16–18

Scatterplot, 40–42, 44–45
Select cases procedure, 223–227
Simple effects, 117, 151–153
Simple regression

assumptions, 174

R2

commands for analyzing, 168–170
effect size, 173
entering the data, 167–168
example, 166
exercises, 175–176
expression of the results in APA 

format, 174
null and alternative hypotheses,

166–167
objective and data requirements of,

166
output of, 170–173
research question, 167
summary of steps for conducting,

174–175
Sphericity, assumption of, 129–132,

136, 148, 150–151
Split file procedure, 227–230
Split-half reliability, 49
Standard error of the estimate

in multiple regression, 184–185
in simple regression, 171–172

Starting SPSS, 2–3

T

t test, dependent samples,
assumptions, 87–88
commands for analyzing, 85–86
effect size, 87
entering the data, 83–84
example, 82
exercises, 88–89
expression of the results in APA 

format, 87
null and alternative hypotheses, 82–83
objective and data requirements of, 82
output of, 86–87
research question, 83
summary of steps for conducting, 88

t test, independent samples,
assumptions, 79
commands for analyzing, 74–75
effect size, 78
entering the data, 72–73
example, 71
exercises, 80–81
expression of the results in APA 

format, 78
null and alternative hypotheses, 71–72
objective and data requirements of, 71
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output of, 75–78
research question, 72
summary of steps for conducting, 79

t test, one-sample
assumptions, 68
commands for analyzing, 65–66
effect size, 67
entering the data, 64
example, 62
exercises, 69–70
expression of the results in APA 

format, 67
null and alternative hypotheses, 62–63
objective and data requirements of, 62
output of, 66–67
research question, 63
summary of steps for conducting, 68

Test-retest reliability, 49
Toolbar buttons, 3
Transform menu, 217, 221
Tukey’s test

interpreting the results of, 98–99
selecting, 94–95

Two-tailed test, 59
Two-way between subjects ANOVA. See

Analysis of variance (ANOVA),
two-way between subjects

Type I error
controlling for, 133–134
defined, 59

Type II error, 59

U

Univariate procedure. See General linear
model procedure

V

Value labels, 9–11
Variability, measures of, 22
Variable

categorical, 7
continuous, 7
creating, 8–9
defined, 6
dichotomous, 7

Variable view window, 5–6
Viewer window. See output window

W

Weight cases method
chi-square goodness of fit test, 193,

195–196
chi-square test of independence,

205–207
Welch’s test, 101
Within subjects factor, 123
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